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1.1 Overview 

This manual introduces the AS Series PLC CPU functions, devices, module tables, basic instructions, applied 
instructions, electrical specifications troubleshooting, as well as appearances, dimensions, and so forth.  
 

1.1.1 Related Manuals 

The related manuals for AS Series programmable logic controllers are listed below. 
 AS Series Quick Start 
 This guides you in how to use the system before reading the related manuals. 
 AS Series Programming Manual 

This introduces programming for the AS Series programmable logic controllers, basic instructions, and 
applied instructions. 

 ISPSoft User Manual 
 This introduces the use of the ISPSoft software, programming language (Ladder, IL, SFC, FBD, and ST), 
POUs, and tasks. 

 AS Series Hardware and Operation Manual 
 This introduces electrical specifications, appearances, dimensions, CPU functions, devices, module 
tables, troubleshooting, and so forth. 

 AS Series Module Manual 
 This introduces special I/O modules such as network modules, analog I/O modules, temperature 
measurement modules, motion control modules, and so forth. 
 

1.1.2 Models Descriptions  

Classification Model Name Description 

Power supply 

module 

AS-PS02 
Input: 100-240 VAC, 50/60 Hz  

Output: 24VDC/2A, 48W (for PLC internal use) 

AS-PS02A 

Input: 100-240 VAC, 50/60 Hz  

Output: 24VDC/1.5A, 36W (for PLC internal use) 

Output: 24VDC/0.5A, 12W (for external use) 

AS-PS03C 

Input: 100-240 VAC, 50/60 Hz  

Output: 24VDC/3A, 72W (for PLC internal use) 

With RS-485 communication port, it can act as a slave, 

providing information including power status. working hours 

and so on. 

AS CPU power 

module adaptor 
AS-ATXB 

For easier wiring, this adaptor allows wiring on the bottom of 

the module instead of on the left-side of the module.   

AS300 Series 

CPU module 
AS332P-A 

CPU module, 24VDC power input, PNP output, 1x Ethernet 

port, 2x RS-485 ports, 1x USB port, 1x Micro SD interface, 

2x function cards (optional), supporting 32 I/Os 
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Classification Model Name Description 

(16DI+16DO) and up to 1024 I/Os. Program capacity:128K 

steps, high-density terminal blocks 

AS332T-A 

CPU module, 24VDC power input, NPN output, 1x Ethernet 

port, 2x RS-485 ports, 1x USB port, 1x Micro SD interface, 

2x function cards (optional), supporting 32 I/Os 

(16DI+16DO) and up to 1024 I/Os. Program capacity:128K 

steps, high-density terminal blocks 

AS324MT-A 

CPU module, 24VDC power input, NPN differential output, 

1x Ethernet port, 2x RS-485 ports, 1x USB port, 1x Micro 

SD interface, 2x function cards (optional), supporting 24 

I/Os (12DI+12DO) and up to 1016 I/Os. Program 

capacity:128K steps, high-density terminal blocks 

AS320P-B 

CPU module, 24VDC power input, PNP output, 1x Ethernet 

port , 2x RS-485 ports, 1x USB port, 1x Micro SD interface, 

2x function cards (optional), supporting 20 I/Os (8DI+12DO) 

and up to 1024 I/Os. Program capacity:128K steps, 

removable terminal blocks 

AS320T-B 

CPU module, 24VDC power input, NPN output, 1x Ethernet 

port, 2x RS-485 ports, 1x USB port, 1x Micro SD interface, 

2x function cards (optional), supporting 20 I/Os (8DI+12DO) 

and up to 1024 I/Os. Program capacity:128K steps, 

removable terminal blocks 

AS300N-A 

CPU module, 24VDC power input, no I/Os, 1x Ethernet port, 

2x RS-485 ports, 1x USB port, 1x Micro SD interface, 2x 

function cards (optional), and supporting up to 1024 I/Os. 

Program capacity:128K steps 

AS200 Series 

CPU module 

AS228P-A 

CPU module, 24VDC power input, PNP output, 1x Ethernet 

port , 2x RS-485 ports, 1x USB port, 1x Micro SD interface, 

CAN communication port, supporting 28 I/Os (16DI+12DO) 

and up to 1024 I/Os. Program capacity: 64K steps, 

removable terminal blocks 

AS228T-A 

CPU module, 24VDC power input, NPN output, 1x Ethernet 

port , 2x RS-485 ports, 1x USB port, 1x Micro SD interface, 

CAN communication port, supporting 28 I/Os (16DI+12DO) 

and up to 1024 I/Os. Program capacity: 64K steps, 
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removable terminal blocks 

AS228R-A 

CPU module, 24VDC power input, Relay output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 28 I/Os 

(16DI+12DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

AS218PX-A 

CPU module, 24VDC power input, PNP output, 1x Ethernet 

port , 2x RS-485 ports, 1x USB port, 1x Micro SD interface, 

CAN communication port, supporting 18 I/Os 

(8DI+6DO+2AI+2AO) and up to 1024 I/Os. Program 

capacity: 64K steps, removable terminal blocks 

AS218TX-A 

CPU module, 24VDC power input, NPN output, 1x Ethernet 

port , 2x RS-485 ports, 1x USB port, 1x Micro SD interface, 

CAN communication port, supporting 18 I/Os 

(8DI+6DO+2AI+2AO) and up to 1024 I/Os. Program 

capacity: 64K steps, removable terminal blocks 

AS218RX-A 

CPU module, 24VDC power input, Relay output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 18 I/Os 

(8DI+6DO+2AI+2AO) and up to 1024 I/Os. Program 

capacity: 64K steps, removable terminal blocks 

AS100 Series 

CPU module 

AS132P-A 

CPU module, 100-240VDC power input, PNP output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 32 I/Os 

(16DI+16DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

AS132T-A 

CPU module, 100-240VDC power input, NPN output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 32 I/Os 

(16DI+16DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

AS132R-A 

CPU module, 100-240VDC power input, Relay output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 32 I/Os 

(16DI+16DO) and up to 1024 I/Os. Program capacity: 64K 
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steps, removable terminal blocks 

AS148P-A 

CPU module, 100-240VDC power input, PNP output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 48 I/Os 

(24DI+24DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

AS148T-A 

CPU module, 100-240VDC power input, NPN output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 48 I/Os 

(24DI+24DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

AS148R-A 

CPU module, 100-240VDC power input, Relay output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 48 I/Os 

(24DI+24DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

AS164P-A 

CPU module, 100-240VDC power input, PNP output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 64 I/Os 

(32DI+32DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

AS164T-A 

CPU module, 100-240VDC power input, NPN output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 64 I/Os 

(32DI+32DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

AS164R-A 

CPU module, 100-240VDC power input, Relay output, 1x 

Ethernet port , 2x RS-485 ports, 1x USB port, 1x Micro SD 

interface, CAN communication port, supporting 64 I/Os 

(32DI+32DO) and up to 1024 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

Digital 

input/output 

module 

AS08AM10N-A 

24VDC  

5mA 

8 inputs 

Spring-clamp terminal block 
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AS08AN01P-A 

5 - 30VDC 

0.5A/output, 4A/COM 

8 outputs 

Sourcing output 

Spring-clamp terminal block 

AS08AN01R-A 

240VAC/24VDC 

2A/output, 8A/COM 

8 outputs 

Relay 

Spring-clamp terminal block 

AS08AN01T-A 

5 - 30VDC 

0.5A/output, 4A/COM 

8 outputs 

Sinking output 

Spring-clamp terminal block 

AS16AM10N-A 

24VDC 

5mA 

16 inputs 

Spring-clamp terminal block 

AS16AN01P-A 

5 - 30VDC 

0.5A/output, 4A/COM 

16 outputs 

Sourcing output 

Spring-clamp terminal block 

AS16AN01R-A 

240VAC/24VDC 

2A/output, 8A/COM 

16 outputs 

Relay 

Spring-clamp terminal block 

AS16AN01T-A 

5 - 30VDC 

0.5A/output, 4A/COM 

16 outputs 
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Sinking output 

Spring-clamp terminal block 

AS16AP11P-A 

24VDC 

5mA 

8 inputs 

5 - 30VDC 

0.5A/output, 4A/COM 

8 outputs 

Sourcing output 

Spring-clamp terminal block 

AS16AP11R-A 

24VDC 

5mA 

8 inputs 

240VAC/24VDC 

2A/output, 8A/COM 

8 outputs 

Relay 

Spring-clamp terminal block 

AS16AP11T-A 

24VDC 

5mA 

8 inputs 

5 - 30VDC 

0.5A/output, 4A/COM 

8 outputs 

Sinking output 

Spring-clamp terminal block 

AS32AM10N-A 

24VDC 

3.2mA 

32 inputs 

MIL connector 

AS32AN02T-A 
5 - 30VDC 

0.1A/output, 3.2A/COM 
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32 outputs 

Sinking output 

MIL connector 

AS64AM10N-A 

24VDC 

3.2mA 

64 inputs 

MIL connector 

AS64AN02T-A 

5 - 30VDC 

0.1A/output, 3.2A/COM 

64 outputs 

Sinking output 

MIL connector 

Analog 

input/output 

module 

AS04AD-A 

4-channel analog input module 

Hardware resolution: 16 bits 

0–10V, 0/1–5V, -5 to +5V, -10 to +10V, 0/4–20mA, -20–

+20mA 

Conversion time: 2 ms/channel 

AS08AD-B 

8-channel analog input module 

Hardware resolution: 16 bits 

0 to +10V, 0/1–5V, -5V to +5V, -10V to +10V 

Conversion time: 2 ms/channel 

AS08AD-C 

8-channel analog input module 

Hardware resolution: 16 bits 

0/4–20mA, -20mA–+20mA 

Conversion time: 2 ms/channel 

AS04DA-A 

4-channel analog output module 

Hardware resolution: 12 bits 

-10 to +10V, 0–20mA, 4–20mA 

Conversion time: 2 ms/channel 

AS06XA-A 

4-channel analog input 

Hardware resolution: 16 bits 

0–10V, 0/1–5V, -5 to +5V, -10 to +10V, 0/4–20mA, -20 to 
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+20mA 

Conversion time: 2 ms/channel 

2-channel analog output 

Hardware resolution: 12 bits 

-10 to +10V, 0–20mA, 4–20mA 

Conversion time: 2 ms/channel 

Temperature 

measurement 

module 

AS04RTD-A 

4-channel, 2-wire/3-wire RTD  

Sensor type: Pt100 / Ni100 / Pt1000 / Ni1000 / JPt100 / LG-

Ni1000 / Cu50 / Cu100 / 0-300Ω / 0-3000Ω input impedance 

Resolution: 0.1°C/0.1°F (16 bits) 

Conversion time: 200ms/channel 

AS06RTD-A 

6-channel, 2-wire/3-wire RTD  

Sensor type: Pt100 / Ni100 / Pt1000 / Ni1000 / JPt100 / LG-

Ni1000 / Cu50 / Cu100 / 0-300Ω / 0-3000Ω input 

impedance, Resolution: 0.1°C/0.1°F (16 bits) 

Conversion time: 200ms/channel 

AS04TC-A 

4-channel thermocouple 

Sensor type: J, K, R, S, T, E, N, B and -100 to +100 mV  

Resolution: 0.1°C/0.1°F (24 bits) 

Conversion time: 200ms/channel 

AS08TC-A 

8-channel thermocouple 

Sensor type: J, K, R, S, T, E, N, B and -100 to +100 mV  

Resolution: 0.1°C/0.1°F (24 bits) 

Conversion time: 200ms/channel 

Load cell 

module 
AS02LC-A 

2-channel, 4-wire/6-wire load cell sensor 

Eigenvalues for a load cell: 1, 2, 4, 6, 20, 40, 80 mV/V 

Highest precision 1/10000 @ 50ms of conversion time 

ADC Resolution : 4 bits 

Conversion time: 2.5–400ms (nine options to choose from) 

Positioning  

module 
AS02PU-A 

2-axis motion control 

5-24 VDC, 1 differential input (A/B/Z phase), maximum 

hardware input frequency at 200 kHz 

24 VDC, 5 mA, 5 inputs, maximum hardware input 
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frequency at 1 kHz, 

5 VDC, 2-axis (4 points) differential outputs, maximum 

output frequency at 200 kHz 

AS04PU-A 

4-axis motion control 

24 VDC, 5mA, 6 inputs, maximum hardware input frequency 

at 1 kHz 

5-30 VDC, 0.1A, 4-axis (8 points) open collector output,  

maximum output frequency at 100 kHz 

Counter 

module 
AS02HC-A 

2-channel high-speed counters 

Input methods are pulse-input (max. at 200 kHz) and SSI 

communication interface input (max. at 1.25 MHz) 

4-axis high-speed open collector output, 5-30 VDC, 0.1A, 

can work with high-speed instructions to output 

Network 

module 

AS00SCM-A 
Serial communication module, 2x communication ports for 

communication cards, supporting Modbus protocols 

AS01DNET-A 
DeviceNet communication port, functioning as master or 

slave  

AS04SIL-A IO-Link module, built-in with 4 IO-Link communication ports 

Remote I/O 

module 

AS00SCM-A 

+ 

AS-FCOPM 

For AS-FCOPM function cards 

AS00SCM-A 

+ 

AS-FEN02 

For AS-FEN02 function cards 

AS01DNET-A (RTU) 

DeviceNet remote IO slave, its right side connectswith AS 

Series extension modules, including digital modules, analog 

modules, temperature modules, etc.  

Function cards 

AS-F232 
Serial communication port, RS232, functioning as master or 

slave 

AS-F422 
Serial communication port, RS422, functioning as master or 

slave 

AS-F485 
Serial communication port, RS485, functioning as master or 

slave 
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AS-FCOPM 
CANopen communication port, supporting DS301, AS 

series remote modules and Delta servo systems 

AS-F2AD 

2-channel analog input  

0-10V (12 bits), 4-20mA (11 bits) 

Conversion time: 3ms/channel 

AS-F2DA 

2-channel analog output  

0-10V, 4-20mA (12 bits) 

Conversion time: 2ms/channel 

AS-FEN02 

Only available for AS300 Series PLC CPU, 2x Ethernet 

ports, supporting switch function, Modbus TCP, EtherNet/IP 

Adapter and AS Series remote control 

AS-FPFN02 

Only available for AS300 Series PLC CPU, 2x Ethernet 

ports, , supporting switch function and PROFINET Device 

(adapter) 

AS-FOPC02 

Only available for AS300 Series PLC CPU, 2x Ethernet 

ports, supporting switch function, OPC UA Server and 

Modbus TCP 

Programming 

cable 

UC-PRG015-01A 

(1.5M) 

Used for the connection between a PLC and a PC via a mini 

USB port, use for AS332T-A, AS332P-A, and AS324MT-A 

UC-PRG030-01A (3M) 
Use for the connection between a PLC and a PC with a mini 

USB port, use for AS332T-A, AS332P-A, and AS324MT-A 

UC-PRG030-20A (3M) 

Use for the connection between a PLC and a PC with a 

RJ45 port, use for AS332T-A, AS332P-A, AS324MT-A , AS-

FEN02 and AS-FPFN02 

I/O extension 

cable 

UC-ET010-24B (1M) 

UC-ET020-24B (2M) 

UC-ET030-24B (3M) 

MIL connector, 40Pin ↔ 40Pin, shielded, use for  

AS32AM10N-A, AS32AN02T-A, AS64AM10N-A and 

AS64AN02T-A 

UC-ET010-24D (1M) 

UC-ET020-24D (2M) 

UC-ET030-24D (3M) 

MIL connector, 40Pin↔ 2x 20Pin, shielded, use for AS332T-

A, AS332P-A, AS324MT-A, AS32AM10N-A, AS32AN02T-A, 

AS64AM10N-A, and AS64AN02T-A 

External 

terminal 

module 

UB-10-ID16A 

16 inputs/outputs, 20-Pin MIL connector, use for AS332T-A, 

AS332P-A, AS324MT-A, AS32AM10N-A, AS32AN02T-A, 

AS64AM10N-A and AS64AN02T-A 
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UB-10-ID32A 
32 inputs, 40-Pin MIL connector, use for AS32AM10N-A and 

AS64AM10N-A 

UB-10-IO32D 

Terminal block (spring clamp/MIL connector), MIL connector 

to 40-Pin spring clamp terminal block, use for AS332T-A, 

AS332P-A, AS324MT-A, AS32AM10N-A, AS32AN02T-A 

UB-10-OR16A 
16 relay outputs, 20-Pin MIL connector, NPN, use for 

AS332T-A, AS32AN02T-A and AS64AN02T-A 

UB-10-OR16B 
16 relay outputs, 20-Pin MIL connector, PNP, use for 

AS332P-A 

UB-10-OT32A 
32 transistor outputs, 40-Pin MIL connector, NPN, use for 

AS32AN02T-A and AS64AN02T-A 

Network cables 

UC-CMC003-01A (0.3M) CANopen communication cable, use for AS-FCOPM series  

UC-CMC005-01A (0.5M) CANopen communication cable, use for AS-FCOPM series  

UC-CMC010-01A (1M) CANopen communication cable, use for AS-FCOPM series  

UC-CMC015-01A (1.5M) CANopen communication cable, use for AS-FCOPM series  

UC-CMC020-01A (2M) CANopen communication cable, use for AS-FCOPM series  

UC-CMC030-01A (3M) CANopen communication cable, use for AS-FCOPM series  

UC-CMC050-01A (5M) CANopen communication cable, use for AS-FCOPM series  

UC-CMC100-01A (10M) CANopen communication cable, use for AS-FCOPM series  

UC-CMC200-01A (20M) CANopen communication cable, use for AS-FCOPM series  

UC-EMC003-02A (0.3M) 
Ethernet communication cable, use for AS Series CPU 

modules, AS-FEN02 and AS-FPFN02 

UC-EMC005-02A (0.5M) 
Ethernet communication cable, use for AS Series CPU 

modules, AS-FEN02 and AS-FPFN02 

UC-EMC010-02A (1M) 
Ethernet communication cable, use for AS Series CPU 

modules, AS-FEN02 and AS-FPFN02 

UC-EMC020-02A (2M) 
Ethernet communication cable, use for AS Series CPU 

modules, AS-FEN02 and AS-FPFN02 

UC-EMC050-02A (5M) 
Ethernet communication cable, use for AS Series CPU 

modules, AS-FEN02 and AS-FPFN02 

UC-EMC100-02A (10M) 
Ethernet communication cable, use for AS Series CPU 

modules, AS-FEN02 and AS-FPFN02 
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UC-EMC200-02A (20M) 
Ethernet communication cable, use for AS Series CPU 

modules, AS-FEN02 and AS-FPFN02 

 
1.2 Overview 

An AS series CPU module is an advanced controller with built-in 6 high speed counters for inputs, up to 6-axis 

(pulse), and can optionally work with a total of 8-axis (CANopen) position outputs. It provides a strong network 

function for users, and users can create connection among devices on the network through software. An AS 

series CPU module also provides structured programming. Users can assign programs to different tasks, and 

write a program which is frequently executed in a function block. Besides, users can choose different 

programming languages ladder diagrams (LD), structured texts (ST), sequential function charts (SFC), 

continuous function chart (CFC) and C language dealt with by IEC 61131-3 according to their needs when 

writing programs. They can create the AS series hardware configuration by means of hardware configuration 

software. They can also restore or back up a system rapidly through the built-in SD interface in an AS series 

CPU module. This manual introduces the basic operation of an AS series system, and help users familiarize 

themselves with the AS series system. 
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Characteristics of the AS series CPU module: 

(1) High efficiency 

 The AS Series CPU module uses a 32-bit high-speed processor. The module executes basic 

instructions at 25 ns each and moving instructions at 150ns each. The module executes instructions 

at a speed of 40k steps/ms (40% of the instructions are basic instructions, and 60% of the 

instructions are applied instructions).  

 The CPU of the AS Series uses the Soc architecture, built with six (or three) high speed counters. 

The maximum frequency is 200 kHz for each counter (differential output models can reach 4 MHz); 

six-axis high speed position output at 200 kHz (differential output models can reach 4 MHz). 

(2) Supporting more inputs and outputs 

 The AS series CPU module supports up to 1024 digital I/Os or 32 I/O modules (any type) or 16 

analog I/O modules.  

 The AS series works with SCM/DNETcommunication modules (AS-FCOPM, and AS-FEN02 included) 

to create a remote connection, and you can connect up to 15 remote modules.  

Note: For the connections between the CPU modules and the remote modules, the I/O points cannot 

exceed 1024 I/Os, 32 I/O modules (any type), or 16 analog I/O modules.  

(3) Multiple I/O modules 

 The AS series CPU module supports the following I/O modules: digital input/output modules, analog 
input/output modules, temperature measurement modules, positioning/counter modules, network 
modules, and function cards. Refer to section 1.1.2 section for more details.  

(4) Larger program capacity and memory 

 The AS300 Series advanced CPU modules have 128k steps of program capacity. 60000 general 
registers (30000 for specific use and 30000 for programming editing), and 64k words of memory (that 
can be used for storing parameters).  

 The AS200 Series advanced CPU modules have 64k steps of program capacity. 60000 general 
registers (30000 for specific use and 30000 for programming editing), and 64k words of memory (that 
can be used for storing parameters).  

(5) Supporting IEC 61131-3 

 The AS series CPU module supports IEC 61131-3. 

 Supported programming languages are ladder diagrams (LD), sequential function chart (SFC), 
structured text (ST), continuous function chart (CFC) (ISPSoft V3.01 or later) and C language 
(ISPSoft V3.08 or later). 
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 You can select a programming language according to your preference. Programming languages 
support one another so that programs written by different users are compatible. 

(6) Strong function block 

 Both standard IEC61131-3 function blocks and convenient functions blocks provided by Delta 

Electronics, Inc. are supported. You can use function blocks for frequently used programs for greater 

structure and convenience. 

 The symbol for a function block in a ladder diagram is similar to an integrated circuit (IC) in a circuit 

diagram. Because the ladder diagram is based on the traditional circuit diagram, the operation of a 

function block is similar to the function of an integrated circuit. You only need to send the signal to the 

corresponding input of the function block.  You do not need to consider the processing procedure 

inside the function block. 

 

 A function block is a program element equipped with the operation function. It is similar to a 

subroutine, and is a type of POU (Program Organization Unit). It cannot operate by itself, and must 

be called through the main program POU. The function defined by the function block is executed 

after being called with the related parameters. The final result can be sent to the device or variable in 

the superior POU after the function block completes.  

 You can set passwords in ISPSoft to provide function block security. The program inside a function 

block cannot be read, and business patents cannot be compromised. 
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(7) Task 

 

 You can assign 283 tasks at most to a program. Among these tasks, 32 are cyclic, 32 are I/O 

interrupts, 4 are timer interrupts, two are communication interrupts, one is an external 24 V low-

voltage interrupt, and 212 are user-defined tasks.  

 You can enable and disable a task when running a program by using the TKON and TKOFF 

instructions. 

(8) Increasing hardware configuration efficiency through a USB cable and ISPSoft 

 The AS Series CPU module provides a standard USB 2.0 interface. USB 2.0 increases the data 

transfer rate and decreases the time it takes to download the program, monitor the program, and 

configure the hardware. You do not need to buy a special communication cable for the CPU module. 

You can use a general USB cable to connect to the AS Series CPU module. 

(9) Serial control interface with multiple functions 

 AS Series CPU modules provide two RS-485 serial control interfaces, COM1 and COM2, which can 

be set as a either master or slave. 

 You use the communication cards to work with two extension serial communication ports and to set 

the port as a master or slave.  

(10) High-speed Ethernet communication interface 

 AS Series CPU modules are equipped with a 10/100 M Ethernet communication interface and 

support email, web, and socket services.  

 System error messages can be sent to your email immediately. You do not need to be on location to 

understand the problem.  
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(11) Memory card 

 The memory card has the following functions. 

System backup: user program, CPU parameters, module table, and the device setting values 

System recovery: user program, CPU parameters, module table, and device setting values 

Parameter storage: device value 

Log storage: system error log and system status log 

(12) I/O module installation 

 The AS Series PLC supports slide-and-lock installation on I/O modules when the power is off. After 

the PLC is powered off, you can remove the defective module and replace it with a new one without 

removing other modules. 

 
 

(13) Supporting on-line debugging mode 

 You can use the on-line debugging mode in the AS series CPU module after a single instruction step 

completes, or after a breakpoint is specified, to find bugs in the program.  

 The CPU module must be running to enter the debugging mode. After enabling the on-line monitoring 

function, click . The debugging screen varies from programming language to programming 

language, but the same operation applies to these programming languages. For the AS series PLC, 

structured text does not support debugging mode, and sequential function charts supports debugging 

mode during the action and the transition. 
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Step 1: Set the PLC to RUN 

 

 

 

 

 

 

 

 

 

Step 2: Entering the on-line mode 
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Step 3: Enter debugging mode 

 

 

(14) On-line editing mode 

 You can use the on-line editing mode when the system is running to update the program without 

affecting the system operation. 

 When the system is in the on-line monitoring mode, enter the on-line editing mode by clicking . 
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 After the program is modified and compiled, you can update the program in the CPU module by 

clicking  to download it to the CPU. 
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2.1 General Specifications 
Item Specifications 

Operating temperature -20 to 60°C 
Storage temperature -40 to 80°C 

Operating humidity 5–95% 
No condensation 

Storage humidity 5–95% 
No condensation 

Work environment No corrosive gas exists. 
Installation location In a control box 
Pollution degree 2 
Ingress protection 
(IP ratings) 

IP20 

EMC (electromagnetic 
compatibility) Refer to Appendix C for more information. 

Vibration resistance 

Tested with: 
5 Hz ≦ f ≦ 8.4 Hz, constant amplitude 3.5 mm;  
8.4 Hz ≦ f ≦ 150 Hz, constant acceleration 1g 
Duration of oscillation: 10 sweep cycles  
per axis on each direction of the three mutually perpendicular axes 
International Standard IEC 61131-2 & IEC 60068-2-6 (TEST Fc) 

Shock resistance 

Tested with: 
Half-sine wave: 
Strength of shock 15 g peak value, 11 ms duration; 
Shock direction: The shocks in each in direction per axis, on three mutually 
perpendicular axes (total of 18 shocks) 
International Standard IEC 61131-2 & IEC 60068-2-27 (TEST Ea) 

Safety  Conforms to IEC 61131-2, UL508 
Ambient air 
temperature-barometric 
pressure-altitude 

Operating: 1080 ~ 795hPa (-1000 ~ 2000 m) 
Storage:1080 ~ 660hPa (-1000 ~ 3500 m) 

Endurance 

Applicable to the removable terminal block, function card slot, SD card slot, 
Ethernet port, USB port on the modules and the connecting ports between 
modules. 
Plugging: more than 100 times (Each plugging in is counted as 1 time and pins 
inside the slots or ports should not be bent or crooked.) 
Force used for plugging in: to plug in a removalbe terminal block, the force 
used is around 70 g and for other slots and ports, the force is around 220 g.   
Force used for plugging out: to plug out a removalbe terminal block, the force 
used is around 1000 g and for other slots and ports, the force is around 20 g. 
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2.2 CPU Module Specifications 
2.2.1 Functional specifications 

Item 
AS324MT-A / AS332T-A / 

AS332P-A 

AS228T-A / AS228P-A 
AS228R-A / AS218TX-A 

AS218PX-A / AS218RX-A 
Remark 

Execution The program is executed cyclically.  

Input/Output control 
Regenerated inputs/outputs  
Direct inputs/outputs 

The inputs and 
outputs can be 
controlled through the 
direct inputs and 
direct outputs. 

Programming language 
IEC 61131-3   
Ladder diagrams, continuous function charts, 
structured text, and sequential function charts 

 

Instruction execution speed 40K steps/ms  
Number of instructions Approximately 666 instructions  

Constant scan cycle (ms) 
1-32000  
(The scan cycle can be increased by one 
millisecond.) 

Setting the parameter 

Program capacity (step) 128K steps (256K bytes) 64K steps (128K bytes)  

Installation DIN rails or screws  
Installation of a module No backplane installation; only module after module   
Maximum number of 
modules which can be 
installed 

32 modules  

Number of tasks 283 tasks (32 cyclic tasks; 16 I/O interrupts; four 
timed interrupts, etc.)  

Refer to the AS Series 
Operation manual for 
more information. 

Number of inputs/outputs 1024 

Number of 
inputs/outputs 
accessible to an actual 
input/output module 

Input relays [X] 1024  
Output relays [Y] 1024  
Internal relays [M] 8192 (M0–M8191)  
Timers [T] 512 (T0–T511)  
Counters [C] 512 (C0–C511)  
32-bit counter [HC] 256 (HC0–HC255)  
Data register [D] 30000 (D0–D29999)  
Data register [W] 30000 (W0–W29999)  
Stepping relay [S] 2048 (S0–S2047)  
Index register [E] 10 (E0–E9)  
Special auxiliary relay [SM] 2048 (SM0–SM2047)  
Special data register [SR] 2048 (SR0–SR2047)  
Serial communication port 2x RS-485   
Ethernet port 10/100 M Refer to the section 9.3 
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Item 
AS324MT-A / AS332T-A / 

AS332P-A 

AS228T-A / AS228P-A 
AS228R-A / AS218TX-A 

AS218PX-A / AS218RX-A 
Remark 

for more details on 
Ethernet specificaitons 

USB port Mini USB  
Storage interface SD Card (Micro SD); maximum storage: 32G  

Real-time clock Years, months, days, hours, minutes, seconds and 
weeks  

*Batteries (CR1620) are 
not included. 

Function card interface 

2x function cards, 
supporting 
communication card, 
AD/DA analog function 
cards 

None  

CANopen DS301 (Master) Maximum node: 64; maximum bytes: 2000 *A function card AS-
FCOPM is required for 
AS300 Series.  CANopen DS301 (Slave) Maximum PDO: 8; maximum bytes: 8 

 
2.2.2 Electrical specifications 

          Model 
 
 

Item 

AS332T-A/ 
AS332P-A/ 
AS324MT-A 

AS320T-B/ 
AS320P-B AS300N-A AS228T-A/ 

AS228P-A 
AS218TX-A/ 
AS218PX-A 

AS228R-A/ 
AS218RX-A 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Power 
consumption (W) 3.6 3.6 3 3.6 4.32 4.56 / 4.8 

Weight (g) 260 285 235 285 290 325 / 310 

Communication 
port isolation  

USB, COM1, COM2, and CAN*1 ports: 500 VAC 
Ethernet: 1500 VAC: 
*1: CAN port is not built-in for AS300 Series. You need to purchase a communication 
card AS-FCOPM to have a CAN port.    

 
 Electrical specifications for the inputs on digital input/output module. The signals passing 

through the inputs are 24 VDC signals. 

Model 
Item 

AS332T-A 
AS332P-A 

AS320T-B 
AS320P-B 

AS324MT-A 

Number of inputs 16 (X0.0-X0.15) 8 (X0.0-X0.7) 12 (X0.0-X0.11) 

Connector type MIL connector Removable terminal blocks MIL connector 
Input type Digital input 

Input form Direct current (sinking or sourcing) 

X0.0+–X0.3+/X0.0- to 
X0.3-: differential input 
X0.4–X0.11: Direct current 
(sinking or sourcing) 

Input voltage/ 
current 

24 VDC 
5 mA 

X0.0+–X0.3+/X0.0- to X0.3-: 
5 VDC, 5 mA 
X0.4–X0.11: 24 VDC, 5 mA 

Action 
level OFF→ON >15 VDC 

X0.0+–X0.3+/X0.0- to X0.3-: 
>0.2VDC 
X0.4–X0.11: >15VDC 



Chapter  2  Spec i f icat ions  and System Conf igurat ion  

2-6  

2_  

Model 
Item 

AS332T-A 
AS332P-A 

AS320T-B 
AS320P-B 

AS324MT-A 

ON→OFF <5 VDC 
X0.0+–X0.3+/X0.0- to 
X0.3-: <-0.2VDC 
X0.4–X0.11: <5VDC 

Response 
time 

OFF→ON 
X0.0~X0.11: < 2.5μs 
X0.12~X0.15: < 50μs 

X0.0+–X0.3+/X0.0- to 
X0.3-： < 0.125 μs 
X0.4–X0.11: < 2.5μs 

ON→OFF 
X0.0~X0.11: < 2.5μs 
X0.12~X0.15: < 50μs 

X0.0+–X0.3+/X0.0- to 
X0.3-： < 0.125 μs 
X0.4–X0.11: < 2.5μs 

Maximum input 
frequency 

X0.0~X0.11: 200 kHz 
X0.12~X0.15: 10 kHz 

X0.0+–X0.3+/X0.0- to 
X0.3-: < 4 MHz 
X0.4–X0.11: < 200 kHz 

Input impedance 5.6 k Ω 

Input signal 
Voltage input 
Sinking: The inputs are NPN transistors whose collectors are open collectors.  
Sourcing: The inputs are PNP transistors whose collectors are open collectors. 

Input isolation 500 VAC 
Input display When the optocoupler is driven, the input LED indicator is ON. 

Note: AS300N-A does not come with inputs/outputs. 
 

 Electrical specifications for the outputs on AS300 Series.  

Model 
Item 

AS332T-A 
AS332P-A 

AS320T-B 
AS320P-B AS324MT-A 

Number of outputs 16 (Y0.0-Y0.15) 12 (Y0.0-Y0.11) 12 (Y0.0-Y0.11) 

Connector type MIL connectorMIL 
connector 

Removable 
terminal blocks 

MIL connector 

Output form  
Transistor-T (sinking)  

Transistor-P (sourcing) 

Y0.0+–Y0.3+/Y0.0- to Y0.3-: differential 
input 
Y0.4–Y0.11: Transistor-T (sinking) 

Voltage  5-30 VDC 
Y0.0+–Y0.3+/Y0.0- to Y0.3- : 5 VDC 
Y0.4–Y0.11: 5-30VDC 

Maximum 
load 

Resistance 0.1A/output, 
1.6A/COM 

0.1A/output, 
1.2A/COM 

Y0.0+-Y0.3+/Y0.0-Y0.3- : 20mA/output 
(+ and – as a group, e.g. Y0.0+ and 
Y0.0- is a group) 
Y0.4-Y0.11:0.1A/output, 0.8A/COM 

Inductance N/A 
Bulb N/A 

Minimum load 1mA / 5V 

Maximum 
output 
frequency*1 

Resistance 
Y0.0-Y0.11: 200 kHz 
Y0.12-Y0.15: 100 Hz 

Y0.0+–Y0.3+/Y0.0- to Y0.3- : 4 MHz 
Y0.4–Y0.11: 200 kHz 

Inductance N/A 

Bulb N/A 

Maximum 
Response 
time 

OFF→ON 
Y0.0~Y0.11: 2.5μs 

Y0.12~Y0.15: 0.5ms 
Y0.0+–Y0.3+/Y0.0- to Y0.3-: 0.125 μs 
Y0.4–Y0.11: 2.5 μs 

Output isolation 500 VAC 
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 Electrical specifications for the inputs on AS200 Series. The signals passing through the inputs 

are 24 VDC signals. 

Model 
Item 

AS228P-A / AS228R-A / AS228T-A AS218PX-A / AS218RX-A / AS218TX-A 

Number of inputs 16 (X0.0-X0.15) 8 (X0.0-X0.7) 

Connector type Removable terminal blocks 
Input type Digital input 
Input form Direct current (sinking or sourcing) 
Input voltage/ current 24 VDC, 5 mA 

Action level 
OFF→ON >15 VDC 

ON→OFF <5 VDC 

Response time 
OFF→ON 

X0.0–X0.7: < 2.5μs 
X0.8–X0.15: < 50μs 

ON→OFF 
X0.0–X0.7: < 2.5μs 
X0.8–X0.15: < 50μs 

Maximum input frequency 
X0.0–X0.7: 200 kHz 
X0.8–X0.15: 10 kHz 

Input impedance 
X0.0~X0.7: 3.9 k Ω 
X0.8~X0.15: 5.6 k Ω 

3.9 k Ω 

Input signal 

Voltage direct input 
Sinking: The inputs are NPN transistors whose collectors are open collectors.  
Sourcing: The inputs are PNP transistors whose collectors are open   

  collectors. 
Digital input isolation 500 VAC 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Analog inputs N/A 2 
Analog input conversion 
time*1 N/A 3 ms / channel 

Analog input resolution N/A 12bits 

Analog input mode N/A 
-10V~10V (voltage mode) or 
20mA~20mA (currentmode) 

Analog linearity error N/A ±1% (full scale) 

Analog input impedance N/A 
≧1 MΩ (Voltage mode) 

250 Ω (Current mode) 

Analog input isolation 

When there is isolation between alaog and digital electricals and there is no 
isolation among analog channels.  
Isolation between analog electrical and gronunding: 500 VAC 
Isolation between analog and digital electrical: 500 VAC 

*1: Analog input data updates automatically in every PLC program scan.  
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 Electrical specifications for the outputs on AS200 Series.  

Model 
Item 

AS228R-A 
AS218RX-A 

AS228T-A 
AS218TX-A 

AS228P-A 
AS218PX-A 

Number of outputs 
AS228 Series: 12 outputs (Y0.0-Y0.11) 

AS218 Series 6 outputs (Y0.0-Y0.5) 
Connector type Removable terminal blocks 

Output form Relay Transistor-T (sinking) 
Transistor-P 
(sourcing) 

Voltage / current 240 VAC / 24 VDC 5-30 VDC 5-30 VDC 
Leakage current 0uA <10uA 

Maximum 
load 

Resistance 
AS228 2A/output, 8A/COM 0.5A/output, 2A/COM 0.5A/output, 2A/COM 

AS218 2A/output, 6A/COM 0.5A/output, 1.5A/COM 
0.5A/output, 
1.5A/COM 

Inductance Life cycle curve*2 N/A N/A 

Bulb 
20W (24VDC) 

100W (230VAC) 
N/A N/A 

Minimum load 1mA / 5V 

Maximum 
output 
frequency 

Resistance 1Hz 200kHz 200kHz 

Inductance 0.5Hz N/A N/A 

Bulb 1Hz N/A N/A 

Maximum 
Response 
time 

OFF→ON 
10 μs 2.5 μs 2.5 μs 

ON→OFF 

Analog outputs AS218 Series: 2 outputs 
Analog output conversion 
time*1 3 ms / channel (for AS218 PLC CPU) 

Analog output resolution AS218 Series: 12bits 
Analog output mode AS218 Series: -10V~10V (voltage mode) or 0mA~20mA (currentmode) 
Electrical output isolaiton 1500 VAC 500 VAC 

Analog output isolation 

When there is isolation between alaog and digital electricals and there is 
no isolation among analog channels.  
Isolation between analog electrical and gronunding: 500 VAC 
Isolation between analog and digital electrical: 500 VAC 

*1: Analog output data updates automatically in every PLC program scan.  
*2: Life cycle curve: The lifetime of a relay terminal varies with the working voltage, the load type (the power 
factor cosψ, the time constant t(L/R)), and the current passing through the terminal. The relation is shown in 
the life cycle curve below. 
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2.2.3 CPU Module Profiles 

 AS324MT-A/AS332T-A/AS332P-A/AS300N-A 

 
8

75

92

98
.3

88

80

1

2
COM1

COM2

5

0

OUT
4

1
2
3

8

9

11
10

2

102

7

5

6

4
IN

3 11

AS324MT

0
1

8
9

40

1

BAT. LOW

ERROR

RUN

POWER

Ethernet

6
7

3

10

11 12

7

4

5

6

9 13

 
Unit: mm 

 
 AS320T-B/AS320P-B 

10

11 12

80
75

95.5

13

98
.3

88

8 1 4

1

2

4

3

5

7
6

 
Unit: mm 

Number Name Description 

1 

Power LED indicator Indicates the power status of the CPU module 

Run LED indicator 
Operating status of the module 
ON: the module is running. 
OFF: the module is stopped.  

Error LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

BAT.LOW LED 
indicator 

Indicates the battery status of the CPU module. 
(Enable/Disable this display in HWCONFIG in ISPSoft) 

COM1 LED 
COM2 LED 

Indicates the communication status of the COM port. 
OFF: no communication over the COM port 
Blinking: communication over the COM port 

2 Model name Shows the model name of the CPU module. 

3 
Run/Stop 

RUN: execute the programs 
STOP: stop the programs 

USB port Mini USB communication port 
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Number Name Description 
SD card slot Provides an interface for an SD card  

VR0/VR1 
VR0: use the flag SM166 to activate the values in SR166 
VR1: use the flag SM167 to activate the values in SR167 

4 
Input/Output LED 
indicator 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

5 Ethernet port Provides an interface for a n Ethernet communication  
6 COM1/COM2  Provides an interface for RS-485 communication 
7 DIN rail clip Secures the DIN rail 
8 Extension card slot Provides an interface for an extension card 

9 
MIL connector Connects the module and the wiring module 

 AS300N-A does not come with inputs/outputs; no MIL connector for it.  
10 Grounding clip For grounding  
11 Power supply For power supply 
12 Label Nameplate 
13 External module port Connects the modules 

14 
Removable terminal 
blocks 

Connects the module and the wiring module 
AS300N-A does not come with inputs/outputs; no MIL connector for it. 

 
 AS200 Series (AS218PX-A/AS218RX-A/AS218TX-A/AS228R-A/AS228T-A/AS228P-A) 

10

11 12

88

75
95.5

13

98
.3

88

8

 9

1

2

4

3

5

7
6

 
Unit: mm 

 
Number Name Description 

1 

Power LED indicator Indicates the power status of the CPU module 

Run LED indicator 

Operating status of the module 
ON: the module is running. 
OFF: the module is stopped.  
Blinking: the module is detecting an error. 

Error LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

BAT.LOW LED 
indicator 

Indicates the battery status of the CPU module. 
(Enable/Disable this display in HWCONFIG in ISPSoft) 

COM1 LED 
COM2 LED 
CAN LED 

Indicates the communication status of the COM/CAN port. 
OFF: no communication over the COM/CAN port 
Blinking: communication over the COM/CAN port 
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Number Name Description 
2 Model name Shows the model name of the CPU module. 

3 

Run/Stop 
RUN: execute the programs 
STOP: stop the programs 

USB port Mini USB communication port 
SD card slot Provides an interface for an SD card  

VR0/VR1 
VR0: use the flag SM166 to activate the values in SR166 
VR1: use the flag SM167 to activate the values in SR167 

4 
Input/Output LED 
indicator 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

5 Ethernet port Provides an interface for a n Ethernet communication  
6 COM1/COM2  Provides an interface for RS-485 communication 
7 DIN rail clip Secures the DIN rail 
8 CAN port Provides an interface for CAN communication 

9 
Removable terminal 
blocks 

Connects the module and the wiring module 

10 Grounding clip For grounding  
11 Power supply For power supply 
12 Label Nameplate 
13 External module port Connects the modules 

 

 MIL connector, extension cable, and wiring modules (for AS332T-A/AS332P-A/AS324MT-A) 

1. Extension Cable UC-ET010-24D (1M) / UC-ET020-24D (2M) / UC-ET030-24D (3M) 

 
Length

3 9 40

1 2

500 +10m m-

39 40

21 2 2

19 2 0

1 2

OUT
  #1

IN
#2

1

2

2

 
Unit: mm 

 
Number Name Description 

1 IDC 40-pin terminal  
Connects a digital input/output module and an external terminal 
module. 

2 IDC 20-pin terminal 
Connects the external terminal modules UB-10-ID16A/UB-10-
OR16A/UB-10-OR16B 
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7

6

113

87
55.3

1
3
4
5

2

2. AS332T-A/AS332P-A/AS324MT-A and the external terminal module UB-10-ID16A 
67.0

87.0

53.62

1

3

4

 
Unit: mm 

Number Name Description 
1 20-pin MIL connector Connects the external terminal module and a wiring module 
2 Terminals Input/Output terminals for wiring 
3 Clip Hangs the external terminal module on a DIN rail 
4 Set screw Fixes the base 

 
3. AS332T-A and the external terminal module UB-10-OR16A/AS332P-A, and UB-10-OR16B 

 

 
 
 
 
 
 
 
 

 

Unit: mm 

 
Number Name Description 

1 20-pin MIL connector Connects the external terminal module and a wiring module 
2 Terminals Input/Output terminals for wiring 
3 2-pin power input terminal Power input terminal for wiring 
4 Output LED indicator If there is an output signal, the output LED indicator is ON. 
5 Relay output Relay output 
6 Clip Hangs the external terminal module on a DIN rail 
7 Set screw Fixes the base 
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 Spring clamp/MIL connector terminal block UB-10-IO32D for AS332T-A/AS332P-A/AS324MT-A 

 

23 6.
24 35.

26.9
33.7

10
1

1

2

 Unit: mm 
 

Number Name Description 
1 Terminal block for output Terminal block 
2 40-pin MIL connector Connects the module and the wiring module 

Note: It is suggested to use simple test for input and output points. Its right-side cannot be conntected to 
the same terminal block typed module, e.g. 64 points DIO module to prevent two terminal blocks from 
interfering with each other. 
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2.2.4 CPU Module Input/Output Terminals 

AS332P-A AS332T-A 

 

- - 

 

- - 
S/S S/S S/S S/S 

X0.15 X0.14 X0.15 X0.14 
X0.13 X0.12 X0.13 X0.12 
X0.11 X0.10 X0.11 X0.10 
X0.9 X0.8 X0.9 X0.8 
X0.7 X0.6 X0.7 X0.6 
X0.5 X0.4 X0.5 X0.4 
X0.3 X0.2 X0.3 X0.2 
X0.1 X0.0 X0.1 X0.0 
C0 C0 - - 
- - C0 C0 

Y0.15 Y0.14 Y0.15 Y0.14 
Y0.13 Y0.12 Y0.13 Y0.12 
Y0.11 Y0.10 Y0.11 Y0.10 
Y0.9 Y0.8 Y0.9 Y0.8 
Y0.7 Y0.6 Y0.7 Y0.6 
Y0.5 Y0.4 Y0.5 Y0.4 
Y0.3 Y0.2 Y0.3 Y0.2 
Y0.1 Y0.0 Y0.1 Y0.0 

AS324MT-A AS320T-B/AS320P-B 

 

S/S S/S 

 

S/S S/S 
X0.11 X0.10 X0 X1 
X0.9 X0.8 X2 X3 
X0.7 X0.6 X4 X5 
X0.5 X0.4 X6 X7 
SG0 SG0 C0 C0 
X0.3- X0.3+ Y0 Y1 
X0.2- X0.2+ Y2 Y3 
X0.1- X0.1+ Y4 Y5 
X0.0- X0.0+ Y6 Y7 

C0 C0 Y8 Y9 
Y0.11 Y0.10 Y10 Y11 
Y0.9 Y0.8   
Y0.7 Y0.6   
Y0.5 Y0.4   
SG1 SG1   
Y0.3- Y0.3+   
Y0.2- Y0.2+   
Y0.1- Y0.1+   
Y0.0- Y0.0+   

  

COM1

COM2

135

0

OUT
4

1

2

3

8

12

9

11

10

2

102

7

5

6

4
IN

3

15

12

13

14

11

AS332P

0

1

8

9

40

1

BAT. LOW

ERROR

RUN

POWER

Ethernet

6

7

14

15

POWER

BAT. LOW

RUN

ERROR

COM2

COM1

146

7 15

113
IN

3

2

1

5

4
OUT

10

11

9

13

12

4

6

5

0

7

14

13

12

8

15

2

AS332T

1

0

2

9

8

10

40

1

Ethernet

COM1

5

6

7

3

2

1

4
OUT

0

10

11

9

8

AS324MT

2

3
IN

4

6

5

7

COM2

1

0

10

11

9

8

2 1

40

BAT. LOW

POWER

RUN

ERROR

Ethernet

X1

Y10OUT
4

5

7

6

IN

6

0

3

4

5

2

1

Ethernet

0

2

3

1

7

C0

Y0

Y2

X6

X4

Y8

Y6

Y4

10

11

9

8

AS320T

RUN

POWER

COM2

BAT. LOW

COM1

ERROR

X2

X0

Y11

X7

Y3

Y1

X5

C0

Y9

Y7

Y5

X3
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AS218RX-A/AS218TX-A/AS218PX-A 

6

5

4

C1

OUT

11

9

C2

7

RUN

146 376

10

8

12

14

0

Et hernet

5

6

7

1

4

3

2

8

9

11

10

157

OUT

●

11

1 3

1 5

●

●

8

10

9

IN

2

4

0

COM2

COM1

80

91

12

13

11

5

4

3
IN

102

BAT. LOW

ERROR

2

1

0

3

1

5

OUT

C0

IN

POWER

 

AIO DIO 

V1+ V2+ S/S C0 

I1+ I2+ X0.0 Y0.0 

VI1- VI2- X0.1 Y0.1 

- - X0.2 Y0.2 

VO1 VO2 X0.3 - 

IO1 IO2 X0.4 C1 

AG AG X0.5 Y0.3 

- - X0.6 Y0.4 

-  X0.7 Y0.5 

AS228R-A/AS228T-A/AS228P-A 

6

5

4

C1

OUT

11

9

C2

7

RUN

146 376

10

8

12

14

0

Et hernet

5

6

7

1

4

3

2

8

9

11

10

157

OUT

●

11

1 3

1 5

●

●

8

10

9

IN

2

4

0

COM2

COM1

80

91

12

13

11

5

4

3
IN

102

BAT. LOW

ERROR

2

1

0

3

1

5

OUT

C0

IN

POWER

 

IN OUT 

S/S S/S C0 C1 

X0.0 X0.1 Y0.0 Y0.4 

X0.2 X0.3 Y0.1 Y0.5 

X0.4 X0.5 Y0.2 Y0.6 

X0.6 X0.7 Y0.3 Y0.7 

X0.8 X0.9 - - 

X0.10 X0.11 - C2 

X0.12 X0.13 Y0.8 Y0.9 

X0.14 X0.15 Y0.10 Y0.11 

 

 MIL connector and the external terminal module UB-10-ID16A for AS332T-A / AS332P-A / 
AS324MT-A 

TB1
TB2
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#1

#2
 

 
AS332T-A 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 C0 - 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 C0 - 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 
 

AS332P-A 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 - C0 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 - C0 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 
 

AS324MT-A 

#1 
TB1 Y0.0+ Y0.1+ Y0.2+ Y0.3+ SG1 Y0.4 Y0.6 Y0.8 Y0.10 C0 

TB2 Y0.0- Y0.1- Y0.2- Y0.3- SG1 Y0.5 Y0.7 Y0.9 Y0.11 C0 

#2 
TB1 X0.0+ X0.1+ X0.2+ X0.3+ SG0 X0.4 X0.6 X0.8 X0.10 S/S 

TB2 X0.0- X0.1- X0.2- X0.3- SG0 X0.5 X0.7 X0.9 X0.11 S/S 

 Spring clamp/MIL connector terminal block UB-10-IO32D for AS332T-A/AS332P-A/AS324MT-A 

40 

 

39 

38 37 

36 35 

34 33 

32 31 

30 29 

28 27 

26 25 

24 23 

22 21 

20 19 

18 17 

16 15 

14 13 

12 11 

10 9 

8 7 

6 5 

4 3 
2 1 



AS Ser ies  Hardware  and  Operat ion Manual  

2-17  

_2 

2.2.5 AS200 Input/Output Terminals 

 Analog Input 

Two analog signal input channels:  

Item Voltage Input Current input 

Analog Signal  -10 to +10 V 
-20 to 20 mA 

4 to 20mA (for FW V1.08 or later) 
Resolution 12-bit 11-bit 
Input impedance ≧1 MΩ 250 Ω 
Conversion time 3 ms / CH 

Analog to digital 
conversion range -2000 to 2000 

-1000 to 1000 (-20 to 20 mA) 
0 to 1000 (4 to 20mA) 

Digital value 
output SR168 (CH1) SR169 (CH2) 

You can use the program to read the values in SR to obtain the corresponding A/D conversion value for the 
channel. 

 

 Analog Output 

Two analog signal output channels: 

Item Voltage output Current output 

Analog Signal  -10 to +10 V 0 to 20 mA 
Resolution 12-bit 12-bit 
Impedance 
allowance ≥1 k Ω ≤500 Ω 

Conversion time 2ms / CH 

Analog to digital 
conversion range 

-2000 to 2000 
 

0 to 4000 

Digital value 
output SR172 (CH1) SR173 (CH2) 

You can use the instruction MOV to move the value to the SR to obtain the corresponding voltage output 
value.  
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2.3 Digital Input/Output Module Specifications 
2.3.1 General Specifications 

 Electrical specifications for the inputs on digital input/output modules  
(The signals passing through the inputs are 24 VDC signals.) 

Module name 08AM10N 
-A 

16AM10N 
-A 

32AM10N 
-A 

64AM10N 
-A 

16AP11R 
A 

16AP11T 
-A 

16AP11P 
-A 

Number of inputs 8 16 32 64 8 8 8 

Connector type Removable terminal 
block 

MIL connector Removable terminal block 

Input type Digital input 
Input form Direct current (sinking or sourcing) 

Input voltage/ current 24 VDC，5 mA 24 VDC 
3.2 mA 

24 VDC，5 mA 

Input impedance 4.7 k Ω 7.5k Ω 4.7 k Ω 

Action level 
OFF→ON >15 VDC 
ON→OFF <5 VDC 

Response 
time 

OFF→ON < 20 us 

ON→OFF < 200 us 

Software filter time Setting range: 0 ~ 25 ms; default: 10 ms 

Maximum input 
frequency 

Varies according to the filter time; for example when the filter is 1 ms, the 
maximum input frequency is 500 Hz, when 2 ms, 250 Hz. 

Note: CPU scan time also affects the maximum input frequency. 

Input signal 

Voltage input 
Sinking: The inputs are NPN transistors whose collectors are open 

collectors.  
Sourcing: The inputs are PNP transistors whose collectors are open 

collectors. 
Input isolation 500 VAC 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Weight 100 g 117 g 100 g 140 g 138 g 120 g 120 g 

 

 Electrical specifications for the outputs on a digital input/output module  

Model 
Item 

08AN01
R-A 

16AN01
R-A 

16AP11
R-A 

08AN01 
T-A 

16AN01 
T-A 

16AP11 
T-A 

08AN01
P-A 

16AN01
P-A 

16AP11 
P-A 

Number of outputs 8 16 8 8 16 8 8 16 8 
Connector type Removable terminal block 
Output type Digital output 
Output form  Relay-R Transistor-T (sinking) Transistor-P (sourcing) 
Voltage/ current 240 VAC/24 VDC 5–30 VDC 5–30 VDC *2 

Leakage current 0uA <10uA 
<250uA (@V1.00A0) 
 <10uA (@V1.00A1) 

Maximum 
load 

Resistance 2A/output, 8A/COM 0.5A/output, 4A/COM 0.5A/output, 4A/COM 

Inductance Life cycle curve 12 W (24 VDC) 12 W (24 VDC) 

Bulb 20 W (24 VDC) 
100 W (230 VAC) 

2 W (24 VDC) 2 W (24 VDC) 

Minimum load 1 mA / 5V 
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Model 
Item 

08AN01
R-A 

16AN01
R-A 

16AP11
R-A 

08AN01 
T-A 

16AN01 
T-A 

16AP11 
T-A 

08AN01
P-A 

16AN01
P-A 

16AP11 
P-A 

Maximum 
output 
frequency*1 

Resistance 1 Hz 100 Hz 100 Hz 

Inductance 0.5 Hz 0.5 Hz 0.5 Hz 

Bulb 1 Hz 10 Hz 10 Hz 
Maximum 
Response 
time 

OFF→ON < 10 ms < 0.5 ms < 0.5 ms 

ON→OFF < 10 ms < 0.5 ms < 0.5 ms 

Output isolation 1500 VAC 500 VAC 

Weight 120 g 158 g 138 g 100 g 122 g 120 g 100 g 123 g 120 g 

 

Model 
Item 

32AN02T-A 64AN02T-A 

Number of outputs 32 64 
Connector type MIL connector 
Output type Digital output 
Output form  Transistor-T (sinking) 
Output voltage 5–30 VDC 
Leadage current <10uA 

Maximum 
load 

Resistance 0.1A/output, 3.2A/COM 
Inductance N/A 
Bulb N/A 

Minimum load 1 mA / 5V 
Maximum output 
frequency*1 100 Hz (resistance) 

Maximum 
Response 
time 

OFF→ON 
< 0.5 ms 

ON→OFF 

Output isolation 500 VAC 
Weight 100 g 142 g 

*1: The scan cycle affects the frequency. Here shows the maximum output frequency. The load type  
       should be taken into account while designing for the application.   

*2: Life cycle curve: The lifetime of a relay terminal varies with the working voltage, the load type (the   
   power factor cosψ, the time constant t(L/R)), and the current passing through the terminal. The  
   relation is shown in the life cycle curve below. 

Contact Current(A)

20

0.50.1 0.2

30
50

0.3 0.7 1 2

200
300

500

100

1000
2000

3000

O
pe

ra
tio

n(
X

10
)3

120VAC Resistive
30VDC Inductive(t=7ms)

240VAC Inductive(cos 0.4)ψ=
120VAC Inductive(cos =0.4)ψ

30VDC 
Inductive
    (t=40ms)
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2.3.2 Digital Input/Output Module Profiles 

 AS08AM10N-A/AS08AN01P-A/AS08AN01R-A/AS08AN01T-A 
28.2

25

8898
.3

1

4

5

3

6

7

8

89

75

7

08AM

5

6

7

2

3 6
5
4
3

4 7

PWR

0

1 2
1
0
IN

IN

S/S

S/S

5

6

7

2

3

4

0

1

IN

S/S

S/S

2

08AN

6
5
4
3

7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0

08AN

6
5
4
3

7

PWR

OUT
0

2
1

C0

C0

OUT

4

5

6

7

1

2

3

0

08AN

3
4
5
6
7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 
Input/output LED 
indicator 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output 
terminals 

Arrangement of the terminals 

5 Terminal block clip Secures the terminal block 
6 DIN rail clip Secures the DIN rail 

7 
External module 
port 

Connects the modules 

8 Label Nameplate 
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 AS16AM10N-A/AS16AN01P-A/AS16AN01R-A/AS16AN01T-A/AS16AP11P-A/AS16AP11R-A/ 
AS16AP11T-A 

38.2 95

75
8898

.3

1

4

5

2

3

6

7

8

7

6

9
10
11

7

8

13

15
14

12

PWR

3
4
5

1
0

2

IN

16AM

12

14

6

8

10

0

4

2

IN IN

15

7

13

11

9

5

1

3

S/S

S/S

S/S

S/S

35

6

12
13

15
14

10
11

9

7

8

OUT

3
4
5

1
0

2

PWR

16AN

OUTOUT

C1

C0

12

14

0

C1

10

8

2

4

6

C0

15

13

11

9

7

5

3

1

6

12
13

15
14

9
10
11

7

8

OUT

3
4
5

0
1
2

PWR

16AN

OUTOUT

12

14

10

8

6

4

2

0

C0 C0

C0 C0

15

13

9

11

7

5

3

1

6

12
13

15
14

9
10
11

7

8

C1

C0

OUT

C1

3
4
5

0
1
2

C0
PWR

16AN

6

4

2

0

8

10

12

14

7

5

3

1

15

11

13

9

OUTOUT

16AP

6

4
5

7
6

1
2
3

7

0
OUT

IN

3
4
5

0
1
2

PWR
C0

OUT

C0

6

7

5

4

3

1

2

0

IN

4

5

6

7

0

1

2

3 6

7

6

4

5

4
5

7
6

1
2
3

7

0
OUT

16AP

3

2

0

1

IN

3
4
5

0
1
2

PWR

OUT

C0

C0

0

4

5

6

7

1

2

3

IN

6

4
5

7
6

OUT

1
2
3

7

0

16AP

IN

3
4
5

1
0

2

PWR
C0

OUT

C0

6

5

4

3

1

2

0

IN

7

6

5

4

3

2

1

0

 
Unit: mm 

 
 

Number Name Description 
1 Model name Model name of the module 

2 
Input/Output LED 
indicator 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output 
terminals 

Arrangement of the terminals 

5 Terminal block clip Secures the terminal block 
6 DIN rail clip Secures the DIN rail 

7 
External module 
port 

Connects the modules 

8 Label Nameplate 
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 AS32AM10N-A 

PWR

39

2

13

15
14

8

10
9

121

11

4
5

3

7
6

IN

1
0

X1 LED
X0 LED

32AM

88
98

.3

1

4

5

2
3

6

28.2

25

7

8

92

75

7

 
Unit: mm 

 
Number Name Description 

1 Model name Model name of the module 

2 
X0/X1 LED 
Indicator switch 

Switches the LED indicators to their represented inputs. 

3 ML connector 
For the external I/O connecting cables UC-ET010-24B, UC-ET020-24B, 
UC-ET030-24B 

4 
Power LED 
indicator 

Indicates the power status of the module 

5 Input LED indicator LED indicator is ON during input. 
6 DIN rail clip Secures the DIN rail 

7 
External module 
port 

Connects the modules 

8 Label Nameplate 
 

  



AS Ser ies  Hardware  and  Operat ion Manual  

2-23  

_2 

 AS32AN02T-A 

PWR

2

13

15
14

8

10
9

12

39

1

11

4
5

3

7
6

OUT

1
0

Y1 LED
Y0 LED

32AN

88
98

.3

1

4

5

2
3

6

28.2

25

7

8

92

75

7

Unit: mm 

 

 

 

Number Name Description 
1 Model name Model name of the module 

2 
Y0/Y1 LED 
indicator switch 

Switches the LED indicators to their represented outputs. 

3 ML connector 
For the external I/O connecting cables UC-ET010-24D, UC-ET020-24D,  
UC-ET030-24D 

4 
Power LED 
indicator 

Indicates the power status of the module 

5 
Output LED 
indicator 

LED indicator is ON during output. 

6 DIN rail clip Secures the DIN rail 

7 
External module 
port 

Connects the modules 

8 Label Nameplate 
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 AS64AM10N-A 

8

9

92

75

8

88
98

.3

1

4
5

2
3

6

2

X0

64AM

40

X1

10

0

9
8

4
5
6
7

3

15
14

2

10

12
11

13
40

X3

2

PWR

IN
0
1

X2

0 1

1

7

38.2

35  
Unit: mm 

 
 

Number Name Description 
1 Model name Model name of the module 

2 
LED indicator 
switch 1 

Switches the LED indicators to their represented inputs. 

3 
LED indicator  
switch 2 

Switches the LED indicators to their represented inputs. 

4 ML connector 
For the external I/O connecting cables UC-ET010-24B, UC-ET020-24B,  
UC-ET030-24B 

5 
Power LED 
indicator 

Indicates the power status of the module 

6 Input LED indicator If there is an input signal, the input LED indicator is ON. 
7 DIN rail clip Secures the DIN rail 

8 
External module 
port 

Connects the modules 

9 Label Nameplate 
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 AS64AN02T-A 

8

9

92

75

8

2

Y0

40

3

7
6
5
4

13

11
12

10

8
9

Y3

14
15

2

64AN

40

Y1

0 1

2

1
0

Y2

PWR

OUT

10

10

88
98

.3

1

4
5

2
3

6

7

38.2

35  
Unit: mm 

Number Name Description 
1 Model name Model name of the module 

2 
LED indicator 
switch 1 

Switches the LED indicators to their represented outputs. 

3 
LED indicator  
switch 2 

Switches the LED indicators to their represented outputs. 

4 ML connector 
For the external I/O connecting cables UC-ET010-24D, UC-ET020-24D, 
UC-ET030-24D 

5 
Power LED 
indicator 

Indicates the power status of the module 

6 
Output LED 
indicator 

If there is an output signal, the output LED indicator is ON. 

7 DIN rail clip Secures the DIN rail 

8 
External module 
port 

Connects the modules 

9 Label Nameplate 
 

 ML connector, extension cable, and wiring modules  

1. Extension Cable UC-ET010-24D (1M) / UC-ET020-24D (2M) / UC-ET030-24D (3M) 

 
Length

3 9 40

1 2

500 +10m m-

39 40

21 2 2

19 2 0

1 2

  #1

#2
1

2

2

 
Unit: mm 

 
Number Name Description 

1 IDC 40-pin terminal  
Connects a digital input/output module and an external terminal 
module. 

2 IDC 20-pin terminal 
Connects the external terminal modules UB-10-ID16A/UB-10-
OR16A/UB-10-OR16B 
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2. I/O connecting cables UC-ET010-24B (1M) / UC-ET020-24B (2M) / UC-ET030-24B (3M) 

Length

39 40 39 40

1 2 1 2  
 

Number Name Description 

1 IDC 40-pin terminal  
Connects an external terminal module and a wiring module UB-10-
ID32A, and UB-10-OT32A 

 
3. AS32AM10N-A/AS64AM10N-A and the external terminal modules UB-10-ID16A, UB-10-ID32A 

 UB-10-ID16A 

67.0

87.0

53.62

1

3

4

 
Unit: mm 

 
 UB-10-ID32A 

 
113

87

53.6

3

2

1

4

 
Unit: mm 

Number Name Description 

1 
UB-10-ID16A: 20-pin ML connector 
UB-10-ID32A: 40-pin ML connector 

Connects the external terminal module and a 
wiring module 

2 Terminals Input/Output terminals for wiring 
3 Clip Hangs the external terminal module on a DIN rail 
4 Set screw Fixes the base 
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4. AS332T-A/AS64AN02T-A and the external terminal modules UB-10-ID16A, UB-10-OR16A, and UB-
10-OT32A. 

  
 UB-10-ID16A 

67.0

87.0

53.62

1

7

6

 
Unit: mm 

 
 UB-10-OR16A 

7

6

113

87
55.3

1
3
4
5

2

 
Unit: mm 

 
 UB-10-OT32A 

113

87

53.6

6

2

1

7

 
Unit: mm 

 
Number Name Description 

1 

UB-10- ID16A /OR16A: 20-
pin ML connector 
UB-10-OT32A: 40-pin ML 
connector 

Connects the external terminal module and a wiring 
module 

2 Terminals Input/Output terminals for wiring 
3 2-pin power input terminal Power input terminal for wiring 
4 Output LED indicator LED indicator is ON during output. 
5 Relay output Relay output 
6 Clip Hangs the external terminal module on a DIN rail 
7 Set screw Fixes the base 
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 Spring clamp/MIL connector terminal block UB-10-IO32D for AS32AM10N-A/AS32AN02T-A 

 

23 6.
24 35.

26.9
33.7

10
1

1

2

 Unit: mm 
 

Number Name Description 
1 Terminal block for output Terminal block 
2 40-pin MIL connector Connects the module and the wiring module 
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2.3.3 Digital Input/Output Module Terminals 

AS08AM10N-A AS08AN01P-A 

  

AS08AN01R-A AS08AN01T-A 

 

 

 

 

 
  

08AM

5

6

7

2

3
6
5
4
3

4 7

PWR

0

1 2
1
0
IN

IN

08AN

6
5
4
3

7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0

08AN

6
5
4
3

7

PWR

OUT
0

2
1

C0

C0

OUT

4

5

6

7

1

2

3

0

08AN

3
4
5
6
7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0
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AS16AM10N-A AS16AN01P-A 

  

AS16AN01R-A AS16AN01T-A 

 

 

 

 
 
  

6

9
10
11

7

8

13

15
14

12

PWR

3
4
5

1
0

2

IN

16AM

12

14

6

8

10

0

4

2

IN IN

15

7

13

11

9

5

1

3

6

12
13

15
14

10
11

9

7

8

OUT

3
4
5

1
0

2

PWR

16AN

OUTOUT

C1

C0

12

14

0

C1

10

8

2

4

6

C0

15

13

11

9

7

5

3

1

6

12
13

15
14

9
10
11

7

8

OUT

3
4
5

0
1
2

PWR

16AN

OUTOUT

12

14

10

8

6

4

2

0

C0 C0

C0 C0

15

13

9

11

7

5

3

1

6

12
13

15
14

9
10
11

7

8

C1

C0

OUT

C1

3
4
5

0
1
2

C0
PWR

16AN

6

4

2

0

8

10

12

14

7

5

3

1

15

11

13

9

OUTOUT
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AS16AP11P-A AS16AP11R-A 

  

AS16AP11T-A AS32AM10N-A 

 

 
 

- - 
S/S S/S 
1.15 1.14 
1.13 1.12 
1.11 1.10 
1.9 1.8 
1.7 1.6 
1.5 1.4 
1.3 1.2 
1.1 1.0 
- - 

S/S S/S 
0.15 0.14 
0.13 0.12 
0.11 0.10 
0.9 0.8 
0.7 0.6 
0.5 0.4 
0.3 0.2 

0.1 0.0 

 
  

16AP

6

4
5

7
6

1
2
3

7

0
OUT

IN

3
4
5

0
1
2

PWR
C0

OUT

C0

6

7

5

4

3

1

2

0

IN

4

5

6

7

0

1

2

3 6

7

6

4

5

4
5

7
6

1
2
3

7

0
OUT

16AP

3

2

0

1

IN

3
4
5

0
1
2

PWR

OUT
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C0

0

4

5

6

7

1

2

3

IN

6

4
5

7
6

OUT

1
2
3

7

0

16AP

IN

3
4
5

1
0

2

PWR
C0

OUT

C0

6

5

4

3

1

2

0

IN

7

6

5

4

3

2

1

0

PWR

39

2

13
14
15

11
12

10

8
9

1

3

7
6
5
4

IN

1
0

32AM
X1 LED
X0 LED
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AS32AN02T-A AS64AM10N-A 

   

- - 

 

- - 2.0 2.1 
C0 C0 S/S0 S/S0 2.2 2.3 

1.15 1.14 1.15 1.14 2.4 2.5 
1.13 1.12 1.13 1.12 2.6 2.7 
1.11 1.10 1.11 1.10 2.8 2.9 
1.9 1.8 1.9 1.8 2.10 2.11 
1.7 1.6 1.7 1.6 2.12 2.13 
1.5 1.4 1.5 1.4 2.14 2.15 
1.3 1.2 1.3 1.2 S/S S/S 
1.1 1.0 1.1 1.0 - - 
- - - - 3.0 3.1 

C0 C0 S/S0 S/S0 3.2 3.3 
0.15 0.14 0.15 0.14 3.4 3.5 
0.13 0.12 0.13 0.12 3.6 3.7 
0.11 0.10 0.11 0.10 3.8 3.9 
0.9 0.8 0.9 0.8 3.10 3.11 
0.7 0.6 0.7 0.6 3.12 3.13 
0.5 0.4 0.5 0.4 3.14 3.15 
0.3 0.2 0.3 0.2 S/S1 S/S1 
0.1 0.0 0.1 0.0 - - 

AS64AN02T-A  

 

- - 2.0 2.1      
C0 C0 2.2 2.3     

1.15 1.14 2.4 2.5     
1.13 1.12 2.6 2.7     
1.11 1.10 2.8 2.9     
1.9 1.8 2.10 2.11     
1.7 1.6 2.12 2.13     
1.5 1.4 2.14 2.15     
1.3 1.2 C1 C1     
1.1 1.0 - -     
- - 3.0 3.1     

C0 C0 3.2 3.3     
0.15 0.14 3.4 3.5     
0.13 0.12 3.6 3.7     
0.11 0.10 3.8 3.9     
0.9 0.8 3.10 3.11     
0.7 0.6 3.12 3.13     
0.5 0.4 3.14 3.15     
0.3 0.2 C1 C1     
0.1 0.0 - -     

 

PWR

39

2

13

15
14

8

10
9

121

11

4
5

3

7
6

OUT

1
0

Y1 LED
Y0 LED

32AN

2

X0

64AM
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0

9
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4
5
6
7

3

15
14
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11

13
40

X3

2

PWR

IN
0
1
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0 1

1

2

Y0

40

3

7
6
5
4

13

11
12

10

8
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Y3

14
15

2

64AN

40
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0 1

2

1
0

Y2

PWR

OUT

10

10
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 ML connector and the wiring module 

1. AS32AM10N-A/AS64AM10N-A  

 The wiring module: UB-10-ID16A 

TB1
TB2

 
 

 

AS32AM10N-A/ AS64AM10N-A 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 
 

 The wiring module: UB-10-ID32A 

 
 
AS series terminals: 

Upper 
row 

X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 X1.0 X1.2 X1.4 X1.6 X1.8 X1.10 X1.12 X1.14 S/S S/S 

Lower 
row 

X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 X1.1 X1.3 X1.5 X1.7 X1.9 X1.11 X1.13 X1.15 S/S S/S 

 
 

#1

#2
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2. AS32AN02T-A/AS64AN02T-A and the wiring modules: 

 UB-10-ID16A 

TB1
TB2

 

#1

#2
 

AS332T-A 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 C0 - 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 C0 - 

 

 UB-10-OT32A 

 
 
AS series terminals: 

Upper 
row Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 Y1.0 Y1.2 Y1.4 Y1.6 Y1.8 Y1.10 Y1.12 Y1.14   

Lower 
row Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 Y1.1 Y1.3 Y1.5 Y1.7 Y1.9 Y1.11 Y1.13 Y1.15 C0 C0 

 UB-10-OR16A 

 
Terminals: 

 GND +24
V 

C0 Y0 Y1 Y2 Y3 C1 Y4 Y5 Y6 Y7 C2 Y10 Y11 Y12 Y13 C3 Y14 Y15 Y16 Y17 
 
AS series terminals: 

 GND +24V 
C0 Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.5 Y0.6 Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 C3 Y0.12 Y0.13 Y0.14 Y0.15 
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3. AS32AM10N-A/AS32AN02T-A and the wiring modules: 

 UB-10-IO32D 
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2.4 Analog Input/Output Module Specifications  
2.4.1 General Specifications 

 AS04AD-A / AS08AD-B / AS08AD-C 

Electrical specifications 

Module Name AS04AD-A AS08AD-B AS08AD-C 
Number of Inputs 4 8 8 
Analog-to-Digital 
Conversion Voltage input/Current input Voltage input Current input 

Supply Voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector Type Removable terminal block 
Conversion Time 2 ms / channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/ 
optocoupler, but the analog channels are not isolated from one another. 
Isolation between a digital circuit and a ground: 500 VAC 
Isolation between an analog circuit and a ground: 500 VAC 
Isolation between an analog circuit and a digital circuit: 500 VAC 
Isolation between the 24 VDC and a ground: 500 VAC 

Weight 145g 

 

Functional specifications 

Analog-to-Digital 
Conversion Voltage Input 

Rated Input Range -10 V ~ +10 V 0 V ~ 10 V ±5 V 0 V ~ 5 V 1 V ~ 5 V 

Rated Conversion 
Range 

K-32000  
~ 

K32000 

K0 
~ 

K32000 

K-32000 
~ 

K32000 

K0 
~ 

K32000 

K0 
~ 

K32000 

Hardware Input 
Limit*1 

-10.12V 
~ 

10.12V 

-0.12V 
~ 

10.12V 

-5.06V 
~ 

5.06V 

-0.06V 
~ 

5.06V 

0.95V 
~ 

5.05V 

Conversion Limit*2 
K-32384 

~  
K32384 

K-384 
~ 

K32384 

K-32384 
~ 

K32384 

K-384 
~ 

K32384 

K-384 
~ 

K32384 
Error Rate Room Temperature: ±0.2% ; Full Temperature Range: ±0.5% 
Hardware 
Resolution 16 bits 

Input Impedance 2MΩ 
Absolute Input 
Range*3 ±15 V 

*1: If the input signal exceeds the hardware input limit, the module only shows the maximum value. If the 
input signal is below the lower limit, it only shows the minimum value.  

*2: If the input signal exceeds the hardware input limit, it also exceeds the conversion limit and a 
conversion limit error appears. For example in the voltage input mode (-10 V to +10 V), when the input 
signal is 10.15 V, exceeding the hardware upper limit, it also exceeds the conversion upper limit. The 
module uses the upper limit value (32387) as the input signal and a conversion limit error appears.     

*3: If an input signal exceeds the absolute range, it might damage the channel.  
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Analog-to-Digital 

Conversion Current Input 

Rated Input Range ±20 mA 0 mA–20 mA 4 mA–20 mA 

Rated Conversion 
Range 

K-32000  
~ 

K+2000 

K0 
~ 

K32000 

K0 
~ 

K32000 
Hardware Input 
Limit*1 -20.24 mA ~ 20.24 mA -0.24 mA ~ 20.24 mA 3.81 mA ~ 20.19 mA 

Conversion Limit*2 
K-32384 

~  
K32384 

K-384 
~ 

K32384 

K-384 
~ 

K32384 

Error Rate Room Temperature: ±0.2% ; Full Temperature Range: ±0.5% 

Hardware Resolution 16 bits 

Input Impedance 250Ω 

Absolute Input 
Range*3 ±32 mA 

*1: If the input signal exceeds the hardware input limit, the module only shows the maximum value. If the 
input signal is below the lower limit, it only shows the minimum value.  

*2: If the input signal exceeds the hardware input limit, it also exceeds the conversion limit and a 
conversion limit error appears. For example in the voltage input mode (4 mA to 20 mA), when the input 
signal is 0 mA, exceeding the hardware upper limit, it also exceeds the conversion upper limit. The 
module uses the upper limit value (-384) as the input signal and a conversion limit error appears.     

*3: If an input signal exceeds the absolute range, it might damage the channel.  

 
 AS04DA-A 

Electrical specifications 

Module name AS04DA-A 
Number of outputs Four 
Digital-to-analog 
conversion Voltage output/Current output 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15%–+20%) 
Connector type Removable terminal block 
Conversion time 2 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, but the analog channels are not isolated from one another. 
Isolation between a digital circuit and a ground: 500 VAC 
Isolation between an analog circuit and a ground: 500 VAC 
Isolation between an analog circuit and a digital circuit: 500 VAC 
Isolation between the 24 VDC and a ground: 500 VAC 

Weight  145 g 
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Functional specifications 

Digital-to-analog 
conversion 

Voltage output 

Rated output 
range ±10 V 0 V–10 V ±5 V 0 V–5 V 1 V–5 V 

Conversion 
Range 

K-32000 
~  

K+32000 
K0 ~ K32000 

K-32000 
~ 

K+32000 
K0 ~ K32000 K0 ~ K32000 

Hardware output 
range 

-10.1V to 
+10.1V 

-0.1V to +10.1V 
-5.05V to 
+5.05V 

-0.05V to 
+5.05V 

0.95V–5.05V 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature 
range)  

±0. 5% 

Linearity error 
(Room 
temperature) 

±0.05% 

Linearity error 
(Full temperature 
range) 

±0.05% 

Hardware 
resolution 12 bits 

Input impedance ≧1 k Ω  ≧500 Ω 
 

Digital-to-analog 
conversion Current output 

Rated output 
range 0 mA–20 mA 4 mA–20 mA 

Conversion 
Range K0 ~ K32000 K0 ~ K32000 

Hardware output 
range -0.2 mA to +20.2 mA 3.8 mA–20.2 mA 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature 
range)  

±0.5% 

Linearity error 
(Room 
temperature) (Full 
temperature 
range) 

±0.03% 

Linearity error ±0.03% 
Hardware 
resolution 12 bits 

Input impedance ≦550 Ω 
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 AS06XA-A 

Electrical specifications 

Module name AS06XA-A 
Number of 
inputs/outputs Inputs: four; Outputs: two 

Analog-to-digital 
conversion Voltage input/Current input; Voltage output/Current output; 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector type Removable terminal block 
Conversion time 2ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, but the analog channels are not isolated from one another. 
Isolation between a digital circuit and a ground: 500 VAC 
Isolation between an analog circuit and a ground: 500 VAC 
Isolation between an analog circuit and a digital circuit: 500 VAC 
Isolation between the 24 VDC and a ground: 500 VAC 

Weight  145 g 
 

Functional specifications for the analog-to-digital conversion 

Analog-to-Digital 
Conversion Voltage Input 

Rated Input Range -10 V ~ +10 V 0 V ~ 10 V ±5 V 0 V ~ 5 V 1 V ~ 5 V 

Rated Conversion Range 
K-32000  

~ 
K32000 

K0 
~ 

K32000 

K-32000 
~ 

K32000 

K0 
~ 

K32000 

K0 
~ 

K32000 

Hardware Input Limit*1 
-10.12V 

~ 
10.12V 

-0.12V 
~ 

10.12V 

-5.06V 
~ 

5.06V 

-0.06V 
~ 

5.06V 

0.95V 
~ 

5.05V 

Conversion Limit*2 
K-32384 

~  
K32384 

K-384 
~ 

K32384 

K-32384 
~ 

K32384 

K-384 
~ 

K32384 

K-384 
~ 

K32384 
Error Rate Room Temperature: ±0.2% ; Full Temperature Range: ±0.5% 
Hardware Resolution 16 bits 
Input Impedance 2MΩ 
Absolute Input Range*3 ±15 V 

*1: If the input signal exceeds the hardware input limit, the module only shows the maximum value. If the input 
signal is below the lower limit, it only shows the minimum value.  

*2: If the input signal exceeds the hardware input limit, it also exceeds the conversion limit and a conversion 
limit error appears. For example in the voltage input mode (-10 V to +10 V), when the input signal is 10.15 V, 
exceeding the hardware upper limit, it also exceeds the conversion upper limit. The module uses the upper 
limit value (32384) as the input signal and a conversion limit error appears.     

*3: If an input signal exceeds the absolute range, it might damage the channel.  
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Analog-to-Digital 
Conversion Current Input 

Rated Input Range ±20 mA 0 mA–20 mA 4 mA–20 mA 

Rated Conversion 
Range 

K-32000  
~ 

K+2000 

K0 
~ 

K32000 

K0 
~ 

K32000 
Hardware Input 
Limit*1 -20.24 mA ~ 20.24 mA -0.24 mA ~ 20.24 mA 3.81 mA ~ 20.19 mA 

Conversion Limit*2 
K-32384 

~  
K32384 

K-384 
~ 

K32384 

K-384 
~ 

K32384 

Error Rate Room Temperature: ±0.2% ; Full Temperature Range: ±0.5% 

Hardware Resolution 16 bits 

Input Impedance 250Ω 

Absolute Input 
Range*3 ±32 mA 

*1: If the input signal exceeds the hardware input limit, the module only shows the maximum value. If the input 
signal is below the lower limit, it only shows the minimum value.  

*2: If the input signal exceeds the hardware input limit, it also exceeds the conversion limit and a conversion 
limit error appears. For example in the voltage input mode (4 mA to 20 mA), when the input signal is 0 mA, 
exceeding the hardware upper limit, it also exceeds the conversion upper limit. The module uses the upper 
limit value (-384) as the input signal and a conversion limit error appears.     

*3: If an input signal exceeds the absolute range, it might damage the channel.  

 

Functional specifications for the digital-to-analog conversion 

Digital-to-Analog 
Conversion Voltage Output 

Rated Output Range ±10 V 0 ~ 10 V ±5 V 0 ~ 5 V 1 ~ 5 V 

Conversion Range 
K-32000 

~  
K32000 

K0 
~ 

K32000 

K-32000 
~ 

K32000 

K0 
~ 

K32000 

K0 
~ 

K32000 

Hardware Output Range 
-10.1 V 

~  
+10.1 V 

-0.1 V 
~  

10.1 V 

-5.05 V 
~ 

+5.05 V 

-0.05 V 
~  

+5.05 V 

0.95 
~ 

5.05 V 
Error Rate  
(Room Temperature) ±0.2% 

Error Range  
(Full temperature range) 

±0.5% 

Linearity Error  
(Room Temperature) 

±0.05% 

Linearity Error  
(Full Temperature Range) 

±0.05% 

Hardware Resolution 12 bits 
Permissible load 
impedance 

≧1k Ω ≧500Ω 
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Digital-to-Analog 

Conversion Current Output 

Rated Output Range 0–20 mA 4–20 mA 

Conversion Range 
K0 
~ 

K32000 

K0 
~ 

K32000 
Hardware Output Range -0.2 mA to 20.2 mA 3.8–20.2 mA 
Error Range 
(Room Temperature) 

±0.2% 

Error Range  
(Full Temperature Range) 

±0.5% 

Linearity Error  
(Room Temperature) 

±0.03% 

Linearity Error  
(Full Temperature Range) 

±0.10% 

Hardware Resolution 12 bits 
Permissible Load 
Impedance 

≦550 Ω 
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2.4.2 Analog Input/Output Module Profiles 

 AS04AD-A/AS08AD-B/AS08AD-C/AS04DA-A/AS06XA-A 

38.2 95

75
35

8898
.3

-

-

1

4

5

2

3

6

7

8

9

7

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

ERROR LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Analog-to-digital / digital- 
to-analog conversion 
indicator 

Indicates the conversion status  
Blinking: conversion is taking place 
OFF: stop conversion 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  
9 Label Nameplate 
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2.4.3 Analog Input/Output Terminals 

AS04AD-A AS08AD-B AS08AD-C 

  
 

 
 

 
AS04DA-A AS06XA-A 

  
 

04AD

V1+

AG

SLD

●

I3+

VI3-

VI1-

V3+

I1+

V2+

0V

24V

SLD

●
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V4+

I2+
PWR

ERR
A    D

24V

0V

AG

A    D
ERR

PWR
V2+V1+

08AD

V1- V2-

V3-

V3+

V4-

V4+

V5-

V5+

V6-
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V7-
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AG

0V

24V

PWR

ERR
A    D

08AD

I1+ I2+
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  I5-
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I6+

  I7-

I7+ I8+

I8-

VO1 VO2

AG

SLD

AG

VO4

0V

24V

SLDSLD

●

AG

VO3

IO3

AG

SLD

IO1

IO4

PWR

ERR
D    A

IO2

04DA

V1+ V2+

IO1 IO2

AG

0V

24V

VO1

I3+

VI3-

VO2

I4+

VI4-

VI1-

V3+

I1+

VI2-

V4+

I2+
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A     D
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2.5 Temperature Measurement Modules Specifications 
2.5.1 General Specifications 

 AS04RTD-A / AS06RTD-A 

Electrical specifications 

Number of analog 
inputs AS04RTD-A: four ; AS06RTD-A: six 

Applicable sensor 

2-WIRE & 3-WIRE Pt100/Ni100/Pt1000/Ni1000/ 
JPt100/LG-Ni1000/Cu50/Cu100/0–300 Ω/0–3000 Ω 
Pt100：DIN 43760-1980 JIS C1604-1989；100 Ω 3850 PPM/°C 

Pt1000：DIN EN60751；1 k Ω 3850 PPM/°C 

Ni100/Ni1000：DIN 43760 

JPt100：JIS C1604-1989 
LG-Ni1000 
Cu50/Cu100 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector type Removable terminal block 

Overall accuracy 

Pt100/Ni100/Pt1000/Ni1000/JPt100 

25°C/77°F: The error is ±0.1% of the 
input within the range. 
-20 to +60°C/-4 to +140°F: The error is 
±0.5% of the input within the range. 

LG-Ni1000 
25°C/77°F: The error is ±0.2% of the 
input within the range. 

Cu50 
25°C/77°F: The error is 4°C of the 
input within the range. 

Cu100 
25°C/77°F: The error is 2°C of the 
input within the range. 

Conversion time Two-wire/three-wire configuration: 200 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, and the analog channels are isolated from one another by 
optocouplers. 
Isolation between a digital circuit and a ground: 500 VAC 
Isolation between an analog circuit and a ground: 500 VAC 
Isolation between an analog circuit and a digital circuit: 500 VAC 
Isolation between the 24 VDC and a ground: 500 VAC 

Weight AS04RTD-A: 115g ; AS06RTD-A: 125g 
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Functional specifications 

Analog-to-digital 
conversion Centigrade (°C) Fahrenheit (°F) Input impedance 

Rated input range*1 

Pt100: -180°C to +800°C 
Ni100: -80°C to +170°C 
Pt1000: -180°C to +800°C 
Ni1000: -80°C to +170°C 
JPt100: -180°C to +500°C 
LG-Ni1000: -50°C to +180°C 
Cu50: -50°C to +150°C 
Cu100: -50°C to +150°C 

Pt100: -292°F to +1,472°F 
Ni100: -112°F to +338°F 
Pt1000: -292°F to +1,472°F 
Ni1000: -112°F to +338°F 
JPt100: -292°F to +932°F 
LG-Ni1000: -58°F to +356°F 
Cu50: -58°F to +302°F 
Cu100: -58°F to +302°F 

0–300 Ω 
0–3000 Ω 

Average function Range: 1–100 

Self-diagnosis Disconnection detection 

*1: If the measured temperature exceeds the upper limit, it only shows the maximum value. If the 
measured temperature is below the lower limit, it only shows the minimum value. 

 
 AS04TC-A / AS08TC-A 

Electrical specifications 

Number of analog 
inputs AS04TC-A: four ; AS08TC-A: eight 

Applicable sensor 
Type J, K, R, S, T, E, N, B, C, U, L, TXK thermocouple;  

input impedance: ±100mV 
Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector type Removable terminal block 

Overall accuracy 
25°C/77°F: The error is ±0.5% of the input within the range. 

-20 to +60°C/-4 to +140°F: The error is ±1% of the input within the range. 
Conversion time 200 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit, 
and the analog channels are isolated from one another by optocouplers. 
Isolation between a digital circuit and a ground: 500 VAC 
Isolation between an analog circuit and a ground: 500 VAC 
Isolation between an analog circuit and a digital circuit: 500 VAC 
Isolation between two group circuits: 500 VAC 
Isolation between the 24 VDC and a ground: 500 VAC 
Isolation between the analog channels: 120VAC 

Weight AS04TC-A: 115g ; AS08TC-A: 125g 
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Functional specifications 

Analog-to-digital 
conversion Centigrade (°C) Fahrenheit (°F) Input impedance 

Rated input range*1 

Type J: -100°C~1200°C 
Type K: -100°C~1,350°C 
Type R: 0°C~1,750°C 
Type S: 0°C~1,750°C 
Type T: -150°C~400°C 
Type E: -150°C~980°C 
Type N: -150°C~1,300°C 
Type B: 200°C~1,800°C 
Type C: 0°C~2,320°C 
Type U: -200°C~600°C 
Type L: -200°C~900°C 
Type TXK: -200°C~800°C 

Type J: -148°F~2,192°F 
Type K: -148°F~2,462°F 
Type R: 32°F~3,182°F 
Type S: 32°F~3,182°F 
Type T: -238°F~752°F 
Type E: -238°F~1,796°F 
Type N: -238°F~2,372°F 
Type B: 392°F~3,272°F 
Type C: N/A 
Type U: -328°F~1,112°F 
Type L: -328°F~1,652°F 
Type TXK: -328°F~1,472°F 

±100mV 

Average function Range: 1~100 
Self-diagnosis Disconnection detection 

*1: If the measured temperature exceeds the upper limit, it only shows the maximum value. If the 
measured temperature is below the lower limit, it only shows the minimum value. 
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2.5.2 Temperature Measurement Module Profiles 

 AS04RTD-A / AS06RTD-A 

38.2

35
8898

.3

1

4

5

2

3

6

04RT D

7

8

9

95

75

7

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

ERROR LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Analog to digital 
conversion indicator 

Indicates the analog to digital conversion status  
Blinking: conversion is taking place 
OFF: stop conversion 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  
9 Label Nameplate 
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 AS04TC-A / AS08TC-A 

38.2

35
8898

.3

1

4

5

2

3

6

04TC

7

8

9

95

75

7

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

ERROR LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Analog to digital 
conversion indicator 

Indicates the analog to digital conversion status  
Blinking: conversion is taking place 
OFF: stop conversion 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  

9 Label Nameplate 
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2.5.3 Temperature Measurement Module Dimensions 

AS04RTD-A AS04TC-A 

L1+ L1-

SLD I4-

0V

24V

L2+

SLD

SLD

L4+

L3+

SLD I3-

L4-

L3-

I2-

I1-

L2-

0 4RTD

PWR

ERR
A    D

 

I1 +

SLD I4-

0V

2 4V

SLD

SLD

SLD
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I3 +

I3-

I2 +
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PWR
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A    D

 
AS06RTD-A AS08TC-A 

PWR
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Unit: mm 

 
  



Chapter  2  Spec i f icat ions  and System Conf igurat ion  

2-50  

2_  

2.6 Positioning Module Specifications 
2.6.1 General Specifications 

Electrical specifications for the inputs  

 AS02PU-A 
Model 

Item 
High-speed Input Normal Input 

Number of inputs 3 (A+/A-, B+/B-, Z+/Z-) 5 (X0.0-X0.4) 

Connector type Removable terminal blocks 
Input form Differential input Direct current (sinking or sourcing) 
Input current 5-24 VDC, 5 mA 24 VDC, 5 mA 
Action 
level 

OFF→ON >3 VDC >15 VDC 
ON→OFF <1.5 VDC <5 VDC 

Response time 1.5 μs < 0.5 ms 

Maximum input 
frequency 200 kHz (A+/A-, B+/B-, Z+/Z-) 1 kHz 

Input impedance 4.7 k Ω 
Input isolation 500 VAC 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Weight  120 g 

 
 AS04PU-A 

Model 
Item 

Normal 

Number of inputs Six 

Connector type Removable terminal blocks 

Input form 
Direct current (sinking or sourcing) 
Sinking: The inputs are NPN transistors whose collectors are open collectors.  
Sourcing: The inputs are PNP transistors whose collectors are open collectors. 

Input current 24 VDC, 5 mA 
Action 
level 

OFF→ON >15 VDC 
ON→OFF <5 VDC 

Response time < 0.5 ms 

Maximum input 
frequency 1 kHz 

Input impedance 4.7 k Ω 
Input isolation 500 VAC 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Weight  120 g 
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Electrical specifications for the outputs  

Model 
Item 

AS02PU-A AS04PU-A 

Number of outputs Four (2-axis) Eight (4-axis) 
Connector type Removable terminal blocks 
Output form  differential output Transistor-T (sinking) (NPN) 
Output current 5 VDC*1 5-30 VDC, 0.1A 
Leakage current < 10 uA 
Minimum load 1 mA / 5 VDC 

Maximum 
load 

Resistance 10 mA 0.1A 
Inductance N/A 
Bulb N/A 

Maximum 
output 
frequency 

Resistance 200 kHz 100 kHz 

Maximum 
Response 
time 

OFF→ON 0.1 μs 1.5 μs 

ON→OFF 0.1 μs 1.5 μs 

Output isolation 500 VAC 

Weight 120 g 

Note *1: Acutal output 4 VDC (high input impedance) to 3.3 VDC (10 mA)/point 
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2.6.2 Positioning Module Profiles 

 AS02PU-A / AS04PU-A 

2

38.2 95

75
35

8898
.3

1

4

5

2

3

6

77

8

9

 
 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
(Blue) 

Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

Run LED indicator 
(Green) 

Operating status of the module 
ON: the module is running and ready to accept instructions. 
OFF: the module is stopped and can NOT accept instrucitons.  

Error LED indicator 
(Red) 

Error status of the module 
OFF: the module is normal. 
Blinking (0.2 seconds ON/OFF): hardware error occurs in the 
module, can NOT operate normally 

Input LED indicator 
(Red) 

ON: Receives an input signal 
OFF: Receives no input signal 

Output LED indicator 
(Red) 

ON: Receives an output signal 
OFF: Receives no output signal 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip On the DIN reail for grounding 
9 Label Nameplate 
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2.6.3 Positioning Module Terminals  

AS02PU-A AS04PU-A 

  
AS02PU-A AS04PU-A 

Wordings with the same indications that are used 
on the terminal block and manual 

 

Manual 
Terminal 

Block 
(left) 

Manual 
Terminal 

Block 
(right) 

A+ A+ A- A- 
B+ B+ B- B- 
Z+ Z+ Z- Z- 
S/S S/S X0.0 0 
X0.1 1 X0.2 2 
X0.3 3 X0.4 4 

Y0.0+ 0+ Y0.0- 0- 
Y0.1+ 1+ Y0.1- 1- 
Y0.2+ 2+ Y0.2- 2- 
Y0.3+ 3+ Y0.3- 3- 

Wordings with the same indications that are used 
on the terminal block and manual 

 

Manual 
Terminal 

Block 
(left) 

Manual 
Terminal 

Block 
(right) 

S/S S/S C0 C0 
S/S S/S Y0.0 0 
X0.0 0 Y0.1 1 
X0.1 1 Y0.2 2 
X0.2 2 Y0.3 3 
X0.3 3 C1 C1 
X0.4 4 Y0.4 4 
X0.5 5 Y0.5 5 

  Y0.6 6 
  Y0.7 7 
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2.7 Counter Module Specifications  
2.7.1 General Specifications 

Item Description 
Number of channels 2 

Pulse Input  

Input signal type Phase differential (A/B): x2, x4; CW/CCW; Pulse/Direction 

Max. transmission 
distance 200 kHz at 30 m 

Counter type Circular counter, linear encoder 

SSI Input 

Max. data length 32-bit (The single-turn, multi-turn, and status data length can 
be set.) 

Coding method Binary code, gray code 
Max. transmission 
distance 

250 kHz at 150 m, 500 kHz at 50 m, 625 kHz at 40 m,  
1 MHz at 20 m, 1.25 MHz at 10 m 

Parity check bit None, odd parity, even parity 

Counter type Circular counter, absolute counter 

Counter 

Counting range -2147483648 ~ 2147483647 (32-bit) 

Counter control Reset, preset, gate, capture,  
offset correction for absolute position  

Output state check 

Direction to count, counting overflow/underflow, linear 
counting beyond the lower and upper limit values, SSI 

feedback, SSI position exceeding the protection limit, SSI 
parity checking, SSI communication status, a zero point is 

set beyond SSI encoder resolution 

External input 
point (phase Z) 

Input point 2 (one for each channel) 

Function  Reset, gate, capture 

Digital filtering OFF, 100 μs, 200 μs to 20 ms 

Min. software interrupt 
response time   20 μs (hardware response time included) 

External output 
point 

Output point 4 

Output type NPN transistor (sinking) 

Comparison 
function 

Instruction  General comparison output instruction, table comparision 
output instruction  

Interrupt Using comparision to achieve the interrupt function  

Measurement 
function 

Measured item Input frequency and revolution 

Average times 1 to 10 times 
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Electrical specifications for the inputs  
Model 

Item 
Pulse input External input 

Number of inputs 4 (A+/B+, A-/B-) 2 (Z+/Z-) 

Connector type D-sub 15 
Input current 5-24 VDC, 6-15 mA 
Action 
level 

OFF→ON 3 V 
ON→OFF 1 V 

Maximum input 
frequency  200 kHz 20 kHz 

Input impedance 4.7 kΩ 
Input signal Signal signal: 5 – 24 VDC (sinking or sourcing) ; differential signal: 5 V 
Input isolation 500 VAC 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Weight  138 g 
 
Electrical specifications for the SSI input and output 

Model 
Item 

SSI input SSI output 

Number of inputs / 
outputs 

2 (DATA+/DATA-) 2 (CLK+/CLK-) 

Connector type D-sub 15 
Voltage / Current 5 VDC, 1 mA 5 VDC, ±60 mA (max.) 

Action 
level 

OFF→ON VID*1 ≧ 0.2V - 

ON→OFF VID ≦ 0.2V - 

Maximum 
input/output 
frequency  

1.25 MHz 

Input impedance 12 kΩ (terminal resistor 120 Ω) - 
Input signal RS-422 
Input isolation 500 VAC 
Input display When the optocoupler is driven, the input LED indicator is ON. 

*1: VID is the voltage difference between DATA+ and DATA-. 
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Electrical specifications for the external outputs 
Model 

Item 
AS02HC-A 

Number of outputs 4 

Connector type D-sub 15 
Ouptut type NPN transistor (sinking) 
Voltage 5 – 30 VDC 
Minimum load 1 mA / 5 VDC 

Maximum load 
Resistance 0.1A/output 
Inductance - 
Bulb - 

Maximum 
output 
frequency*1 

Resistance 10 kHz 

Maximum 
Response time 

OFF→ON 
ON→OFF 25 μs 

Output isolation 500 VAC 
 
Electrical specifications for the +5 V encoder power supply 

Model 
Item 

AS02HC-A 

Number of outputs 2 (+5 VO/GND) 

Connector type D-sub 15 

Voltage / Current 5 VDC (±5%), ±100 mA (max.) 
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2.7.2 Counting Module Profiles 

98
.3

88

35 75

1

2

4

3

5

6

57

 
Number Name Description 

1 Model name Model name of the module 

2 

POWER LED indicator  
(Blue) 

Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

Error LED indicator 
(Red) 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Counter LED indicator 
for Ch1 Act. & Ch2 Act. 
(Green) 

Counting status of the module 
OFF: the counter is disabled.  
ON: the counter is enabled but the result of counting is not changed. 
Blinking: the result of counting is updating. 
When SSI input:  
Blinking: the counter is enabled and the position value is updating. 

Input / output LED 
indicator 

ON: Receives an input / output signal 
OFF: Receives no input / output signal 

3 D-sub 15  
Input: connected for pulse input and encoder 
Output: connected to loads to be driven 
Power: providing external encoder +5 VDC 

4 DIN rail clip Secures the module onto the DIN rail 
5 Module connecting set Connects the modules 
6 Ground clip On the DIN reail for grounding 

7 Label Nameplate 
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2.7.3 Counting Module Terminals 

 

Pin No. CH1 CH2 

8 A1+ A2+ 

3 A1- A2- 

7 B1+ B2+ 

2 B1- B2- 

6 Z1+ Z2+ 

1 Z1- Z2- 

10 CLK1+ CLK2+ 

5 CLK1- CLK2- 

9 DATA1+ DATA2+ 

D-sub15 pin  

515 1
0

6 111

 

4 DATA1- DATA2- 

14 +5VO1 +5VO2 

15 GND1 GND2 

12 Y0.0 Y0.2 

11 Y0.1 Y0.3 

13 COM0 COM1 

 
  

PWR

ERR

CH1 Act.
CH1 A
CH1 B
CH1 Z

Y0.0
Y0.1

CH2 Act.
CH2 A
CH2 B
CH2 Z

Y0.2
Y0.3

02HC

CH1

CH2
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2.8 Network Module Specifications  
2.8.1 General Specifications 

 AS00SCM-A 

RS-485/RS-422/RS-232 communication interface 

Item Specifications 
Connector type European-style terminal block, spring-clamp terminal block 
Electronical isolation 500 VAC 

Communication 
format 

Stop bit: 1 stop bit or 2 stop bits 
Parity bit: none, an odd parity bit, or an even parity bit 
Data bit: 7 data bits or 8 data bits 

Communication 
protocol CAN  

 
CAN communication interface 

Item Specifications 
Connector type RJ-45 
Transmission speed 10K, 20K, 50K, 125K, 250K, 500K, 1000 Kbps 

Communication 
protocol 

AS special remote mode (for RTU mode)  
CANopen (available for models with firmware V2.0 or later) 

 

Ethernet communication interface 

Item Specifications 
Connector type RJ-45 
Transmission speed 10M, 100 Mbps 
Communication 
protocol 

EtherNet/IP (available for models with firmware V2.02 or later),  
PROFINET (available for models with firmware V2.06 or later) 

 

Electrical specifications 

Item Specifications 
Supply voltage 24 VDC 
Electric energy 
consumption 0.6 W 

Weight 169 g 
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 AS01DNET-A 

CAN communication interface 

Item Specifications 
Connector type Removable terminal blocks (enclosed with fastening screws, 5.08 mm ) 
Electronical isolation 500 VAC 
Transmission cables Communication cable *2, power cable *2, shield cable *1 
Communication 
protocol DeviceNet 

 
Communication interface 

Item Specifications 
Data type I/O polling, explicit message 

Transmission speed 
Standard mode: 125K, 250K, 500Kbps 
Extension mode: 10K, 20K, 50K, 125K, 250K, 500K, 1000K, 800Kbps and 1M 
bps 

 

Electrical specifications 

Item Specifications 
Voltage 11~25 VDC supplied by power cable of the network 
Current Ttypical value: 28 mA; rush current: 125 mA (24 VDC) 
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 AS04SIL-A 

Unit Specifications 

Item Specifications 

Model type IO-Link master  

Model name AS04SIL-A 

Number of ports 4 

Communication  

Baud rate 4.8 kbps；38.4 kbps；230.4 kbps 

Topology 1 : 1 
Compliant 
standards 

 IO-Link Interface and System Specification Version 1.1.2 
 IO-Link Test Specification Version 1.1.2 

Modes 
IO-Link Yes 
SIO (DI) Yes 
SIO (DO) Yes, up to 100 mA / channel 

Cyclic communications 2 ms min. ; dynmatic, according to the valid data length 
Input: data size in each 
communication port  32 bytes max. 

Output: data size in each 
communication port 32 bytes max. 

Input: data size in each module  128 bytes max.  
Output: data size in each module 128 bytes max.  
Input PDO data size 100 words max.  
Output PDO data size 100 words max.  
Back up Yes 

Cable specification  

Type Unshielded (can also apply to shielded ones) 
Length 20 m max. 
Electrostatic 
capacity 
between lines 

3 nF max. 

Loop 
resistance 6 Ω max.  

External connection terminals Clamping terminal block 
 
  

MELODY.CHEN 陳雅亭

纜線規格
�纜線類型
�非隔離類型；也適用於隔離類型
�
�
�纜線長度
�最大20 m
�
�
�線間靜電容量
（Effective line capacitance）
�最大3 nF
�
�
�迴圈電阻（Overall loop resistance）
�最大6 Ω
�
�
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Electrical specifications 

Item Specifications 

Power supply to 
device in IO-Link 
mode or SIO (DI) 
mode 

Rated voltage 24 VDC (20.4 VDC~ 28.8 VDC) (9-15%~+20%) 

Maximum load 
current 0.2A/port 

Short-circuit 
protection Yes 

Digital inputs in 
SIO (DI) mode 

Internal I/O 
common NPN, PNP 

Input voltage / 
current 24 VDC, 5 mA 

ON voltage >15 VDC  
OFF voltage <5 VDC 

Input filter time No filter, 1 ms (default), 2 ms, 4 ms, 8 ms, 16 ms, 32 ms, 64 ms, 
128 ms, 256 ms 

Digital outputs in 
SIO (DO) mode 

Internal I/O 
common NPN, PNP 

Output voltage / 
current 24 VDC (20.4 VDC~ 28.8 VDC), 0.1A/port 

Short-circuit 
protection Yes  

Leakage current <0.1 mA  
Residual 
voltage <1.5 VDC 

Digital inputs for 
pin 2 in IO-Link 
mode 

Internal I/O 
common NPN, PNP 

Input voltage / 
current 24 VDC, 2 mA 

ON voltage >15 VDC 
OFF voltage <5 VDC 

Input filter time No filter, 1 ms (default), 2 ms, 4 ms, 8 ms, 16 ms, 32 ms, 64 ms, 
128 ms, 256 ms 

Electronical isolation 500 VAC 

Power consumption 0.8 W 

Weight 133g 
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2.8.2 Network Module Profiles 

 AS00SCM-A 

1

4

5

2

6 75

98
.3

88

56

3

7

8

9

7

10

SCM
PO WER

CA RD 1

CA RD 2

ER RO R

F OR MA T 2

C OM . RTU

ID 2

FOR M AT 1

ID 1

 
Unit: mm 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: The power is on 
OFF: No power or the power is low 

ERROR LED indicator 
Error status of the module 
OFF: The module is normal. 
Blinking: Error occurs now or error had occurred before 

Extension card 1 
indicator 
(orange) 

Blinking: Communication is taking place in card 1 
OFF: No communication in card 1 

Extension card 2 
indicator 
(orange) 

Blinking: Communication is taking place in card 2 
OFF: No communication in card 2 

3 
Address and function 
setting knobs 

2 sets for setting up the address and function in card 1 and 2 

4 

Slot of function card 1  COM mode: Available for AS-F232, AS-F422, AS-F485 

Slot of function card 2 
COM mode: Available for AS-F232, AS-F422, AS-F485,  

            AS-FCOPM 
RTU mode: AS-FCOPM, AS-FEN02, AS-FPFN02 

5 Mode switch  COM: Serial communication mode; RTU: remote module mode 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  
9 Label Nameplate 

10 
Input for supplying power 
to remote modules  

Power supply for the remote module (NOT for COM mode) 
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 AS01DNET-A 

 
Unit: mm 

 
Number Name Description 

1 Model name Model name of the module 

2 State LED indicator 

Master/slave mode: 
 NS LED 
OFF: no power or duplicate ID check has not been  

 completed. 
Green light blinking every 0.5 seconds: the connection  

 to the DeviceNet network failed. 
Green light ON: online; the connection to the DeviceNet  

 network is normal. 
Red light blinking every 0.5 seconds: communication  

 error 
Red light ON: Network trouble, duplicate node ID, no  

 network power or Bus-OFF.   
 
 MS LED 
OFF: no power  
Green light blinking every 0.5 seconds: no module is  

 configured. 
Green light ON: input and output data are normal. 
Red light blinking every 0.5 seconds: when AS01DNET 

 works as the master, the slave in Scan List can not work  
 normally. When AS01DNET works as the slave, an error  
 occurs in the configuration. 
Red light ON: hardware error 
 
 Combination of NS LED and MS LED 
NS LED OFF & MS LED OFF: no power  
NS LED OFF & MS LED green light ON: duplicate ID  

 check has not been completed.  
NS LED red light ON & MS LED green light ON: duplicate  

 ID check failed or Bus-OFF. 
 NS LED red light ON & MS LED red light blinking every  
 0.5 seconds: no network power 
 NS LED red light ON & MS LED red light ON: hardware  
 error  
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Number Name Description 

 

RTU mode: 
 NS LED 
OFF: no power or duplicate ID check has not been  

 completed. 
Green light blinking every 0.5 seconds: the connection  

 to the DeviceNet network failed. 
Green light ON: online; the connection to the DeviceNet  

 network is normal. 
Red light blinking every 0.5 seconds: I/O connection  

 timeout between AS01DNET (RTU) and DeviceNet master 
Red light ON: Network trouble, duplicate node ID, no  

 network power or Bus-OFF.   
 
 MS LED 
OFF: no power  

 Green light blinking every 0.5 seconds:  
 - AS01DNET (RTU) is waiting for the I/O data from   
  DeviceNet master.  
 - No I/O data transmission between AS01DNET(RTU) and   
  DeviceNet master 
- The PLC connected to DeviceNet master is in STOP state. 
Green light ON: normal transmission of I/O data between  

 AS01DNET (RTU) and DeviceNet master  
Red light blinking every 0.5 seconds: no network power  

 supply; configuration error; module alarms.  
Red light ON: hardware error 

3 Address switch  Setting up the address  

4 Function switch 
Setting up the funcitons, including the work mode and baud rate 

of   
 DeviceNet network 

5 
DeviceNet communication 
port 

Connects the modules via DeviceNet communication.  
Use AS01DNET-A connector for wiring. 

6 
Mode switch  
(RTU/DNET; 
Master/Slave) 

Master/Slave mode: the port does not need an external  
 24VDC power supply connected 
RTU mode: the power input port of the network module is  

 required to connect an external 24VDC power supply only.  
 You can connect 

7 Left-side extension port Connects the modules 
8 Label Nameplate 
9 Right-side extension port Connects the modules 

10 
Input for supplying power 
to remote modules  

Power supply for the remote module  
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 AS04SIL-A 

 38.2 95

75
35

8898
.3

1

4

5

2

3

6

7

8

7

Q2

Q4
E4

Q3
E3
C4

E2

C3

CQ 1

Q1
E1
C2

MS
NS
C1

PWR

04 SI L

●

CQ2

L3+

L3 -

L4+

L4-

DI 1

DI2

CQ3

DI3

CQ4

DI4

L2+

L2-

L1+

L1-

24 V

0V

Unit: mm 
Number Name Description 

1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power or the power is low 

 Module LED indicator 

Error status of the module 
OFF: The module is normal. 
Blinking:  
 Module setting or communication error (blinks every 1 second) 
 Hardware or low power error (blinks every 0.2 second) 

Network LED indicator 

Error status of the network 
ON: No external power supply 
Blinking: Scanning is under going or the module is configured and the 
diagnosis is done. 
OFF: The module is configured but the diagnosis has not done yet.  

C1, C2, C3, C4 LED 
indicator (orange) 

IO-Link connection status of each communication port 
ON: The communication port is in IO-Link mode and a device is 
connected. 
Blinking: The communication port is in IO-Link mode but no device is 
connected or thhe device connected is not configured.  
OFF: The communication port is disabled or in SIO mode.  

Q1, Q2, Q3, Q4 LED 
indicator (orange) 

Indicates the status of input / output in SIO mode 
ON: The input/output is working in SIO mode. 
OFF: The communication port is disabled or in IO-Link mode. 

E1, E2, E3, E4 LED 
indicator (red) 

Indicates if any warning or error occurs in the IO-Link connection 
Blinking: A warning or error occurs 
OFF: No warnings or errors  

3 
Removable terminal 
block 

IO-Link  

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Label Nameplate 
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2.9 Load Cell Module Specifications  
2.9.1 General Specifications 

 AS02LC-A 

Item Description 
Rated supply voltage/Power 
consumption 24 VDC (-15 to +20%) / 5W 

Minimum/maximum voltage 18~31.2VDC 
Maximum current consumption 150 mA 
Input signal range ±40mVDC 
Sensibility +5 VDC +/-10% 
ADC resolution 24 bits 
Highest precision 0.04% 
Applicable sensor type Four-wire or six-wire load cell 
Expanding a temperature 
coefficient ≤ ± 50 ppm/K v. E   

Reducing a temperature 
coefficient to zero  ≤ ± 0.4 μV/K 

Linearity error ≤ 0.02% 
Response time 2.5, 10, 16, 20, 50, 60, 100, 200, and 400ms 
Eigenvalue applicable to a load 
cell 0–1, 0–2, 0–4, 0–6, 0–20, 0–40 and 0–80 mV/V 

Maximum distance for 
connecting a load cell 100 meters 

Maximum output current 5 VDC * 160 mA 
Allowable load 40–4,010 Ω   
Common-mode rejection ratio 
(CMRR @50/60 Hz) ≥100 dB  

Dynamic range K1–K5 
Averaging weights K1–K100 

Isolation 
Between a digital circuit and the ground: 500 VAC  
Between an analog circuit and the ground: 500 VAC  
Between an analog circuit and a digital circuit: 500 VAC 

Weight 140 g 
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2.9.2 Load Cell Module Profiles 

 AS02LC-A 

38.2

35

8898
.3

1

4

5

2
3

6

7

8

9

95

75

7

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

ERROR LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Analog to digital 
conversion indicator 

Indicates the analog to digital conversion status  
Blinking: conversion is taking place 
OFF: stop conversion 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  
9 Label Nameplate 
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2.9.3 Load Cell Module Dimensions 

 AS02LC-A 

EX C-EX C+

SL D

0 V

2 4V

SE N+

EX C+

SI G+

SE N+

SL D

SI G+

CH2
SE N-

EX C-

SI G-

CH1
SE N-

SI G-

02LC

 
Unit: mm 
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2.10 Extension Card Specifications  
2.10.1 General Specifications 

 AS-F2AD 

Two DC analog signal input channels:  

Item Voltage Input Current Input 

Rated Input Range 0 V - 10 V 4 mA - 20 mA 

Resolution 12-bit 11-bit 

Digital Conversion 
Range 

0 - 4000 0 - 2000 

Hardware Input 
Limit*1 

0V ~ +10.24V 4mA ~ 20.37mA (FW V1.00) 
3.63mA ~ 20.37mA (FW V1.20 or later) 

Digital Conversion 
Limit*2 

0 ~ 4095 0 ~ 2047 (FW V1.00) 
- 48 ~ 2047(FW V1.20 or later) 

Error Rate room temperature: ±0.5% ; full temperature range: ±1.0% 

Isolation The isolation between digital and analog is 500 VAC; no isolation between channels. 

Input Impedance 2 MΩ 250 Ω 

Conversion Time*3 3 ms / CH 

Characteristic 
Curve 

10V

4000

0
Voltage inputD

ig
ita

l V
al

ue
 O

ut
pu

t

 Current input

D
ig

ita
l V

al
ue

 O
ut

pu
t

20mA

2000

4
 

Digital Value 
Output*4 

Card 1 SR168 (CH1), SR169 (CH2) 
Card 2 SR170 (CH1), SR171 (CH2) 

*1: The input signal should NOT exceed the limit. If exceeding the limit, damage may occur.  

*2: If the input signal exceeds the hardware input limit, the module only shows the maximum value. If the input 
signal is below the lower limit, it only shows the minimum value. If the input signal exceeds the hardware input 
limit, it also exceeds the digital conversion limit and a conversion limit error appears. For example in the 
current input mode (4 mA to 20 mA), when the input signal is 0 mA, exceeding the hardware lower limit, it also 
exceeds the conversion lower limit. The module uses the lower limit value (-48) as the input signal. If a 
disconnected analysis is required, you can check if the digital conversion value is -48.    

*3: The conversion time is the time for each channel to convert signals to hardware input signals. If you need 
to calculate a complete conversion time, you need to add the PLC scan time.    

*4: Use the program to read the values in SR to obtain the corresponding A/D conversion value for the 
channel. 

*5: Refer to section 2.2.16 SM/SR notes for more information on descriptions of SM27/SR27 analog input 
error codes.  
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 AS-F2DA 

Two DC analog signal output channels: 

Item Voltage Output Current Output 

Analog Signal 0 V - 10 V 4 mA - 20 mA 

Resolution 12-bit 12-bit 
Digital Conversion 
Limit 

 

0 - 4000 0 - 4000 

Error Rate room temperature: ±0.5% ; full temperature range: ±1.0% 

Isolation The isolation between digital and analog is 500 VAC; no isolation between channels. 

Impedance 
Allowance ≥1 kΩ ≤500 Ω 

Conversion Time*1 2ms / CH 

Characteristic 
Curve 

Di gital Value Input

Vo
lta

ge
  O

ut
pu

t 10V

40000
 

Digital Value Input

C
ur

re
nt

 O
ut

pu
t 20mA

40004
 

Digital Value 
Output*2 

Card 1 SR172 (CH1) SR173 (CH2) 

Card 2 SR174 (CH1) SR175 (CH2) 

*1: The conversion time is the time for each channel to convert signals to hardware input signals. If you need 
to calculate a complete conversion time, you need to add the PLC scan time.    

*2: Use the MOV instruction to move the value to the SR to obtain the corresponding voltage output value.  

 

 AS-F232 

The AS series PLC is built with COM1 (RS-485), and COM2 (RS-485). You can use this extension card for 
communication with different interfaces such as RS-232 and a PC. The communication functions and isolation 
levels are the same as the PLU CPU built-in ones. It can be used in slave or master mode. After installing the 
extension card, go to the HWCONFIG in the ISPSoft for communication setup. 

 
 Wiring example 

DB9 male to DB9 female (standard cable)

    AS-F232
(DB9 female) + + Superior

machine
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 AS-FCOPM 

With its own standalone communication port, the extension card can work independently and can act as a 
master or a sloave. After installing the extension card, go to the HWCONFIG in ISPSoft to set up the 
communication.  

 Wiring example 

 

GNDCAN_H CAN_L

Master node Slave node Slave node

Terminal 
 resistor
(120 ohm)

Shielded  
    cable

GNDCAN_H CAN_L GND CAN_H CAN_L

Terminal 
 resistor
(120 ohm)

 
 

 AS-F422 

You can use this extension card for communication with Delta HMI series or other devices through the RS-422 
communication port. You can use this extension card for communication with different interfaces such as RS-
232 and a PC. The communication functions and isolation levels are the same as the PLU CPU built-in ones. 
It can be used in slave or master mode. After installing the extension card, go to the HWCONFIG in the 
ISPSoft for communication setup. 

 Wiring example of the communication with Delta HMI DOPA series via COM2 

 

3
4

1
2

6
7
8
9

COM2/DB-9

AS-F422 Delta HMI  ser iesDOPA

2
1

3
4

T+
T-

R+
R-

Rx+
Rx-

Tx+
Tx-

RTS-
RTS+

CTS+
CTS-

 
 

 AS-F485 

With its own standalone communication port, the extension card can work independently. You can use this 
extension card for communication with different interfaces such as RS-232 and a PC. The communication 
functions and isolation levels are the same as the PLU CPU built-in ones. It can be used in slave or master 
mode. After installing the extension card, go to the HWCONFIG in the ISPSoft for communication setup. 

 Wiring example 

D+ D- SG D+ D- SG SG D+ D-

Master node Slave node Slave node

Shielded  
    cable

Shielded  
    cable

Terminal 
 resistor
(120 ohm)

Terminal 
 resistor
(120 ohm)
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 AS-FEN02 

With its own standalone communication port, the extension card can work independently and can be set as a 
MODBUS TCP server, Client or EtherNet/IP Adapter. After installing the extension card, go to the HWCONFIG 
in ISPSoft to set up the communication.  

Ethernet communication interface 

Item Specifications 
Connector type RJ-45*2 
Transmission speed 10/100BASE-T (X) full duplex, switched Ethernet 
Cable CAT5e (up to 100 m) 
Communication protocol Modbus TCP Server, Client and EtherNet/IP Adapter 
Isolation 1500 VAC 

 
 AS-FOPC02 

With its own standalone communication port, the extension card can work independently and can be set as a 
Modbus TCP Server and OPC UA Server. After AS-FOPC02 is installed on the PLC, you need to go to 
HWCONFIG to edit the parameters. 

Ethernet communication interface 

Item Specifications 
Connector type RJ-45*2 
Transmission speed 10/100BASE-T (X) full duplex, switched Ethernet 
Cable CAT5e (up to 100 m) 
Communication protocol Modbus TCP Server and OPC UA Server 
Isolation 1500 VAC 

 

 AS-FPFN02 

With its own standalone communication port, the extension card can work independently and can be set as a 
PROFINET slave to connect to PROFINET network and exchange data with PROFINET master. After 
installing the extension card, go to the PROFINET Configurator to set up the communication and download 
the configurations to the master and then the master sends the configurations to the function card.   

Ethernet communication interface 

Item Specifications 
Connector type RJ-45*2 
Transmission speed 10/100BASE-T (X) full duplex, switched Ethernet 
Cable CAT5e (up to 100 m) 
Communication protocol PROFINET RT 
Isolation 1500 VAC 
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2.10.2 Extension Card Profiles 

 AS-F2AD/AS-F2DA/AS-F422/AS-F485 

37 23.9
59

.3
60

.8

1 5

  
Unit: mm 

Pin no. AS-F2AD AS-F2DA AS-F422 AS-F485 

1 V1+ VO1 R+ - 
2 I1+ IO1 R- - 
3 V2+ VO2 T+ D+ 
4 I2+ IO2 T- D- 
5 COM COM SG SG 

 AS-F232/AS-FCOPM 

AS-F232 AS-FCOPM 

37 23.9

59
.3

66
.3

1 5

6 9

 

61
.3

37

59
.3

23.9

12345678

18

 
Unit: mm 

Pin no. AS-F232 AS-FCOPM 

1 - CAN_H 
2 TX CAN_L 
3 RX GND 
4 - - 
5 GND - 

6-9 - - 
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 AS-FEN02 

1

88

42

61.5

25.2

2

3
4

5

6
 

Number Name Description 

1 MS indicator 

Indicates if the module has been set 
ON: the setting is complete 
Blinking: the setting is not complete 
OFF: no power 

2 NS indicator 

Indicates the status of Ethernet connection 
Green lignt ON: a CIP connection is established 
Green lignt BLINKING: a CIP connection is not established 
Red light ON: duplicated IP address 
Red light BLINKING: communication timeout / DLR conection  

 lost / IP address change 
OFF: no power / network cable is not connected 

3 RJ-45 port X1/X2 Use for network connections  

4 LINK indicator X1/X2 
Indicate the status of Ethernet connection 
Green light ON: a network connection is established 
OFF: a network connection is not established 

5 ACT indicator X1/X2 
Indicate the status of Ethernet communication 
Orange BLINKING: data transmission  
OFF: no data transmission  

6 Clip ring Secures AS series 

 
RJ-45 Pin Definition  

1 TX+ 2 TX- 3 RX+ 4 N/C 

 
5 N/C 6 RX- 7 N/C 8 N/C 
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 AS-FPFN02 

1

88

42

61.5

25.2

2

3
4

5

6
 

 
Number Name Description 

1 SF indicator 

 System Fail Indicator 
 Red light ON: an error occurs in the system 
 Example: the parameters downloaded to the Controller are different from 

the actual placement, connecting port 2, instead of connecting to port 1  
OFF: no system error 

2 BF indicator 

 Bus Fail Indicator 
 Red light ON: the connection with PROFINET Controller is OFF. 
 Red light BLINKING: the connection is working fine but the communication    
 with PROFINET Controller is NOT normal. 
 OFF: the connection with PN-Controller is working fine. 

3 RJ-45 port X1/X2 Uses for network connections  

4 LINK indicator X1/X2 
Indicates the status of Ethernet connection 
Green light ON: a network connection is established 
OFF: a network connection is not established 

5 ACT indicator X1/X2 
Indicates the status of Ethernet communication 
Orange BLINKING: data transmission  
OFF: no data transmission  

6 Clip ring Secures AS series 

 
 
RJ-45 Pin Definition 

1 TX+ 2 TX- 3 RX+ 4 N/C 

 
5 N/C 6 RX- 7 N/C 8 N/C 

 
 

2.10.3 Function Card Weights 
 

AS- 
F2AD 

AS- 
F2DA 

AS- 
F422 

AS- 
F485 

AS- 
F232 

AS- 
FCOPM 

AS- 
FEN02 

AS-
FEN02 / 

AS-
FOPC02 

Weight 30 g 30 g 22 g 29 g 26 g 29 g 51 g 51 g 
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2.11 Power Supply Module Specifications  
2.11.1 General Specifications 

 AS-PS02/AS-PS02A 

Item Specifications 

Supply voltage 
100–240 VAC (-15% to +10%) 
50/60 Hz±5% 

Action 
specifications 

If the input power supply is larger than 85 VAC, the power supply module can 
function normally. 

Allowable 
instantaneous 
power failure time 

If the instantaneous power failure time is less than ten milliseconds, the power 
supply module keeps running. 

Fuse 2.5A/250 VAC 

Inrush current ＜70A@115 VAC 

24 VDC output 
AS-PS02: 2 A for internal use: the CPU and the modules.  
AS-PS02A: 1.5 A for internal use: the CPU and the modules;  
           0.5 A for external use. 

Power protection The 24 VDC output is equipped with the short circuit protection and the 
overcurrent protection. 

Electronical 
isolation 

1,500 VAC (Primary-secondary),  
1,500 VAC (Primary-PE),  
500 VAC (Secondary-PE) 

Insulation voltage 
Above 5 MΩ  
The voltage between all inputs/outputs and the ground is 500 VAC. 

Ground The diameter of the ground should not be less than the diameters of the 
cables connected to the terminals L and N. 

Weight 
AS-PS02 270 g 
AS-PS02A 310 g 
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 AS-PS03C 

Item Specifications 

Supply voltage 
100–240 VAC (-15% to +10%) 
50/60 Hz±5% 

Action 
specifications 

If the input power supply is larger than 85 VAC, the power supply module can 
function normally. 

Allowable 
instantaneous 
power failure time 

If the instantaneous power failure time is less than ten milliseconds, the power 
supply module keeps running. 

Fuse 5 A / 250 VAC 

Inrush current ＜50A typ. @230 VAC 

24 VDC output 3 A for internal use: the CPU and the modules.  

Power protection The 24 VDC output is equipped with the short circuit protection and the 
overcurrent protection. 

Electronical 
isolation 

3,000 VAC (Primary-secondary),  
2,500 VAC (Primary-PE),  
500 VAC (Secondary-PE) 

Insulation voltage 
Above 5 MΩ  
The voltage between all inputs/outputs and the ground is 500 VAC. 

Ground The diameter of the ground should not be less than the diameters of the 
cables connected to the terminals L and N. 

Weight 310 g 
 
 

2.11.2 Power Supply Module Profiles 
 AS-PS02 

70

8898
.3

1

4

2

3

IN PUT

Wai t 5 seconds a f ter removing

L G WARNING

Ri sk o f e lect rical shock.

power before servi ci ng.

N

L

PS02

POWER

74.2
77.9

75
91.5

4
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 AS-PS02A 

70

8898
.3

1

4

2

3

74.2
77.9

75
91.5

O UTP UT

IN PU T

PS02A

POWER

LG WA RN IN G
Ris k o f e le c tr ic al s h oc k.
Wa it 5 s e co nd s a f te r r e m o vi ng
po w er b ef o re s er v icin g .

N
L

24G
+24V

O UTP UT

IN PU T

+24V
24G

Ris k o f e le c tr ic al s h oc k.

LG

L
N

WA RN IN G

POWER

PS02A

po w er b ef o re s er v icin g .

4

 
 

Number Name Description 

1 
POWER LED 
indicator (green) 

Indicates the status of the power supply 

2 Model name Model name of the power supply module 

3 
Arrangement of the 
terminals 

+24V: connecting external 24VDC + 
24G: connecting external 24G 
LG: Line ground 
L: AC power input (Line) 
N: AC power input (Neutral) 

4 Power output Connected with AS series 
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2.11.3 AS-PS03C Communication Formats and Station ID Setups 

AS-PS03C supports Modbus communication protocol. You can read the power status, working hours and so 
forth by connecting through the RS-485 port. There are three methods to set up the communication format 
and station ID. All the methods for setting up the communication formats and station IDs are involved with the 
16-way knobs on the device. See the detailed descriptions below.    

 
Setting value for the 

16-way knob 
(decimal format)*1 

Modbus Station ID Communication Format Delay Time (ms) 

00 (0) Previous saved settings Previous saved settings Previous saved settings 

01-F7 (1-247) 
1~247 

Same as the settings by 16-
way knob on the device 

Previous saved settings Previous saved settings 

F8-FD (248-253) Reserved Reserved Reserved 
FE (254) 247 ASCII/9600/8/N/1 10 
FF (255) 247 ASCII/9600/7/E/1 10 

Note: the value of the 16-way knobs is a combination of two knobs: 161 x setting value + 160 x setting value. 
For example, if the setting value in 161 is F, and the setting value in 160 is E, the value in 16-way knob is 254 = 
F x 161 + E x 160.  
 
 Use hardware to set up 

Set the 16-way knobs to FE (254) or FF (255). This way of setting is only availbe for applicaiton of one adapter 
(slave). And you can only work with the default communication format and station ID, but this is very useful 
when it is your first time to use this device.  
 
 Use software to set up  

Before using this method to set up, you need to know the current communication settings in AS-PS03C and 
make sure the communication settings of PLC CPU are the same as the settings in AS-PS03C. If you do not 
know the current communication settings in AS-PS03C, you can use the two 16-way knobs to read the 
settings and then use software to set up. Free Modbus protocol software can be found on the internet.  
Step 1: Set the 16-way knobs to 0 (0).  
Step 2: Through PLC CPU to change the setting values in Modbus (0x33~0x37 in hexadecimal format). Refer 
to the following Modbus addresses for more information.  
Step 3: Through PLC CPU to set the setting values in Modbus (0x38 in hexadecimal format) to 2 to confirm 
and save the above settings.    
Step 4: If the communication format or other communicational related settings are changed, be sure to change 
the PLC CPU settings to be the same as the settings in AS-PS03C.  
 
 Use both hardware and software to set up 

Step 1: First, use software to set up the communication format as the previous method showed. If using the 
default values, this step can be skipped.  
Step 2: Set the 16-way knobs to 01-F7 (1-247). 
After that instead of going through the communication set up, you can use the 16-way knobs to change the 
station ID directly. For an easier setup, use the default communication format (ASCII/9600/7/E/1) to complete 
the multiple connections of AS-PS03C.   
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 Modbus Addresses 

Address 

Function Data 
type Setting Value Default Unit Attr. Retainable Decimal 

format 

Hex-
decimal 
format 

40001 0x0000 Module status WORD 

 Bit0: True = OVP alarm  
     (over voltage protection) 
 Bit1: True = OCP alarm   
     (over current protection) 
 Bit2: True = OTP alarm  
     (over temperature  
     protection) 
 Bit3: True = UVP alarm (under  
      voltage protection) 
 Bit4: True = ambient  
      temperature continues to  
      exceed alarm (>30 min.) 
 Bit5~7: Reserved 
 Bit8: True = Approaching the  
      end of its life cycle  
      (suggested to change for  
      a new one) 
 Bit9: True = Approaching 50%  
      of the end of its life cycle  
 Bit10~14: Reserved 
 Bit15: True = Enter safety  
       mode (Power-off and  
       then power-on again) 

0 - R N 

40002 0x0001 Output voltage INT 0~28000 0 mV R N 
40003 0x0002 Output current INT 0~10000 0 mA R N 

40004 0x0003 
Output courrent 

(peak value) 
INT 0~10000 0 mA R N 

40005 0x0004 
Continuous 

working hours 
(Low Word) 

DINT 0~26280000 0 Min R N 

40006 0x0005 
Continuous 

working hours 
(High Word) 

40007 0x0006 
Accumulated 
working hours 
(Low Word) 

DINT 0~876000 0 Hr R Y 

40008 0x0007 
Accumulated 
working hours 
(High Word) 

40009 0x0008 
Estimated 

lifetime 
INT 0~1000 0 0.1% R Y 

40010 0x0009 
Ambient 

temperature 
INT -400~1000 0 0.1℃ R N 

40011 0x000A 
Accumulated 

times of Power-
On 

INT 0~32767 0 Times R Y 

40012~ 
40032 

0x000B~ 
0x001F 

Reserved - - - - - - 

40033 0x0020 Accumulated INT 0~32767 0 Times R Y 
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Address 

Function Data 
type Setting Value Default Unit Attr. Retainable Decimal 

format 

Hex-
decimal 
format 

times of OVP 

40034 0x0021 
Accumulated 
times of OCP 

INT 0~32767 0 
Times 

R Y 

40035 0x0022 
Accumulated 
times of OTP  INT 0~32767 0 

Times 
R Y 

40036 0x0023 
Accumulated 
times of UVP 

INT 0~32767 0 
Times 

R Y 

40037 
0x0024~ 
0x002F 

Reserved - - - - - - 

40038 0x0030 Module name WORD 0x0001：AS-PS03C - - R Y 

40039 0x0031 
Firmware – 

main version 
WORD - - - R Y 

40040 0x0032 
Firmware – 
subversion 

WORD - - - R Y 

40041 0x0033 Station ID INT 1~247 247 - R/W Y 

40042 0x0034 Modbus modes INT 
0: Modbus ASCII 
1: Modbus RTU 

0 - R/W Y 

40043 0x0035 
Transmission 

speed 
INT 

0: 1200 
1: 2400 
2: 4800 
3: 9600 

4: 19200 
5: 38400 
6: 57600 
7: 76800 
8: 115200 
9: 230400 

3 bps R/W Y 

40044 0x0036 
Communication 

format INT 

0: 7/E/1 
1: 7/E/2 
2: 7/O/1 
3: 7/O/2 
4: 7/N/1 
5: 7/N/2 
6: 8/E/1 
7: 8/E/2 
8: 8/O/1 
9: 8/O/2 
10: 8/N/1 
11: 8/N/2 

0 - R/W Y 

40045 0x0037 
Delays in 

response time 
INT 0~10000 10 ms R/W Y 

40046 0x0038 Actions to take  WORD 

 Bit0: Reset peak value of the   
      output current 
 Bit1: Apply and save the  
      current settings 
 Bit2~15: Reserved 

- - R/W N 

40047~ 0x0039~ Reserved - - - - - - 
* R indicates read-only and W write-only. 
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2.12 Power Supply Module Adapter Specification  
For easier wiring, this adaptor allows wiring on the bottom of the module instead of on the left-side of the 
module. If you already purchased AS-PS02 or AS-PS02A, you do not need this adaptor to have an easier 
wiring.  
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Before developing an AS Series system, install ISPSoft and COMMGR. ISPSoft is a software platform for integrating 

the hardware, network configuration, and program development for a system. COMMGR functions as middleware 

between a computer and devices. It functions as a communication management interface between ISPSoft and AS 

Series hardware. 

3.1 Installing and Uninstalling ISPSoft 

 System requirements 

Item System requirement 

Operating system Windows XP / 7 / 8 / 10 

CPU Pentium 1.5 G or above 

Memory 256 MB or above (512 MB or above is recommended.) 

Hard disk drive Capacity : 500 MB or above 

CD-ROM drive This is optional for installing ISPSoft. 

Monitor 
Resolution: 800×600 or above  

(suggested setting: 1024x768/96 dpi) 

Keyboard/Mouse A general keyboard/mouse or devices compatible with Windows 

Printer A printer with a driver for Windows. This is needed to print projects. 

RS-232 port For connecting to a PLC 
One of them is used, but a PLC that is 

connected must have a corresponding port. (*1) 
USB port For connecting to a PLC 

Ethernet port For connecting to a PLC 

Communication 

software 
COMMGR, a communication manager, must be installed. (*2) 

Supported Models  
AH500 series PLCs/DVP series PLCs (exclusive of DVP-PM series PLCs)/ AS series, AC 

motor drives: VFD with PLC built-in series, and Text panel HMI with PLC built-in series. 

*1. ISPSoft supports several ways to connect a computer to a PLC.  Make sure the port and the mode supported by 

the PLC are correct before you connect a computer to the PLC. 

*2. Please refer to section 3.2 for more information about COMMGR. 

*3. The functions and specifications mentioned above are only applicable to ISPSoft version 3.00 or above. The older 

versions are not equipped with complete functions. 
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3.1.1 Installing ISPSoft 

If an older version of ISPSoft has been installed on a computer, uninstall it before you install ISPSoft. Refer to section 

3.1.2 for more information about uninstalling ISPSoft. The following are the steps to install ISPSoft. 

(1) Start the Windows operating system and then install ISPSoft. You may need administrative privileges to install the 

software. 

(2) Put the ISPSoft CD in the CD-ROM drive, or download the installation program from the official Delta website 

http://www.delta.com. Before you install the installation program downloaded from the website, you must 

decompress the file. 

(3) Click Start, and then click Run… to open the Run window. Specify the path to the file called setup.exe in the 

Open box, and then click OK. You can also double-click the setup icon to execute the installation program. 

 

 

(4) When a previous version of the ISPSoft is found, click OK then Yes to uninstall that version shown in the 

pop-up windows (see below).  

 

 

http://www.delta.com/
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(5) Click Install once Shield Wizard window appears. 

 

(6) The installation program detects if your computer has installed Microsoft Visual C++ 2013 or not. If not, the 

following installation steps will show up. Click Install to install and after the installation is done, click Close.  
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(7) After the ISPSoft x.xx – Install Shield Wizard window appears, click Next. 

 
 

(8) Select I accept the terms in the license agreement and click Next. 

 

(9) Type the necessary information in the User Name and Organization boxes, and then click Next. 
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(10)  Check if the installation information is correct and then click Install.  

 
 

(11) After ISPSoft is installed, click Finish to complete the installation. 
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(12)  Next the HWCONFIG is about to be installed. If there is a previous version of HWCONFIG installed in your 

computer. The following image appears. Click Yes to replace the previous version of HWCONFIG  with a newer 

version.   

 
 

(13) Click Install, once the installation window appears.  
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(14) After HWCONFIG is installed, click Finish to complete the installation. 

 
 

(15) After installation is done, the installation program creates shortcuts on the desktop and the Start menu. Click 

Close to complete the installation. 
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3.1.2 Uninstalling ISPSoft 

(1) Generally, you can click ISPSoft Uninstall or select Programs under Control Panel to remove the ISPSoft; 

when ISPSoft Uninstall is not found, there are two methods to uninstall the software: 

 Method 1: Select ISPSoft x.xx from the Windows list, click More then select Open file location. 

 Method 2: Place %ProgramData%\Microsoft\Windows\Start Menu\Programs\Delta Industrial 

Automation\PLC\ in the address box and press Enter. Then, double click ISPSoft x.xx file.  

 

 

(2) Remove the software by double-click the ISPSoft UnInstall. 
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(3) To uninstall ISPSoft, click Yes shown in the pop-up window. The window will automatically close once the 
software is removed.    

 

 

3.2 Installing and Uninstalling COMMGR 

3.2.1 Installing COMMGR 

COMMGR is a software independent of ISPSoft. It must be installed separately. When the previous version of 

COMMGR is detected in a computer, that version is advised to be uninstalled first before the latest COMMGR can be 

installed. 

(1) Start a computer and enter the Windows operating system. You need to log on to the system as a system 

administrator before installing COMMGR. 

(2) Put a COMMGR CD in the CD-ROM drive, or download the installation program from official Delta website 

http://www.deltaww.com/. Before you install the program downloaded from the website, you must decompress 

the file. 

(3) Click Start, and then click Run… to open the Run window. Specify the path to the file called setupComm.exe in 

the Open box, and then click OK. Alternatively, you can double-click the icon which is used to install COMMGR 

to execute the installation program. 

 

http://www.deltaww.com/
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(4) When the previous version of COMMGR is installed, click OK to remove that version shown in the pop-up 

window (see below) and when uninstall is complete, click OK again.  

 

(5) Click Next after the Setup window appears. 

 

(6) Use default setup in the destination folder. Click Install to start the installation. 
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(7) After you install COMMGR, the installation program creates a shortcut to the program on the Start menu. Click 

Finish to complete the installation. 
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3.2.2 Uninstalling COMMGR 

(1) Enter the settings of Apps & features in Windows, select COMMGR x.xx and click Uninstall. 
 

 

 
(2) Click Yes and then OK to complete COMMGR uninstallation.   
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4.1 AS Series Hardware Framework 

4.1.1 AS Series Hardware Component  

The AS series programmable logic controller is a medium-to-small programmable logic control (PLC). The 

execution speed and memory capacity are increased. Use of function blocks is also supported. In order to meet 

your more advanced application requirements, the AS series programmable logic controllers provide more 

flexible system extension frameworks. Under such system frameworks, you do not need to use several CPU 

modules to control the system because there are too many I/O points or the equipment is too far away. This 

retains system completeness, and you can be more efficient in developing projects. 

The minimum framework requirement for the AS series system is one CPU module and one power supply 

module to operate the CPU module. 

Power supply module + AS series PLC (AS-PS02 + AS332T-A) 

 
The following lists the limits for setting up a common framework of the AS PLC system. Exceeding any one of 

the limits causes the PLC to send an error message.  

Limit 1: You can connect up to 32 extension modules to the PLC, not including the power module, CPU module, 

and remote module. 

Limit 2: The maximum number of digital I/O points is 1024. The built-in digital I/O points of the CPU module are 

included. 

Limit 3: You can connect up to 16 analog modules (AD, DA, XA, RTD, TC and LC) to the PLC. 

Limit 4: You can connect up to 4 communication modules (AS00SCM, AS01DNET-A, and AS04SIL-A) to the  

       PLC.  

Limit 5: You can connect up to 8 positioning modules (AS02PU-A, AS04PU-A and AS02HC-A) to the PLC. 

Limit 6: You can connect up to 15 remote modules (AS00SCM+AS-FCOPM) to the PLC. The remote modules 

can work with up to eight digital/analog modules. 



AS Ser ies  Hardware  and  Operat ion Manual  

4-4 

_4 

Limit 7: You can connect up to 15 remote modules (AS00SCM+AS-FEN02) to the PLC. The remote modules 

can work with up to eight digital/analog modules. 

Limit 8: You can connect up to 8 extension modules (digital modules, analog modules, temperature 

measurement module, etc.) to AS01DNET-A (RTU mode).  

Limit 9: You can connect remote modules to digital/analog modules (temperature measurement and load cell 

modules), but not to communication or positioning modules. 

 

4.1.1.1 Necessary Components 

A complete AS Series system consists of the following four necessary components. 

 Power supply module 

A power supply module converts alternating current to direct current or directly provides direct current. It 

provides power to the modules connected to it.  
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 CPU module 

A CPU module is the nucleus of a complete AS Series system. It is responsible for controlling and 

managing the whole system. Delta Electronics, Inc. provides businesses with several types of CPU 

modules. You can select a CPU module according to your needs.
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 Communication cable 

Several communication interfaces are included in a CPU module, and many types of network modules are 

available. You can select a suitable communication cable according to the actual situation. 

The following table lists information about communication interfaces and main applications. 

Interface Connector Application 

Communication 

port 

Five-pin removable 

terminal block 

Computer/HMI communication/Industrial control network  

(2x RS-485)  

Ethernet RJ45 
Computer/HMI communication/Remote control/Data 

exchange/Industrial control network 

USB Mini USB Computer communication 

 

4.1.1.2 Modules  

Various kinds of modules can be purchased according to your needs. Refer to section 1.1.2 for detailed 

information on the modules that can be used with your AS Series System.   

 

 Extension module 

AS Series CPU module is equipped with standard communication ports but not with other kinds of I/O 

functions. If you want to use other I/O functions, you can select suitable modules according to the actual 

situation.  
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4.2 Installation Notes 

 To ensure you have sufficient installation space for AS Series System, before installation begins, be sure to 

measure the size of your AS Series System and the size of the communication cable connectors and the 

space between devices should also be taken into account. 

 Make sure that the work environment conforms to the specifications for the products. It is necessary to 

consider the basic temperature/humidity control and dust/corrosion prevention. 

 Electromagnetic interference can result in system malfunction. Therefore, you must design the EMC 

carefully. Refer to Appendix C in this manual for more information on EMC standards. 

 If components such as screws and washers are specified in the manual, do use components conforming to 

the specifications. 

 If a cable is connected to a communication port, make sure the cable connector is properly joined to the 

port on the module. 

 For the installation of DIN Rail, use a 35 mm wide rail or use the one that complies with EN 60715.  

35mm
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4.3 Installation 

4.3.1 Installing Modules in a Control Box 

A PLC has to be installed in a closed control box. In order to ensure that the PLC radiates heat normally, the 

space between the PLC and the control box must be larger than 50 millimeters. 

 
50mm＞

 
50mm＞

50mm＞

50mm＞

 

 Keep the PLC away from high-voltage equipment, high-voltage wires, and high-voltage motors. 

 In order to prevent the PLC from overheating, please do not install the PLC vertically on the bottom or top 

of the control box. 

 Please install the PLC horizontally in the control box, as shown above. 

 If you intend to increase the number of modules, you must leave some space for installing the modules in 

the control box. 
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4.3.2 Installing a Module 

1. Press the clip rings if they are out as the image 1 shown. Push the module to the desire position until you 
hear a click to finish installation.  

2. Link the I/O modules on the right side of the PLC and make sure they are hooked together. Push the 
modules into the DIN rail until you hear a click.  

3. After you installed the module, fasten the screws on the modules to secure the module on the DIN rail. 

1

1

     

2

 

 
 

If there is a vibration source near the installation site, install anti-vibration baffles on the sides of the AS 
Series modules for better stabilization, such as the gray baffles show below. 
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 Install the baffles: 
 Hook the baffle onto the DIN rail and press it down as the directional arrow shows below.  

 

 

 Use screws to secure the baffle.  

 

 
a. The completed baffle installation is shown below. 
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4.3.3 Installing a Removable Terminal Block 

Install the removable terminal block on the module as shown below. 

 Installation 

1. Align the terminal block at the printed circuit board, and press it into the module. 

 

 

 Removal 

1. Pull the clips down in the direction shown by the arrow, and then pull the terminal block up 

as shown below. 
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4.3.4 Changing a Module 

1. Take the removable terminal block out of the module and pull the clip out from the DIN rail as the 

image shown below.  

 

 

 

 

 

 

 

2. Remove the module to be changed out.  

3. Slide the new module in as the image shows below.  

 
 

4.3.5 Installing and Removing an Extension Card 

A. AS-F232/AS-F422/AS-F485/AS-F2AD/AS-F2DA/AS-FCOPM 

 Installation 

Push the extension card into the extension card slot until you hear a click.  
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 Removal 

Press the PUSH  button to release the extension card and then take the extension card out.  

 

 
B. AS-FEN02 / AS-FPFN02 
 Installation 

Push the extension card into the extension card slot until you hear a click.  

 
 Removal 

Press the buttons on the upper and lower ends to release the extension card and then take the extension 
card out. 
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4.3.6 Installing a Wiring Module 

Put a communication cable in the port on a CPU module, and make sure the connector of the cable is properly 

joined to the port. 

 Installation 

1. One side of the wiring module has to be fixed first. 

2. Press the driver board in the direction indicated by arrow 1, and make sure the groove is   

aligned with the DIN rail.  

 

 

 Removal 

1. Push the wiring module in the direction indicated by arrow 1. 

2. Pull the wiring module in the direction indicated by arrow 2. 
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24-22AWG< 1mm 8-10mm

4.4 Wiring 

 Please pay attention to the following warnings. 

 

 

 Before installing or wiring a module, you must verify that the external power supply is turned 

off. If the power supply is not turned off, you may get an electric shock, or the product may be 

damaged. 

 After you complete installing or wiring the module, make sure that a terminal block cover is 

installed on the module before turning on the power supply or operating the module. If the 

terminal block cover is not installed properly, you may get an electric shock, or the module 

may not operate normally.  

 Be sure to connect the terminals FG and LG with protective grounding conductors. Otherwise, 

you may get an electric shock, or the module may not operate normally. 

 To ensure that a PLC is wired correctly, you must check the rated voltage of the product and 

the arrangement of the terminals. If the PLC is connected to a power supply that does not 

conform to the rated voltage, or the product is not wired correctly, a fire may occur, or the 

product may be damaged. 

 The external connections should be crimped, press-welded by specific tools, or soldered 

correctly. Improper connections may result in a short circuit, fire, or malfunction. 

 Tighten the terminal screws to the specified torque. If the terminal screws are loose, a short 

circuit, fire, or faulty operation may occur. Tightening the terminal screws too far may cause 

damage to the terminal screws or the module, resulting in a short circuit or malfunction. 

 Make sure there are no foreign substances such as iron filings or wiring debris inside the 

module. Foreign substances may result in a fire, damage, or malfunction. 

 
 I/O module wiring notes 

(1) Terminal definitions 

◆ Two-/three-wire (passive sensor): the sensor and the system share the same power circuit.   

◆ Four-wire (active sensor): the sensor uses an independent power supply and should not share the 

same power circuit with the system. 

(2) Terminals with insulation sleeves cannot be used as a terminal block. It is recommended that the 

terminals be covered with insulation tubes. 

(3) Use single-wire cables or two-wire cables with a diameter of 24 AWG to 22 AWG and with less than 

1mm pin-type terminals. Only use copper conducting wires with a temperature rating of 60/75°C. 
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(4) Keep the input cables, output cables, and power cable separate from one another.  

(5) If the main circuit and the power cable cannot be separated from each other, use a shielded cable, 

and ground it at the side of the I/O module. In some cases, the shielded cable can be grounded at the 

opposite side. 

 

(6) If you wire a module through conduit, you must ground the conduit correctly. 

(7) Keep 24 VDC input cables separate from 110 VAC input cables and 220 VDC input cables. 

(8) If the wiring length is more than 200 meters (656.19 feet), leakage current can result from parasitic 

capacitance, and the system will not function properly. 

 Power cable wiring notes 

(1) Use 110 V/220 V power cable and the 24 VDC power cable with a diameter of 22-18AWG and with 

less than 2 mm pin-type terminals. Be sure to twist the power cables at the terminal screws. To 

prevent a short circuit from loose screws, you must use solderless terminals with insulation sleeves. 

22-18AWG< 2mm 11-12mm  

(2) If cables are connected to the terminals LG and FG, you must ground the cables. Do not connect LG 

and FG to any devices. If LG and FG are not grounded, the PLC will be susceptible to noise. Since 

LG carries electric potential, you will get an electric shock if you touch the metal parts. 

 
 
 
 
 
 
 
 
 

Shielded cable 

AC power  
supply 

Load through which the 
alternating current passes 
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4.5 Connecting Power Cables 

4.5.1 Precautions 

 Connecting AC power cables 

(1) The cables carrying the 110 VAC, 220 VAC, and 24 VDC should be single or two-wire cables. 

(2) Do not bundle 110 VAC cable, 220 VAC cable, 24 VDC cable, the (high-voltage high-current) main 

circuit, and the I/O signal cable together. The distance between adjacent cables should be more than 

100 millimeters (3.94 inches). 

(3) To prevent electrical surge from lightning, install a surge protector as shown below. 

AC power supply
100-240V

AS Series 
Power Module

 

Surge absorber

 

Points for attention: 

1. Ground the surge protector and the PLC system. 

2. Select the surge protector with a working voltage that is not less than the maximum allowable input 

voltage. 

 

4.5.2 Ground 

 The diameter of the ground should not be less 
than the diameters of the cables connected to the 
terminals L and N. 

 If using multiple pieces of equipment, use a 
single-point ground. 

 AS Series 
Power Module

Another piece of 
equipment

The single-point ground is better.  
 If you cannot use a single-point ground, use a 

common-point ground. 
AS Series 

Power Module

The common-point ground is permitted.

Another piece of 
equipment

 
 Do not connect equipment ground wires together 

as shown on the right. 
AS Series 

Power Module

The equipment can not be grounded in this way.

Another piece of 
equipment

 
 



Chapter  4  Ins ta l l ing Hardware and W ir ing 

4-17 

4_  

4.5.3 Wiring Power Supply Modules 

 Connecting an AC power cable 

AS-PS02 

LG

L
N

PS02 AS Series

Control Box

     100~240V

 

AS-PS02A 

 

+24V
24G

LG

L
N

PS02A AS Series 06XA

24V
0V

Control Box 

     100~240V

 

AS-PS03C 

 

AS PS03C- AS Series 06XA

24V
0V

Control Box

     1 00~240V

+24V
24G
L
N
LG

SG

+
+
-
-

AS ATXB-

24V 0V
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*1. The live wire and the neutral wire in the AC power cable are connected to L and N on the power 

supply module respectively. To prevent incorrect system operation, the ground in the AC power 

cable must be connected to LG on the power supply module. 

The power input is the AC input. You must pay attention to the following points when using the AS power 

modules. 

 The alternating-current input voltage is between 100 VAC–240 VAC. Connect the power supply to the 

terminals L and N. If you connect the 110 VAC or the 220 VAC power supply to the input terminals +24V 

and 24G, you will damage the PLC. 

 If a power outage lasts for less than 10 milliseconds, the PLC keeps running without being affected. If the 

power outage lasts longer, or if the voltage of the power supply decreases, the PLC stops running, and 

there is no output. When the power supply returns to normal, the PLC resumes operating. Note that there 

are latched auxiliary relays and registers in the PLC when you write the program. 

 Use single-wire cables or two-wire cables in a diameter of 22 AWG to 18 AWG and with less than 2 mm 

pin-typed terminals. Only use copper conducting wires with a temperature rating of 60/75°C. 

22-18AWG< 2mm 11-12mm  
 

 

4.5.4 Communication Port of Power Module 

 AS-PS03C Wiring 
 

Terminal resistor
(120 ohm)

SG

+

-

++

-

SG

+

-

++

-

SlaveSlaveMaster

+

-

SG (120 ohm)
Terminal resistor

 
 

There are two sets of terminals + and – on the RS485 port of AS-PC03C; instead of connecting the signal cable 

to the same terminal, connecting to the next slave can be through the terminal + and - directly. And when 

AS-PS03C acts as the last slave, the terminal + and – can be used to connect to the terminal resistor.   
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4.5.5 Power Consumption 

The following table lists the power consumption for AS Series modules. 

Classification  Model name 
Internal power 
consumption 

(mA) 

Internal power 
consumption (W) 

External power 
consumption (W) 

CPU module 

AS332P-A 150 3.6 N/A 
AS332T-A 150 3.6 N/A 

AS324MT-A 150 3.6 N/A 
AS320P-B 150 3.6 N/A 
AS320T-B 150 3.6 N/A 
AS300N-A 125 3 N/A 
AS228T-A 150 3.6 N/A 
AS228P-A 150 3.6 N/A 
AS228R-A 190 4.56 N/A 

AS218TX-A 180 4.32 N/A 
AS218PX-A 180 4.32 N/A 
AS218RX-A 200 4.8 N/A 

Digital I/O 
module 

AS08AM10N-A 20 0.5 N/A 
AS08AN01T-A 30 0.72 N/A 
AS08AN01P-A 60 1.4 N/A 
AS08AN01R-A 70 1.7 N/A 
AS16AM10N-A 20 0.5 N/A 
AS16AP11T-A 30 0.7 N/A 
AS16AP11P-A 30 0.7 N/A 
AS16AP11R-A 80 1.9 N/A 
AS16AN01T-A 60 1.4 N/A 
AS16AN01P-A 60 1.4 N/A 
AS16AN01R-A 140 3.4 N/A 
AS32AM10N-A 20 0.48 N/A 
AS32AN02T-A 30 0.72 N/A 
AS64AM10N-A 30 0.72 N/A 
AS64AN02T-A 60 1.44 N/A 

Analog I/O 
module 

AS04AD-A 50 1.2 2.16 
AS08AD-B 50 1.2 2.5 
AS08AD-C 50 1.2 2.5 
AS04DA-A 50 1.2 2.64 
AS06XA-A 50 1.2 2.16 

Temperature 
measurement 

module 

AS04RTD-A 30 0.75 2 
AS06RTD-A 30 0.75 2 
AS04TC-A 30 0.75 2 
AS08TC-A 30 0.75 2 

Load cell 
module AS02LC-A 30 0.75 3 

Positioning 
module 

AS02PU-A 62.5 1.5 N/A 
AS04PU-A 62.5 1.5 N/A 

Network 
module 

AS00SCM-A 25 0.6 N/A 
AS01DNET-A 33 0.8 N/A 

AS04SIL-A 33 0.8 0.5 

Function 
cards 

AS-F232 20 0.48 N/A 
AS-F422 30 0.72 N/A 
AS-F485 20 0.48 N/A 

AS-FCOPM 20 0.48 N/A 
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Classification  Model name 
Internal power 
consumption 

(mA) 

Internal power 
consumption (W) 

External power 
consumption (W) 

AS-F2AD 15 0.36 N/A 
AS-F2DA 50 1.2 N/A 
AS-FEN02 50 1.2 N/A 

AS-FPFN02 50 1.2 N/A 
AS-FOPC02 50 1.2 N/A 
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4.6 Wiring CPU Modules 

 When you use open collector NPN/PNP outputs to activate AS300 high speed inputs, you need to 

have the pull up/pull down resistor connected to X point and S/S. Only use 3 W / 470 ohm or 2 W / 1 

Kohm resistors. 

 When you use Push-Pull outputs to activate AS300 high speed inputs, you don’t need to use any pull 

up/pull down resistor connected to X point and S/S. 

 

Note:  

 In case open collector NPN/PNP outputs are used to activate AS300 high speed inputs, you need to 

have the pull up/pull down resistor connected to X point and S/S. 

 In case Push-Pull outputs are used to activate AS300 high speed inputs, you don’t need to use any 

pull up/pull down resistor connected to X point and S/S. 

 It is recommended to use the resistor of 3W/470ohm or 2W/1Kohm. 

 

Through the following wiring you can increase the resistance of a resistor. See the illustration below for 

reference.  

NPN PNP 

 

S/S

X

24V

0V

R

 
 

 

S/S

X

R

0V

24V
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4.6.1 Wiring AS324MT-A  

Input form 
X0.0+ to X0.3+/X0.0- to X0.3- : Differential input 

X0.4–X0.11: Direct current (sinking or sourcing) 

Input current/voltage 
X0.0+ to X0.3+/X0.0- to X0.3- : 5V DC, 5 mA  

X0.4–X0.11: 24 VDC, 5 mA 

Output form 
Y0.0+ to Y0.3+/Y0.0- to Y0.3- : Differential input  

Y0.4–Y0.11: Transistor-T (sinking) 

Output current/voltage 

Y0.0+ to Y0.3+/Y0.0- to Y0.3-: 5V DC, 20mA/output 

(+ and – as a group, e.g. Y0.0+ and Y0.0- is a group) 

Y0.4 to Y0.11: 5 to 30V DC, 0.1A/output, 0.8A/COM 

 

COM1

COM2

5

0

OUT
4

1
2
3

8

9

11
10

2

102

7

5

6

4
IN

3 11

AS324MT

0
1

8
9

40

1

BAT. LOW

ERROR

RUN

POWER

Ethernet

6
7

 

40 

2

40

1

 

39 S/S S/S 
38 37 X0.11 X0.10 
36 35 X0.9 X0.8 
34 33 X0.7 X0.6 
32 31 X0.5 X0.4 
30 29 SG0 SG0 
28 27 X0.3- X0.3+ 
26 25 X0.2- X0.2+ 
24 23 X0.1- X0.1+ 
22 21 X0.0- X0.0+ 
20 19 C0 C0 
18 17 Y0.11 Y0.10 
16 15 Y0.9 Y0.8 
14 13 Y0.7 Y0.6 
12 11 Y0.5 Y0.4 
10 9 SG1 SG1 
8 7 Y0.3- Y0.3+ 
6 5 Y0.2- Y0.2+ 
4 3 Y0.1- Y0.1+ 
2 1 Y0.0- Y0.0+ 
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S/ S

X0. 11

 X0 .10

X0 .9
X0. 8

X0 .7
 X0 .6

X0 .5

X0 .4

X0 .3+

 X0 .3-
5V

S G

4 .7 k

10k

5V

GN D

X0 .2+

 X0 .2-
5 V

SG

4. 7k

X0 .1+
 X0 .1-

5 V

SG

4. 7k

X0 .0+
 X0 .0-

5 V

SG

10 k

4. 7k

10k

C0
Y0. 11

 Y0 .10

Y0 .9
Y0.8

Y0 .7

 Y0 .6

Y0 .5
Y0 .4

5V

GN D

FP Y 0.3+
Y0. 3-

1 00k

2k

2 k

FP Y 0.2+
Y0. 2-

1 00k

2k

2 k

FP Y 0.1+

Y0. 1-
1 00k

2k

2 k

FP Y 0.0+
Y0. 0-

1 00k

2k

2 k

Y0. 0-

Y0. 0-S G1 GND

AS DA - A2

Y0. 0-SG0

Shielded cable *1

5V

GN D

5V

G N D

Diffe re ntial
Inp ut

10k

1 0k

1 0k

10k

10k

Shielded c able *1

Shielded c able *1

Shielded c able *1

Shielded c able *1

Shielded c able *1

Shielded c able *1

Shielded c able *1

 
 
 Wiring the External Terminal Module UB-10-ID16A  

Input form 
X0.0+ to X0.3+/X0.0- to X0.3-: Differential input  

X0.4–X0.11: Direct current (sinking or sourcing) 

Input current/voltage 
X0.0+ to X0.3+/X0.0- to X0.3- : 5  VDC, 5 mA  

X0.4–X0.11: 24 VDC, 5 mA 

Output form 
Y0.0+ to Y0.3+/Y0.0- to Y0.3- : Differential input 

Y0.4–Y0.11: Transistor-T (sinking) 

Output current/voltage 
Y0.0+ to Y0.3+/Y0.0- Y0.3-: 5  VDC, 20 mA 

Y0.4–Y0.11: 5 to 30 VDC, 0.1 A 
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TB1
TB2

 

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:

39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 
 

#1 
TB1 Y0.0+ Y0.1+ Y0.2+ Y0.3+ SG1 Y0.4 Y0.6 Y0.8 Y0.10 C0 

TB2 Y0.0- Y0.1- Y0.2- Y0.3- SG1 Y0.5 Y0.7 Y0.9 Y0.11 C0 

#2 
TB1 X0.0+ X0.1+ X0.2+ X0.3+ SG0 X0.4 X0.6 X0.8 X0.10 S/S 

TB2 X0.0- X0.1- X0.2- X0.3- SG0 X0.5 X0.7 X0.9 X0.11 S/S 
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4.6.2 Wiring AS332P-A  

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-P (souring) 

Output current/voltage 5 to 30 VDC, 0.1A/output, 1.6A/COM 

 

COM1

COM2

135

0

OUT
4

1

2

3

8

12

9

11

10

2

102

7

5

6

4
IN

3

15

12

13

14

11

AS332P

0

1

8

9

40

BAT. LOW

ERROR

RUN

POWER

Ethernet

6

7

14

15

 

X0.1

X0.3

X0.5

X0.7

X0.9

X0.11

X0.13

X0.15

X0.0

X0.2

X0.4

X0.6

X0.8

X0.10

X0.12

X0.14

S/SS/S

Y0.0Y0.1
Y0.2

Y0.4

Y0.6

Y0.8

Y0.10

Y0.12

Y0.14

Y0.3

Y0.5

Y0.7

Y0.9

Y0.11

Y0.13

Y0.15

C0 C0

OUT  
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 Wiring the External Terminal Module UB-10-ID16A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC. 5 mA 

Output form Transistor-P (souring) 

Output 
current/voltage 

5 to 30 VDC. 0.1A 

TB1
TB2

 

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:

39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 - C0 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 - C0 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 

 
 Wiring the External Terminal Module UB-10-OR16B  

For cables that can only be connected to the cables of group #1, see below. 

Output form Relay 

Output voltage Less than 250 VAC, 30 VDC 

 
Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 

C0 Y0.5Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.6 C3Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 Y0.12 Y0.14 Y0.15Y0.13

GND +24V
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4.6.3 Wiring AS332T-A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-T (sinking) 

Output current/voltage 5 to 30 VDC, 0.1A/output, 1.6A/COM 

POWER

BAT. LOW

RUN

ERROR

COM2

COM1

146

7 15

113
IN

3

2

1

5

4
OUT

10

11

9

13

12

4

6

5

0

7

14

13

12

8

15

2

AS332T

1

0

2

9

8

10

40

1

Ethernet

 

X0.1

X0.3

X0.5

X0.7

X0.9

X0.11

X0.13

X0.15

X0.0

X0.2

X0.4

X0.6

X0.8

X0.10

X0.12

X0.14

S/SS/S

Y0.0Y0.1
Y0.2

Y0.4

Y0.6

Y0.8

Y0.10

Y0.12

Y0.14

Y0.3

Y0.5

Y0.7

Y0.9

Y0.11

Y0.13

Y0.15

C0 C0

OUT  
 Wiring the External Terminal Module UB-10-ID16A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-T (sinking) 

Output current/voltage 5 to 30 VDC, 0.1 A 

TB1
TB2

 

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:

39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 C0 - 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 C0 - 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 
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 Wiring the External Terminal Module UB-10-OR16A  

For cables that can only be connected to the cables of group #1, see below. 

Output form Relay 

Output voltage Less than 250 VAC, 30 VDC 
Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 

 
Note: UB-10-OR16A can be used with AS Series and DVP Series. The indications on the UB-10-OR16A board 

is for DVP Series. For the definitions of terminal connections for AS Series, you can see the reference table 

below. Or refer to the enclosed sticker for AS Series.    
 

AS C0 Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.5 Y0.6 Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 C3 Y0.12 Y0.13 Y0.14 Y0.15 

DVP C0 Y0 Y1 Y2 Y3 C1 Y4 Y5 Y6 Y7 C2 Y10 Y11 Y12 Y13 C3 Y14 Y15 Y16 Y17 

 

C0 Y0.5Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.6 C3Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 Y0.12 Y0.14 Y0.15Y0.13

GND +24V
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4.6.4 Wiring AS320P-B  

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-P (souring) 

Output 
current/voltage 

5 to 30 VDC, 0.1A/output, 1.2A/COM 

X1

Y10OUT
4

5

7

6

IN

6

0

3

4

5

2

1

Ethernet

0

2

3

1

7

C0

Y0

Y2

X6

X4

Y8

Y6

Y4

10

11

9

8

AS320P

RUN

POWER

COM2

BAT. LOW

COM1

ERROR

X2

X0

Y11

X7

Y3

Y1

X5

C0

Y9

Y7

Y5

X3

 

X7

X5

X1

X3

IN

S/S

X6

X4

X2

X0

S/S

Y7

Y5

Y9

Y11

Y4

Y6

Y2

Y8

C0
C0

Y0

Y3

Y10

Y1

OUT  
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4.6.5 Wiring AS320T-B  

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-T (sinking) 

Output 
current/voltage 

5 to 30 VDC, 0.1A/output, 1.2A/COM 

 

X1

Y10OUT
4

5

7

6

IN

6

0

3

4

5

2

1

Ethernet

0

2

3

1

7

C0

Y0

Y2

X6

X4

Y8

Y6

Y4

10

11

9

8

AS320T

RUN

POWER

COM2

BAT. LOW

COM1

ERROR

X2

X0

Y11

X7

Y3

Y1

X5

C0

Y9

Y7

Y5

X3

 

X7

X5

X1

X3

IN

S/S

X6

X4

X2

X0

S/S

Y7

Y5

Y9

Y11

Y4

Y6

Y2

Y8

C0
C0

Y0

Y3

Y10

Y1

OUT  
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4.6.6 Wiring AS228P-A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-P (sourcing) (PNP) 

Output 
current/voltage 

5 to 30 VDC, 0.5A/output, 2A/COM 

 

6

5

4

C1

OUT

11

9

C2

7

RUN

146 376

10

8

12

14

0

Ethernet

5

6

7

1

4

3

2

8

9

11

10

157

OUT

●

11

13

15

●

●

8

10

9

IN

2

4

0

AS228P
COM2

COM1

80

91

12

13

11

5

4

3
IN

102

BAT. LOW

ERROR

2

1

0

3

1

5

OUT

C0

IN

POWER

 

X0.7

X0.5

X0.1

X0.11

X0.3

X0.9

IN

S/S

X0.13

X0.15

X0.10

X0.12

X0.8

X0.6

X0.4

X0.2

X0.14

X0.0
S/S

  

OUT

Y0.7

Y0.6

Y0.11

Y0.5

Y0.9

Y0.4

C1

Y0.8

Y0.10

Y0.3

Y0.2

Y0.1

Y0.0

C 0

C2
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4.6.7 Wiring AS228R-A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Relay 

Output 
current/voltage 

240VAC/24VDC, 2A/output, 8A/COM 

 

AS228R

COM1

BAT. LOW

POWER

RUN

ERROR

COM2

91

6

7

1

5

4

3

2

8

9

11

10

10

15

12

13

14

11

2

7

5

6

4

3

OUT

IN

80

10

8

14

12

2

4

0

6

9

11

13

15

3

1

5

7

ININ

5

6

7

11

C2

4

C1

OUT

3

2

1

8

10

C0

0

OUT

●

●

●

9
Ethernet

0

 

X0.7

X0.5

X0.1

X0.11

X0.3

X0.9

IN

S/S

X0.13

X0.15

X0.10

X0.12

X0.8

X0.6

X0.4

X0.2

X0.14

X0.0
S/S

 

OUT

Y0.7

Y0.6

Y0.11

Y0.5

Y0.9

Y0.4

C1

Y0.8

Y0.10

Y0.3

Y0.2

Y0.1

Y0.0

C0

C2
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4.6.8 Wiring AS228T-A  

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-T (sinking) (NPN) 

Output 
current/voltage 

5 to 30 VDC, 0.5A/output, 2A/COM 

 

ERROR

POWER

BAT. LOW

RUN

COM1

COM2

76 7 36 14

15

13

11

14

12

8

10

OUT

7 15

10

11

9

8

2

3

4

1

7

6

5

C2

●

9

11

9

10

8

●

●

IN

0 8

AS228T

0

4

2
2 10

IN
3

4

5

11

13

12

1 9

OUT

C1

4

5

6

IN

C0

OUT

5

1

3

0

1

2

Ethernet

0

 

X0.7

X0.5

X0.1

X0.11

X0.3

X0.9

IN

S/S

X0.13

X0.15

X0.10

X0.12

X0.8

X0.6

X0.4

X0.2

X0.14

X0.0
S/S

 

OUT

Y0.7

Y0.6

Y0.11

Y0.5

Y0.9

Y0.4

C1

Y0.8

Y0.10

Y0.3

Y0.2

Y0.1

Y0.0

C 0

C2
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4.6.9 Wiring AS218PX-A / AS218RX-A / AS218TX-A 

4.6.9.1 Wiring AS218PX-A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-P (sourcing) (PNP) 

Output 
current/voltage 

5 to 30 VDC, 0.5A/output, 1.5A/COM 

Analog input*1 12bits, -10V-10V (voltage), -20mA-20mA (current) 

Analog output*1 12bits, -10V-10V(voltage), 0- 20mA (current) 

*1. Refer to section 4.6.9.4 for more details on wiring analog input and output.   

 

0

1

2

C0

C1

3

4

OUT

5

OUT

5

4

3
7

AS218PX I N

Ethernet

6

1

2

7

1

5

4

3
IN

2

0

0

0

1

2

3

4

5

6

●

BAT. LOW

POWER

ERROR

COM2

COM1

RUN

DIOAIO

V2+

VI2-

I2+

V1+

VI1-

I1+

●

●

●

VO1

IO1

AG

VO2

●

●

AG

IO2

 

IN
S/S

X0.6

X0.0

X0.5

X0.4

X0.3

X0 .2

X0.1

OUT

Y0.2

Y0.1

Y0.0

C0

Y0.5

Y0.4

Y0.3

C1

X0.7
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4.6.9.2 Wiring AS218RX-A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Relay 

Output 
current/voltage 

240 VAC / 24 VDC, 2A/output, 6A/COM 

Analog input*1 12 bits, -10V-10V (voltage), -20mA-20mA (current) 

Analog output*1 12 bits, -10V-10V(voltage), 0- 20mA (current) 

*1. Refer to section 4.6.9.4 for more details on wiring analog input and output.   

 

ERROR

POWER

BAT. LOW

RUN

COM1

COM2

36

4

OUT

7

2

3

4

1

5

C1

●

IN

0

AS218RX

0

2

1
2

IN
3

4

5

1

OUT

C0

0

1

2

7

6

5

5

4

3

VO1

AG

IO1

I1+

VI1-

V1+

VO2

I O2

I 2+

VI2-

V2+

0

Ethernet

DIOAIO

AG

●

●

●

●

●

 

IN
S/S

X0.6

X0.0

X0.5

X0.4

X0.3

X0 .2

X0.1

OUT

Y0.2

Y0.1

Y0.0

C0

Y0.5

Y0.4

Y0.3

C1

X0.7
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4.6.9.3 Wiring AS218TX-A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Output form Transistor-T (sinking) (NPN) 

Output 
current/voltage 

5 to 30 VDC, 0.5A/output, 1.5A/COM 

Analog input*1 12 bits, -10V-10V (voltage), -20mA-20mA (current) 

Analog output*1 12 bits, -10V-10V(voltage), 0- 20mA (current) 

*1. Refer to section 4.6.9.4 for more details on wiring analog input and output.   

ERROR

POWER

BAT. LOW

RUN

COM1

COM2

OUT
3

4

5

57

I NAS218TX OUT

0

0

7

2

1

6

2

IN
3

4

5

1

4

3

C1

C0

●

2

1

0

6

5

4

3

2

1

0

Ethernet

DIOAIO

V2+

VI2-

I2+

V1+

VI1-

I1+

●

●

●

VO1

IO1

AG

VO2

●

●

AG

IO2

 

IN
S/S

X0.6

X0.0

X0.5

X0.4

X0.3

X0 .2

X0.1

OUT

Y0.2

Y0.1

Y0.0

C0

Y0.5

Y0.4

Y0.3

C1

X0.7
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4.6.9.4 Wiring Details on AS218PX-A/AS218RX-A/AS218TX-A  

1M

AG

1 M

1M

AG

1 M

25 0

2 50

VO2
I O2
 AG

Current output
0mA~20 mA

AG

VO1

IO1
 AG

Vol tage o utput
-10V ~+10V

*5

AG

1M

AG

1 M

2 50

Shi elded cabl e *1
4-wi re: vol tage i nput

-1 0V~+10 V
V1+

I 1+

 VI 1-

CHX-I

2-wire: current i nput

V2 +

I 2+

 VI2-

*3

*2

+
-

Shi elded cabl e *1
4-wi re: curr ent i nput

-2 0mA~+2 0mA
V2 +
I 2+

 VI2 -

*2+

-

+

-

+24 V

0V

+2 4V

0V

4m A~+20m A
+2 4V

0V

V1+
I1 +

VI 1-

1M

AG

1M

250

3-wire: voltage i nput

1M

AG

1M

25 0

-20 mA~+20 mA

+24V +

-

V2 +

I2+

 VI 2-

*2

-10V~+1 0V

+24V +

-0V

0 V

* 6

CHX-I
* 6

CHX-I
*6

CHX-I
* 6

CHX-I
* 6

CHX-O
*6

CHX-O
*6

Shi elded cabl e *1

Shi elded cabl e *1

Shi elded cabl e *1
2-wire: current i nput

Shi elded cabl e *4

Shi elded cabl e *4

AC motor dri ve,
recorder,
proport ioning valve

AC motor dri ve,
recorder,
proport ioning valve  
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4.6.10 Wiring  

AS300/AS200 Series AS300 Series AS200 Series 

CO M 1

CO M 2

O UT

IN

BAT. LO W

ER RO R

RU N

PO WE R

E thernet

USB
SD card

Ethernet

USB
SD card

 

RS-485

 

RS-485

CAN
 

 USB port 

Pin Function 

 

1 VBUS (4.4–5.25 V) 

2 D− 

3 D+ 

4 Ground 

5 Ground 

 Refer to Appendix A : Installing a USB Driver, if it is the first time for AS Series to use USB port to 
communicate.     

 Time to use USB port: uploading/downloading PLC programs, monitoring during calibration and 
upgrading firmware.  

 NOT suggested to use USB port: applications that require a long and un-interruptible 
communication.  

 What to do when a communication failure occurs: unplug any communication connector from the 
USB port and then plug the connector back. After that reconnect and try communication again.   

 
 Ethernet port 

Pin Signal Description 

 

1 TX+ Transmitting data (positive pole) 

2 TX- Transmitting data (negative pole) 

3 RX+ Receiving data (positive pole) 

4 -- N/C 

5 -- N/C 

6 RX- Receiving data (negative pole) 

7 -- N/C 

8 -- N/C 
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 RS485 

Pin Signal Description 

1
2
3
4
5

 

1 + COM1 D+ 

2 - COM1 D- 

3 SG Signal Ground 

4 + COM2 D+ 

5 - COM2 D- 

 RS485 Wiring 

D+ D- SG D+ D- SG SG D+ D-

Master Slave Slave
Terminal
resistor

(120 ohm)

Shielded
cable

Shielded
cable  

 
 CAN 

Pin Signal Description 

1
2
3
4
5

 

1 CAN+ CAN_H 

2 CAN- CAN_L 

3 GND GROUND 

4 
120Ω Terminal resistor 

5 

Note: Pin4 and Pin5 must be short-circuited to activate the built-in terminal resistor 120Ω and work as an 

impedance to reduce noise inference when signal reflections occur and ensure signal can be transmitted 

normally.  

 

 CAN Wiring 

GNDCA N+ CA N- GND GNDCAN+ CAN- CA N+ CA N-Pin5P in4P in5P in4 P in5P in4

Shielded
cable

Master SlaveSlave

 
 

1. It is recommended to use Daisy Chain for connection and be sure to use terminal resistor in the 

beginning and the end of the terminal arrangement.  

2. Pin4 and Pin5 must be short-circuited to activate the built-in terminal resistor 120Ω. 
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4.7 Wiring Digital Input/Output Modules 

This section illustrates how to wire digital input/output modules. The wiring diagrams below also illustrate how 

the power supplies are connected to S/S, and COM. If you need more information about wiring of digital 

input/output terminals, refer to Section 4.8 in this manual. 

4.7.1 Wiring AS08AM10N-A 

Input form Direct current (sinking or sourcing) 

Voltage specifications 24 VDC, 5 mA 

08AM

5

6

7

2

3
6
5
4
3

4 7

PWR

0

1 2
1
0
IN

IN

 

3

2

0

5

1

4

IN
S/S

S/S

6

7
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4.7.2 Wiring AS08AN01P-A 

Output form Transistor-P (souring) 

Voltage specifications 5 to 30 VDC, 0.5A/output, 4A/COM 

 

08AN

6
5
4
3

7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0

 

OUT

3

2

5

1

4

C0

0

6

C0

7
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4.7.3 Wiring AS08AN01R-A 

Output form Relay 

Voltage specifications 5 to 30 VDC, 2A/output, 8A/COM 

 

08AN

6
5
4
3

7

PWR

OUT
0

2
1

C0

C0

OUT

4

5

6

7

1

2

3

0

 

OUT

3

2

5

1

4

C0

0

6

C0

7
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4.7.4 Wiring AS08AN01T-A 

Output type Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.5A/output, 4A/COM 

 

08AN

3
4
5
6
7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0

 

OUT

3

2

5

1

4

C0

0

6

C0

7

 

 



AS Ser ies  Hardware  and  Operat ion Manual  

4-44 

_4 

4.7.5 Wiring AS16AM10N-A 

Input type Direct current (sinking or sourcing) 

Voltage specifications 24 VDC, 5 mA 

 

6

9
10
11

7

8

13

15
14

12

PWR

3
4
5

1
0

2

IN

16AM

12

14

6

8

10

0

4

2

IN IN

15

7

13

11

9

5

1

3

 

7

5

1

11

3

9

IN

S/S
S/S

13

15

10

12

8

6

4

2

14

0

S/S

S/S
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4.7.6 Wiring AS16AN01R-A 

Output type Relay 

Voltage specifications 240 VAC/24 VDC, 2A/output, 8A/COM 

 

6

12
13

15
14

9
10
11

7

8

OUT

3
4
5

0
1
2

PWR

16AN

OUTOUT

12

14

10

8

6

4

2

0

C0 C0

C0 C0

15

13

9

11

7

5

3

1

 

OUT

7

5

11

3

9

C0

1

13

C0

15

10

12

8

6

4

2

14

0

C0

C0
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4.7.7 Wiring AS16AN01T-A 

Output type Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.5A/output, 4A/COM 

 

6

12
13

15
14

9
10
11

7

8

C1

C0

OUT

C1

3
4
5

0
1
2

C0
PWR

16AN

6

4

2

0

8

10

12

14

7

5

3

1

15

11

13

9

OUTOUT

 

OUT

7

5

11

3

9

1

13

C0

15

10

12

8

6

4

2

14

0

C0

C1
C1
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4.7.8 Wiring AS16AN01P-A 

Output type Transistor-P (souring) 

Voltage specifications 5 to 30 VDC, 0.5A/output, 4A/COM 

 

6

12
13

15
14

10
11

9

7

8

OUT

3
4
5

1
0

2

PWR

16AN

OUTOUT

C1

C0

12

14

0

C1

10

8

2

4

6

C0

15

13

11

9

7

5

3

1

 

OUT

7

5

11

3

9

1

13

C0

15

10

12

8

6

4

2

14

0

C0

C1
C1
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4.7.9 Wiring AS16AP11R-A 

Input form Direct current (sinking or sourcing) 

Voltage specifications 24 VDC, 5 mA 

Output type Relay 

Voltage specifications 240 VAC/24 VDC, 2 A/inputs, 8 A/COM 

 

6

7

6

4

5

4
5

7
6

1
2
3

7

0
OUT

16AP

3

2

0

1

IN

3
4
5

0
1
2

PWR

OUT

C0

C0

0

4

5

6

7

1

2

3

IN

 

OUT

3

2

5

1

4

C0

0

6

C0

7

IN

S/S

5

6

4

3

2

1

7

0

S/S
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4.7.10 Wiring AS16AP11T-A 

Input form Direct current (sinking or sourcing) 

Voltage specifications 24 VDC, 5 mA 

Output type Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.5A/output, 4A/COM 

 

16AP

IN

3
4
5

1
0

2

PWR
C0

OUT

C0

6

5

4

3

1

2

0

IN

7

6

5

4

3

2

1

0

6

4
5

7
6

OUT

1
2
3

7

0

7

 

OUT

3

2

5

1

4

C0

0

6

C0

7

IN

S/S

5

6

4

3

2

1

7

0

S/S
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4.7.11 Wiring AS16AP11P-A 

Input form Direct current (sinking or sourcing) 

Voltage specifications 24 VDC, 5 mA 

Output type Transistor-P (sourcing) 

Voltage specifications 5 to 30 VDC, 0.5A/output, 4A/COM 

 

16AP

6

4
5

7
6

1
2
3

7

0
OUT

IN

3
4
5

0
1
2

PWR
C0

OUT

C0

6

7

5

4

3

1

2

0

IN

4

5

6

7

0

1

2

3

 

OUT

3

2

5

1

4

C0

0

6

C0

7

IN

S/S

5

6

4

3

2

1

7

0

S/S
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4.7.12 Wiring AS32AM10N-A 

Input form Direct current (sinking or sourcing) 

Input current 24 VDC, 5 mA 

PWR

39

2

13
14
15

11
12

10

8
9

1

3

7
6
5
4

IN

1
0

32AM
X1 LED
X0 LED

 

0.1

0.3

0.5

0.7

0.9
0.11

0.13
0.15

1.1
1.3
1.5

1.7

1.9
1.11
1.13

1.15

0.0

0.2
0.4
0.6

0.8
0.10

0.12

0.14
S/S

1.0

1.2
1.4

1.6

1.8

1.10
1.12
1.14

S/S

S/S

S/S

 

 Wiring the External Terminal Module UB-10-ID16A 

For cables that can only be connected to the cables of group #2, see below. 

Input form Direct current (sinking or sourcing) 

Voltage specifications 24 VDC, 5 mA 

TB1
TB2

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:

39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2
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#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 

 

 Wiring the External Terminal Module UB-10-ID32A 

Input form Direct current (sinking or sourcing) 

Input current/voltage 24 VDC, 5 mA 

Length

39 40 39 40

1 2 1 2

UC-ET010-24B(1M)
UC-ET020-24B(2M)
UC-ET030-24B(3M)

Length:

 

X0.0
X0.1

X0.14
X0.15

X0.2
X0.3

X0.4
X0.5

X0.6
X0.7

X0.8
X0.9

X0.10
X0.11

X0.12
X0.13

X1.0
X1.1

X1.14
X1.15

X1.2
X1.3

X1.4
X1.5

X1.6
X1.7

X1.8
X1.9

X1.10
X1.11

X1.12
X1.13

S/S
S/S

S/S
S/S

Upper row
Lower row

24 V DC, 5 mA  

 

Note: UB-10-ID32A can be used with AS Series and DVP Series. The indications on the UB-10-ID32A board is 

for DVP Series. For the definitions of terminal connections for AS Series, you can see the reference table below. 

Or refer to the enclosed sticker for AS Series. 

 

U
pper 
row

 

AS X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 X1.0 X1.2 X1.4 X1.6 X1.8 X1.10 X1.12 X1.14 S/S S/S 

DVP X0 X2 X4 X6 X10 X12 X14 X16 X20 X22 X24 X26 X30 X32 X34 X36 S/S S/S 
Low

er 
row

 
DVP X1 X3 X5 X7 X11 X13 X15 X17 X21 X23 X25 X27 X31 X33 X35 X37 S/S S/S 

AS X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 X1.1 X1.3 X1.5 X1.7 X1.9 X1.11 X1.13 X1.15 S/S S/S 
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4.7.13 Wiring AS32AN02T-A 

Output form Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.1A/output, 3.2A/COM 

PWR

39

2

13

15
14

8

10
9

121

11

4
5

3

7
6

OUT

1
0

Y1 LED
Y0 LED

32AN

 

1.0
1.2
1.4

1.6
1.8

1.10

1.12
1.14

1.1

1.3

1.5
1.7

1.9
1.11

1.13
1.15

0.00.1
0.2
0.4
0.6

0.8

0.10

0.12

0.14

0.3

0.5
0.7

0.9

0.11

0.13

0.15

C0C0

C0 C0

OUT

 
 

 Wiring the External Terminal Module UB-10-ID16A  

For cables that can only be connected to the cables of group #1, see below.  

Output form Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.1 A 

TB1
TB2

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:

39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 

 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 C0 - 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 C0 - 
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 Wiring the External Terminal Module UB-10-OR16A  

For cables that can only be connected to the cables of group #1, see below. 

Output form Relay 

Voltage specifications Less than 250 VAC, 30 VDC, 2 A 

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 

C0 Y0.5Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.6 C3Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 Y0.12 Y0.14 Y0.15Y0.13

GND +24V

 
 

Note: UB-10-OR16A can be used with AS Series and DVP Series. The indications on the UB-10-OR16A board 

is for DVP Series. For the definitions of terminal connections for AS Series, you can see the reference table 

below. Or refer to the enclosed sticker for AS Series. 
 

AS C0 Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.5 Y0.6 Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 C3 Y0.12 Y0.13 Y0.14 Y0.15 

DVP C0 Y0 Y1 Y2 Y3 C1 Y4 Y5 Y6 Y7 C2 Y10 Y11 Y12 Y13 C3 Y14 Y15 Y16 Y17 

 

 Wiring the External Terminal Module UB-10-OT32A 

Output form Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.1 A 

Length

39 40 39 40

1 2 1 2

UC-ET010-24B(1M)
UC-ET020-24B(2M)
UC-ET030-24B(3M)

Length:

 

Y0.0
Y0.1

Y0.14
Y0.15

Y0.2
Y0.3

Y0.4
Y0.5

Y0. 6
Y0. 7

Y0.8
Y0.9

Y0.10
Y0.11

Y0. 12
Y0. 13

Y1.0
Y1.1

Y1.14
Y1.15

Y1.2
Y1.3

Y1.4
Y1.5

Y1 .6
Y1 .7

Y1.8
Y1.9

Y1.10
Y1.11

Y1.12
Y1.13 C0

Upper 
row

C0Lower
row
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Note: UB-10-OT32A can be used with AS Series and DVP Series. The indications on the UB-10-OT32A board 

is for DVP Series. For the definitions of terminal connections for AS Series, you can see the reference table 

below. Or refer to the enclosed sticker for AS Series. 

U
pper 
row

 

AS Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 Y1.0 Y1.2 Y1.4 Y1.6 Y1.8 Y1.10 Y1.12 Y1.14   

DVP Y0 Y2 Y4 Y6 Y10 Y12 Y14 Y16 Y20 Y22 Y24 Y26 Y30 Y32 Y34 Y36   

Low
er 

row
 

DVP Y1 Y3 Y5 Y7 Y11 Y13 Y15 Y17 Y21 Y23 Y25 Y27 Y31 Y33 Y35 Y37 C0 C0 

AS Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 Y1.1 Y1.3 Y1.5 Y1.7 Y1.9 Y1.11 Y1.13 Y1.15 C0 C0 
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4.7.14 Wiring AS64AM10N-A 

Input type Direct current (sinking or sourcing) 

Voltage specifications 24 VDC, 5 mA 

2

X0

64AM

40

X1

10

0

9
8

4
5
6
7

3

15
14

2

10

12
11

13
40

X3

2

PWR

IN
0
1

X2

0 1

1

 

1.15 1.14
1.13

1.11

1.9

1.7

1.5

1.3

1.1

1.12

1.10

1.8

1.6

1.4

1.2

1.0

2.0 2.1
2.2

2.4

2.6

2.8

2.10

2.12

2.14

3.0

3.2

3.4

3.6

3.8

3.10

3.12

3.14

2.3

2.5

2.7

2.9

2.11

2.13

2.15

3.1

3.3

3.5

3.7

3.9

3.11

3.13

3.15

0.15

0.13

0.11

0.9

0.7

0.5

0.3

0.1

0.14
0.12

0.10

0.8

0.6

0.4

0.2

0.0

S/S

S/S

S/S

S/S

S/S S/S

S/SS/S

 
 Wiring the External Terminal Module UB-10-ID16A 

For cables that can only be connected to the cables of group #2, see below. 

Input form Direct current (sinking or sourcing) 

Voltage specifications 24 VDC, 5 mA 

TB1
TB2

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:

39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 
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 Wiring the External Terminal Module UB-10-ID32A 

For cables that can only be connected to the cables of group #2, see below. 

Input form Direct current (sinking or sourcing) 

Voltage specifications 24VDC, 5mA 

Length

39 40 39 40

1 2 1 2

UC-ET010-24B(1M)
UC-ET020-24B(2M)
UC-ET030-24B(3M)

Length:

 

X0.0
X0.1

X0.14
X0.15

X0.2
X0.3

X0.4
X0.5

X0.6
X0.7

X0.8
X0.9

X0.10
X0.11

X0.12
X0.13

X1.0
X1.1

X1.14
X1.15

X1.2
X1.3

X1.4
X1.5

X1.6
X1.7

X1.8
X1.9

X1.10
X1.11

X1.12
X1.13

S/S
S/S

S/S
S/S

Upper row
Lower row

24 V DC, 5 mA  

 

Note: UB-10-ID32A can be used with AS Series and DVP Series. The indications on the UB-10-ID32A board is 

for DVP Series. For the definitions of terminal connections for AS Series, you can see the reference table below. 

Or refer to the enclosed sticker for AS Series. 

U
pper 
row

 

AS X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 X1.0 X1.2 X1.4 X1.6 X1.8 X1.10 X1.12 X1.14 S/S S/S 

DVP X0 X2 X4 X6 X10 X12 X14 X16 X20 X22 X24 X26 X30 X32 X34 X36 S/S S/S 
Low

er 
row

 
DVP X1 X3 X5 X7 X11 X13 X15 X17 X21 X23 X25 X27 X31 X33 X35 X37 S/S S/S 

AS X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 X1.1 X1.3 X1.5 X1.7 X1.9 X1.11 X1.13 X1.15 S/S S/S 
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4.7.15 Wiring AS64AN02T-A 

Output type Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.1A/output, 3.2A/COM 

2

Y0

40

3

7
6
5
4

13

11
12

10

8
9

Y3

14
15

2

64AN

40

Y1

0 1

2

1
0

Y2

PWR

OUT

10

10

1.0
1.2
1.4

1.6
1.8

1.10

1.12
1.14

1.1

1.3

1.5
1.7

1.9
1.11

1.13
1.15

0.00.1
0.2
0.4
0.6

0.8

0.10

0.12

0.14

0.3

0.5
0.7

0.9

0.11

0.13

0.15

C0C0

C0 C0

OUT

C1 C1

3.0

3.2

3.4

3.6

3.8

3.10

3.12

3.14

3.1

3.3

3.5

3.7

3.9

3.11

3.13

3.15

2.0 2.1

2.2

2.4

2.6

2.8

2.10

2.12

2.14

2.3

2.5

2.7

2.9

2.11
2.13

2.15

C1 C1

 
 Wiring the External Terminal Module UB-10-ID16A 

For cables that can only be connected to the cables of group #1, see below. 

Output type Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.1 A 

TB1
TB2

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:

39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 
 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 C0 - 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 C0 - 
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 Wiring the External Terminal Module UB-10-OR16A 

For cables that can only be connected to the cables of group #1, see below. 

Output form Relay 

Voltage specifications Less than 250 VAC, 30 VDC, 2 A 

Length

UC-ET010-24D(1M)(28AWG)
UC-ET020-24D(2M)
UC-ET030-24D(3M)

(28AWG)
(28AWG)

Length:39 40

1 2
500+10mm-

19 20

1 2

19 20

1 2

#1

#2

 

C0 Y0.5Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.6 C3Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 Y0.12 Y0.14 Y0.15Y0.13

GND +24V

 
 

Note: UB-10-OR16A can be used with AS Series and DVP Series. The indications on the UB-10-OR16A board 

is for DVP Series. For the definitions of terminal connections for AS Series, you can see the reference table 

below. Or refer to the enclosed sticker for AS Series. 
 

AS C0 Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.5 Y0.6 Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 C3 Y0.12 Y0.13 Y0.14 Y0.15 

DVP C0 Y0 Y1 Y2 Y3 C1 Y4 Y5 Y6 Y7 C2 Y10 Y11 Y12 Y13 C3 Y14 Y15 Y16 Y17 
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 Wiring the External Terminal Module UB-10-OT32A 

Output type Transistor-T (sinking) 

Voltage specifications 5 to 30 VDC, 0.1 A 

 

Length

39 40 39 40

1 2 1 2

UC-ET010-24B(1M)
UC-ET020-24B(2M)
UC-ET030-24B(3M)

Length:

 

 

Y0.0
Y0.1

Y0.14
Y0.15

Y0.2
Y0.3

Y0.4
Y0.5

Y0. 6
Y0. 7

Y0.8
Y0.9

Y0.10
Y0.11

Y0. 12
Y0. 13

Y1.0
Y1.1

Y1.14
Y1.15

Y1.2
Y1.3

Y1.4
Y1.5

Y1 .6
Y1 .7

Y1.8
Y1.9

Y1.10
Y1.11

Y1.12
Y1.13 C0

Upper 
row

C0Lower
row

 

Note: UB-10-OT32A can be used with AS Series and DVP Series. The indications on the UB-10-OT32A board 
is for DVP Series. For the definitions of terminal connections for AS Series, you can see the reference table 
below. Or refer to the enclosed sticker for AS Series. 

U
pper 
row

 

AS Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 Y1.0 Y1.2 Y1.4 Y1.6 Y1.8 Y1.10 Y1.12 Y1.14   

DVP Y0 Y2 Y4 Y6 Y10 Y12 Y14 Y16 Y20 Y22 Y24 Y26 Y30 Y32 Y34 Y36   

Low
er 

row
 

DVP Y1 Y3 Y5 Y7 Y11 Y13 Y15 Y17 Y21 Y23 Y25 Y27 Y31 Y33 Y35 Y37 C0 C0 

AS Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 Y1.1 Y1.3 Y1.5 Y1.7 Y1.9 Y1.11 Y1.13 Y1.15 C0 C0 
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4.8 Wiring Digital Input/Output Terminals  

4.8.1 Wiring Digital Input Terminals 

4.8.1.1 Sinking and Sourcing 

The input signal is the 24 VDC power input. Sinking and sourcing are the current driving capabilities of a circuit. 
They are defined as follows. 

 Sinking  Sourcing 

Sinking=The current flows into the common 

terminal S/S. 

 

Souring=The current flows from the common 

terminal S/S. 

 

 
4.8.1.2 Relay Type 

 Sinking 

Internal 
circuit

S/S

 X0.0

I/O

Internal circuit

24VDC
 

 

  

 Sourcing 

Internal circuit

Internal 
circuit

S/S

 X0.0

I/O

24VDC
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4.8.1.3 Open-collector Input Type 

 Sinking  

(NPN transistor whose collector is open) 

S/S

 X0.0
I/O

24VDC

NPN

Internal circuit

Internal 
circuit

 
 

 Sourcing 

(PNP transistor whose collector is open) 

S/S

 X0.0
I/O

+Vcc

0V

24VDCPNP

Internal circuit

Internal 
circuit

 
 

 

4.8.1.4 Two-wire Proximity Switch 

Use the two-wire proximity switch whose leakage current IL is less than 1.5 mA when the switch is OFF. If the 

leakage current is larger than 1.5 mA, connect the divider resistance Rb using the formula below. 

5.1
6
−

≤
IL

Rb  (k Ω) 

 

 Sinking 

S/S

 X0.0
I/O

Rb

IL

24VDC

Two-wire proximity switch

Internal 
circuit
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 Sourcing 

S/S

 X0.0
I/O

Rb

IL

24VDC

Internal 
circuit

Two-wire proximity switch
 

4.8.1.5 Three-wire Switch 

 Sinking 

Three-w
ire sw

itch

S/S

 X0.0
I/O

24VDC

Internal 
circuit

 

 Sourcing 

S/S

 X0.0
I/O

24VDC

Internal 
circuit

Three-w
ire sw

itch  
 

4.8.1.6 Optoelectronic Switch 

 Sinking 

Above 
15 V DC

Optoelectronic switch

Internal 
circuit

S/S

 X0.0

I/O

24VDC
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 Sourcing  

Above 
15 V DC

Optoelectronic switch

Internal 
circuit

S/S

 X0.0

I/O

24VDC

 

4.8.1.7 Differential Input  

X0.3+

 X0 .3-
5V

SG

4.7k

10k

5V

GND

Shielded cable *1 10k

SG0
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4.8.2 Wiring Digital Output Terminals 

4.8.2.1 Output Circuits 

There are three types of output units. They are relay outputs, transistor outputs, and differential outputs. 

1. Relay output 

 

250VAC
2A

I/O Rel ay
Y0.0

C0

 

 

 
I/O Rel ay

Y0.0

C0
30VDC
2A

 

2. Transistor output 

 

5~3 0VDC 
0.5A

C0

Y0.0
+

I /O( )S ink 

 

 
Y0.0

C0

+ 5~3 0VDC
0.5A

I /O (Sou rce )

 

 
 
3. Differential output 

 
 

 

 
 

 

FP Y0 .3+

Y0. 3-
100k

2k

ASDA-A2
Shielded c able *1

HSI GN 4 6

/ HS IGN 4 0

2k

FP Y 0. 0+

Y0 .0 -

ASDA-A2
Shielded c able *1

SIGN 36
/SIGN 37
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4.8.2.2 Relay Output Circuit 

Relay terminals have no polarity. They can be used with alternating current that passes through a load, or with 

direct current that passes through a load. The maximum current that can pass through every relay terminal is 2 

A, and refer to each product specification for the maximum current that can pass through every common 

terminal. Life cycle curve: The lifetime of a relay terminal varies with the working voltage, the load type (the 

power factor cosψ, the time constant t(L/R)), and the current passing through the terminal. The relation is 

shown in the life cycle curve below. 

Contact Current(A)

20

0.50.1 0.2

30
50

0.3 0.7 1 2

200
300

500

100

1000
2000

3000

O
pe

ra
tio

n(
X

10
)3

120VAC Resistive
30VDC Inductive(t=7ms)

240VAC Inductive(cos 0.4)ψ=
120VAC Inductive(cos =0.4)ψ

30VDC 
Inductive
    (t=40ms)

 

 

 Relay output circuit 

 

① Direct-current power supply 

② Emergency stop using an external switch. 

③ Fuse: to protect the output circuit, a fuse having a breaking capacity between 5 A to 10 A is connected 
to the common terminal.  

④ Alternating-current power supply 
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⑤ 

A relay or a solenoid valve is used as a DC load. A diode is connected in parallel to absorb the surge 
voltage that occurs when the load is OFF. 

V D C pow er supply

 

⑥ 

An electromagnetic contactor is used as an AC load. A resistor and a capacitor are connected in 
parallel to absorb the surge voltage that occurs when the load is OFF. 

Electromagnetic contac tor

Y0.7

 

⑦ 

A bulb (incandescent lamp) is used as a DC load. A thermistor is connected in series to absorb the 
surge current that occurs when the load is ON. 

V DC power supply

 
A bulb (neon lamp) is used as an AC load. A thermistor is connected in series to absorb the surge 
current that occurs when the load is ON. 

 

○8  
Mutually exclusive output: For example, Y0.3 controls the clockwise rotation of the motor, and Y0.4 
controls the counterclockwise rotation of the motor. This interlock circuit and the program in the PLC 
ensure that there are protective measures if an abnormal condition occurs. 
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4.8.2.3 Transistor Output Circuit (NPN) 

 

 

ZD D

[ Figur e 2 ] 

C

Y

VDC
+

High powe r-
Fre quentl y ON OF F/

ZD: 9V Zen er, 5W
D: 1N4001 d io de

 

 

① Direct-current power supply 

② Emergency stop 

③ Fuse 

④ 

The output terminals of a transistor module are open-collector output terminals. If Y0.0/Y0.1 is a pulse 
train output terminal of a transistor module, the output current passing through its output pull-up resistor 
must be greater than 0.1 A to ensure that the transistor module operates normally. 
1. A diode is connected in parallel to absorb the surge voltage: used in low-power situations (refer to 

Figure 1). 
2. A diode and Zener are connected in parallel to absorb the surge voltage: used in high-power and 

power-on/off frequently situations (refer to Figure 2). 

⑤ A bulb (incandescent lamp) is used as a DC load. A thermistor is connected in series to absorb the 
surge current which occurs when the load is ON.  

⑥ 
Mutually exclusive output: For example, Y0.2 controls the clockwise rotation of the motor, and Y0.3 
controls the counterclockwise rotation of the motor. This interlock circuit and the program in the PLC 
ensure that there are protective measures if an abnormal condition occurs. 

⑦ Connected to a NTC thermistor (negative temperature coefficient), when a bulb (incandescent lamp) is 
used as a DC load and a thermistor is connected in series to absorb the surge current. 

 
 
 

VDC
+

D

[ Figure 1 ] 

C

Y

Low power-

D : 1N4001 di ode
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4.9 Wiring Analog Input/Output Modules 

Definitions of the terminals 

◆ Two/three-wire (passive sensor): the sensor and the system share the same power circuit.   

◆ Four-wire (active sensor): the sensor uses an independent power supply and should not share the 

same power circuit with the system. 

◆ Note: use cables with the same length (less than 200 m) and use terminal resistors of less than 100 

ohm. 

4.9.1 Wiring AS04AD-A 

Shielded cable *1-10 V~+10 V
V I+

I1 +

 VI 1-

CHX

V 3+

I3 +

 V I3 -

*3

* 2

CH1

1 M

CH3

AG

1M

1M

A G

1 M

2 5 0

25 0

0 V

 24 V
24 VDC

DC/DC

Con ve rt e r

+15 V

-15 V
A G

 FE
*4

*5

+

-

-20 mA ~+2 0 mA
V 2+

I2 +

 V I2 -

* 2 CH2

1M

A G

1 M

25 0

*4

 FE

+

-

+

-

+24 V

0 V

V4 +

I 4+

V I4 -

CH4

1M

A G

1 M

25 0

+2 4V

0V

4 mA ~+2 0m A

CH1

1M

A G

1M

25 0

-2 0m A~+20 m A

+24 V +

-

V 1+

I1 +

 V I1 -

*2

-1 0 V~+10 V

+2 4V +

-

* 4

 FE

*4
 FE

*4
 FE

0 V

+2 4V

0 V

0V

*6

CHX
*6

CHX
* 6

CHX
*6

CHX
* 6

Shielded c able *1

Shielded c able *1

Shielded c able *1

Shielded c able *1

4-wir e: vol tage input

4-wir e: c urr ent input

2-wire: cu rrent input

3-wire: vo ltage inpu t

2-wire: cu rrent input

3-wire: cur rent inpu t

 

*1. Use shielded cables to isolate the analog input signal cable from other power cables. 

*2. If the module is connected to a current signal, the terminals Vn and In+ (n=1–4) must be short-circuited. 
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*3. If noise in the input voltage results in noise interference in the wiring, connect the module to a capacitor with 

a capacitance between 0.1–0.47 μF with a working voltage of 25 V. 

*4. Connect FE of the shielded cable to ground.  

*5. Connect the terminal  to ground. 

*6. Every channel can work with the wiring shown above.  

 

4.9.2 Wiring AS08AD-B 

-10 V~+10 V

V 1+

 V1 -

CHX

*2

1 M

A G

1 M

0V

 2 4V
2 4 VDC

DC/ DC
Con ve rte r

+1 5V

-1 5V
AG

 FE
*3

* 4

+

-
+2 4V

0V

-10 V~+10 V

+2 4V +

-

* 3
 FE

0V

*5

V 2+

 V2 -

CHX 1 M

AG

1M

*5
Shielded c able *1

Shielded c able *1
4-wir e: vol tage in put

3-wire: vo lt age input

 
 
*1. Use shielded cables to isolate the analog input signal cable from other power cables. 

*2. If noise in the input voltage results in noise interference in the wiring, connect the module to a capacitor with 

a capacitance between 0.1–0.47 μF with a working voltage of 25 V. 

*3. Connect FE of the shielded cable to ground.  

*4. Connect the terminal  to ground. 

*5. Every channel can work with the wiring shown above.  
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4.9.3 Wiring AS08AD-C 

I2 +

 I2 -

2 50

0V

 2 4V
2 4 VDC

DC/ DC
Co n vert er

+1 5V

-1 5V
AG

*3

-2 0m A~+2 0m A

I1 +

 I1 -

1 M

AG

1 M

* 2

 FE

+

-

+

-

+2 4V

0V

4m A~+20 m A

-20 mA ~+2 0 mA

+2 4 V +

-
I 3+

 I3 -
* 2

 FE

* 2
 FE

+24 V

0 V

0 V

CHX
* 4

CHX
* 4

CHX
*4

2 50

2 5 0

1 M

AG

1 M2 5 0

25 0

1 M

A G

1M25 0

Shielded c able *1

Shielded c able *1

Shielded c able *1
4-wire: cur rent in put

2-wir e: c urr en t input

3-wire: cu rrent input

 

 
*1. Use shielded cables to isolate the analog input signal cable from other power cables. 

*2. Connect FE of the shielded cable to ground.  

*3. Connect the terminal  to ground. 

*4. Every channel can work with the wiring shown above.  
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4.9.4 Wiring AS04DA-A 

Con ve rte r

VO4
IO4
 AG

CHX0mA~20mA CH4

AG

VO1
IO1

 AG

CHX
-10V~+10V

*2
CH1

AG

24VDC
DC/DC

+15V

-15V
AG

 SLD

 SLD

 FE
*3

0V

 24V

*4

*4

AC m otor drive, 
recorder, 
proport ioning valve

AC motor drive,
recorder,
proporti oni ng val ve

Shielded cable*1

Shielded cable*1

Voltage output

Current output

 
 

*1. Use shielded cables to isolate the analog input signal cable from other power cables. 

*2. If noise in the input voltage results in noise interference in the wiring, connect the module to a capacitor with 

a capacitance between 0.1–0.47 μF with a working voltage of 25 V. 

*3. Connect the SLD to FE. Connect FE and the terminal  to ground. 

*4. Every channel can work with the wiring shown above.  
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4.9.5 Wiring AS06XA-A 

Shielded c able *1
4-wire: vol tage input

4-wire: c urr en t input

3-wire: vo ltage inpu t

3-wire: cur rent inpu t

Con ve rte r

CH1

1 M

CH2

AG

1M

1M

AG

1M

2 50

250

VO2
IO2

 AG

0mA~20 mA CH6

AG

VO1
IO1

 AG

-10V ~+10V

*5
CH5

AG

2 4VDC
DC/DC

+15V

-15 V
A G

*7

*6

*6

 FE

 FE

CH3

1M

AG

1M

250

-1 0V~+10 V
V1 +

I1+

 VI1 -

CHX-I

V 3+

I 3+

 VI 3-

*3

*2

+
-

-2 0mA~+2 0mA
V 2+
I 2+

 VI 2-

*2+

-

+

-

+24V

0V

+2 4V

0 V

4m A~+20m A

*6
 FE

+2 4V

0 V

V4+

I 4+
VI4-

CH4

1 M

A G

1M

25 0

CH1

1 M

A G

1M

25 0

-20 mA~+20 mA

+24V +

-

V 1+

I1 +

 VI1-

*2

-1 0V~+10 V

+24V +

-

*6
 FE

*6
 FE

0V

0V

 FE
*6

 FE
*6

0V

 24V

*8

CHX-I
*8

CHX-I
*8

CHX-I
*8

CHX-I
*8

CHX-O
*8

CHX -O
*8

Shielded c able *1

Shielded c able *1

Shielded c able *1

Shielded c able *1

Volt age output

Cur rent ou tpu t

Sh ielded cable *4

Sh ielded cable *4

AC motor dr ive, 
recorder, 
proport ioning valve

AC motor dr ive, 
recorder, 
proport ioning valve

2-wire: cu rrent inpu t
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*1. Use shielded cables to isolate the analog input/output signal cable from other power cables. 

*2. If the module is connected to a current signal, the terminals Vn and In+ (n=1–4) must be short-circuited. 

*3. If noise in the input voltage results in noise interference with the wiring, connect the module to a capacitor 

with a capacitance between 0.1–0.47 μF with a working voltage of 25 V. 

*4. Use shielded cables to isolate the analog output signal cable from other power cables. 

*5. If noise in the output voltage results in noise interference in the wiring, connect the module to a capacitor 

with a capacitance between 0.1 μF–0.47 μF with a working voltage of 25 V. 

*6. Connect FE of the shielded cable to ground. 

*7. Connect the terminal  to ground. 

*8. CHX-I: Every channel can work with the input wiring shown above. CHX-O: Every channel can work with the 

output wiring shown above. 
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4.10 Wiring Temperature Measurement Modules 

4.10.1 Wiring AS04RTD-A 

 
Ni100Pt100,J Pt100, 
Cu50,  C u100/
Ni1000, P t1000,  
LG-Ni1000 *3

,

A G

ADC

A G

INA

CH1

2-Wire

CH2

3-Wire

L1+
L1-

 I1-

0~300
Ni100 /Ni1000/Pt100/Pt1000
Cu50/Cu100/JPt100/LG -Ni1000

Ω , 0~3000Ω

L2+

 L2-

 I2-

Shielded cab le 1 *

Shielded cab le 1*

*2

SLD

 

 
*1. Use shielded twisted pair cables for temperature sensors, and keep them away from power cables and 

other cables that generate noise.  

*2. If you use two-wire temperature sensors, Ln- and In- must be short-circuited (where n is between 1–4). 

*3. There are two different internal excitation currents. If you are using a Ni100 temperature sensor, a 

Pt100 sensor, a JPt100, a Cu50/Cu100, or a 0~300 Ω resistance sensor, the internal excitation current 

is 1.5 mA. If you are using a Ni1000 temperature sensor, a Pt1000 temperature sensor, a LG-Ni1000 

sensor, or a 0~3000 Ω resistance sensor, the internal excitation current is 0.2 mA. 

Note: use cables with the same length (less than 200 m) and use terminal resistors of less than 200 ohm. 
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4.10.2 Wiring AS06RTD-A 

 
Ni100Pt100,J Pt100, 
Cu50,  C u100/
Ni1000, P t1000,  
LG-Ni1000 *3

,

ADC

A G

INA

CH1

2-Wire

CH2

3-Wire

L1+
L1-

0~300
Ni100 /Ni1000/Pt100/Pt1000
Cu50/Cu100/JPt100/LG -Ni1000

Ω , 0~3000Ω

L2+

 L2 -

 I12-

Shielded cable 1*

Shielded cable 1*

SLD

*2

 

 

*1. Use shielded twisted pair cables for temperature sensors and keep them away from power cables and 

other cables that generate noise.  

*2. Terminal “I12-“ indicates “ I1- & I2-“, terminal “I34-“ indicates “ I3- & I4-“, and terminal “I56-“ indicates 

“ I5- & I6-“. If you use two-wire temperature sensors, Ln- and In- must be short-circuited (where n is 

between 1–6). 

*3. There are two different internal excitation currents. If you are using a Ni100 temperature sensor, a 

Pt100 sensor, a JPt100, a Cu50/Cu100, or a 0~300 Ω resistance sensor, the internal excitation current 

is 1.0 mA. If you are using a Ni1000 temperature sensor, a Pt1000 temperature sensor, a LG-Ni1000 

sensor, or a 0~3000 Ω resistance sensor, the internal excitation current is 0.2 mA. 

Note: use cables with the same length (less than 200 m) and use terminal resistors of less than 200 ohm. 
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4.10.3 Wiring AS04TC-A / AS08TC-A 

CH 1

+
-

Shiel ded cable 1*

I 3+

 I3-

C H3

Col d con ju nct io n-
com pe nsa ti on

INA

ADC

+

-

J,K,R,S,T,E,N, B

-100m V~100mV

I1+

 I1-

 SLD

 SLD

 
*1. The cable connected to the input terminal should be the cable or the shielded twisted pair cable connected 

to a type J, K, R, S, T, E, N, B thermocouple. It should be kept separate from other power cables and cables 

that generate noise. 

 

Note1: do not wire empty terminals. 

Note2: only use copper conducting wires with a temperature rating of 60/75°C and the length must be less  

than 50 m. 

Note3: TC modules must run for 30 minutes before they start to take any temperature measurement.  
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4.11 Wiring Positioning Modules and Counter Modules 

4.11.1 Wiring AS02PU-A 
 

S S/

X0.0

X0.1

X0.2

X0.3

X0.4

+24V

Z-

A+

A-

B-

B+

Z+

Y0.0+

Y0.0-
Y0.1+
Y0.1-

Y0 .2+
Y0 .2-
Y0 .3+
Y0 .3-

MPG Shielded 
cable

Phase A

Phase B

Phase Z

Delta s er vo d rive
ASD A A2-  Series

Delta s er vo d rive
ASD A A2-  Series

/PLS
PLS

/S IGN
SIGN 36

43

41

37

36

43

41

37

/PLS
PL S

/SIGN
SIGN

 
 
Note: Refer to API1402 from Chapter 6 in AS Series Programming Manual and Delta Servo Manual for more 

details on the output modes and operations.  
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S S/

X0.0

X0.1

X0.2

X0.3

X0.4

+24V

X0.5
Y0.0
C0

Delta servo drive ASD A-A2

*3

39
1kΩ Ma x. 

2 00Kpps

Ω51
Ω51

24V

Y0.4
C1 *2

5~30VD C, 0.1A

0V

*3

*1
VDD 17

PULL_HI_P

PULS E

/PULSE

COM-

43

41

45

39

Y0.1
C0

Delta servo drive ASD A-A2

*3

39
1 kΩ Max. 

200 Kpps

Ω51
Ω51

24V

0V

*1
V DD 17

PULL_HI_S

SI GN

/S IGN

COM-

37

45

35

36

4.11.2 Wiring AS04PU-A 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*1: VDD and COM are seen as a group and its power is provided by Delta servo drive.  

*2: Load or input point.  

*3: Use a single power supply for the same COM port.  
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4.11.3 Wiring AS02HC-A 

4.11.3.1 Pulse Input 

 NPN output encoder 

 

Z-

A+

A-

B-

B+

Z+

Shield cable

NPN output encoder

Phase A 

Phase B 

External power 5V, 12V, 24VDC

COM

+24V0V

Phase Z 

OUT

OUT

OUT

AS02HC-A

 
 

 PNP output encoder 
 

Phase A 

Phase B 

5V, 12V, 24VDC

COM

+24V 0V

Phase Z 

Z-

A+

A-

B-

B+

Z+

Shield cable
OUT

OUT

OUT

AS02HC-A

NPN output enco der

External power  
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 5V differential output encoder 

Z-

A+

A-

B-

B+

Z+

5V dif ferential output encoder

Shield cable

Phase A

Phase B

Phase Z

AS02HC-A

A

A

B

B

Z

Z

 
 

4.11.3.2 SSI Input / Output Encoder 

DATA-

+5V

GND

CLK-

CLK+

DATA+

SSI encoder

Shield cable

AS02HC-A

+V

0V

DATA-

CLK-

CLK+

DATA+

 
Note: The power supply of the SSI encoder you are using may NOT be 5 VDC, check for the actual 

power supply of your SSI encoder.  
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4.11.3.3 External Output 

Y0.0

COM0

Y0.2

COM1

AS02 HC-A

*2

5~30VDC, 0.1 A

*2
5~30 VDC, 0.1A

*1

*1

 
 

*1: A load or an input point 

*2: The same COM should use power from the same supply.  
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4.12 Load Cell Modules  

4.12.1 Wiring AS02LC-A 

Converter

4-w ire

6-wi re

Co nne ct  the te rm in al
to th e groun d te rm ina l System  gr oun d

T he 3rd gro und in g
(g roun d resis ta nce of  

le ss tha n 100 Ω)  
 
 Multiple load cells connected to one load cell module: 

Load Cell 

CH1

CH2

AS02LC

Load Cell 

Load Cell 

Load Cell 

Load Cell 

Load Cell 

Load Cell 

Load Cell 
 

*1. Connect the  of the power module and the of the load cell module to the system ground terminal. 

Use the system ground as the third grounding or connect it to the control box.  

*2. When connecting multiple load cells, the total resistance of the load cells should be greater than 40 Ω. 
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4.13 Wiring Network Modules 

4.13.1 AS00SCM-A 

ERROR

CARD 2

CARD 1

POWER

SCM

FORMAT 2

ID 2

ID 1

FORMAT 1

RTUCOM.

 
 

4.13.2 Wiring AS00SCM-A 

4.13.2.1 AS00SCM-A module wiring for communication 

 COM communication mode 

AS00SCM-A module has with two function card slots, CARD1 and CARD2, supporting function cards 

AS-F232, AS-F422, and AS-F485. Refer to Section 4.14 for wiring.  

 RTU remote control mode 

The card slot CARD2 supports AS-FCOPM and both CARD1 & CARD2 support AS-FEN02 and 

AS-FPFN02. Refer to Section 4.14 for wiring.  

 

4.13.2.2 AS00SCM-A module wiring for power 

 COM: extension via serial ports 

Switch the dip switch of the AS00SCM-A module to COM and install the module on the right side of the 

AS300 series CPU module. To avoid errors, do not supply extra power to this module.  

 RTU remote control mode 

Switch the dip switch of the AS00SCM-A module to RTU. This module uses an independent 

direct-current power supply. Note the following when wiring. 

(1) Keep the input cables, the output cables, and the power cable separate from one another as shown 

in the following illustration. Use an independent power supply for this module.  

(2) The 24 VDC cable should be twisted and connected to a module within a short distance. Do not 



Chapter  4  Ins ta l l ing Hardware and W ir ing 

4-85 

4_  

bundle 110 VAC cable, 220 VAC cable, 24 VDC cable, the (high-voltage high-current) main circuit, 

and the I/O signal cable together. The distance between adjacent cables should be more than 100 

millimeters. 

(3) Use single-wire cables or two-wire cables with a diameter of 20 AWG to 14 AWG. Only use copper 

conducting wires with a temperature rating of 60/75°C. 

DC Power Supply
24VDC

Min 1.5A

SC M AS IO

DC Power Supply
24VDC

24V0VGr ounding

Grounding

Grounding

Grounding

24V

0V

Other 
device s

DC Po we r Supp ly
24VDC

Grounding

24V

0V

 

4.13.3 AS01DNET-A 

01 DNE T
MS

NS

x101

x100

I N 0
I N 1 Node Address

RTU Mast er Slave/
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4.13.4 Wiring AS01DNET-A  

The network requires one or multiple supply powers to supply the power to each piece of network equipment 

via the bus cable. Delta DeviceNet communication cable consists of five wires, among which the power cable 

and signal cable occupy two wires respectively and the one on the left is the shielded wire as the above figure 

shows. The supply power for the bus is optional and could be a single supply power or multiple supply powers 

according to the actual demand. 

 

 Single Supply Power 

 

 

 

 Multiple Supply Powers 
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4.13.5 AS04SIL-A  

Q 2

Q 4

E 4

Q3
E 3

C 4

E 2

C3

C Q 1

Q 1

E 1

C 2

M S

NS

C 1

P WR

04SIL

●

CQ 2

L3 +

L3 -

L4 +

L4 -

DI 1

D I2

CQ 3

D I3

CQ 4

D I4

L2 +

L2 -

L1 +

L1 -

2 4V

0 V

 

4.13.6 Wiring AS04SIL-A  

4.13.6.1 IO-Link mode communication and power wiring 

(1) Keep the input cables, output cables, and power cable separate from one another. It is suggested to use 

independent power for AS04SIL-A. See the example below.    

IO-Link (Master)
AS04SIL-A

CQ1 L1+

DI1 L1-

CQ2 L2+

DI2 L2-

CQ3 L3+

DI3 L3-

CQ4 L4+

DI4 L4-

. 24V

0V

1 Brown

3 Blue

4 Black

1 Brown

3 Blue

4 Black

2 White

IO-Link Sensor
(with DI)

DC Power Supply 
24VDC

24V0V

.

..
.

.

.
.

IO-Link Sensor
(w ithout DI)
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(2) The 24 VDC cable should be twisted and connected to a module within a short distance.  

(3) Do not bundle 110 VAC cable, 220 VAC cable, 24 VDC cable, the (high-voltage high-current) main circuit, 

and the I/O signal cable together. The distance between adjacent cables should be more than 100 

millimeters. 

(4) Connect a cable with a diameter of 14 AWG or higher to ground.  

(5) Use single-wire cables or two-wire cables with a diameter of 20 AWG to 14 AWG. Only use copper 

conducting wires with a temperature rating of 60/75°C. 

 

4.13.6.2  Digital Input Wiring (SIO Mode) 

When the connected device is a PNP type When the connected device is a NPN type 

Ln+

CQn

Ln-

2 4V

0V

AS04SIL-A

24 V

0V

 

Ln+

CQn

Ln-

2 4V

0V

AS04SIL-A

24 V

0V

 

Note: n=1~4 

4.13.6.3 Digital Output Wiring (SIO Mode) 

When the connected device is a PNP type When the connected device is a NPN type 

Ln+

CQn

Ln-

2 4V

0V

AS04SIL-A

+

R

24 V

0V

-

signal

Load

 

Ln+

CQn

Ln-

2 4V

0V

AS04SIL-A

R
+

-

signal

24 V

0V

Load

 

Note: n=1~4 
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4.13.6.4 Digital Input Wiring 

When the connected device is a PNP type When the connected device is a NPN type 

Ln+

DIn

Ln-

2 4V

0V

AS04SIL-A

24 V

0V

 

Ln+

DIn

Ln-

2 4V

0V

AS04SIL-A

24 V

0V

 

Note: n=1~4 
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4.14 Wiring Function Cards 

4.14.1 Communicational Function Card Profiles and the Pin Definitions   

AS-F232 AS-FCOPM AS-F422/AS-F485 

37 23.9

59
.3

66
.3

1 5

6 9

 

61
.3

37

59
.3

23.9

12345678

18

 
37 23.9

59
.3

60
.8

1 5

 
 

Pin no. AS-F232 AS-FCOPM AS-F422 AS-F485 

1 - CAN_H R+ - 
2 TX CAN_L R- - 
3 RX GND T+ D+ 
4 - - T- D- 
5 GND - SG SG 

6-9 - -   

 
AS-FEN02 / AS-FPFN02 

88

42

61.5

25.2

 

 

1 TX+ 2 TX- 3 RX+ 4 N/C 

 
5 N/C 6 RX- 7 N/C 8 N/C 

 
 
 
 



Chapter  4  Ins ta l l ing Hardware and W ir ing 

4-91 

4_  

4.14.2 Wiring the Communicational Function Cards 

 AS-F232 wiring example: 

 DB9 male to DB9 female (standard cable)

    AS-F232
(DB9 female) + + Superior

machine

 

 

 AS-F422 wiring example: 

3
4

1
2

6
7
8
9

COM2/DB-9

AS-F422 Delta HMI  ser iesDOPA

2
1

3
4

T+
T-

R+
R-

Rx+
Rx-

Tx+
Tx-

RTS-
RTS+

CTS+
CTS-

 

 

 AS-F485 wiring example: 

D+ D- SG D+ D- SG SG D+ D-

Master node Slave node Slave node

Shielded  
    cable

Shielded  
    cable

Terminal 
 resistor
(120 ohm)

Terminal 
 resistor
(120 ohm)

 

 

 AS-FCOPM wiring example: 

GNDCAN_H CAN_L

Master node Slave node Slave node

Terminal 
 resistor
(120 ohm)

Shielded  
    cable

GNDCAN_H CAN_L GND CAN_H CAN_L

Terminal 
 resistor
(120 ohm)  
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 AS-FEN02 wiring example: 

 Linear Topology 

 
 

 Star Topology 

 
 

 Ring Topology 

A DLR function is required to create a ring topology.  

 

When a switch is needed for topology, the switch 
should support the DLR function. If not, the 
connection might fail. 

 

 
 AS-FPFN02 wiring example: 

 Linear Topology 

 
 

 Star Topology 
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4.14.3 Analog Function Card Profiles and the Pin Definitions 

37 23.9

59
.3

60
.8

1 5

 
 

 
Pin no. AS-F2AD AS-F2DA 

1 V1+ VO1 
2 I1+ IO1 
3 V2+ VO2 
4 I2+ IO2 
5 COM COM 
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4.14.4 Wiring AS-F2AD 

0V~ +10V
V1+

I1+

 C OM

C HX

V1 +

I1+

*3

*2

CH 1

1 M

C H1

AG

1M

1M

AG

1M

25 0

250

 FE
*4

+

-

4mA~ +20m A
V2 +

I2+
*2 C H2

1M

AG

1M

250

*4

 FE

+

-

+

-

+ 24V

0V

V 2+

I2+
C H2

1M

AG

1M

250

+24V

0V

4mA~ +20m A

CH 1

1M

AG

1M

250

4mA~ +20m A

+2 4V +

-

V1+

I1+
*2

0V~ +10V

+ 24V +

-

*4
 FE

*4
 FE

*4
 FE

0V

+24 V

0V

0V

*5

C HX
*5

CH X
*5

C HX
*5

CH X
*5

 C OM

 C OM

 C OM

 C OM

Shielde d c able 1*

Shielde d c able 1*

4-wire vol tage in put

4-wire cu r ren t in put

2 -wir e cu rr ent inpu t

Shielded cable 1*

Shielde d c able 1*

Shielde d c able 1*
3 -wir e cur re nt inpu t

3 -wir e volt age inpu t

 
 

*1. Use shielded cables to isolate the analog input signal cable from other power cables. 

*2. If the module is connected to a current signal, the terminals Vn and In+ (n=1–2) must be short-circuited. 

*3. If noise in the input voltage results in noise interference in the wiring, connect the module to a capacitor with 

a capacitance between 0.1–0.47 μF with a working voltage of 25 V. 

*4. Connect FE of the shielded cable to ground. 

*5. CHX: Every channel can work with the input wiring shown above.  

 



Chapter  4  Ins ta l l ing Hardware and W ir ing 

4-95 

4_  

4.14.5 Wiring AS-F2DA 

Shielde d ca ble*1

Current output

VO2
IO2

CHX4mA~20mA CH2

AG

VO1
IO1

 COM

CHX
0V~+10V

*2
CH1

AG
 F E

*3

*4

*4

 FE

*3

 COM

AC motor dri ve, 
recorder, 
proport ioning valve

AC motor drive, 
recorder, 
propor tioning val ve

Shie lded cable *1

Vol tage output

 
 

 
*1. Use shielded cables to isolate the analog input signal cable from other power cables. 

*2. If noise in the input voltage results in noise interference in the wiring, Connect the module to a capacitor with 

a capacitance between 0.1–0.47 μF with a working voltage of 25 V. 

*3. Connect FE of the shielded cable to ground. 

*4. CHX: Every channel can work with the input wiring shown above.  
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5.1 Introduction of Devices 

This section describes the values and strings processed by the PLC. It also describes the functions of devices 

that include input, output, and auxiliary relays, as well as timers, counters, and data registers. The PLC 

simulates external devices in the PLC’s internal memory, so the word “device” is a generic name that refers to 

all the internal memory locations in the PLC. A device can be a bit device or a word device. Bit devices 

simulate coils, contacts and flags, while word devices simulate registers.  

5.1.1 Device Table 

Type Device name Number of devices Range 

Bit device 

Input relay X 1024 X0.0–X63.15 

Output relay Y 1024 Y0.0–Y63.15 

Data register 
D 48,0000 D0.0–D29999.15 

W 48,0000 W0.0–W29999.15 *4 

Auxiliary relay M 8192 M0–M8191 

Special auxiliary relay SM 4096 SM0–SM4095 

Stepping relay S 2048 S0–S2047 

Timer T 512 T0–T511 

Counter C 512 C0–C511 

32-bit counter HC 256 HC0–HC255 

Word device 

Input relay X 64 X0–X63 

Output relay Y 64 Y0–Y63 

Data register 
D 30000 D0–D29999 

W 30000 W0–W29999 *4 

Special auxiliary relay SR 2048 SR0–SR2047 

File register FR 65536 FR0–FR65535 

Timer T 512 T0–T511 

Counter C 512 C0–C511 

32-bit counter HC 256（512 words） HC0–HC255 

Index register E 
10 E0–E9 

5 E10–E14 *4 

Constant*1 Decimal system K 
16 bits: -32768 to 32767 

32 bits: -2147483648 to 2147483647 
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Type Device name Number of devices Range 

Constant*2 

Hexadecimal system 16# 
16 bits: 16#0–16#FFFF 

32 bits: 16#0–16#FFFFFFFF 

Single-precision floating-

point number 
F 32 bits: ±1.17549435-38 to ±3.40282347+ 38 

String*3 String “$” 1–31 characters 

*1: Constants are indicated by K in the device lists in Chapter 5 and Chapter 6 in the AS Series Programming 

Manual. An example when “K50” appears in the AS Series Programming Manual, enter only the number 50 in 

ISPSoft. 

*2: Floating-point numbers are indicated by F/DF in the device lists in Chapter 5 and Chapter 6 in the AS 

Series Programming Manual, but they are represented by decimal points in ISPSoft. For example, for the 

floating-point number F500, enter 500.0 in ISPSoft.  

*3: Strings are indicated by “$” in Chapter 5 and Chapter 6 in the AS Series Programming Manual, but they 

are represented by quotes (“ ”) in ISPSoft. For example, for the string 1234, enter “1234”in ISPSoft. 

*4: This is used for editing in ISPSoft only.  

5.1.2 Basic Structure of I/O Storages 

Device Function 
Access by 

bits 

Access by 

words 

Modify by 

ISPSoft 
Force the bit ON/OFF 

X Input relay OK OK OK OK 

Y Output relay OK OK OK OK 

M Auxiliary relay OK - OK - 

SM 
Special auxiliary 

relay 
OK - OK - 

S stepping relay OK - OK - 

T Timer OK OK OK - 

C Counter OK OK OK - 

HC 32-bit counter OK OK OK - 

D Data register OK OK OK OK 

SR Special data register - OK OK - 

FR File register - OK*1 - - 

E Index register - OK OK - 

*1: Use an instruction for writing to an FR.   



AS Ser ies  Hardware  and  Operat ion Manual  

5-4 

_5 

5.1.3 Relation Between the PLC Action and the Device Type 

Device type 

 

PLC action 

Non-latched area Latched area 

Device Y 
Other 

devices 

File 

register 

Other 

devices 

Power: OFF→ON Cleared Cleared Retained Retained 

Restore to defaults Cleared Cleared Cleared Cleared 

STOP 

↓ 

RUN*1 

This clears the non-latched area 

state. 
Cleared Cleared Retained Retained 

This retains the non-latched 

area state. 
Retained Retained Retained Retained 

RUN 

↓ 

STOP*1 

This clears the  

device Y. 
SM203 = OFF Cleared Retained Retained Retained 

This retains the 

device Y. 
SM203 = OFF Retained Retained Retained Retained 

This clears the  

device Y. 
SM203 = ON*3 Cleared Cleared Retained Retained 

This retains the 

device Y. 
SM203 = ON Retained Cleared Retained Retained 

SM204 is ON.This clears all non-latched 

areas.*2 
Cleared Cleared Retained Retained 

SM205 is ON.This clears all latched 

areas.*2 
Retained Retained Retained Cleared 

*1: For state setups, see HWCONFIG in ISPSoft. The PLC STOP->RUN default is “clear the non-latched area 

state”. The PLC RUN->STOP default is “clear the state of device Y”.  

*2: The timing for clearing the SM is when SM turns from OFF to ON. After PLC completes clearing, the 

system turns SM from ON to OFF.  

*3: When SM203 is ON, the system clears all non-latched area once when PLC is from RUN to STOP, 

available for AS PLC CPU with FW V1.08.30 or later.  

 
  



Chapter  5  Device  

5-5 

5_  

5.1.4 Latched Areas in the Device Range 

Device Function Device range Latched area 

X Input relay X0–X63 All devices are non-latched. 

Y Output relay Y0–Y63 All devices are non-latched. 

M*1 Auxiliary relay M0–M8191 The default range is M6000–M8191. 

SM Special auxiliary relay SM0–SM2047 

Some devices are latched and cannot be 

changed. 

Refer to the list of special auxiliary relays for more 

information. 

S*1 Stepping relay S0–S1023 The default range is S512–S1023 

T Timer  T0–T511 All devices are non-latched. 

C*1 Counter C0–C511 The default range is C448–C511 

HC*1 32-bit counter HC0–HC255 The default range is HC128–HC255 

D*1 Data register 
D0–D29999 The default range is D20000–D23999 

W0–W29999 Use this for editing in ISPSoft only. 

FR File register FR0–FR65535 All devices are latched. 

SR Special data register SR0–SR2047 

Some are latched and cannot be changed. Refer 

to the list of special data registers for more 

information. 

E Index register 
E0–E9 All devices are non-latched. 

E10–E14 Use this for editing in ISPSoft only. 

*1: For the latched area setups, see HWCONFIG in ISPSoft. Setting the latched area means the other areas 

show as non-latched areas. The range of latched areas cannot exceed the device range. For example, if 

you set the M600–M7000 as latched areas, M0–M5999 and M7001–M8191 become non-latched areas. 
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5.2. Device Functions 

Procedure for processing the program in the PLC: 

Input terminal X

Device memory

Processin g th e prog ram

D
evice m

em
ory

Regenerating the output s ignal
and sending it to the output terminal

 

Regenerating the input signal 

Device memory

 

 Regenerating the input signal 

1. Before executing the program, the external input 

signal state is read into the memory for the input 

signal.  

2. When the program is executed, the state in the 

memory location for the input signal does not change 

even if the input signal changes from ON to OFF or 

from OFF to ON. The input signal is not refreshed 

until the next scan begins. 

 Processing the program 

After the input signal is refreshed, the instructions in the 

program are executed in order from the starting address 

of the program. The results are stored in the device 

memories.  

 Regenerating the state of the output  

After the instruction END is executed, the device memory 

state in the device memory is sent to the specified output 

terminal. 

5.2.1 Values and Constants 

Name Description 

Bit A bit is the basic unit in the binary system. Its state is either 1 or 0. 

Nibble 
A nibble is composed of four consecutive bits (for example b3–b0). Nibbles 

can represent 0–9 in the decimal system or 0–F in the hexadecimal system. 

Byte 
A byte is composed of two consecutive nibbles (i.e. 8 bits, b7–b0). Bytes can 

represent 00–FF in the hexadecimal system. 

Word 
A word is composed of two consecutive bytes (i.e. 16 bits, b15–b0). Words 

can represent 0000–FFFF in the hexadecimal system. 

Double word 

A double word is composed of two consecutive words (i.e. 32 bits, b31–b0). 

Double words can represent 00000000–FFFFFFFF in the hexadecimal 

system. 
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The relation among bits, nibbles, bytes, words, and double words in the binary system is shown below. 

b31b30 b29 b28 b27b26 b25 b24b23 b22 b21 b20b19 b18 b17 b16 b15b14 b13 b12b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

NB0NB1NB2NB3NB4NB5NB6NB7

BY3 BY2 BY1 BY0

W1

DW

W0

Double word

Word

Byte

N ibble

Bit
 

The PLC uses four types of values to execute the operation according to different control purposes. The following 
illustrates the values of these functions.: 

1. Binary number (BIN) 

The PLC uses the binary system to operate the values. 

2. Decimal number (DEC) 

The PLC uses decimal numbers for; 

 The setting value of a timer (T) or the setting value of a counter (C/HC); for example, TMR C0 50 
(constant K). 

 The device number; for example, M10 and T30 (device number) 

 The number before or after the decimal point; for example, X0.0, Y0.11, and D10.0 (device number). 

 The constant K: used as the operand in an applied instruction. For example, MOV 123 D0 
(constant K). 

3. Binary-coded decimal (BCD) 

A decimal value is represented by a nibble or four bits, so that sixteen consecutive bits represent a 
four-digit decimal value.  

4. Hexadecimal number (HEX) 

The PLC uses hexadecimal numbers for;  

 the constant 16#: used as the operand in an applied instruction; for example, MOV 16#1A2B D0 
(hexadecimal constant). 
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The following table shows the corresponding values. 

Binary Number 

(BIN) 

Decimal Number 

(DEC) 

Binary Code Decimal 

(BCD) 

Hexadecimal Number 

(HEX) 

PLC internal execution 
Constant K,  

Device number 
BCD related instruction 

Instant 16#,  

Device number 

0000 0 0000 0 

0001 1 0001 1 

0010 2 0010 2 

0011 3 0011 3 

0100 4 0100 4 

0101 5 0101 5 

0110 6 0110 6 

0111 7 0111 7 

1000 8 1000 8 

1001 9 1001 9 

1010 10 - A 

1011 11 - B 

1100 12 - C 

1101 13 - D 

1110 14 - E 

1111 15 - F 

10000 16 0001 0000 10 

10001 17 0001 0001 11 
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5.2.2 Floating-point Numbers 

The floating-point numbers are represented by decimal points in ISPSoft. For example, the floating-point number 
of 500 is 500.0.  Refer to Section 2.2.2 in the AS Series Programming Manual for more information. 

5.2.2.1 Single-precision Floating-point Numbers 

Floating-point numbers are represented by the 32-bit register. The representation adopts the IEEE754 standard, 
and the format is as follows.  

S Exponent Mantissa

8-b it 23-bi t

b31 b0

Sign b it
0 : Positive
1: Negative  

Equation: ( ) 127;.121 =××− − BMBES
 

The single-precision floating-point numbers range from ±2-126 to ±2+128, and correspond to the range from 
±1.1755×10-38 to ±3.4028×10+38. 

The AS series PLC uses two consecutive registers to form a 32-bit floating-point number. Take (D1, D0) for 
example. 

S E7 E6 E5 E1 E0 A22 A21 A20 A6 A5 A4 A3 A2 A1 A0

b0b1b2b3b4b5b6b20b21b22b23b24b28b29b30b31

2 2 2 2 2 2 2 2 2 2 2 2 22 2

D1(b15~b0) D0(b15~b0)

Exp on en t ( 8 b its) Ma nt issa (2 3b its)

Ma nt issa sign b it (0 : Po sit ive; 1: Ne ga tive)
W hen b 0~b3 1 a re zeros, the con te nt is zero .

The pos it ion w here the d eci mal point  is  hid den

 

Example 1: 

23 is represented by a single-precision floating-point number. 

Step 1: Convert 23 into the binary number, i.e. 23.0=10111. 

Step 2: Normalize the binary number, i.e. 10111=1.0111 ×24 (0111 is the mantissa, and 4 is the exponent.).  

Step 3: Get the value of the exponent. 

∵ E-B=4→E-127=4 ∴ E=131=100000112 

Step 4: Combine the sign bit, the exponent, and the mantissa to form the floating-point number. 

0 10000011 011100000000000000000002=41B8000016 
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Example 2: 

-23 is represented by a single-precision floating-point number. 

Converting -23.0 into the floating-point number uses the same steps as converting 23.0 into the floating-point 
number, except that the sign bit is 1.  

1 10000011 011100000000000000000002=C1B8000016 

 

5.2.2.2 Decimal Floating-point Numbers 

-23 is represented by a single-precision floating-point number. 

Converting -23.0 into the floating-point number uses the same steps as converting 23.0 into the floating-point 
number, except that the sign bit is 1.  

1 10000011 011100000000000000000002=C1B8000016 

 

5.2.2.2 Decimal Floating-point Numbers 

 Single-precision floating-point numbers and double-precision floating-point numbers can be converted 

into decimal floating-point numbers so people can read them. However, the PLC uses single-precision 

floating-point numbers and double-precision floating-point numbers internally. 

 A 32-bit decimal floating-point number is represented by two consecutive registers. The constant is 

stored in the register whose number is smaller while the exponent is stored in the register whose 

number is bigger. Take (D1, D0) for example. 

10Decimal f loating-point number=[Constant        ]*D0
[Exponent      ]D1

 

Base number D0=±1,000 to ±9,999 

Exponent D1=-41–+35  

The base number 100 does not exist in D0 because 100 is represented by 1,000×10-1. 32-bit decimal floating-

point numbers range from ±1175×10-41 to ±402×10+35. 
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5.2.3 Strings 

The PLC can process strings composed of ASCII codes (*1). A complete string begins with a start character and 
ends with an ending character (NULL code). Strings can be a maximum of 31 characters, and the ending 
character 16#00 is added automatically in ISPSoft.  

1. No string (NULL code) is moved. 

 

D0=0 (NULL) 

 

2. The string has an even number of characters. 

 

D0 16#62 (b) 16#61 (a) 

D1 16#64 (d) 16#63 (b) 

D2 0 (NULL) 

 

3. The string has an odd number if characters. 

 

D0 16#62 (b) 16#61 (a) 

D1 16#64 (d) 16#63 (b) 

D2 0 (NULL) 16#65 (e) 
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*1: ASCII code chart 

Hex 0 1 2 3 4 5 6 7 8 9 A B C D E F 

ASCII                 

Hex 10 11 12 13 14 15 16 17 18 19 1A 1B 1C 1D 1E 1F 

ASCII                 

Hex 20 21 22 23 24 25 26 27 28 29 2A 2B 2C 2D 2E 2F 

ASCII SP ! " # $ % &  （ ） * + ， - . / 

Hex 30 31 32 33 34 35 36 37 38 39 3A 3B 3C 3D 3E 3F 

ASCII 0 1 2 3 4 5 6 7 8 9 ： ; < = > ? 

Hex 40 41 42 43 44 45 46 47 48 49 4A 4B 4C 4D 4E 4F 

ASCII @ A B C D E F G H I J K L M N O 

Hex 50 51 52 53 54 55 56 57 58 59 5A 5B 5C 5D 5E 5F 

ASCII P Q R S T U V W X Y Z      

Hex 60 61 62 63 64 65 66 67 68 69 6A 6B 6C 6D 6E 6F 

ASCII ` a b c d e f g h i j k l M n o 

Hex 70 71 72 73 74 75 76 77 78 79 7A 7B 7C 7D 7E 7F 

ASCII p q r s t u v w x y z { | } ~  

Note:  represents an invisible character. Please do not use it. 

5.2.4 Input Relays (X) 

 Input function  

The input is connected to the input device (external devices such as button switches, rotary switches, and 

number switches), and PLC reads the input signal. You can use input contact A or contact B several times 

in the program, and the ON/OFF input state varies with the ON/OFF input device state. 

 Input number (the decimal number): 

For the PLC, the input numbers start from X0.0. The number of inputs varies with the number of inputs on 

the digital input/output modules. The inputs are numbered according to the order in which the digital 

input/output modules are connected to the CPU module. The maximum number of inputs for the PLC is 

8192, and the input number range is between X0.0 and X511.15. 

 Input type: Inputs are classified into two types. 

1. Regenerated inputs: PLC reads the state of a regenerated input before the program is executed.  For 

example, LD X0.0. 

2. Direct input: The state of a direct input is read by the PLC during the execution of the instructions. For 

example, LD DX0.0. 
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5.2.5 Output Relays (Y) 

 Output function 

The output sends the ON/OFF signal to drive the load connected to the output, such as an external signal 
lamp, a digital display, or an electromagnetic valve. There are four types of outputs: relays, transistors (NPN 
and PNP), and TRIACs (thyristors). You can use the output contact A or contact B several times in the 
program. Use output Y only once in the program; otherwise, according the PLC’s program-scanning 
principle, the state of the output depends on the circuit connected to the last output Y in the program.  

 Output number (the decimal number) 

For the PLC, the output numbers start from Y0.0. The number of outputs varies with the number of outputs 
on the digital input/output modules. The outputs are numbered according to the order in which the digital 
input/output modules are connected to the PLC. The maximum number of outputs on the PLC is 1024, and 
the range is between Y0.0 and Y63.15. 

An output that is not used as an output device can be used as a general device.  

 Output types  

Outputs are classified into two types. 

1. Regenerated output: The state of a regenerated output is not written until the program executes the 
instruction END according to the states of the outputs. For example, OUT Y0.0. 

2. Direct output: The state of a direct output is written by the PLC during the execution of the instructions 
according to the states of the outputs. For example, OUT DY0.0. 

 

5.2.6 Auxiliary Relays (M) 

The auxiliary relay has contact A and contact B. It can be used several times in the program. You can combine 

the control loops with the auxiliary relay, but you cannot drive the external load with the auxiliary relay. You can 

use the auxiliary relays in either of two ways. 

1. For general use: In general use, if an electrical power interruption occurs when the PLC is running, 

the auxiliary relay is reset to OFF. When the power is restored, the auxiliary relay 

remains OFF. 

2. For latched use: In latched use, if an electrical power interruption occurs when the PLC is running, 

the state of the auxiliary relay states for latched use is retained. When the power 

supply is restored, the state remains the same as before the power interruption. 

 

5.2.7 Special Auxiliary Relays (SM) 

Every special auxiliary relay has its own specific function. Refer to section 2.2.7 in the AS Series Programming 

Manual for more information. 
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5.2.8 Stepping Relays (S) 

You can easily see the stepping relay in industrial automation to set the procedure. It is the most basic device 

in sequential function chart (SFC) programming. Refer to the ISPSoft User Manual for more information on 

using sequential function charts. 

There are 2048 stepping relays, (S0–S2047). Every stepping relay is like an output relay in that it has an 

output coil, contact A, and contact B. You can use it several times in the program, but the relay cannot directly 

drive the external load. You can use the stepping relay as a general auxiliary relay when it is not used in a 

sequential function chart. 

 

5.2.9 Timers (T) 

• 100 millisecond timer: The timer specified by the instruction TMR takes 100 milliseconds as the timing 

unit. 

• 1 millisecond timer: The timer specified by the instruction TMRH takes 1 millisecond as the timing unit. 

• The accumulative timers are ST0–ST511. If you want to use the device-monitoring function, these timers   

can monitor T0–T511. 

• If you use the same timer repeatedly in a program, including in different instructions TMR and TMRH, the 

timer setting value is the one that the timer matches first. 

• If you use the same timer repeatedly in a program, the timer is OFF when one of the conditional contacts 

is OFF. 

• If you use the same timer in a program as the timer for a subroutine’s exclusive use and an accumulative 

timer in the program, it is OFF when one of the conditional contacts is OFF. 

• When the timer is switched from ON to OFF and the conditional contact is ON, the timer is reset and 

counts again. 

• When the instruction TMR is executed, the specified timer coil is ON and the timer begins to count. When  

the value of the timer matches the timer setting value (value of the timer ≧ setting value), the contact 

state is ON. 
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A. General-purpose timer 

When the instruction TMR is executed, the general-purpose timer begins to count. When the value of the 

timer matches the timer setting value, the output coil is ON. 

 When X0.0=ON and the timer takes 100 ms as the timing unit, the output coil T0 is ON when the 

value of the timer = setting value100.  

 When X0.0=OFF or the power is off, the value of the timer is 0 and the output coil T0 is OFF.  

 

X0.0

T0(PV)

Y0.0

SV:K100

10  sec

 

 

B. Accumulative timer 

When the instruction TMR is executed, the accumulative timer begins to count. When the value of the 

timer matches the timer setting value, the output coil is ON. As long as you add the letter S in front of the 

letter T, the timer becomes an accumulative timer. When the conditional contact is OFF, the value of the 

accumulative timer is not reset. When the conditional contact is ON, the timer counts from the current 

value. 

 When X0.0=ON and the timer T250 takes 100 ms as the timing unit, the output coil T250 is ON 

when the value of the timer = timer setting value100.  

 When X0.0=OFF or the power is off, the timer T250 stops counting, and the value of the timer 

stays the same. When X0.0=ON, the value of the timer is accumulating value When the 

accumulated value = timer setting value 100, the output coil T250 is ON.  
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X0.0

T2

Y0.0

SV: K100

T1+T2=10 sec

T250(PV)

T1

 

C. Timer used in the function block 

Use the T412–T511 timers for the function block or the interrupt. 

When the instruction TMR or END is executed, the timer used in the functional block begins to count. 

When the value of the timer matches the timer setting value, the output coil is ON. 

If you use the general-purpose timer is used in the function block or the interrupt, and the functional or 
interrupt is not executed, the timer cannot count correctly. 

 

5.2.10 16-bit Counters 

 Characteristics of the 16-bit counter 

Item 16-bit counter 

Type General type 

Number C0–C511 

Direction Counting up 

Setting value 0–32,767 

Specificying the counter setting 

value 

The setting value can be either the constant or the value in the data 

register. 

Change of the current value 
The counter stops counting when the value of the counter matches the 

setting value. 

Output contact The contact is ON when the value of the counter matches the setting value. 
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Item 16-bit counter 

Reset 
When the instruction RST is executed, the current value is cleared to zero, 

and the contact is reset to OFF. 

Action of the contact After the scan completes, the contact acts. 

 Counter function 

Each time the input switches from OFF to ON, the value of the counter is the same as the output coil. Use 

either the decimal constant or the value in the data register as the counter setting value. 

 16-bit counter: 

1. Setting range: 0–32,767. The setting values 0 and 1 both mean the same thing in that the output contact 

is ON when the counter counts for the first time. 

2. For the general-purpose counter, the current value of the counter is cleared when there is a power 

interruption. If the counter is latching, the current value of the counter and the state of the contact before 

the power interruption are retained. The latched counter counts from the current value when the power 

supply is restored. 

3. If you use the instruction MOV or ISPSoft to transmit a value bigger than the counter setting value to the 

current value register C0, the contact of the counter C0 is ON and the current value becomes the same 

as the counter setting value next time X0.1 switches from OFF to ON. 

4. Use either the constant or the value in the data register as the counter setting value. 

5. The counter setting value can be a positive or negative value. If the counter counts up from 32,767, the 

next value is 0. 

6. Here we uses the most common application as an example. You can use this counter with API 1003 CNT 

instruction; refer to CNT instruction for more description.  

Example:  
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1. When X0.0=ON, the instruction RST will be executed and the current value of C0 will be reset to zero and 

the output contact of the counter C0 will be FF. 

2. When X0.1 is from OFF to ON, the value of the counter increases by one increment.   

3. When the value of the counter C0 reached the setting value 5, the contact of the counter C0 will be ON 

(the current value of C0 = the setting value = 5). After that the trigger from X0.1 will not be accepted by 

C0 and the current value of C0 will stay at the value 5.   

X0.0

X0.1

Y0.0,C0 

C0 (PV)

0
1

2
3

4
5

(SV)

0

 
 

5.2.11 32-bit Counters (HC) 

 Characteristics of the 32-bit counter 

Item 32-bit counter 

Type Up/down counter Up counter High-speed counter 

Number HC0–HC63 HC64–HC199 HC200–HC255 

Direction Counting up/down Counting up Counting up/down 

Setting value -2,147,483,648 to +2,147,483,647 

Specification of the 

setting value 

The setting value can be either the constant or the value occupying two data 

registers (32-bit). 

Change of the current 

value 

The counter keeps counting even after the value of the counter matches the setting 

value. 

Output contact 

The contact is ON when the value of the addition counter matches the setting value. 

The contact is reset to OFF when the value of the subtraction counter matches the 

setting value. 

Reset 
When the RST instruction is executed, the current value is cleared to zero, and the 

contact is reset to OFF. 
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Item 32-bit counter 

Action of the contact After the DCNT instruction scan is complete, the contact activates. 

 32-bit general-purpose addition/subtraction counter 

1. Setting range: -2,147,483,648 to 2,147,483,647 

2. The switch between the 32-bit general-purpose addition counters and the 32-bit general-purpose 

subtraction counters depends on the states of the special auxiliary relays SM621–SM684. For example, 

the counter HC0 is the addition counter when SM621 is OFF, but HC0 is the subtraction counter when 

SM621 is ON. Use either the constant or the value in the data registers as the setting value for the 

counter, and the setting value can be a positive or a negative number. If you use the value in the data 

registers as the setting value of the counter, the setting value occupies two consecutive registers. 

3. For the general-purpose counter, the current value of the counter is cleared when there is a power 

interruption. If the counter is latched, the current value of the counter and the state of the contact before 

the power interruption are retained. The latched counter counts from the current value when the power 

supply is restored. 

4. If the counter counts up from 2,147,483,647, the next current value is -2,147,483,648. If the counter 

counts down from -2,147,483,648, the next current value is 2,147,483,647. 

5. Here we uses the most common application as an example. You can use this counter with API 1004 

DCNT instruction; refer to DCNT instruction for more description.  

 32-bit high speed addition/subtraction counter 

Refer to the DCNT instruction description (API 1004) in the AS Series Programming Manual for more details. 

Example:  
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1. X10.0 drives SM621 to determine counting direction (up/down) of HC0. 

2. When X11.0 goes from OFF to ON, RST instruction executes, the PV in HC0 is  cleared to 0, and its 

contact is OFF.  

3. When X12.0 goes from OFF to ON, PV of HC0 counts up (plus 1) or down (minus 1). 

4. When PV in HC0 changes from -6 to -5, the contact HC0 goes from OFF to ON. When PV in HC0 

changes from -5 to -6, the contact HC0 goes from ON to OFF. 

X10.0

X11.0

X12.0

 When t he output c ontact w as O N 

Y0.0,
HC0 Contacts

HC0 
( )PV

Accumulatively
increasing Progressive ly

decreasing

0
1

2
3

4
5

4
3

2
1

0
-1

-2
-3

-4
-5

-6
-7

-8

0

-7
-6

-5
-4

-3

Accumulatively
increasing

 

 

5.2.12 Data Registers (D) 

The data register stores 16-bit data. The highest bit represents either a positive sign or a negative sign, and 

the values that you can store in the data registers are between -32,768 to +32,767. Two 16-bit registers can 

be combined into a 32-bit register, that is, (D+1, D) in which the register whose number is smaller represents 

the lower 16 bits. The highest bit represents either a positive sign or a negative sign, and the values that you 

can store in the data registers are between -2,147,483,648 to +2,147,483,647. Four 16-bit registers can be 

combined into a 64-bit register; that is, (D+3, D+2, D+1, D) in which the register whose number is smaller 

represents the lower 16 bits. The highest bit represents either a positive sign or a negative sign, and the 

values which can be stored in the data registers are between -9,223,372,036,854,776 to 

+9,223,372,036,854,775,807. You can also use the data registers to refresh the values in the control registers 

in the modules other than digital I/O modules. Refer to the ISPSoft User Manual for more information about 

refreshing the values in the control registers. 

  

 



Chapter  5  Device  

5-21 

5_  

The registers can be classified into three types according to their properties. 

1. General-purpose register: when the PLC begins to run or is disconnected, the value in the register    

clears to zero. To retain the data when the PLC begins to RUN, refer to the ISPSoft User Manual for more 

information. Notice that the value still clears to zero when the PLC is disconnected. 

2. Latched register: if the PLC is disconnected, the data in the latched register is not cleared. In other words, 

the value before the disconnection is still retained. To clear the data in the latched area, use the RST or 

ZRST instruction.  

3. Data exchange area: When the PLC is connected with a module, the PLC exchanges data with the 

connected module at every scan cycle. And the data is stored in data registers D26000 to D29999. Refer 

to the ISPSoft > HWCONFIG > Module > Device Setting > Normal Exchange Area to see the data register 

range and refer to Chapter 8 for more descriptions. 

 

5.2.13 Special Data Registers (SR) 

Every special data register has its definition and specific function. Refer to section 2.2.14 in the AS Series 

Programming Manual for more information. 

 

5.2.14 Index Register (E) 

The index register is a 16-bit data register. Like the general register, you can read data from it and write data 

into it. However, it is mainly used as the index register. The index registers range from E0–E9. Refer to section 

4.4 in the AS Series Programming Manual for more information about using index registers. 

 

5.2.15 File Registers (FR) 

The AS Series PLC provides you with file registers for storing larger numbers of parameters. You can edit, 

upload, and download the system parameters with ISPSoft. You can read the values in a file register can be 

read while operating the PLC. Refer to the MEMW instruction (API 2303) in the AS Series Programming 

Manual for more information about how to write to a file register.  
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5.3. Assigning I/O Addresses for Modules 

This chapter explains how to assign input and output devices to an AS Series input/output module. 

Using HWCONFIG in ISPSoft 

The following picture shows the HWCONFIG window in ISPSoft. Please refer to Chapter 8 for more 

information on the hardware configuration. 

 
 

 Module addresses defined by software 

Through HWCONFIG, the system automatically assigns a starting address to every slot of an input/output 

module in ISPSoft. 

 

 Remote module addresses defined by software 

You use HWCONFIG to assign a starting address to a remote module in ISPSoft. Double-click the CPU 

module and select Function Card 2. Change the Card 2 Detect mode to Manual and then select AS-FCOPM 

from the Manual Select Card. You can assign a starting address to the first remote module installed on the 

right side of the I/O module slot. Then the following I/O modules are assigned addresses automatically and 

consecutively. 
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5.4 Module Addresses Defined by Software 

5.4.1 Starting Addresses for Digital Input/Output Modules 

HWCONFIG automatically assigns input/output devices to a digital input/output module in ISPSoft according 

to the number of inputs and outputs in the digital input/output module (X0.0–X0.15, X1.0–X1.15, X2.0–

X2.15…; Y0.0–Y0.15, Y1.0–Y1.15, Y2.0–Y2.15). The default starting addresses are shown below. 

Note: each digital I/O module reserves 20 words of data devices and it assigns consecutive data devices 

automatically starting from D28000. 

 AS332T/AS332P: There are 16 inputs. The input and output device range occupies 16 bits. (Xn.0–Xn.15), 

(Yn.0–Yn.15) and 20 words of data devices. 

 AS324MT: There are 16 outputs. The input and output device range occupies 16 bits. (Xn.0–Xn.15), 

(Yn.0–Yn.15) and 20 words of data devices. 

 08AM: There are eight inputs. The input device range occupies 16 bits (Xn.0–Xn.15) and 20 words of 

data devices. 

 08AN: There are eight outputs. The output device range occupies 16 bits (Yn.0–Yn.15) and 20 words of 

data devices. 

 16AM: There are 16 inputs. The input device range occupies 16 bits (Xn.0–Xn.15) and 20 words of data 

devices. 

 16AN: There are 16 outputs. The output device range occupies 16 bits (Yn.0–Yn.15) and 20 words of 

data devices. 

 16AP: There are eight inputs and eight outputs. The input and output device range occupies 16 bits. 

(Xn.0–Xn.15), (Yn.0–Yn.15) and 20 words of data devices. 

 32AM: There are 32 inputs. The input device range occupies 32 bits (Xn.0–Xn+1.15) and 20 words of 

data devices. 

 32AN: There are 32 outputs. The output device range occupies 32 bits (Yn.0–Yn+1.15) and 20 words of 

data devices. 

 64AM: There are 64 inputs. The input device range occupies 64 bits (Xn.0–Xn+3.15) and 20 words of 

data devices. 

 64AN: There are 64 outputs. The output device range occupies 64 bits (Yn.0–Yn+3.15) and 20 words of 

data devices. 
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Note: though there is no information on the occupied data devices in the image shown above, the CPU 

reserves 20 words of data devices.  

 
5.4.2 Starting Addresses for Analog Input/Output Modules 

HWCONFIG automatically assigns consecutive input and output data registers starting from D28000 to an 

analog input/output module in ISPSoft according to the number of registers defined for the analog input/output 

module.  

1. 04AD: There are four input channels. The input device range occupies 20 data registers.  

2. 08AD: There are eight input channels. The input device range occupies 20 data registers. 

3. 004DA: There are four output channels. The input device range occupies two data registers and the 

output device range occupies 18 data registers. 

4. 06XA: There are four input channels and two output channels. The input device range occupies 10 data 

registers, and the output device range occupies 10 data registers.  
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5.4.3 Starting Addresses for Temperature Measurement Modules 

HWCONFIG automatically assigns consecutive input and output data registers starting from D28000 to a 

temperature measurement module in ISPSoft according to the number of registers defined for the temperature 

measurement module.  

1. 04RTD: There are four input channels. The input device range occupies 20 data registers.  

2. 06RTD: There are six input channels. The input device range occupies 20 data registers.  

3. 04TC: There are four input channels. The input device range occupies 20 data registers.  

4. 08TC: There are eight input channels. The input device range occupies 20 data registers.  

 

 
5.4.4 Starting Addresses for Positioning/Counter Modules 

HWCONFIG automatically assigns consecutive input and output data registers starting from D28000 to a 

network module in ISPSoft according to the number of registers defined for the network module. 

1. 02PU: The input device range occupies 20 data registers.  

2. 04PU: The input device range occupies 20 data registers.  

3. 02HC: The input device range occupies 20 data registers.  
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5.4.5 Starting Addresses for Network Modules 

HWCONFIG automatically assigns consecutive input and output data registers starting from D28000 to a 

network module in ISPSoft according to the number of registers defined for the network module. 

• SCM, as a general COM communication module: 

Communication status and communication method; the input device range occupies 20 data registers, 

and the output device range occupies 20 data registers. 

 
 

• Remote module SCM: the input device range and output device range each occupy 10 data registers. 

 
 

• AS01DNET-A: when selecting the COM communication mode, its communication status and 

communication method: the input device range occupies 20 data registers, and the output device range 

occupies 20 data registers. 
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• AS04SIL-A: when selecting the COM communication mode, its communication status and communication 

method: the input device range occupies 20 data registers. 

 

 
5.4.6 Starting Addresses for Load Cell Modules 

HWCONFIG automatically assigns consecutive input and output data registers starting from D28000 to a load 

cell module in ISPSoft according to the number of registers defined for the load cell module.  

• 02LC: The input device range occupies 7 data registers and the output device range occupies 13 data 

registers. 
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5.5 Remote Module Addresses Defined by Software 

Double-click the CPU module to see the setting page where you can set up the PLC parameters. Select 

options on the left under the General or Data Exchange tab, you can see the setting items on the right under 

the tab of the option you have selected. 

 
• Click Function Card2 on the left to see the Function Card 2 Setting tab on the right and find setting 

items under the tab.  

 
 
• For Card 2 Detect mode, select Manual. For Manual Select Card, select AS-FCOPM Card.  
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• For AS-FCOPM Working mode, select AS Remote Communication, and then enter the number of the 

connected AS Remote module. Click Upate and then close the setting page. 

 

• You can see the new remote module on the main page. For the configurations of remote modules, refer 

to the configurations of modules. 

Note: You can add up to 15 modules in the remote group. The total number of I/O modules and 

connected remote modules cannot exceed 32. Only digital I/O modules, analog I/O modules, 

temperature measurement modules, load cell modules and AS04SIL-A can be used for remote modules.  
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• Change the address of the remote module  

You can change the remote module address by simply double-click the  behind the Input Device Range and 
then you can see the Manual Assignment window. Define the starting address of your remote module and click 
OK to confirm and save the change.    
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5.5.1 Starting Addresses for Digital Input/Output Modules 

The remote module AS00SCM-A can connect to up to eight modules on its right side. HWCONFIG 

automatically assigns input and output devices to a digital input/output module in ISPSoft according to the 

number of inputs/outputs in the digital input/output module (X1.0–X1.15, X2.0–X2.15…；Y0.0–Y0.15, Y1.0–

Y1.15, Y2.0–Y2.15). The default starting addresses are shown below. 

Note: each digital I/O module reserves 20 words of data devices and it assigns consecutive data devices 

automatically starting from D29000. 

 08AM: There are eight inputs. The input device range occupies 16 bits (Xn.0–Xn.15) and 20 words of 

data devices. 

 08AN: There are eight outputs. The output device range occupies 16 bits (Yn.0–Yn.15) and 20 words of 

data devices. 

 16AM: There are 16 inputs. The input device range occupies 16 bits (Xn.0–Xn.15) and 20 words of data 

devices. 

 16AN: There are 16 outputs. The output device range occupies 16 bits (Yn.0–Yn.15) and and 20 words of 

data devices. 

 16AP: There are eight inputs and eight outputs. The input and output device range occupies 16 bits. 

(Xn.0–Xn.15), (Yn.0–Yn.15) and 20 words of data devices. 

 32AM: There are 32 inputs. The input device range occupies 32 bits (Xn.0–Xn+1.15) and 20 words of 

data devices. 

 32AN: There are 32 outputs. The output device range occupies 32 bits (Yn.0–Yn+1.15) and 20 words of 

data devices. 

 64AM: There are 64 inputs. The input device range occupies 64 bits (Xn.0–Xn+3.15) and 20 words of 

data devices. 

 64AN: There are 64 outputs. The output device range occupies 64 bits (Yn.0–Yn+3.15) and 20 words of 

data devices. 
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5.5.2 Starting Addresses for Analog Input/Output Modules 

HWCONFIG automatically assigns input and output data registers to an analog input/output module in ISPSoft 

according to the number of registers defined for the analog input/output module. The default starting address 

is D29000. 

1. 04AD: There are four input channels. The input device range occupies 20 data registers. 

2. 08AD: There are eight input channels. The input device range occupies 20 data registers.  

3. 004DA: There are four output channels. The input device range occupies two data registers and the 

output device range occupies 18 data registers.  

4. 06XA: There are four input channels, and two output channels. The input device range occupies 10 data 

registers, and the output device range occupies 10 data registers.  
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5.5.3 Starting Addresses for Temperature Measurement Modules 

You can use HWCONFIG to assign input registers to a temperature measurement module in ISPSoft. The 

default starting address is D29000. 

1. 04RTD: There are four input channels. The input device range occupies 20 data registers.  

2. 06RTD: There are six input channels. The input device range occupies 20 data registers.  

3. 04TC: There are four input channels. The input device range occupies 20 data registers.  

4. 08TC: There are eight input channels. The input device range occupies 20 data registers.  

 
 
 
 
 
 
 
 
 
 

 
5.5.4 Starting Addresses for Load Cell Modules 

HWCONFIG automatically assigns input data registers to a load cell module in ISPSoft according to the 

number of registers defined for the load cell module. The default starting address is D29000. 

• 02LC: The input device range occupies 7 data registers and the output device range occupies 13 data 

registers. 
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5.5.5 Starting Addresses for AS04SIL-A Modules 

• AS04SIL-A: when selecting the COM communication mode, its communication status and communication 

method: the input device range occupies 20 data registers. 
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6.1 Quick Start 

This chapter provides a simple example showing you how to create a traditional ladder diagram in ISPSoft.  

Because you may not be familiar with IEC 61131-3 and may not understand the functions provided by ISPSoft, 

the chapter does not introduce programming concepts related to IEC 61131-3.  For example, the chapter 

does not include POUs, function blocks, variables, and so on.  

6.1.1 Example 

When the equipment in this example operates, the parts on the conveyor move from left to right. If a sensor 

senses that a part is under an injector, the PLC sends a trigger signal to the injector, and the injector injects 

the glue. The injection length is set externally and is not controlled by the PLC program . However, the PLC 

program must be able to turn the trigger signal OFF so that the trigger signal can be sent next time. There are 

two injectors above the conveyor, and the two injectors inject glue in the same way. 

There is a sensor at the left side of the conveyor. When a part passes the sensor, the sensor value increases 

by one increment. When the sensor value is 100, the internal completion flag is set to ON. The flag state can 

be used by other procedures later. However, this example does not introduce the use of flag states. 

 

6.1.2 Hardware 

In this example, the AS series CPU module used is the AS332T-A. 

Type ID Description 

Digital input X0.0 START button 

Digital input X0.1 STOP button 

Digital input X0.2 In position sensor 1 

Digital input X0.3 In position sensor 2 

Digital input X0.4 Counting sensor 

Digital output Y0.0 Conveyer 

Digital output Y0.1 Trigger signal for injector 1 

Digital output Y0.2 Trigger signal for injector 2 
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6.1.3 Program 

(1) When the START button (X0.0) switches from OFF to ON, the internal operation flag is set to ON, and the 

conveyor (Y0.0) starts. When the STOP button (X0.1) switches from OFF to ON, an error occurs (the 

error flag is ON), the operation flag is reset to OFF, and the conveyor stops. 

(2) When the in position sensor 1 (X0.2) is ON, the trigger signal for injector 1 (Y0.1) is set to ON. When the 

in position sensor 1 is OFF, the trigger signal for injector 1 is reset to OFF. 

(3) When the in position sensor 2 (X0.3) is ON, the trigger signal for injector 2 (Y0.2) is set to ON. When the 

in position sensor 2 is OFF, the trigger signal for injector 2 is reset to OFF. 

(4) When the counting sensor (X0.4) switches from OFF to ON, the sensor value increases by one 

increment. If the sensor value is larger than or equal to 100, the internal completion flag is set to ON. 

6.2 Procedure for Creating a Project in ISPSoft 

This section shows you the procedure for creating a project in ISPSoft. You can adjust the procedure 

according to your needs.  

 Hardware configuration 

You set the parameters such as a range of latched devices and a port number in a PLC. You configure 

the modules with an AS Series CPU module, and set the parameters in these modules. 

 Network configuration 

If a system uses a network architecture, or devices need to exchange data, use the network configuration 

tool NWCONFIG in ISPSoft to configure a network and exchange data with COM as well as Ethernet.  

 Programming 

After you write a program in ISPSoft, compile the program. If the compiling is unsuccessful, messages in 

the Compile Message page show where the errors occur. 

 Testing and debugging 

Download the compiled program, the hardware configuration, and the network configuration to a PLC. 

You can then test and debug the program online with the functions provided by ISPSoft. 

Because the example introduced in this chapter does not discuss a network configuration, you only perform 

the following procedure.  
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6.3 Creating a Project 

After you start ISPSoft, on the File menu, point to New, and then click New to create a new project. You can 

also create a new project by clicking  on the toolbar after you start ISPSoft. 

 

 
In the Create a New Project dialog box, type a project name in the Project Name box and a path in the 

Drive/Path box, select a PLC in the PLC Type drop-down list box, and then click OK. The PLC in this 

example is the AS332T. 

 

 
After you create the project, a project management area appears at the left side of the main screen. The 

relation between the items listed in the project management area is represented by a hierarchical tree 

structure. If the project management area does not appear, on the View menu, click Workspace , or click 

 on the toolbar. 
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6.4 Hardware Configuration 

After you double-click HWCONFIG in the project management area, the HWCONFIG window appears. 

 

 
In the HWCONFIG window, the default setting is for a CPU module. Refer to Chapter 8 for more information 

on settings for other types of modules.   

When the hardware configuration is complete, download the configuration and the settings to the CPU module 

to take effect. Save the configuration and settings now, and you can download them with the program later in 

the project. After that close the HWCONFIG window.  
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6.5 Creating a Program 

The following sections show you how to create a traditional ladder diagram in ISPSoft. The sections include 

creating a POU, editing a traditional diagram, and compiling a program. 

6.5.1 Adding a Ladder Diagram 

(1) Right-click Programs in the project management area, point to POU (program organization unit), and 
then click New…. 

                   

(2) In the Create Program dialog box, type a program name in the POU Name box, select Ladder Diagram 

(LD) in the Language section, and keep the other default values. Click OK after the setting is complete. A 

new program organization unit (POU) appears under Programs in the project management area.  
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(3) After you add the POU, a program editing window appears in the main working area. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

After the program editing window opens, the corresponding toolbar appears in the window. The list below 

describes the functions. 

 
 

Icon Keyboard shortcut Function 

 None Switches to the address mode 

 Shift+Ctrl+C Display/hides the comments on the networks 

 None Displaying/hides the commands on the devices 

 Shift+Ctrl+B 
Adds a bookmark to the selected network selected or 

deletes a bookmark from the selected network 

 Shift+Ctrl+P Goes to the previous bookmarked position 

 Shift+Ctrl+N Goes to the next bookmarked position 

 Ctrl+I Puts a network above the selected network 

 Shift+Ctrl+I Put a network under the selected network 

 ESC Selects an item 

 Typing an instruction Inserts a contact 

Local symbol table

Program edit ing area
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Icon Keyboard shortcut Function 

 Typing an instruction Inserts a coil 

 Typing an instruction Inserts a comparison contact 

 Typing an instruction Selects a type of comparison contact 

 Typing an instruction 
Inserts a block logic instruction 

(NP/PN/INV/FB_NP/FB_PN) 

 Typing an instruction 
Selects a type of block logic instruction 

(NP/PN/INV/FB_NP/FB_PN) 

 Shift+Ctrl+U Inserts an instruction or a function block 

*. Refer to Section 6.5.3 for more information about typing an instruction. 

 
6.5.2 Basic Editing ─ Creating a Contact and a Coil 

(1) Click  on the toolbar, and then move the mouse cursor to the red frame in Network 1. The mouse 

cursor changes to a contact when the mouse cursor is moved to the left, right, or bottom of the red frame. 

Decide where to insert a contact. If you edit a ladder diagram, the mouse cursor must be near a position 

you want to edit. The system automatically arranges an inserted object; you cannot move the object. 

In this example, you do not need to decide where to insert the contact. Place the mouse cursor near the 

red frame and click the left mouse button. 
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(2) Click  on the toolbar, or press Esc on the keyboard. After you double-click the contact, a list appears. 

The items on the list are Normally Open, Normally Close, Rising-edge Trigger, and Falling-edge 

Trigger. In this example, click Rising-edge Trigger. 

 

 
(3) Click the line at the right side of the contact, click  on the toolbar, and then move the mouse cursor to 

the red frame. The mouse cursor changes to a coil when the mouse cursor is above or under the red 

frame. Decide where to insert the coil. 

In this example, you do not need to decide where to insert the coil. Place the mouse cursor near the red 

frame and click the left mouse button. 
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(4) Click  on the toolbar, or press Esc on the keyboard. After you double-click the coil, a list appears. 

The items on the list are Out, Set, and Reset. In this example, click Set. 

 

 
 

(5) Click ??? above the contact, type a device address in the box, and then press Enter on the keyboard to 

jump to the next box in the network. After you type a device address in the box, press Esc on the 

keyboard to complete the editing. In this example, type X0.0 in the box for the contact, and type M0 in the 

box for the coil. 
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Additional remark 

After you click a network and press Enter on the keyboard, you can edit a box. Press Enter on the keyboard to 

edit the next box in the network. Press Tab on the keyboard to select the next network. Use the keyboard to 

edit boxes. After you finish the editing, press Enter on the keyboard to jump to the next box. Press Esc on the 

keyboard to exit editing. 

If you have declared symbols, click  in a box, or press Page Down on the keyboard when you edit the box. 

The symbols on the drop-down list are the symbols that you can assign to the object. Select a symbol with the 

mouse or the up/down key on the keyboard. Refer to Chapter 6 in the ISPSoft User Manual for more 

information about symbols. 

 

 
6.5.3 Basic Editing ─ Inserting a Network and Typing an Instruction 

Click  on the toolbar to select a network. Click  on the toolbar to place another network above the 

selected network. In this example, Network 2 is under Network 1. 

 

 
Create a contact and a coil by clicking  and  on the toolbar or by typing instructions. 

(1) Click the line in Network 2. 
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(2) Type the IL instruction “LD M0”. This instruction is not case-sensitive. As soon as you type the IL 

instruction,  a box which you can edit appears. After you finish typing the IL instruction, press Enter on 

the keyboard or click OK at the right side of the box. 

 

 
(3) Type the IL instruction “OUT Y0.0”, and write the program shown below. 

 

 
 

Additional remark 

You create a contact and a coil by typing simple instructions. Refer to the description below. The instructions 

typed are not case-sensitive. 

 To Insert a normally-open contact (contact A), type “A <device address>” 
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 To insert a normally-closed contact (contact B), type “B <device address>” 

 

 

 To insert an output coil (OUT), type “O <device address>” 

 

 

6.5.4 Basic Editing ─ Selecting a Network and Operation 

Before you select an object in a network, press Esc on the keyboard, or click  on the toolbar. After the 

cursor appears as a small arrow, click the object in the network. The basic selection shows below. 

 

 Select the network 

 Select the input contact 

 Select the network 

 Select the output coil 

 Select the block 

To select a group of devices, click a device and drag it to draw a frame around the group of devices. You can 

also select the group of devices by clicking the first device, pressing Ctrl+B on the keyboard, clicking the last 

device, and then pressing Ctrl+B on the keyboard. You must draw a frame around devices that are in the 

same network, and the devices must be adjacent to one another. Input and output devices cannot be in the 

same frame. 
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To select several networks, press and hold the Ctrl key on the keyboard and click the networks. You can also 

select a range of networks by pressing and holding Shift on the keyboard, clicking the first network within the 

range, and then clicking the last network within the range. 

 

Right-click an object after selecting it to show the context menu. 

Item Function 

Undo 
Undo the last action. 

You can undo up to 20 previous actions. 

Redo You can redo an action that has been undone. 

Cut Cut a device, block, or network. 

Copy Copy a device, block, or network. 

Paste Paste an object that has been copied or cut into the present position. 

Paste right 
Paste an object at the right side of the selected position. 

The object is connected in series to the selected position. 

Paste under 
Paste an object under the selected position. 

The object is connected in parallel to the selected position. 

Delete Delete a device, block, or network. 

Activate/Inactivate 

Network 

Activate or deactivate the selected network. 

The deactivated network is ignored when you compile the program. 

Fold/Unfold Network Fold or unfold the network section.   

Auto Generate 

Symbols 
Used on the contacts of the function block to generate symbols automatically. 
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Item Function 

Add to Device Monitor 

Table 
Used on the selected contacts to quickly add the device to the Monitor Table. 

 
Proceed with the steps in the example below. 

(1) Select Network 1, then right-click Network 1, and then click Copy. 

 

 
(2) Select Network 2, right-click Network 2, and then click Paste. A copy of Network 1 is put above Network 

2, and Network 2 becomes Network 3. 
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6.5.5 Basic Editing ─ Connecting a Contact in Parallel 

(1) Click  on the toolbar, and then move the mouse cursor to the input contact in Network 2. The mouse 

cursor changes to a contact. Move the mouse cursor to the input contact in Network 2. After the mouse 

cursor changes to , click the left mouse button. This connects a contact in parallel with the input 

contact in Network 2. 

 

 
 
 

(2) Write the program in Network 2 shown below. 

 

 
Additional remark 

After you select a group of contacts, connect a contact to the group of contacts as described above. 
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6.5.6 Basic Editing ─ Editing a Comment 

(1) Press  on the toolbar. Click the position above a device name, type a comment in the box, and then 

press Enter on the keyboard. 

 

(2) Press  on the toolbar. Click the position under a network number, and then type a comment in the 

box. To start a new line of text, press Shift+Enter on the keyboard. Press Enter on the keyboard after the 

you complete the editing. 

 

 

(3) Write the program shown below. 
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6.5.7 Basic Editing ─ Inserting an Applied Instruction 

Add Network 6 under Network 5, and then write the program shown below. Insert an applied instruction in one 

of the three ways described below. 

 

 Method 1 

Click the position where you want to insert an instruction, type the instruction (INC in this example), and 

then press Enter on the keyboard. 

 

 
 Method 2 

Click APIs in the project management area and find the instruction type. 

 

Click the instruction (INC in this example) that you want to insert, and then drag it to the desired position. 
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 Method 3 

Click the position where you want to insert an instruction, click  on the toolbar, select the instruction 

(INC in this example) to insert in the API/FB dialog box, and then click Insert. 

 

After you insert the instruction, assign a device address to the operand, and write the program shown 

below. 
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6.5.8 Basic Editing ─ Creating a Comparison Contact and Typing a 
Constant 

You can insert a comparison contact with the following steps. Add Network 7 under Network 6, and write 

the program shown below. 

 

 
 

(1) Click  on the toolbar, and then select a operator (>= in this example). 

 

 

(2) Click  on the toolbar, and then move the mouse cursor to the position where you want to insert the 

comparison contact. The mouse cursor changes to a comparison contact when you move the mouse to 

the left, right, or bottom of the red frame. Decide where to insert the comparison contact, and then click 

the left mouse button to insert the comparison contact. 

 

 
Write the program shown below. In ISPSoft, K precedes a decimal value and H precedes a hexadecimal 

value. To type a decimal value in ISPSoft, type it directly. To type a hexadecimal value in ISPSoft, type “16#” 

and the hexadecimal value; e.g. 16#7FFF. In ISPSoft, 8# precedes an octal value, and 2# precedes a binary 

value. 
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6.5.9 Writing a Program 

The previous sections introduced creating a traditional ladder diagram in ISPSoft. Write the program shown 

below. Because the program is not yet compiled for the PLC, the mother line at the left side of the ladder 

diagram is colored red while you write the program. The following sections show how to compile and 

download the compiled program for testing. 

 

*1. The program above saves in the folder …\ISPSoft x.xx\Project\Example\Gluing_System_C. 

*2. Refer to Chapter 10 in the ISPSoft User Manual for more information about creating a ladder diagram. 
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6.5.10 Checking and Compiling a Program 

After you write a program, check the syntax of the programming language or compile the program. The syntax 

and structure in the present window are checked after you run the Check function. The system checks the 

entire project after you run the Compile function. If the system does not find any errors in the project, it 

automatically generates execution code. After you successfully compile the program, the mother line at the left 

side of the ladder diagram becomes black. 

 Check 

From the Compile menu, click Check, or  on the toolbar. 

 

 Compile 

From the Compile menu, click Compile, or  on the toolbar. 

 

After you complete the check, the Compile Message page shows the check result. If there are any errors in 

the project, the Compile Message window shows the related message. After you click the message, the 

system automatically shows you where the error occurs. You can run the Check function or the Compile 

function after you correct the error. 
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6.6 Testing and Debugging a Program 

6.6.1 Creating a Connection 

Before you download a program and parameters to a PLC or monitor them online, connect ISPSoft to the 

PLC. In this example, connect ISPSoft to the CPU module AS332T-A with a USB cable. Refer to Section 2.4 in 

the ISPSoft User Manual for more information about connecting ISPSoft to a PLC in other ways. Refer to the 

AS Operation Manual for more information about wiring. 

You can skip this section if you have connected ISPSoft to a PLC successfully as described in Section 
2.4 in the ISPSoft User Manual. 

(1) Install the modules on the main backplane to match the hardware configuration in HWCONFIG. Make 

sure that the wiring is correct, and then power on the CPU module. 

(2) Connect the CPU module to the computer with a USB cable. If the USB driver for the AS series CPU 

module is installed on the computer, Delta PLC appears in the Device Manager window, and a port 

number is assigned to Delta PLC. Refer to Appendix A for more information about installing a USB driver. 

(3) Make sure that COMMGR is started and the icon representing COMMGR is displayed on the system tray. 

If the icon representing COMMGR is not displayed on the system tray, start COMMGR by clicking the 

shortcut on the Start menu (Start > Programs > Delta Industrial Automation > Communication > 

COMMGR). 

 

(4) Double-click the icon representing COMMGR on the system tray to open the COMMGR window. Click 

Add in the COMMGR window to create a driver. 
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(5) Set the parameters in the Driver Properties dialog box, and then click OK. 

 

 Type a driver name in the Driver Name box. 

 Select USB (Virtual COM) in the Type list in the Connection Setup section. 

 Select a communication port in the COM Port list. If the first two steps are complete, the connected 

PLC and its communication port display in the COM Port list. 

 Select the number of times to retry the sending of a command if a connection error occurs in the Time 

of Auto-retry box, and select a retry interval in the Time Interval of Auto-retry box. 

(6) After you finish the setup, USB_Driver appears in the COMMGR window. When the connection is normal, 
OK appears in the Status column.  

 

(7) Click the driver you created in the COMMGR window, and then click Start. Start ISPSoft, and then on the 

Tools menu, click Communication Settings…. In the Communication Setting dialog box, select the 

driver you created in the Driver list, select 0 in the Station Address list, and then click OK. The driver 

information displays in the ISPSoft status bar. 
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(8) On the PLC menu, click System Information. ISPSoft retrieves related information from the PLC. If the 

computer communicates with the CPU module normally, the related information retrieved from the PLC 

displays in the System Information dialog box. 
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6.6.2 Downloading a Program and Parameters 

If ISPSoft is correctly connected to a PLC, you can download the parameters and program in the project to the 
PLC. First, start ISPSoft and open the project you created in the previous sections. In this example, you 
download two types of parameters to the CPU module: hardware configuration and the program itself. 

 Downloading the hardware configuration 

(1) Double-click HWCONFIG in the project management area to open the HWCONFIG window. 

 

(2) The hardware configuration displays in the window. Before you download the hardware configuration 
to the CPU module, make sure the actual hardware configuration is the same as the hardware 
configuration in the window. 

(3) Click Download under the Communication tab to see the Download page. Select the PLC 
parameters that you’d like to download to the PLC and then click OK to download. 
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(4) After you successfully download the hardware configuration to the CPU module, the BUS FAULT 

LED indicator on the CPU module is OFF. Close the HWCONFIG window. If the BUS FAULT LED 

indicator on the CPU module is still ON or blinking, the CPU module is in an abnormal state. Make 

sure the actual hardware configuration is the same as the hardware configuration in the HWCONFIG 

window, and refer to the operation manual for more information about eliminating the error. Refer to 

Chapter 8 for more information about HWCONFIG. 

  

 

 

Download Not Download Run Stop 
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 Downloading the program 

After the program is compiled, select Transfer under the PLC tab and click Download to see the 

Download page. You can also click  on the toolbar to see the Download page. Select the Program 

and the Comments so that you can upload the program in the CPU module later, and then click Transfer 

again. 

 

 

6.6.3 Connection Test 

After you download a program to a PLC, you can monitor the execution status of the PLC through ISPSoft. 

ISPSoft provides two monitoring modes; device monitoring mode and program monitoring mode. 

Monitoring mode Description 

  

Device monitoring mode 

You can monitor the status of the devices in the PLC through the 

monitoring table. In this mode, ISPSoft updates only the status of the 

devices. The current program in ISPSoft does not have to be the same as 

the program in the PLC. 

  

Program monitoring mode 

In this mode, the operating status of the program is displayed in the 

program editing window. The present program in ISPSoft must be the 

same as the program in the PLC. 

*. You can enable the device monitoring function without program monitoring; however, if you enable the program 

monitoring function, the device monitoring function is also enabled. 
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On the PLC menu, click Online Mode, or  on the toolbar, to enable the online monitoring function. The 

system also enables device monitoring mode and program monitoring mode. 

 

In the online monitoring mode, you can view the present scan time, the communication status, and the status 

of the PLC in the status bar in ISPSoft. 

 

The present status of the devices display in the original program editing window after you enable the program 

monitoring function. 

 

You can change the operating state of a PLC with the RUN/STOP switch on the PLC. You can also change the 

operating status of a PLC with the functions provided by ISPSoft. On the PLC menu, click Run or  on the 

toolbar to start the PLC. On the PLC menu, click Stop or  on the toolbar to stop the PLC. 
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In the online monitoring mode, you can select a device, then right-click the device, and the click a command 

on the context menu. During a test, you can change the status of a device or the value in a device by clicking 

an item on the context menu. 

 Before you change the status of a device, make sure the operation does not cause damage to 

equipment or personnel. 

 

The table below describes the items in the context menu. The Force command only applies to input and 

output contacts. 

Item Description 

Set On Set the contact selected to ON 

Set Off Set the contact selected to OFF 

Rising-edge Trigger 
No matter what the state of the selected contact is, the system sets the contact 

to OFF, and then sets it to ON. 

Falling-edge Trigger 
No matter what the state of the selected contact is, the system sets the contact 

to ON, and then sets it to OFF. 

Force Force an input contact or output contact ON or OFF 

Force Device List Force several input contacts or output contacts in the tables ON or OFF  

To change the value in a device, right-click the device, click Change Present Value, and set a present value 

in the Enter Present Value dialog box. 
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The list below describes the Enter Present Value dialog box. 

 

 Message 

 Type a 16-bit, 32-bit or 64-bit value. 

 Type a value in the Present Value box. 

 Type the name of a device or a symbol whose present value you want to change 

 Value change history (Format: Device name Value) 

 In binary mode, use the mouse to set the bit states. 

 Click OK to apply the setting values. Click Cancel to close the window without applying the values. 

 Display or hide binary mode. 

In this example, X0.0–X0.15 and Y0.0–Y0.15 are input and output devices assigned to the digital I/O module 

AS332T-A. After you download the hardware parameters to the CPU module, the states of X0.0–X0.15 are the 

same as the states of the inputs on the actual module. Even if you set X0.0–X0.15 to ON or OFF in the 

program editing window, the actual input signals update the states of X0.0–X0.15. 
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However, you can force an input contact ON or OFF during a test. Click an input or output contact to set, right-

click the contact, point to Force, and click On (X/Y), Off (X/Y), Release (X/Y), or Release All. If you force an 

input or output contact ON or OFF, a lock symbol appears at the left side of the contact. 

 
 
 

Force Description 

On (X/Y) Force the selected input or output contact ON 

Off (X/Y) Force the selected input or output contact OFF 

Release (X/Y) Release the contact from the locked state 

Release All Release all the contacts from the locked states 

 

If you force an output contact in the program ON or OFF, the program execution result does not affect the 

output state of this contact. 

 

*. If you disable the online monitoring function, the contacts are not automatically released from the locked states. 

You must check whether the contacts need to be released from the locked states after you complete the test. 

You can create a monitoring table online or offline. 

 

 Method 1 

On the PLC menu, click New Devices Table, or  on the toolbar. 
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 Method 2 

Right-click Device Monitoring Table in the project management area, and click New. 

 

Type a table name in the Add Monitor Table dialog box, and then click OK. An item appears under Device 

Monitor Table in the project management area. Double-click the item to open the monitoring table. You can 

create several monitoring tables in the project, and the monitoring tables are saved with the project. 

 

 

After you double-click the item, a item monitoring window appears. You can add items to be monitored to the 

window. To add an item to the window, double-click the blank space in the monitoring table, type a device 

name, type a start address, and the number of devices to be monitored in the Device Monitor Input dialog 

box. You can add up to 100 items to a monitoring table. 
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Press Insert on the keyboard to switch between inserting and replacing an item in the monitoring table. The 

selected mode displays in the status bar in ISPSoft. 

If you select insert mode, the new item is added above the selected item in the monitoring table. If you select 

replacement mode, the new item overwrites the selected item in the monitoring table. 

 

To hide certain columns in the monitoring table, right-click the monitoring table, point to Set the Fields, and 
clear certain items. After you clear an item, the corresponding column disappears. 
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The following describes the columns in the monitoring table. 

Column Description 

Source Source of a symbol 

Identifier Identifier of a symbol 

Device name Name of a monitored device  

Status State of a monitored bit device or a contact (ON or OFF). 

Data type Data type of a monitored symbol. 

Value (16 bits) In online mode, displays a 16-bit value. 

Value (32 bits) In online mode, displays a 32-bit value. 

Value (32-bit 

floating-point 

value)  

In online mode, displays a 32-bit floating-point number. 

Value (64-bit 

floating-point 

value)  

In online mode, displays a 64-bit floating-point number. 

Radix Select a format to represent a value. 

Comment Display the comments on a device or on a symbol. 

After you create the monitoring table, you can monitor the items in the monitoring table in online mode. Right-

click an item in the monitoring table in online mode to display a context menu which is the same as the context 

menu in the program editing window. You can change the item state or the item value by clicking an item in 

this context menu. 

 

You can text and debug the program you created in this chapter through the monitoring table you created in 

this section. Refer to Chapter 18 in the ISPSoft User Manual for more information about testing and debugging 

a program.  
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6.7 Setting a Real-time Clock 

After you connect an AS Series CPU module to a computer, you can set the real-time clock in the CPU 

module through ISPSoft. 

(1) On the Tools menu, click Set RTC. 

 

 

(2) Select Computer, and then click Synchronize to complete setting the real time clock. 
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7.1 Overview of Memory Cards 

The AS Series CPU modules support standard MicroSD cards that meet the specifications in this chapter. This 

chapter describes the specifications and usage for the MicroSD cards supported by the AS series CPU 

modules. 

7.1.1 Appearances of Memory Cards 

SD cards are classified into three types according to size: SD cards, MiniSD cards, and MicroSD cards. AS 

Series CPU modules support MicroSD cards. 

 

7.1.2 Memory Card Specifications  

SD cards are also classified into three types according to capacity: SD cards, SDHC cards, and SDXC cards. 

The AS Series currently only supports a maximum of 32GB in FAT32 format. SD card families are shown in 

the table below. The Micro SDHC in the SDHC column indicates the specifications supported by the AS 

Series. Be sure to purchase products that meet these specifications. 

 SD card families  

Type SD SDHC SDXC 

Capacity 32MB~2GB 4GB~32GB 32GB~2TB 

File 

system 
FAT16/FAT32 FAT32 exFAT（FAT64） 

Size SD SDHC Mini SDHC Micro SDHC SDXC Micro SDXC 

Speed 

class 

rating 

N/A 

CLASS 2 (Min. 2MB/Sec.) 
CLASS 4 (Min. 4MB/Sec.) 
CLASS 6 (Min. 6MB/Sec.) 

CLASS 10 (Min. 10MB/Sec.) 

CLASS 2 (Min. 2MB/Sec.) 
CLASS 4 (Min. 4MB/Sec.) 
CLASS 6 (Min. 6MB/Sec.) 

CLASS 10 (Min. 10MB/Sec.) 
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7.2 Before using a Memory Card 

7.2.1 Formatting a Memory Card 

You may need to format a new SDHC memory card with the FAT32 file system before you use it for the first 

time.  You cannot use an unformatted SDHC memory card in an AS Series CPU module. 

The following example introduces the most common way to format an SDHC card: formatting an SDHC card 

through a card reader. Also carefully read the documents provided by the SDHC card manufacturer. 

 

(1) Insert the SDHC card into a card reader. The operating system detects a new storage device. 

(2) Right-click the new storage device, and then click Format. 

(3) You must format the memory card with the FAT32 file system. Do not change any other default settings. 

Click Quick Format, and then click Start. 

(4) After you click OK in the warning window, the SDHC card formats. 

 

  

When you format a memory card, you also delete all the data in the memory card. Verify whether you 
need to back up the data in a memory card before you format the memory card. 
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7.3 Installing and Removing a Memory Card 

7.3.1 Memory Card Slot in a CPU Module 

The memory card slot is on the front side of the AS Series PLC.  

Memory Card Slot

 

7.3.2 Installing a Memory Card 

Insert a memory card into the CPU module memory card slot and push it in until it clicks. Be sure the memory 

card is fixed firmly in the slot; if the memory card is loose, it is not installed correctly. The memory card can 

only be inserted in one direction. Do not force the memory card or you may damage the CPU module. The 

correct way to insert the memory card is shown below. 

 

 
 
 

 

 

 

 
 
 

 

 

 

7.3.3 Removing a Memory Card 

You can remove a memory card by pushing it in. The card then springs from the slot. 
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7.4 Memory Card Contents  

7.4.1 Initializing a Memory Card 

When you insert an SDHC card into a CPU module that is powered on, and use ISPSoft -> CARD Utility to 

back up a project, the system initializes the SDHC card, and creates a default folder named according to the 

model of the CPU module. (If the folder is already existed, the system does not create a second folder for the 

same model.)  

When the system initializes an SDHC card, it automatically adds any missing folders to the directory structure. 

However, if the initialization of a SDHC card fails, you cannot initialize the SDHC card again until you reformat 

it.  

When you initialize a memory card, the SYSTEM indicator in the software blinks. 

 

7.4.2 Folder Structure in a Memory Card 

The image below shows the default folder group created by an AS System. The folder name is AS200/300. 

Several subfolders are contained inside the AS200/300 folder. Related files created by you and the AS system 

are stored in the subfolders. 

 

PLC CARD SDCard AS300 Firmware 

Log 

SysDup 

DevMem 

Setup 

UserProg 
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Folder Description 

Firmware Stores firmware files (.ext) 

You can store firmware file here for a firmware upgrade; after that use 

the USB port on the computer to connect to the USB port of the AS 

Series PLC CPU for a firmware upgrade.  

Log Stores Log files (.log) 

SysDup Stores backup files (.dup) 

UserProg Stores device memory files (.txt, .dmd, .csv) 

DevMem, Setup Reserved for the system use 
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7.5 Introduction to the CARD Utility 

The AS Series CPU modules include SDHC slots, and you can back up and restore PLC CPU data with a 

memory card. ISPSoft includes the CARD Utility for the AS Series CPU modules. With this utility, you can back 

up and restore data in an AS Series CPU module or backup and restore an ISPSoft project. The backup can 

include the program code, parameter settings, hardware configuration, network configuration, and the values 

in the latched area in an AS series CPU module. Refer to AS Series Manuals for more information about the 

specifications and usage of SDHC cards with AS Series CPU modules. 

For AS Series PLC CPU firmware V1.08.20 or previous versions, the PLC CPU backs up and restores the 

following data: 

 Programs includes PLC execution code, PLC programs, project password, and PLC ID. 

 Parameters includes HWCONFIG settings, configurations of CPU module and modules, data exchange 

table, and positioning planning table. 

 Retainable data includes device setting range, values in retainable devices.  

Note: Ethernet/IP and CANopdn DS301 data exchange tables created by the network planning tool cannot be 

backed up or restored.   

For AS Series PLC CPU firmware V1.10.00 or later versions, the PLC CPU backs up and restores the above-

mentioned data and the following data: 

 User Language C execution code 

 Device default value table 

 E-CAM table 

 Data Logger parameters 

 Ethernet/IP Tag 

 Ethernet/IP data exchange table 

 OPC UA Tag  

 IOLINK device parameters of AS04SIL  

 CANopen DS301 data exchange table 

 

NOTE: if the backup file created by the PLC CPU whose firmware is different from the one you are going to 

perform restoring, things will be like one of the followings:  

* Backing up on the older firmware version of the PLC CPU and restoring to a later firmware version of the 

PLC CPU: Backup file can be restored on the later firmware version of the PLC.  

* Backing up on the later firmware version of the PLC CPU and restoring to an older firmware version of the 

PLC CPU: Backup file can NOT be restored on the older firmware version of the PLC. It is suggested to 

upgrade the PLC firmware or use a backup file created by the same firmware version of the PLC CPU to 

perform restoring.  
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The list below describes the functions supported by the CARD Utility, including a flowchart. 

 If you export data from an AS Series CPU module as a backup file (*.dup), you can save the exported data 

in the memory card in the module or in a folder on the computer. You can also decide whether to back up 

the values in the devices in the AS Series CPU module. 

 If you export an ISPSoft project for an AS Series CPU module as a backup file (*.dup), you can only save 

the exported ISPSoft project in a folder in the computer. You can see data such as register editing (*.dvl), 

device status editing (*.dvb), file register editing (*.wft) for the AS Series as values in the device and back 

them up. You can put a memory card with the backup file into the AS series CPU module. You can copy a 

backup file (*.dup) saved on the computer into the AS series CPU module connected to the computer, or 

restore the backup file to an ISPSoft project. If you choose to restore the backup file to an ISPSoft project, 

the system automatically skips the values in the devices and the hardware configuration in the backup file.  

 If you restore the backup file (*.dup) from the PC to an ISPSoft project for an AS Series CPU module, you 

can also restore data such as register editing (*.dvl), device status editing (*.dvb), and file register editing 

(*.wft) for the AS Series.  

 

Double-click CARD Utility in the project management area to open the CARD Utility wizard. After selecting 

the controller type, click “Next” to proceed.  
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7.6 Backing Up a Project 

If the backup source or backup destination is an AS Series CPU module or memory card, make sure that 

ISPSoft is connected to the AS Series CPU module. During backup, the CPU LED and Error LED blinks 

alternatively and SM452 flag is ON. After the backup is done, the CPU LED and Error LED stops blinking and 

SM452 flag is OFF. Refer to Section 2.4 in the ISPSoft User Manual for more information. 

(1) Select the Backup (To DUP File) option button in the CARD Utility wizard and then click Next. 

 

(2) Select a backup source, and then click Next. 

a. If you select the CPU (Need Connection), the backup file is stored in the memory card.  
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b. If you select the ISP Project (Compiled and saved), the backup file is stored in your computer. Click 

 and select an isp file in the Open dialog box. If the program in the isp file selected is not compiled, a 

message appears when you back up the isp file. Open the isp file with ISPSoft, compile the program in 

the isp file, and then save the isp file. After the program in the isp file is compiled, you can back up the isp 

file. 

 

(3) After you select CPU (Need Connection) / ISP Project (Compiled and saved), click Next,  

a. If you select the CPU (Need Connection), a prompted window appears. And you need to decide 

whether to back up the values in devices on the AS Series CPU module that is connected to ISPSoft. 
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b. If you select the ISP Project (Compiled and saved), the backup file is stored in your computer. Click 

 and select an isp file in the Open dialog box and then decide the file path where you’d like to store 

the backup file in your computer and then define its file name.  

 

 
(4) Select a backup destination. If the backup source is an ISPSoft project, the backup destination must be a 

computer. 

a. If you select Memory Card (PLC Side), the filename of the backup file is AUTOEXEC.dup, and the 

backup file paths for AS200 and AS300 are shown below.   

AS200: Root directory of the memory card\SDCard\PLC CARD\AS200\SysDup\AUTOEXEC.dup  

AS300: Root directory of the memory card\SDCard\PLC CARD\AS300\SysDup\AUTOEXEC.dup 

 

 

 



Chapter  7  Memory Card 

 7-13 

7_
 

b. If you select PC (DUP File), click , select a folder in the Save in list in the Save As dialog box, 

and type a filename in the File name box. When you select the backup source for the ISPSoft 

Project, set the PLC password. You can set the password to be the same as the Project password, 

set a new PLC password, or not set a PLC password. If you do not set a password for the Project, 

the PLC password is also not set. When you select Setting new PLC password, the wizard looks 

like the following image. And you can set new PLC password and number of the attempt times.  

 

 
(5) After that you can see the summary. Make sure that the summary in the CARD Utility wizard is consistent 

with the data backup you want to perform, and then click Execute.  
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(6) The AS Series CPU module still performs the data backup even if you click Cancel. You can turn off the 

AS Series CPU module to stop the data backup; however, the backup file produced is not a complete 

backup file, and you must delete the backup file from the memory card. 

If you select Memory Card (PLC Side), the filename of the backup file is AUTOEXEC.dup, and the 

backup file path is Root directory of the memory card\AS300\SysDup\AUTOEXEC.dup. If there is an 

old backup file in the memory card, the Warning message appears. Click Replace, Archive, or Cancel in 

the Warning message. 

 

If the backed up data is protected by passwords, these passwords are also backed up. 

Data backup Description 

CPU module  Memory card 
The backed up data includes the PLC ID and the PLC password set 

in the CPU module. 

ISPSoft project  Computer 
The backed up data includes the program ID and the project 

password set in the ISPSoft project. 

(7) After you perform the data backup, click Home or Close in the CARD Utility wizard. 
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7.7 Restoring a Project 

If the restoration source or restoration destination is an AS Series CPU module or memory card, make sure 

that ISPSoft is connected to the AS Series CPU module. During restoration, the CPU LED and Error LED 

blinks alternatively and SM452 flag is ON. After restoration is done, the CPU LED and Error LED stops 

blinking and SM452 flag is OFF. Refer to Section 2.4 in the ISPSoft User Manual for more information. 

(1) Select Restore (From DUP File) in the CARD Utility wizard and then click Next.  

 

(2) Select a restoration source, click  and then select a backup file to be restored. 

a. If you select Memory Card (PLC side) (Need Connection), the backup files in the memory card 

display in a window after you click . Double-click a backup file in the window to choose it. 
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b. If you select PC (Need Connection), the backup files in the PC display in a window after you click 

. Double-click a backup file in the window to choose it. 
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(3) Select a restoration destination, and then click Next.  

a. To put the selected backup file into the AS Series CPU module, select CPU (Need Connection). If 

the restoration source is the CPU (Need Connection), the restoration destination must be the AS 

Series CPU module.  

 

b. If you select ISP Project, click , and then specify a filename and a path. If the path specified point 

to a file that already exists, the file is overwritten when you restore the data. 
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(4) Make sure that the summary in the CARD Utility wizard is consistent with the data restoration you want 

to perform and then click Execute. 

 

If you click Cancel in the process of restoring data to the AS Series CPU module, the data is not 

completely restored. The AS Series CPU module still performs the data restoration even if you click 

Cancel in the process of restoring a backup file in the memory card. You can turn off the AS Series CPU 

module to stop the data restoration from being performed. To prevent the AS Series CPU module from 

operating incorrectly, restore the AS Series CPU module to the factory setting, or perform the data 

restoration again.  

The restoration source or restoration destination may contain a password and an ID. The following table 

describes the password and the ID process. 

Data restoration Description 

Memory card 

 PU module 

a. The ID in the backup file must be the same as the ID in the CPU module; 

otherwise the data is not restored. 

b. If there is a PLC password in the CPU module, the password in the backup 

file must be the same as the PLC password in the CPU module. Otherwise 

the data is not restored. 

c. If there is no PLC password in the CPU module, and there is a password in 

the backup file, the system restores the data, and the password in the backup 

file becomes the PLC password in the CPU. 

Computer 

ISPSoft project 

The ID and the password in the backup file become the program ID and the 

project password in the ISPSoft project. 
 

(5) After you perform the data restoration, click Home or Close in the CARD Utility wizard.  
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7.8 Restoration Starts Once CPU is supplied with Power 

When the backup file in the memory card is consistent with the specific path and file name, the CPU can 

perform restoration once it is supplied with power. During restoration, the CPU LED and Error LED blinks 

alternatively and SM452 flag is ON. After restoration is done, the CPU LED and Error LED stops blinking and 

SM452 flag is OFF.  

Operation Steps: 

(1) Set up the backup file path and file name for the memory card backup file. The filename of the backup file 

is BACKUP.dup and the backup file paths for AS200 and AS300 are shown below.   

AS200: Memory card root directory\SDCard\PLC CARD\AS200\SysDup\AS300_BACKUP.dup  

AS300: Memory card root directory\SDCard\PLC CARD\AS300\SysDup\AS300_BACKUP.dup 

Insert the memory card into the card slot when the CPU power is off.  

(2) When the CPU power is on, it automatically checks if the memory card data is consistent with the PLC 

data. If not, the restoration begins. The data check is specifically on the data in CPU programs and 

HWCONFIG parameters.     

(3) During the restoration, the CPU LED and Error LED blinks alternatively. Once the restoration is done, the 

blinking stops.  
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7.9 CPU Error Log  

The system stores CPU error messages in the memory card whenever the quantity of the error messages 

reached to 20. You can also use special flag SM36 and special device SR36 to read the CPU error messages 

and state change logs. If there is error logs recorded in the memory card, the memory card keeps storing the 

error logs. You can change the file path to store other error logs or change the file name to store other error 

logs.   

Special Device Function Code Description 

SR36 

a. when the value is 0, it indicates there is no recording.  
b. when the value is 1234, it indicates the logs are stored in the memory card.  
c. when the value is 3456, it indicates the error logs and state change logs are stored 

in the memory card.  

 

Operation Steps to read CPU error logs and state change logs: 

Make sure the memory card is in the slot before reading the CPU error logs and state change logs.  

(1) Set SM36 to ON and the value in SR36 to 1234 or 3456 to read the CPU error logs and state change 

logs.  

(2) The root directory path of the memory card for the error log is  

AS200: Memory card root directory\SDCard\PLC CARD\AS200\Log\Error.log  

AS300: Memory card root directory\SDCard\PLC CARD\AS300\Log\Error.log 

Use ISPSoft to read the error logs. ISPSoft Tools -> Review Error Log File -> Open Log File  

The root directory path of the memory card for the status log is  

AS200: Memory card root directory\SDCard\PLC CARD\AS200\Log\STATUS.log 

AS300: Memory card root directory\SDCard\PLC CARD\AS300\Log\STATUS.log 

(3) Use ISPSoft to read the status logs. ISPSoft Tools -> Review Error Log File -> Open Log File  
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8.1 Hardware Configuration Tool for AS Series Modules - 
HWCONFIG 

HWCONFIG is a built-in hardware configuration tool in ISPSoft. You can configure CPU and module parameters, 

download/upload parameters, detect a hardware configuration online, and make a diagnosis through HWCONFIG. 

The examples used below are from HWCONFIG 4.0 (ISPSoft V3.11). Refer to previous versions of ISPSoft Manual or 

AS Series Operation Manual for the operation examples on the previous versions of HWCONFIG.  

You must download all parameters set in HWCONFIG to the CPU module for them to take effect.  

The data exchange area set in HWCONFIG for modules cannot be used repeatedly for other communication 

data and vise versa.  

 

8.1.1 Introduction of the HWCONFIG Environment  

In ISPSoft, double-click HWCONFIG in the project management area to start HWCONFIG. 
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 Window Title: Here shows the current project name and the program name.  

 Tool Bar: There are 6 tabs on the tool bar. 

 Project Tree: Tree-structured projects for easier management 

 Output Message Section: Here shows project related information. 

 Status Bar: Here shows the connection status and the communication parameters. 

 Hardware Configuration Area: You can set up hardware configuration here. 

 Edit Area: You can set up parameters for PLC CPU and modules. 
 Product list: Available hardware is listed in the catalog.  
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8.1.2 Configuring a Module 

8.1.2.1 Adding a Module 

 Method 1 

Double-click the module you want to add in the project or select it from the Product List and drag that module to the 

desired position. There will be a suggestive dotted line to indicate the legitimate position for the selected module. 
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 Method 2 

(1)  Double-click a vacant slot or right-click the slot and choose Add.  

 

 
(2)  Double-click the selected module to add. You can repeat these two steps to add more   
     modules in.  
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 Method 3 

In the Product List section, double-click the selected module or select the desired module and press Enter on the 

keyboard to add the selected module in the hardware configuration area.    
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 Add More Modules at the Same Time 

In the Product List section, right-click the selected module that you need for more than one, and you will see the 

context menu showing three options Expand All, Collapse All, and Add Multiple. Click Add Multiple, and then an 

Add Multiple Modules (your desired module name) window appears, use the up and down arrows to increase or 

decrease the quantity number that you need and then click OK to confirm the setting.   
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8.1.2.2 Replacing the Module 

The following steps show you how to replace the module.  
(1) Select and right-click the module for replacement in Hardware Configuration area or from CPU Group 

Information section.  

 

 
(2) Choose Replace on the context menu. After that you can see two different types of replacements for selection, 

Same Type and All Type.    

 

 
 Same Type 

Replace only the selected module with the same type module. The new module Input/Output Device 

Range will be the same, while other parameters may return to system defaults if they cannot be matched.  

  All 

Replace selected module to be any type of module. The result is similar to deleting the original module by 

adding a new one, so the new module Input/Output Device Range will be re-configured and other 

parameter settings will also return to system defaults.  
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(3) Once the replace type is selected, the Module Selection window appears with modules available for the 

selected replace type. Double click or select the module you want to replace with and click OK.   

 

 

8.1.2.3 Rearrange Module Position by Drag and Drop 

Except CPU modules, you can drag and drop all module graphics in Hardware Configuration area to rearrange their 

positions.  

AS Series PLC is non-backplane designed. When the module is dragged to a position between two modules, a red 

arrow mark appears indicating the position where the module will be after dropping.   

 

 

* When rearranging the module position, the input/output device range, comment, internal parameters, corresponding 

device D and advanced parameters for intelligent modules are also rearranged with the module. 
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8.1.2.4 Remarks and Comments 

 Remarks for the project 

Click Remarks field on the top of the Hardware Configuration area and a blank box appears for you to leave 

remarks for the project. After typing the remarks, press Enter on the keyboard or click Close to save the remarks.  
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 Comments for PLC CPU and Modules 

Click the module graphic and you can see its details in the Edit Area. You can leave comments for the PLC CPU and 

Modules. After typing the comments, it saves the comments automatically.  
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8.1.2.5 Hardware Configuration Area – Reset Configuration 

Use the functional button Reset Configuration to set the PLC configurations back to default values  
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8.1.2.6 Hardware Configuration Area – Show Information 

Use the functional button Show Information to show / hide the hardware configurations  

  

 

8.1.2.7 Hardware Configuration Area – Input / Output Device Rearrange 

Use the functional button Input / Output Device Rearrange to rearrange the device ranges and assign the devices to 
the very beginning of the range. 

 



AS Ser ies  Hardware  and  Operat ion Manual   

 8-14 

_8 

8.1.2.8 Assigning I/O Addresses  

The AS Series does not support manually assigned addresses. Addresses are automatically assigned to an 

input/output module through HWCONFIG in ISPSoft. You assign a start address to the first remote module installed 

on the right side of the I/O module slot (SCM module). The following I/O module is automatically assigned with the 

next address. For remote module configuration, refer to Section 8.1.2.9 for more details. 

The following table shows the addresses (devices) that are automatically assigned to an input/output module through 

HWCONFIG in ISPSoft. Refer to the following table to see the actual allowable range for program design, while 

editing a PLC program. Below, local indicates the IO module is connected on the right side of the CPU and Remote 

indicates the IO module is connected on the right side of remote module. 

Module type 
X/Y 

device range 
D device range Remark 

Digital module 

(DIO) 

Input points: 

X1.0 ~ X63.15 

 

Output points: 

Y1.0 ~ Y63.15 

Local: D28000 ~ D28999 

Remote: D29000 ~ D29999#1 

Each module takes 20 devices.  

Data device number will not be 

shown; it is only for PLC internal use.  

Maximum points in total: 1024 points. 

For modules with less than 16 points, 

they will be counted as 16 points.  

Analog module 

(AIO) 
N/A 

Local: D28000 ~ D28999 

Remote: D29000 ~ D29999#1 

Each module takes 20 devices. 

Up to 16 AIO modules are 

configurable.  

Positioning 

module (PIO) 

 

N/A 

Local: D28000 ~ D28999 

PU module takes 40 devices. 

HC module takes 20 devices. 

Up to 8 PIO modules are configurable 

locally, but not available remotely.  

Network 

module (NIO) 
N/A 

Local: D28000 ~ D28999 

Remote: D29000 ~ D29999#1 

Each module takes 20 devices. 

Up to 4 NIO modules are 

configurable locally. SCM module can 

be used as remote module but not on 

the right-side of the remote module.  

DNET modules can only be 

connected locally.  

SIL modules can either be used 

locally or remotely.  

Communication data area:  

D26000 ~ D27599 

Each module takes 400 devices. 

Note: #1: the remote module itself also takes 20 devices.  

  



Chapter  8  Hardware  Conf igurat ion  

 
 

8-15 

_8  

8.1.2.9 Hardware Configuration Area - Change Input Device Range of the Remote 

Modules 

Click the remote module and then you can see  in the column of Input Device Range. Double-click it to see the 

Manual Assignment window and start editing your desired input device range.     
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8.1.2.10 Hardware Configuration Area - Resize 

Use the functional buttons  ,   or   to rearrange the size of the device images in 

Hardware Configuration Area. Use  to set the display of the configuration area back to its default values 

(shown at 100% and in the center). 
 

 

 

8.1.2.11 Edit Area – Import and Export 

You can import/export the module parameters in .dep format. Click the Import button and then choose a file to import. 
Click the Export button and then choose a path and enter a file name for the exported file. Click the Import button to 
import. When importing, the system checks if the file format and the module name are matched. If not, an error message 
shows up. If the addresses of the imported data device are already taken, the addresses will be assigned to other 
available addresses.  
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8.1.2.12 Edit Area – Update 

To update the module parameters, first you need to be in the online mode. Select the module that you want to update 
its parameters and then click the Update button. This functionality is only available for digital IO modules, analog IO 
modules and network modules.   

 

 

8.1.2.13 Show or Hide the Display 

Click  or  to hide the display area and after that only its tab remains shown. Move your cursor to the tab to 

have the hidden display area shown. Click  to pin and lock the display area to keep it shown.  
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8.1.2.14 Module State and Diagnosis 

To check the module state and diagnosis, first you need to be in the online mode. Right-click the module that you want 

to check its module state and diagnosis and then a context menu appears.  

 

After you click Diagnosis, you can see a table with three tabs. On the Diagnosis tab, you can see the Current Error Log 

table. When the error is cleared, you can use  to clear the error log stored in the module and the module state 

can be restored to normal. Use  to update the module state.  

8.1.2.15 Change Module State in Online Mode 

You can change the module state in online mode.  

 Before changing the module state, make sure no personnel or system will be affected.  

 Change the module operation state 

Right-click the PLC CPU to see the context menu and click Run for the PLC CPU and module to start running (RUN 

LED ON) or click Stop for the PLC CPU and module to stop running. 
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 Change the module I/O state 

This functionality is only available for digital IO modules, analog IO modules and temperature modules. Right-click the 

module to see the context menu and click Module State and then you can see an IO state table shows up. For digital 

IO modules, you can right-click to set the input/output channel to ON or OFF, when the PLC CPU and the module are 

on the RUN state.  

 

 

 Force to ON：Force to set the channel state to ON 

 Force to OFF：Force to set the channel state to OFF 

 Release：Release the selected channel from the force 

 Release all：Release all channels from the force 
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8.1.2.16 Configure a Remote Module 

Drag AS-FCOPM from the Product List to the Function Card Slot 2 of the PLC CPU. After that you can set the Working 

Mode for the AS-FCOPM as AS Remote Communication and then you can set the quantity of the Remote Modules that 

you want to connect.  

 

If you set the Remote module count to 2 and click OK, you can see two remote modules connected to the PLC CPU.  
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You can add more digital IO modules or analog modules to the remote module.  
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And then you can click the module to open its configuration page to configure.  

 

 

8.1.2.17 Open Communication Software from HWCONFIG 

Right-click the PLC CPU and click Communication Software to see which software is available for this PLC CPU. If 

the software option is grayed out, you may need applicable function cards to work along with the project. 
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8.2 Setting the Parameters in an AS Series CPU Module 

8.2.1 System Settings – System Information 

In the Edit Area, select the option System Settings and you can find two items, PLC Label and Comment under this 

option. You can input up to 16 characters in the value field of PLC Label and 32 characters in the value field of 

Comment. You can use all in the fields, including special characters and spaces. Note: One Chinese character 

occupies two characters. characters 

 

 

After the project is created, you can find the PLC label behind the product name in the project management area. 

You can change the PLC label in HWCONFIG as it is mentioned above. The PLC label is very useful when you have 

more than one PLC in the project. This label can be seen as the PLC identity. So that you will not change other PLC 

parameters by mistake. To prevent errors, when you download/upload the program, the system will remind you to 

check the name of the PLC CPU and the PLC label. 
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8.2.2 System Settings – System Parameter 

The parameters on System Parameter table are shown in the following window. You can set appropriate values via a 

drop-down list or type the values in the box. 

 

 Clear Non-latched area when Stop Run 

This determines whether the states and values of the non-latched devices are cleared when the PLC changes 

from Stop to Run. 

 Disable: All the states and values in the non-latched devices stay the same. 

 Enable: All the states and values in the non-latched devices are cleared and restored to defaults. 

 

 Y keeps outputting when RUN Stop 

This determines the states of the Y devices when the CPU module begins to run or stop.  

 Off: All Y devices are set to OFF. 

 Keep: The states of the Y devices stay the same. 

 

 I/O allocation setting when Power On 

This determines whether the CPU module is automatically configured, or you configure the parameters in 

HWCONFIG.   

 Auto: Operates based on actual connected modules without any module and parameters set. 

 Manual: You configure the parameters in HWCONFIG and PLC checks the parameters automatically once it 

is supplied with power. 

 Manual + Flags (only I/O module of CPU module): This function is available for PLC with firmware 

V1.06.00 or above and you need to use ISPSoft V3.07 or above to execute this function. Firstly you can 

create the largest possible module allocation design and use this option along with the SM flags (refer to 

Chapter 2 in AS Series Programming Manual for more information on SM flags) to activate or deactivate the 

modules on the right-side of the PLC CPU to set up a smaller I/O application without changing the PLC 

program, the original I/O allocation table or its corresponding device address.  
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 Manual + Flags (I/O module of CPU and Remote module): This function is available for PLC with 

firmware V1.08.50 or above and you need to use ISPSoft V3.12 or above to execute this function. Selected 

this option, you can control both the right-side modules of the PLC CPU and the remote modules. The 

operation is the same as the operation of the option above, Manual + Flags (only I/O module of CPU 

module). Refer to the explanation on Manual + Flags (only I/O module of CPU module) for more details. 

 

 Select Action when I/O Module Parameter with Manual CONFIG Different 

This determines which action is taken when the actual settings are NOT the same as the parameters that you 

manually set when the previous setting option is set to Manual.   

 Auto update: the CPU module is automatically configured. 

 Show error: the CPU module shows an error.  

 

 CPU module Stop when I/O Module No Response 

This determines how the CPU module and other modules react when a connected extension module is not 

responding.  

 Stop: the CPU module stops running and sends an error. 

 Keep Run: the CPU module and I/O modules keep running.  

 

 CPU module Stop when I/O Module Occurred Error 

This determines how the CPU module reacts when a minor module error occurs. 

 Stop: the CPU module stops running and sends an error. 

 Keep Run: the CPU module keeps running and sends an error.  

 

 Setting delay time to detect I/O Module 

This sets the timing when to start detecting the connected I/O module after CPU module is power-on.  

Normally the CPU module detects its connected I/O module once it is supplied with power. But you can set the 

delay time (unit: 0.1 second) for the CPU module to postpone detecting. This function is very useful when it takes 

time for the supply power to be stable or when the remote I/O module is not supplied with power at the same 

time as the CPU module is. With a set delay time, the detection on the connected sets can be more accurate. 

Refer to the image below for the time frame. 
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 When the power is switched from OFF to ON, the power supply will be unsteady for a short time. During this 

short period of time, the CPU module and I/O module are not ready to operate normally.    

 When the supply power for the CPU module and the I/O module is stable, the system starts to initialize for 

about 1 second. After that the I/O module is ready to be detected by the CPU module.   

 The CPU module starts to wait for the set delay time to pass. Once the delay time is up, it starts to detect the  

connected I/O modules locally and remotely.  

It is suggested using  +  to set the delay time. Default delay time is 2 seconds.  

 

 Non-Retain Symbol Initial Value Take Effect When Stop  RUN   

This determines whether the states and values of the non-latched devices are restored to initial values when the 

PLC changes from Stop to Run. 

 Disable: All the states and values in the non-latched devices stay the same. 

 Enable: All the states and values in the non-latched devices are restored to initial values when the PLC 

changes from Stop to Run. . 

 

 Retain Symbol Initial Value Take Effect When Stop  RUN 

This determines whether the states and values of the latched devices are restored to initial values when the PLC 

changes from Stop to Run. 

 Disable: All the states and values in the latched devices stay the same. 

 Enable: All the states and values in the latched devices are restored to initial values when the PLC changes 

from Stop to Run. . 

 

 Assign X Input Point Control Run/Stop 

This assigns an input point to have the CPU module run or stop. 

 Disable: Run or stop the CPU module by the dip switch of the CPU module. 

On

Time

Power
Switch

24Vdc

IO Module
status

CPU Module
status



Off

Power
Supply 0Vdc



ReadySetup

Start to detect IOSetup
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 Enable: Run or stop the CPU module by the assigned input point, and the dip switch of the CPU module still 

controls the run stop state of the CPU module.   

 

 Select X Input Point 

If you select Enable in the previous option, you can select one input point to control the Run or Stop state of the 

CPU module from the dropdown list.  

 

 Constant Scan Cycle Time 

This sets the minimum scan cycle time. 

 Disable: Disables this function. 

 Enable: When the actual scan cycle time is less than the setting time, the CPU module waits until the setting 

time is met, and then starts the next scan. When the actual scan time is longer than the setting time, 

the CPU module starts the next scan after the actual scan time completes.   

 

 Input Constant Time 

If you selected Enable in the previous option, you set the scan cycle time here. If the actual scan time is less 

than the setting time, the CPU module waits to begin the next scan until the setting time is met. If the actual scan 

time is larger than the setting time, the CPU module ignores the setting time and operates according to the 

actual scan time. If you set the scan time longer than the watchdog timeout set, a watchdog timeout occurs when 

the CPU module operates.  

 

 Setting Watchdog Time 

This parameter sets a timeout during which the program is scanned. The CPU module sends an error if the 

program execution exceeds the watchdog time. 

 

 Show Battery Low Voltage Error (BAT.LV) 

This parameter sets whether to show an alarm when the lithium battery for the real-time clock has low voltage or 

is not installed in the AS Series PLC. 

 Disable: Disables this function. 

 Enable: Enables the alarm by keeping the low voltage LED ON when the lithium battery has low voltage or is  

           not installed. 

Note: If the PLC self-checks and finds an error in the RTC, this low voltage LED will be ON, even if this option is 

disabled. 
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 Save Error History Info 

This specifies where to store the error log. 

 PLC: Store error logs in the PLC. The PLC can store up to twenty error logs. If there are more than twenty    

            error logs, the oldest error log is overwritten by the latest error log.  

 PLC & SD Card: When there are more than twenty error logs, the oldest error log is backed up to the memory  

                      card before the oldest error log is overwritten in the PLC.  

 

 COM Communication Error Record 

This parameter sets whether to enable the error record when there is an error at the COM port. 

     Disable: Disables this function. 

   Enable: Enables this function and starts recording COM errors in the error log.  

 

 Select Action When 24Vdc Input Unstable 

What to do when the 24Vdc power is unstable 

 Continue Running when power stable: When the power is unstable, the AS Series pauses, and after the 

power stabilizes, the PLC continues running. 

 Into Error Status: When the power is unstable, the error LED blinks and the AS Series stops running. The 

voltage is unstable and the communication will also be affected. 

  

 Communication Module Refreshed Priority 

 Scan time first: Only refresh the data that is different from the original ones to save scan time.  

 Synchronous Data first: Scan and refresh all the data to ensure all data are synchronized.  

 

 AS remote module updated method 

 PLC Scan cycle first: update according to PLC program scan cycle 

 Update one remote module by one scan time: update one remote module at one scan time 

 Update all remote modules at one scan time: update all remote modules at one scan time 

 

 I601 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1601 timer interrupt. This function is used together with Timer Interrupt 0. 

 I602 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1602 timer interrupt. This function is used together with Timer Interrupt 1. 

 

 I603 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1603 timer interrupt. This function is used together with Timer Interrupt 2. 

 

 I604 Timer interrupt Setting Time Base  
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Sets the interval for triggering the 1604 timer interrupt. This function is used together with Timer Interrupt 3. 

 

8.2.3 System Settings – Device Range Setting 

The parameters on Device Range Setting table are shown in the following window. 

 

 

Click  to open the parameter dialog box to set the start and end address. In the dialog box, click Default to 

restore the setting to the default values; click Clear to clear the set values; click OK to save the values and close the 

dialog box; click Cancel to discard the setting and close the dialog box.  
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8.2.4 System Settings – Input Point Filter Time 

On the Input Point Filter Time page, you can set the input point filter time for each input. If the duration of the received 

signal time is less than the filter time setting value, it is processed as noise and filtered out. Select an appropriate 

filter time according to your needs. 

 

 X Input Point Filter for CPU module  

 Default Setting: uses the default values in the input point filter. 

 Manual Setting: uses the values you enter for the filter time for each X input point. 

 

 X0.0–X0.15 Input Point Filter Time 

 If you select Manual Setting for the previous parameter, you can set the filter time individually for X0.0–X0.15. 
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8.2.5 System Settings – Position Control Parameter 

The parameters on Position Control Parameter table set to specify input points as the positive and negative limits of 

axis 1~ axis 6 channels. 12 limit points can be set at most. Axis No. 1~6 can also be set as Z phase triggers, home 

function finish points and clear output selects or positive/negative limited position.  

 

 Axis1 (Y0.0/Y0.1) Positive/negative Limited Select ~ Axis 6 (Y0.10/Y0.11) Positive/negative Limited 

Select. 

Select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0.0/Y0.1) Z Phase Trigger ~ Axis6 (Y0.10/Y0.11) Z Phase Trigger 

Select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0.0/Y0.1) Home Function Finish and Clear Output Select ~ Axis6 (Y0.10/Y0.11) Home Function 

Finish and Clear Output Select  

Select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0.0/Y0.1) Positive/negative Limited Position ~ Axis6 (Y0.10/Y0.11) Positive/negative Limited 

Position  

Set up the number of pulses as the positive or negative limited position in axis 1~6; setting range is -

2147483647～2147483647.  
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8.2.6 System Settings – Daylight Saving Timing 

The parameters on Daylight Saving Timing table are used to enable or disable the function of daylight saving time 

and set the date when the daylight saving is conducted. The clock will automatically set the daylight saving time in 

advance based on the period of time set after the function is enabled. 

 

 Disable/Enable D.S.T Function 

The parameter sets to enable or disable daylight saving time. 

 Start date- month 

The parameter sets the month from which the daylight saving time starts. 

 Start date- day 

The parameter sets the date on which the daylight saving time starts. 

 End date- month 

The parameter sets the month in which the daylight saving time ends. 

 End date- day 

The parameter sets the date on which the daylight saving time ends. 

 Saving time 

The parameter is used to adjust to the earlier daylight saving time with the unit of minute. 

Example explanation: example from the above image and all the options are enabled. 

 Date shown in SR Time shown in SR  
PLC time  

(Real Time Clock) 
Remarks 

3/31 23:59:58 23:59:58 
Normal 

3/31 23:59:59 23:59:59 

4/01 01:00:00 00:00:00 

Shown after 60 minutes 4/01 01:00:01 00:00:01 

: (to) : (to) : (to) 
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9/30 23:59:59 22:59:59 

10/01 00:00:00 (9/30) 23:00:00 

: (to) : (to) : (to) 
10/01 00:59:59 (9/30) 23:59:59 

10/01 00:00:00 00:00:00 
Normal 

10/01 00:00:01 00:00:01 

 

8.2.7 Options - COM1 Port Setting & COM2 Port Setting 

PLC modules are equipped with one or two COM ports based on different models. COM1 and COM2 parameters are 

set by clicking COM1 Port Setting and COM2 Port Setting in the list on the left-side of the following window. And the 

setting items for the two COM ports are the same. 

 

 Set a station address. You can identify a device on a network by the station address. The station address cannot 

be the same as the station address for another device on the same network. If the communication port functions 

as a slave, and there are other slaves, the station address of the communication port cannot be 0. Station 

address 0 broadcasts to all slaves in a communication protocol. If a master specifies in a data packet that data 

must be sent to station address 0, the data is sent to all slaves. No matter what the station address of these 

slaves are, these slaves receive the data packet addressed to station address 0. 

 Set when the communication port runs. Select Stop --> Run, and communication works when the CPU module 

switches from Stop to Run. If you instead select Power-on, the communication starts working when you Power-

on the module.  

 Select a communication speed in the Baud Rate list, or select Custom and enter a new rate.  
 Set the communication parameters for the port. 
 Set the Delay Time to Sending when the AS CPU is in Slave mode, after receiving communication, the time you 

set here indicates the time it waits before responding. For AS CPU (FW V1.08 or later), this function also works 
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for data exchange application. You can set the time it waits before exchanging any data. This is useful for some 

Slaves with slower responses in communication. Received Data Timeout applies when the AS Series CPU 

module acts as a server to send out communications. The timeout is how long the module waits before the 

received data times out.    

 Set COM1 LED to show: when COM1 is selected from the drop-down list, it shows the RS485 communication 

status of the COM1. If CARD1 is selected, it shows the CARD1 communication status.  
Set COM2 LED to show: when COM2 is selected from the drop-down list, it shows the RS485 communication 

status of the COM2. If CARD2 is selected, it shows the CARD2 communication status. 

 

8.2.8 Options - Ethernet Port Basic Setting  

The communication parameters can be set for the Ethernet port in the CPU module in this page. Refer to other related 

documents or manuals for more information about Ethernet. 

 

Mode sets the addressing mode of the IP of the CPU module. 

If users select Static, they can specify an IP address directly. If DHCP or BOOTP is selected, the IP address is assigned 

dynamically by a DHCP/BOOTP server. 
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8.2.9 Ethernet Port Advance Setting – IP Filter 

IP Filter sets the filter function of network devices. Devices whose IP addresses are listed in the table are allowed to 

communicate with the CPU module; the CPU module discards data packets sent from devices whose IP addresses 

are not in the table. Devices on a network are filtered. This setting ensures that objects communicating with the CPU 

module are known devices. You can set up to 8 address ranges for allowed devices.  

 

Select IP Filter Function Enable checkbox to enable the IP filter function and type the start address and end address 

of group 1~8 IP.  

 

8.2.10 Ethernet Port Advance Setting – NTP 

You can use NTP table to enable the CPU module and adjust time via NTP server. Relevant parameters are set here. 

For more information on NTP, refer to related literature and manuals.  

 

 Select NTP Client Function Enable checkbox to enable the function. 

 Set the address of NTP server and cycle of constant update. Take the figure above as an example. The CPU  

     module connects to the NTP server every 30 minutes. 

 Set up the time zone for the daylight saving time area. 
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8.2.11 Ethernet Port Advance Setting – Email 

Email table is for users to set the email-related functions. The email will be sent to the set email address after the 

email function is enabled. Total four groups of email sending conditions and four groups of email addresses can be 

set. 

 

 Select Email Function Enable to enable the function and then start setting the following parameters. 

 Set an IP address of SMTP server. Set the COM port of SMTP server at the COM port and set the sender’s 

email box at local email address. Type a mail subject as the start of the subject of every email.  

 Select Account identification checkbox to enable the function. Users can set to authenticate themselves with 

a user name and a password before logging in to an SMTP server. 

 Type the target email address of a receiver. 

Type a trigger name in Trigger Name box and a minimum interval in Trigger Min Cycle in the Trigger Setting table. 

And then select a trigger condition on the drop-down list. When the sending condition is met, the system will send an 

email every a period of time. But the same email will not be sent again within the set interval.  
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Trigger modes can be set as follows. 

 CPU Error 

If an error occurs in the CPU module, the condition of triggering the sending of an email is met. Please refer to 

operation manuals for more information about errors occurring in CPU modules. After users select the CPU Error 

option button, they have to select Fatal Error Only or All Errors in the drop-down list at the right side of the option 

button. 

a) Fatal Error Only: If a fatal error occurs in the CPU module, the condition of triggering the sending of an email is 

met and an email will be sent. 

b) All Errors: If an error occurs in the CPU module, the condition of triggering the sending of an email is met and 

an email will be sent. 

 

 CPU (RUN<=>STOP) 

When the CPU module begins to run, or when the CPU module stops running, the condition of triggering the sending 

of an email is met and an email will be sent. 

 

 Bit Status Change 

If the state of a bit device specified meets a condition set, the sending of an email will be triggered and an email will 

be sent. For example, if X0.0 is turned from OFF to ON, the condition of triggering the sending of an email will be 

met. If users want to set a condition, they can click  button in the following window. 

 
 Device Name: Users can select a device type in the Device Name drop-down list box. 

 Device Number & Bit: Users can type a device address in the Device Number box. If the device type selected is 

X/Y, the users have to specify a bit number. 

 State: Users can select Rising or Falling in the State drop-down list. 
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 Register Value Change 

If the value in a device specified meets a set condition, the sending of an email will be triggered and an email will be 

sent. For example, if the value in D0 is larger than 10, the condition of triggering the sending of an email will be met 

and an email will be sent. If users want to set a condition, they can they can click  button in the following window. 

 

 

 

 Device Name: Users can select a device type in the Device Name drop-down list. 

 Device Number: Users can type a device address in the Device Number field. 

 State & Value: Users can set s condition of triggering the sending of an email here. 

 

 Periodic Timer 

An email is sent periodically. How often an email is sent depends on the interval typed in the Trigger Min Cycle box 

in the Trigger Setting section. 

Where any trigger mode is set, the user message and error log related parameters will show up. 
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Select the Trigger User Message Enable box and then click  button to the right side of Trigger User Message. 

Type some content as the email text in the pop-up window. 

If users select the Error Log Enable checkbox in the Trigger Setting table, the error log will be added to the email 

content automatically.  

 

The options on the drop-down menu of Trigger Attachment Mode decide whether to add an attachment to the email. 

Please make sure the maximum size of the email file allowed before setting an attachment. For more information, 

refer to relevant operation manuals. 

 None 

If this option button is selected, no attachment will be inserted. 

 File 

Users can select an error log in the memory card, or the system backup file in the memory card as the attachment of 

the email.  

 PLC Device 

If this option button is selected, the system automatically retrieves the states of the devices, or the values in the 

devices listed in the table as the attachment when the email is sent. After this option button is selected, users can 

click  button in the following window to open the Attachment window. Two groups of devices at most can be set. 

For example, if the condition is met, the values in D0~D9 will be sent as an attachment.  
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Select the target email address of a receiver when the condition of sending an email is met in Trigger Receiving 

table. And the specific email box is set in the Email section. 

 

 

8.2.12 Ethernet Port Advance Setting – Socket 

In the Socket table, you can set COM port parameters for data transmission through Ethernet; however, you need to 

use this function along with specific API instructions. For more details, refer to the AS Series Programming Manual. 

The AS300 Series PLC supports data transmissions between the CPU module and other CPU module or device 

through sockets and the communication protocols including TCP and UDP are supported; four groups of connections 

can be set respectively for each protocol. As for AS200 Series PLC, two groups of connections are supported 

respectively.  
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The parameters in the TCP Socket Setting are the same as the parameters in the UDP Socket Setting except that 

there is no Keep Alive Timer parameter in the UDP Socket Setting. The parameters in the TCP and UDP Socket 

Setting are described below. 

 Remote IP: Users can set a remote IP address. 

 Remote Port: Users can set a communication port used by the remote device for this TCP connection. The port 

number must be within the range between 0 and 65535. 

 Local Port: Users can set a communication port used by the local CPU module for this connection. The port 

number must be within the range between 0 and 65535. 

 Send Address: Uses can set the initial device in the CPU module where data which will be sent is stored.  

 Send Length: Users can set the length of data which will be sent by the local CPU module. The length must be 

within the range between 0 and 200 bytes. For PLC CPU with FW V1.06.20 or later, the range is between 0 and 

512 bytes. 

 Receive Address: Uses can set an initial device in the CPU module where data which will be received is stored. 

 Receive Length: Users can set the length of data which will be received by the local CPU module. The length 

must be within the range between 0 and 200 bytes. For PLC CPU with FW V1.06.20 or later, the range is 

between 0 and 512 bytes. 

 Keep Alive Timer: Users can set a maximum keep alive time for the connection. If no data is transmitted, and 

the keep alive period has elapsed, the CPU module will terminate the connection automatically. 

 

The port number used by the local CPU module and the port number used by the remote device cannot be the same, 

and the devices where data which will be sent is stored cannot overlap the devices where data which will be received 

is stored. If the IP address of the remote device is 192.168.1.100, the port number used by the remote device is 65500, 

and the port number used by the local CPU module is 65501, the remote device and the local CPU module can transmit 

data through this TCP connection. 
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If the local CPU module wants to send 10-word data to the remote device, the data will be stored in D0~D9 before the 

data is sent. If the local CPU module receives 20-word data from the remote device, the data will be stored in 

D100~D119.  

If the length of data received is larger than the length set, the first 20-word data will be stored in D100~D119, and the 

data after the first 20-word data will be discarded. Likewise, if the length of data received is less than the length set, 

the data will be stored in the devices starting from D100, and the values in devices where no new data is stored will be 

retained. 

If no data is transmitted, and 60 seconds have elapsed, the CPU module will close the socket, and terminate the 

connection. 

 

8.2.13 Ethernet Port Advance Setting – RTU Mapping 

In the RTU Mapping table, users can set Delta RTU-EN01 slave in connection with PLC CPU. The remote device can 

be controlled via Ethernet. For the setting and operation of RTU-EN01, refer to the operation manual. 

 
Select RTU Mapping Enable checkbox to enable the function of connection between RTU module and PLC CPU. Set 

the update cycle in Cycle box and a timeout in Timeout box. It means a timeout when RTU does not give a reply within 

the timeout set. 

The data mapping between each group of RTU-EN01 and PLC CPU is set in the RTU Mapping section. RTU-EN01 

and I/O module connected to it are set via DCISoft. For more information on DCISoft, refer to the operation manual. 
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 Users can select RTU1 Enable to enable this RTU function. Each RTU can be set individually. 

 Users can set a station address and IP address. 

 Users can set RX mapping address and RX mapping length to make the digital input points of DI module 

connected to RTU mapped to X/M devices and length of PLC CPU. While, the RY mapping address and length 

set is used for making the digital output points of DO module mapped to Y/M devices and length of PLC CPU. 

 Users can set RCR Read mapping address and RCR Read mapping length to make the analog input points of 

AI module connected to RTU mapped to D/SR devices and length of PLC CPU. While, the RCR Write mapping 

address and length set is used for making the analog output points of AO module mapped to D/SR devices and 

length of PLC CPU. 

 

8.2.14 Function Card 1 Setting 

The Function Card 1 Setting table is used for setting parameters of function card in AS300 series CPU module, which 

is installed by inserting to the slot. For AS100 and AS200 Series PLC CPU, there is no Function Card 1 and thus there 

is no settings for Function Card 1. 

 

 Users can select Auto in Card1 Detect mode box to detect the actual card model and setting or Manual to 

select the AS--F232/ F422/ F485/F2AD/F2DA function card which need be configured in the Manual Select 

Card box. 

 For the setting of parameters in AS--F232/ F422/ F485. 

 Users can set F2AD to receive the signal of 0~10V or 4~20mA in F2AD Analog Input Mode box and set F2AD 

to send the signal of 0~10V or 4~20mA in F2DA Analog Output Mode box. The average times are set in F2AD 

Sampling Time and Average Times boxes respectively. 
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8.2.15 Function Card 2 Setting 

The Function Card 2 Setting table is used for setting parameters of Function Card 2 in AS300 Series PLC CPU, which 

is installed by inserting to the slot. Besides settings for Function Card 2, settings for AS-FEN02 and IP filter are also 

included. The only difference between Function Card 1 and Function Card 2 is the settings options of AS-FCOPM and 

AS-FEN02 are added in Manual Select Card box for Function Card 2. For AS100 and AS200 Series PLC CPU, the 

AS-FCOPM is used for internal communication port and no changes can be made. If you have inserted AS-FCOPM or 

AS-FEN02 in AS300 Series PLC CPU, you can set up their parameters here. For AS-FCOPM card, the parameters 

can be set as shown in the following window. 

 
 Select AS Remote Control/Delta Servo Drives and AS Remote Module/CANopen DS301 from the AS-FCOPM 

working mode box. The AS Remote Module and Delta Servo Drives adopts communication protocols exclusive 

to Delta servo products and AC motor drives. In addition, the AS Remote Module and Delta Servo Drives are also 

applied in connecting remote I/O AS series as well as CANopen DS301 for the application of DS301 standard 

protocol. 

 Set the address of the station when CANopen DS301 is selected from the AS-FCOPM working mode box. 

 The remote I/O parameters can be set if AS Remote Mode is selected from the AS-FCOPM working mode box. 

The AS Remote Module No. sets the number of remote I/O modules and each one can connect one expansion 

module. 

 If AS Remote Mode/Delta servo drives and AS Remote Mode is selected from the AS-FCOPM working mode box, 

you can set the followings:  

The actions after detecting the remote modules in Select run mode after detect remote module: Run 

connected remote module or All remote module stop.  

  The actions when the remote I/O module is disconnected during operation in AS CPU module keep or Stop 

when slave node dis-connected: only Shows Error Message or PLC Stop & Show Error Message.  

  You can define after how long the remote I/O module does not give a reply can be seen as timeout in Remote 

and CANopen Communication Timeout. 
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You can define the times of trying to connect after a timeout occurs in Auto Retry connection after Disconnected.  

 All three AS-FCOPM working modes can set the AS-FCOPM Bit Rate. 

  Communication data sampling position: It is suggested to select Auto, but if the communication with the slave 

is unstable, you can select the data sampling position in percentage.  

 When CANopen DS301 protocol is selected from the AS-FCOPM working mode box, you can set  
  DS301 PDO Data Exchanged: Start after power-on or Start after CPU running 

 

Insert AS-FEN02 by clicking the function card slot 2 and selecting AS-FEN02, as the image shown below. 
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You can also set AS-FEN02 card in the Edit Area. Set AS-FEN02 as Manual Select Card (Note: If AS-FEN02 card is 

selected from Manual Select Card, then Function Card 1 cannot be set.) After that you can set up Ethernet 

communication parameters.  
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The IP filter adds another layer of confirmation to ensure the devices for communication are permitted. This function 

can also limit communication objects. When IP filter function enables, only the devices within the listed IP address 

from the IP filter table are allowed to communicate with AS-FEN02. By selecting IP Filter Function Enable, users 

can input the beginning and ending of 1-8 set of IP address.   

 

 

8.2.16 Data Exchange  

AS Series PLC CPU is equipped with the data exchange function through standard Modbus TCP. You can find the 

relevant settings under the Data Exchange tab.     

 

AS Series PLC CPU is built with two ports, two COM ports or one COM port and one Ethernet port varied by different 

models. When acted as a Master and performs data exchange with a remote Slave, the data exchange through 

COM1 and COM2 is via the Modbus protocol; if the data exchange through Ethernet is via the Modbus TCP protocol. 

The setting items for COM1, COM2 and Ethernet are the same.  
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 You can set the three Modes to start data exchange. 

A. Program Control: PLC decides whether or not to execute the set flags for data exchange. Refer to  

                  special flags (SM) descriptions for more details in AS Series Programming  

                  Manual.  

B. PLC Run: The set data exchange will be executed automatically when PLC is in RUN state. If the 

PLC is in STOP state, the communication will stop.  

C. Always Enable: The data exchange will be executed constantly after PLC is powered on. 

 

 Function buttons and descriptions:  

Function Button Description 

 Click Add to add a new data exchange item in area .  

 
Click Edit to enter the selected data exchange setting 

page.  

 

 

Select the data exchange item and click Move Up and 

Move Down to rearrange the order of data exchange 

table.  

 

Select the data exchange item and click Copy and the 

copied item will be pasted to the last raw of the data 

exchange table.  

 
Select the data exchange item and click Delete to delete 

the selected item. 

 
Click Delete All to delete all data exchange items 

presented. 

 

Select this option to detect if the assigned slaves of the 

data exchange table exist. If the slave does NOT exist, 

the connection to the slave will stop to increase 

efficiency. 

Note: It is suitable for applications that the time it takes 

for the slaves to power-on is less than the master does. 

If not, do not select this option.   
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 Items on the data exchange table:  

Name Description 

Item The number of the block for data exchange.  

Enable Selects whether to enable the data exchange table when the data exchange is performed. 

Station Address/ 

IP Address 

The slave station address for the data exchange table. You can set one address for 

multiple data exchange tables. It is a station address under the COM1 and COM2 tabs, 

and an IP under the Ethernet tab. 

Local Address The device address range used by the master in the data exchange table 

  
: Input: the data block where the master reads from a slave 

: Output: the data block where the master writes to a slave 

Remote Address 

This is the device address range used by a slave in the data exchange table. 

The device range is in hexadecimal if the slave in the data exchange table is a user-

defined Modbus Device. 

Quantity  
This is the size of the data exchange table, which is consistent with the result calculated 

from the device range. 
 

Data Exchange Setting Page 
Under the Data Exchange Tab, you can set up data exchange for COM communication, Ethernet 
communication and Function Card. Click Add and then Edit or double-click the data exchange table 
to open the editing page. 

 

MELODY.CHEN 陳雅亭
new
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 Local Device Setting 
Select the option Enable for data exchange to start. You can set the shortest update cycle and 
connection timeout time in ms. If there is no response from the target device for a period of time that you have set 
,that is considered as a timeout. If you select the option Support Read/Write Synchronization (Function Code: 
0x17), the master PLC CPU can use Modbus function code to complete read and write synchronization at one 
execution. However you need to make sure all the devices support Modbus function codes; otherwise, the slaves 
devices may NOT recognize the function code and fail to complete read/write synchronization. 
 
 Remote Device Setting  
Slave Address: station number of the slave device for data exchange 
IP Address: IP address of the slave device (only available for EtherNet) 
Remote Device Type: slave device model type, such as Delta PLC or standard Modbus devices 
 
 Read 
Read: When PLC CPU reads data from the remote device: PLC CPU defines a device range to store data including 
the device type, starting address and quantity which are read from the remote device. Define the device type, starting 
address and quantity in the remote device that will be read by PLC CPU. 
Local Start Address: Device type and start address of devices where PLC CPU store data 
Remote Start Address: Device type and start address of the remote device to be read 
Quantity: Data length of input 
 
 Write 
Write: PLC CPU writes data to a remote device; PLC CPU defines a device range for the remote device to read the 
following data, the device type, starting address and quantity. Define the device type, starting address and quantity in 
the remote device that will be written by the PLC CPU. 
Local Start Address: Device type and start address of the source data of PLC CPU 
Remote Start Address: Device type and start address of the remote device where data are to be written 
Quantity: Data length of output 

 



 

 

Chapter 9. EtherNet/IP Specification and  

           Operation 

Table of Contents 
9.1 Introduction ............................................................................................... 9-4 

9.1.1 EtherNet/IP ........................................................................................... 9-4 

9.1.2 Definitions of Common Network Terms ...................................................... 9-4 

9.1.3 Ethernet Features ................................................................................... 9-5 

9.2 Installation ................................................................................................ 9-7 

9.2.1 EtherNet/IP Device ................................................................................. 9-7 

9.2.2 Network Cable Installation ....................................................................... 9-7 

9.2.3 Network Communication Parameter Setting ..............................................9-10 

9.3 Specifications ........................................................................................... 9-11 

9.3.1 Ethernet Specification ............................................................................9-11 

9.3.2 EtherNet/IP Specification ........................................................................9-12 

9.3.3 PROFINET Specification ..........................................................................9-14 

9.3.4 EtherNet Communication Port .................................................................9-14 

9.4 EIP Builder ................................................................................................ 9-15 

9.4.1 Run the EIP Builder ................................................................................9-15 

9.4.2 Set up the IP Address ............................................................................9-17 

9.4.3 Network ...............................................................................................9-25 

9.4.4 Data Mapping ........................................................................................9-34 

9.4.5 Diagnosis .............................................................................................9-42 

9.5 Programming ............................................................................................ 9-44 

9.5.1 Explicit Message .........................................................................................9-44 

9.5.2 TAG ..........................................................................................................9-44 

9.6 Troubleshooting ........................................................................................ 9-49 

9.6.1 Error Code Classification ..............................................................................9-49 

9.6.2 Error Codes & How to fix them .....................................................................9-49 

9.6.3 AS-FPFN02 Error Codes & How to fix them .....................................................9-53 

9.7 Studio 5000 Software Operation ............................................................... 9-54 

9 
 



AS Ser ies  Hardware  and  Operat ion Manual  

 

9-2 

_9 

9.7.1 Architecture ............................................................................................... 9-54 

9.7.2 Create a New Project .................................................................................. 9-54 

9.7.3 Create a Scanner ....................................................................................... 9-56 

9.7.4 Connect to a Delta Adapter .......................................................................... 9-58 

9.7.5 Editing Corresponding Addresses for AS300 ................................................... 9-63 

9.7.6 Download .................................................................................................. 9-64 

9.7.7 Data Mapping ............................................................................................ 9-65 

9.8 CIP Object ................................................................................................ 9-67 

9.8.1 Object List ................................................................................................. 9-67 

9.8.2 Data Type .................................................................................................. 9-68 

9.8.3 Identity Object (Class ID: 01 Hex) ................................................................ 9-71 

9.8.4 Message Router Object (Class ID: 02 Hex) .................................................... 9-73 

9.8.5 Assembly Object (Class ID: 04 Hex) ............................................................. 9-74 

9.8.6 Connection Manager Object (Class ID: 06 Hex) .............................................. 9-78 

9.8.7 Port Object (Class ID: F4 Hex) ..................................................................... 9-80 

9.8.8 TCP/IP Interface Object (Class ID: F5 Hex) .................................................... 9-82 

9.8.9 Ethernet Link Object (Class ID: F6 Hex) ........................................................ 9-85 

9.8.10 X Register (Class ID: 350 Hex) ................................................................... 9-88 

9.8.11 Y Register (Class ID: 351 Hex) ................................................................... 9-89 

9.8.12 D Register (Class ID: 352 Hex) .................................................................. 9-90 

9.8.13 M Register (Class ID: 353 Hex) .................................................................. 9-91 

9.8.14 S Register (Class ID: 354 Hex) ................................................................... 9-92 

9.8.15 T Register (Class ID: 355 Hex) ................................................................... 9-93 

9.8.16 C Register (Class ID: 356 Hex) ................................................................... 9-94 

9.8.17 HC Register (Class ID: 357 Hex) ................................................................. 9-95 

9.8.18 SM Register (Class ID: 358 Hex) ................................................................ 9-96 

9.8.19 SR Register (Class ID: 359 Hex) ................................................................. 9-97 

9.9 Delta EIP Product List ................................................................................ 9-98 

9.9.1 Delta EIP Products ...................................................................................... 9-98 

9.9.2 Delta EIP Products, DLR (Device Level Ring) supported ................................... 9-98 

9.9.3 Delta EIP Products, Scanner supported ......................................................... 9-99 

9.10 Operation and Monitor on the Web .......................................................... 9-100 

9.10.1 Getting Started ...................................................................................... 9-100 

9.10.2 Device Information .............................................................................. 9-104 

9.10.3 Network configuration .......................................................................... 9-104 

9.10.4 Data Monitoring .................................................................................. 9-107 

9.10.5 Diagnostic .......................................................................................... 9-112 

9.10.6 Configurations..................................................................................... 9-114 



Chapter  9  Ethernet  Spec i f icat ion and Operat ion 

 

9-3  

9_ 

9.11 Delta EIP Product Application (with OMRON Products) ......................... 9-114 

9.11.1 Architecture ........................................................................................ 9-114 

9.11.2 TAG Connection ................................................................................... 9-115 

9.11.3 IO Connection ..................................................................................... 9-131 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



AS Ser ies  Hardware  and  Operat ion Manual  

 

9-4 

_9 

9.1 Introduction 
9.1.1 EtherNet/IP  

EtherNet/IP (“IP” stands for “Industrial Protocol”) is an industrial Ethernet network managed by ODVA, Inc. (formerly Open 
DeviceNet Vendors Association, Inc.), a global trade and standards development organization.  

EtherNet/IP works on a TCP/UDP/IP based Ethernet network and uses the most widely deployed collections of Ethernet 
standards to provide a broad range of applications in different industries that require high-speed and stability including 
Factory Automation (FA), Building Automation (BA), Process Automation (PA) and many more.  

Delta covers a full range of controller and drive products supported by EtherNet/IP, including Programmable Logic 
Controllers (PLC), inverters, Human Machine Interfaces (HMI) and so on. Refer to Section 9.9 for a full product list that 
support EtherNet/IP. In addition, you can also use EDS files to connect to other brands of EtherNet/IP devices. You can 
run Delta EtherNet/IP software (EIP Builder) through the ISPSoft software. Download the ISPSoft software at:   
Delta | Download Center (deltaww.com)  

 

9.1.2 Definitions of Common Network Terms  

Term Definition 

ODVA Open DeviceNet Vendor Association for EtherNet/IP  

EIP 
EtherNet/IP, an industrial Ethernet network, provides interoperability for system providers. 

IP stands for Industrial Protocol. The term “EIP” (EtherNet/IP) is used in this manual.  

I/O Connection Use the I/O connection to connect to EtherNet/IP and to exchange data cyclically.  

Explicit Message 
Connect to EtherNet/IP and to exchange data non-cyclically. Data is exchanged piece by 

piece through instructions.  

RPI 
Requested Packet Interval, through the I/O connection to connect to EtherNet/IP to 

exchange data at regular time intervals.  

ACD Address Conflict Detection to detect IP address duplications. 

Produced/Consumed 

TAG (P/C TAG) 

 You use TAGs for assigning and referencing memory locations for Rockwell PLCs, 

the same as registers for Delta PLCs.  

 Produced tag: A tag that a controller makes available for other controllers. Multiple 

controllers can simultaneously consume (receive) the data. A produced tag sends 

its data to consumed tags (consumers) without using logic. 

 Consumed tag: A tag that receives the data of a produced tag. The data type of the 

consumed tag and the produced tag must match (including any array dimensions).  

 The data is transferred over Ethernet/IP. For example, PLC-A needs data from 

PLC-B, so PLC-B sends the data to PLC-A. Therefore, PLC-B is the producer and 

PLC-A is the consumer. 

https://downloadcenter.deltaww.com/en-US/DownloadCenter?v=1&q=ISPSoft%20V3.12&sort_expr=cdate&sort_dir=DESC
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EDS 

Electronic Data Sheets: EDS files are simple text files used by EtherNet/IP network 

configuration tools to help you identify EtherNet/IP products and easily commission them 

on a network.  

Data Mapping Exchanging data between devices  

EIP Scanner The master station is called an EIP Scanner in EtherNet/IP. 

EIP Adapter The slave station is called an EIP Adapter in EtherNet/IP. 

DLR 

Device Level Ring (DLR) provides fault-tolerant network design for daisy-chain and linear 

topology. The DLR protocol provides high network availability in a ring topology. It was 

intended primarily for implementation in EtherNet/IP end-devices that have two Ethernet 

ports and embedded switch technology, providing fast network fault detection and 

reconfiguration to support the most demanding control applications.  

Modbus TCP This is a Modbus variant used for communications over TCP/IP networks. 

 

9.1.3 Ethernet Features  

9.1.3.1 Delta EIP Architecture 

This typical Delta EIP architecture includes an EIP Scanner and Adapters; data mapping is achieved between devices 

through an I/O connection and explicit messaging. The AS Series supports single port Ethernet; thus you can install and 

configure devices with embedded switch technology over EtherNet/IP. 
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9.1.3.2 EIP Features 

 Flexibility 

- Flexible topology: EIP devices may include single port Ethernet as well as dual port Ethernet, and provide 
applicable networks such as linear topology, ring topology and ring topology for faster expansion and easier 
management.  

- EtherNet/IP works on a TCP/UDP/IP based Ethernet network, uses most widely deployed collections of Ethernet 
standards, and supports Wi-fi connection. Even personnel with no IT background can build the network easily.  

- Applicable networks include linear topology, ring topology, star topology, Ethernet, EtherNet/IP, one or more 
LANs, etc. You can set configuration through USB or an interface. 

 Simplicity 

- With a connector: Delta provides a full range of products, including human machine interfaces (HMI), 
programmable logic controllers (PLC), and inverter drives for application in an industrial operation. You can build 
a network simply through an RJ-45 connector, saving costs on cables and other connecting tools.   

- Single network: in place of the 3-tier industrial architecture, single network architecture provides 100MB/bits 
high-speed cyclical and non-cyclical data mapping functions, ensuring complete network diagnosis and 
effectively shortening debugging time.    

- Graphical user interface software: the EIP Builder uses a graphical user interface designed for intuitive operation. 

 Integration 

- Data mapping: the EIP Builder provides a consistent setting interface, allowing you to reduce the time to learn 
and set up configurations. 

- Listed device parameters: the EIP Builder presents the device parameters in a list. Instead of looking them up 
in the user manual, you can quickly check on the parameters in the list.  

- EDS file: you can connect to Delta and other brands of EtherNet/IP products with EDS files.   
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9.2 Installation 

9.2.1  EtherNet/IP Device 

A Delta EtherNet/IP (EIP) device allows you to build a linear topology, ring topology, and star topology networks. A Delta 

EIP device includes the EIP Builder software, EIP Scanner, EIP Adapter, EIP Tap, and an Ethernet switch. EIP Scanners 

and EIP Adapters can be further divided into single port and dual port devices. The AS Series are single port devices. 

Refer to Section 9.2.2.1 for the single port setup and refer to Section 9.2.2.3 for the software installation.  

9.2.2  Network Cable Installation 

Each EtherNet/IP device is connected to an Ethernet switch with a CAT 5e cable. Please use Delta standard cables and 

the DVS series industrial switches. Refer to the Delta PLC/HMI Cable Selection Guide for more information.  

9.2.2.1. Single Port Device  

You can use a single port device to build up either a linear or a star network topology. An Ethernet switch and an Ethernet 

tab are required to create a star topology or a ring topology. 

Linear Topology 

 Linear Topology 1 

 

 

 Linear Topology 2 

 

 
 

Star Topology 
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9.2.2.2. Dual Port Device 

You can use a dual port device to build a linear, a star or a ring network topology. A DLR function is required to create a 

ring topology. Refer to Section 9.9.2 for DLR supported series.  

Linear Topology 

 

 
Star Topology 

 

 
 

Ring Topology 

A DLR function is required to create a ring topology. Refer to Section 9.9.2 for AS series that support DLR. 

 
 

When a switch is needed for the particular topology, the switch should support the DLR function. If not, the connection 

might fail.  
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9.2.2.3 EIP Builder Software 

Linear and star topology 

Install the EIP Builder software on your PC to monitor and configure the EIP devices. You can also connect an EIP 

device to your PCs directly, or use a switch to connect to the PCs.  

 
Ring topology 
Install the EIP Builder on your PC to monitor and configure the EIP devices. Be sure to save a network connection for 

your PC to connect to the EIP device.  
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Alternatively, you can use an EIP tap to connect your PC so that the ring topology stays intact.  

 
 

9.2.3 Network Communication Parameter Setting 

In ISPSoft you can edit, upload, download and monitor AS PLC CPU programs through Ethernet communication. Refer 

to section 2.4.3.4 in ISPSoft User Manual for more details. Go to ISPSoft -> Help -> ISPSoft User Index and then find 

section concerning Communication Parameter Setting – Ethernet for more details.  
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9.3 Specifications 

9.3.1 Ethernet Specification 

Model AS300 & AS200 Series 

Communication Protocols EtherNet/IP Scanner / Adapter、Modbus TCP 

Protocols  BOOTP, DHCP, SMTP, NTP, Socket, HTTP 

Communication Speed 10/100 Mbps Auto-Detection 

Communication Interface RJ-45 with Auto MDI/MDIX 

Numbers of the Ethernet Port  1 

 
Model AS-FEN02 ( work with AS300 Series) 

Communication Protocols EtherNet/IP Scanner / Adapter, Modbus TCP 

Protocols  BOOTP, DHCP, SMTP, NTP, Socket, HTTP 

Communication Speed 10/100 Mbps Auto-Detection 

Communication Interface RJ-45 with Auto MDI/MDIX 

Numbers of the Ethernet Port  2 

 
Model AS-FPFN02 ( work with AS300 Series) 

Communication Protocols PROFINET RT 

Protocols  PROFINET IO 

Communication Speed 100 Mbps Auto-Detection 

Communication Interface RJ-45 with Auto MDI/MDIX 

Numbers of the Ethernet Port  2 

 

Item / per transmission 
Specification 

AS300 AS200 AS-FEN02 

Modbus TCP 

Maximum connection quantity 

for Client *1 
32 16 8 

Maximum connection quantity 

for Server*1 
32 16 8 

Max. data length   100 words 

Socket  TCP connection quantity 4 2 N/A 
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(communication port)*1 UDP connection quantity 

Max. data length 200 bytes 
SMTP (for emailing) Emailing quantity 4 4 

*1: Numbering is used for connections via the communication port. You can use connection 1 in TCP mode or UDP 

mode and up to 4 connections can be made per transmission. If connection 1 is used in TCP mode, the same connection 

number cannot be used in UDP mode.  

 

9.3.2 EtherNet/IP Specification 

Item 
AS300 Series AS200 Series AS-FEN02 

Scanner Adapter Scanner Adapter Adapter 

General  
Device type Scanner / Adapter Adapter 

Topology type Star topology Star, linear topologies 

CIP Network 

I/O 

Connection 

CIP connection 

number 

(data exchange) 

32 8 16 8 8 

TCP connection 

number 

16 

(Clients + Servers) 

8 

(Clients + Servers) 
8 

Requested Packet 

Interval (RPI) 
5 ms – 1000 ms 1 ms – 1000 ms 

Max. Transmission 

Speed 
3,000 pps 10,000 pps 

Max. Data Length/per 

transmission 
500 bytes  200 bytes 

Supported devices, 

registers, and flags 

FMV1.08 

or 

previous 

versions: 

D  

FW V1.10 

or later: 

D/M 

D, X, Y, 

SR 

FMV1.08 

or 

previous 

versions: 

D  

FW 

V1.10 or 

later: D/M 

D, X, Y, 

SR 
D, X, Y, SR 

CIP Network 

Explicit 

Message 

Class 3  

(Connected Type) 
16 8 8 8 8 

UCMM  Total 16 Total 8 Total 8 
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Item 
AS300 Series AS200 Series AS-FEN02 

Scanner Adapter Scanner Adapter Adapter 

(Non-Connected 

Type, only uses TCP 

connections) 

(for all connection 

types) 

(for all connection 

types) 

(for all connection 

types) 

CIP Objects 

Identity Object (16#01) 

Message Router Object (16#02) 

Assembly Object (16#04) 

Connection Manager Object (16#06) 

Port Object (16#F4) 

TCP/IP Interface Object (16#F5) 

Ethernet Link Object (16#F6) 

CIP Network 

TAG 

Max. Consumed TAG 

Number 
32 16 

N/A 

Max. Produced TAG 

Number 
32 16 

Max. Data Length 
500 bytes (IO Connection) 

400 bytes (Explicit Message) 

Requested Packet 

Interval (RPI) 
5 ms – 1000 ms 

Maximum number of connections when using AS300 to connect to other devices through Ethernet/IP: 

 AS300 can act as a Scanner and an Adapter simultaneously. It can connected up to 16 devices (for example 8 

Scanners and 8 Adapters). 

 When AS300 acts as a Scanner, it can connect to up to 16 devices. Each device can establish up to 32 

connections for data mapping. Data mapping types can be I/O connection and Consumed TAG. You can use 

explicit message for data mapping at the same time, up to 16 explicit message connections can be created.  

 When AS300 acts as an Adapter, it can connect to up to 16 devices. Each device can establish up to 8 

connections for data mapping. Data mapping types can be I/O connection and Produced TAG. You can use explicit 

message for data mapping at the same time, up to 8 explicit message connections can be created. 

 Using device D or device M takes 2 bytes (16 bits) as a unit in data length for IO connections, for example M0 to 

M15 (16 bits), M12 to M43 (32 bits). If you need to store the data of 200 bits from M100, the data length should be 

set in a value larger than 200 bits and in bytes it will be 26 bytes (26 bytes = 208 bits), the actual devices to be 

mapped will be M100 to M307. D0.0 will be stored in M100 (the first bit).   
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9.3.3 PROFINET Specification 

When AS-FPFN02 is installed on AS300 PLC CPU, this communication card can work independently and does NOT 

occupy the communication port of PLC CPU. AS-FPFN02 can act as a PROFINET adapter and connect to a PROFINET 

scanner to exchange data on the PROFINET Network (PN) Refer to section 10.2.8 of AS Module Manual for more 

information.  

Item Specification 

Communication Protocol PROFINET  

EtherNet/IP Interface 100 Mbit with 2 x RJ45 

Device Type PROFINET Devices 

Network Cable Length 100 meter 

Error Indicator System Fail (SF): Red; Bus Fail (BF): Red 

Max. IO Slot Supported 17 

Register to Read and Write AS300 series data registers are supported to read and write 

Minimum Time for Data Exchange to Operate  10 ms 

Maximum Data Length/Per Transmission 
Input: 250 words 

Output: 250 words 

PROFINET Configuration Download PROFINET Configurations from PN Controller 

9.3.4 EtherNet Communication Port 

9.3.4.1 Communication Port Pin Assignment 

Delta EtherNet/IP devices use CAT5e industrial Ethernet cables and can be connected via RJ-45 communication port.  

Pin Signal Description Pin Signal Description 

 

1 Tx+ Transmit plus 5 -- N/C 

2 Tx- Transmit negative 6 Rx- Receive negative 

3 Rx+ Receive plus 7 -- N/C 

4 -- N/C 8 -- N/C 
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Open
I SPSoft V3 0X. 

Create 
I SPSoft Project 

Open 
HW CONF IG

Download 
HW CONF IG

 

Open 
EI P Bui lder

Start 

9.3.4.2 Communication LED Indicator 

LED Indicator LED Status Description 

LINK Green 

ON 
 Communication port is connected. 

 Connected to Ethernet 

OFF 
 Communication port is not connected. 

 Not Connected to Ethernet 

ACK Yellow 

Blinking 
 Packets transmitting/receiving 

 Packets transmitting/receiving over Ethernet 

OFF 
 No packets transmitting/receiving 

 No packets transmitting/receiving over Ethernet 

Note: The LED indicator is at the RJ45 connection.  

 

9.4 EIP Builder  

The Delta EtherNet/IP software, EIP Builder, is embedded in ISPSoft. You run it from the ISPSoft software (version 3.0 

and above). Download the ISPSoft software at:   

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&d

ownloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US  

 

9.4.1 Run the EIP Builder   

You can call EIP Builder from Delta EIP Scanner’s HWCONFIG in ISPSoft. You can also call it independently to set up 

parameters for the Adapter. The Delta EIP Scanner is equipped with the EtherNet/IP communication PLC and the 

EtherNet/IP module. Refer to Section 9.9.3 for a list of Delta EIP Scanner products supported by EIP Builder. 

9.4.1.1 Run the EIP Builder via an EIP Scanner  

 Steps to run EIP Builder 

Run EIP Builder from an EIP Scanner product. When using a Delta EIP Scanner, you set up an EIP module through 

HWCONFIG in ISPSoft. Make sure the current communication is via EtherNet in ISPSoft.  

 

 

 

 

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
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1. Open ISPSoft V3.0X: click the Start menu and go to Programs > Delta Industrial Automation > PLC > 

ISPSoft 3.0X  

2. Create a new project: on the File menu, click New to display the Create a New Project dialog box. 

 
 
 
 
 
 

 
 

 
3. Select a PLC: in the Create a New Project dialog box, select a PLC product that is supported by EIP builder.  

 
 
 
 

4. Open HWCONFIG: double-click HWCONFIG in the Project window.  
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5. Save and download the settings from HWCONFIG：on the File menu click Save to save the settings and then 

click the download button  on the toolbar to download the file to PLC. You must save the configuration in 

HWCONFIG before opening the other communication tools. While working in the communication tools, you 

cannot work in HWCONFIG. 

 

6. Open EIP Builder: right-click the CPU module in the system configuration area point to Communication 

Software and then click EIP Builder. If EIP Builder is not available, check if the current communication is via 

EtherNet in ISPSoft. 

 

9.4.2 Set up the IP Address 

This section provides an overview of how to set up IP address for AS Series modules. Set up the IP address before 

configuring the EIP related parameters or data mapping settings.  
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Create
Projec tI SPSoft 

 

Open
HWC ONFI G

Set up 
I P Address

 

Dow nload
HWC ONFI G

9.4.2.1 IP Address Types 

The AS Series supports 3 types of IP addressing, BOOTP, DHCP and static IP address.  

Type of IP Address Definition 

BOOTP 

Uses the TCP/IP Bootstrap Protocol (BOOTP) to set up the IP address, netmask and 

gateway. A BOOTP server may require some configuration. The BOOTP protocol is 

designed for a network in which each host has a permanent network connection. 

DHCP 
Uses the Dynamic Host Configuration Protocol (DHCP) to automatically obtain IP address, 

netmask, gateway, main computer name and the WINS server.  

Static IP You manually set the IP address, netmask and gateway.  

9.4.2.2 Set the IP Address (Static IP) 

 Steps to set the IP address  

When using an EIP product with a static IP address, set up the IP address in HWCONFIG in ISPSoft. The following 

example uses the AS Series.  

 

 

 

 

Refer to Section 9.4.1.1 for how to set up an EIP module in HWCONFIG.  

1. Configure the network parameters 

 Double-click the AS Series module in HWCONFIG to open the Device Setting dialog box. 

 On the Options tab, set the IP address on the Ethernet Port Basic Settings page, and then click OK.   
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2. Save and download the settings from HWCONFIG: on the File menu click Save to save the settings and then 

on the Options menu, click Download or click the Download button on the toolbar. 

 

9.4.2.3 Set the IP Address (BOOTP/DHCP) 

 Steps to set the IP address 

When using an EIP product with a BOOTP/DHCP IP address, users can set up the IP address through the IP 

Manager in the EIP Builder.   

Create
AddressMAC Set up IP

Same I assign P 
mode after each 
power-on 

Reset I assign P 
mode after each 
power-on 

Y Disable
BOOTP

N 

Open
EIP Bui lder

Open
 IP M anager
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Descriptions for the IP Manager:  

1
2
3

4

7

6

8
9

10

5

 

 Item Definition 

 Stop the Server 
Stops the BOOTP/DHCP server; the IP manager does not request an IP 

addresses from the BOOTP/DHCP server. 

 Network Settings 
Opens a dialog box to set up the subnet mask, gateway, primary DNS, 

secondary DNS, and domain name.  

 Clear List Clears the contents of the list. 

 New Adds a new IP/MAC address.  

 Delete Deletes the selected item from the list. 

 Import Imports the IP/MAC address list; the file format is .CSV. 

 Export Exports the IP/MAC address list; the file format is .CSV. 

 Enable BOOTP Enables the BOOTP to assign an IP address for the selected item.  

 Enable DHCP Enables the DHCP to assign an IP address to the selected item. 

 Disable BOOTP/DHCP 
Disables the BOOTP/DHCP on the device; the device does not request an IP 

addresses from the server.  
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 Steps to set the IP address:  

1. MAC address: find the MAC address on the EIP device. The MAC address uniquely identifies the device.  

 

2. Open the IP Manager 

 In EIP Builder on the Tool menu, click IP Manager. 

 
 
 

 The IP Manager can be the BOOTP/DHCP Server, receiving IP address requests from devices. The IP  

     Manager window is shown below. 
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3. Set up the IP address 

 Double-click the listed MAC address for your device to open the Input Data dialog box.  

 
 Enter the IP address and click OK. 

 
 

4. Disable DHCP/BOOTP 

Click the device in the Mapping Table that you want to disable, then click Disable DHCP/BOOTP. The selected 

device does not send DHCP/BOOTP requests. To change the IP address receiving mode, refer to Section 9.4.2.4 

for more information.   
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 Notes 

 Enable BOOTP: when the IP address receiving mode is BOOTP (BOOTP is enabled), the IP address is 

assigned, and the device sends out BOOTP requests for IP addresses during each power-on. 

 Enable DHCP: when the IP address receiving mode is DHCP (DHCP is enabled), the IP address is assigned, 

and the device sends out DHCP requests for IP addresses during each power-on. 

 Disable DHCP/BOOTP: when BOOTP is disabled, the device does not send out any DHCP/BOOTP requests 

for IP addresses during each power-on.  

 

9.4.2.4 Re-enable BOOTP/DHCP  

To enable the DHCP or BOOTP function again, use the device software to make the change. Using the AS Series as an 

example: from the Start menu, start ISPSoft, then HWCONFIG, and then IP Manager. In IP Manager sets the IP address 

to the receiving mode.  

Open 
HWCONFIG

Set up
parameters

Set up IP
receiving mode

Open
EIP Builder

Download
HWCONFIG

Open
IP Manager

 
 
 

 Steps to set device parameters  

1. Refer to Section 9.4.1.1 for how to start HWCONFIG. 

2. Set the parameters: enable the IP address receiving mode to BOOTP/DHCP.  

◆ Double-click the device to open the Device Setting dialog box.  

◆ Make changes to the items, such as IP address receiving modes and click OK to confirm the settings. 
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3. Download the settings from HWCONFIG 

◆ Refer to Section 9.4.1.1 for more information. 

4. Open EIP Builder. 

◆ Refer to Section 9.4.1.1 for more information. 

5. Open the IP Manager 

◆ Refer to Section 9.4.2.2 for more information. 

6. Open the IP setup page 

◆ Refer to Section 9.4.2.2 for more information. 
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9.4.3 Network  

EIP Builder provides a graphical user interface, and you can see the devices and their EtherNet/IP connections in the 

Network View. This section provides an overview of how to add your devices to the network connections. 

 

Add Device
(Scan Network)

Create Network
(Set u p Connection)

Set up Device
Settings

IP Manager
(Set up IP)

Add Devices
(Manually)

EIP Builder

 
 

Descriptions of the EIP Builder Window 

1

3

4

2

  

 Item Definition 

 Toolbar Toolbar buttons 

 Network View Displays the connected devices and their connection status 

 Configuration Area Displays the configurations and allows you to set the parameters 

 Product List Displays the available devices that can be connected to EtherNet/IP  
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 Toolbar buttons 

 
 

Icon Name Definition  

 
New Creates a new EIP Builder project 

 
Open Opens an existing project 

 
Save Saves the project 

 
Help Opens the help file 

 
Cut Cuts the selected item 

 
Copy 

Copies the selected item 

 
Paste 

Pastes the selected item 

 
Delete 

Deletes the selected item 

 
Scan Network Scans the network for device availability  

 
Check Checks if the project is planed properly 

 
On-line Mode Switches to on-line mode 

 
Uploader Uploads from a device 

 
Downloader Downloads to a device 

 
Setup Button 

Opens the communication setting; set up the path connecting the PC to the EIP 

Scanner.  
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 Network View 

1

2

3

4

 
 Name Definition  

 Station Name Name of the station 

 Device Name Name of the device 

 Ethernet COM Port 
Displays the number of devices with Ethernet communication ports.  

The last digit of the IP address is shown on the COM port. 

 Network_0 
Displays the connection status; devices on the same line indicate they are in the same 

network. 

 
 Configuration Area 
Refer to Section 9.4.3.3 for more information. 

 
 Product List 

1

2

 
 

 Name Definition  

 Search Bar 
Type the module name you want to find; if no match is found, that means there is no 

EDS file in the system matching the module name. 

 Product List 
Categorizes the devices according to the EtherNet/IP definition; devices from third 

parties are in the Others folder. 
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9.4.3.1 Scan Network 

1

3

2

 
 Name Definition  

 Selection checkboxes Select the devices you want to add to the network view. 

 Refresh Refreshes the network view (scans the network again) 

 Join Adds the selected device to the network view 

 Operation Steps: Add new devices in (scan the network) 

1. Click the Setup button to display the Communication Setting dialog box.  

 
 

2. Once your PC is connected to the EIP Scanner, there are 3 ways to set up the network communication.  

(a) Select an existing driver: Select the driver from the COMMGR Driver list.  

(b) Edit an existing driver: Click the setup button in the Common Setting section to edit the driver in the 

Driver Properties dialog box.  

(c) Add a new driver: Click the setup button+ in the Common Setting section to add a new driver in the 

Driver Properties dialog box. 
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(a)

(b)

(c)

 
 

 
3. Click the Scan Network button to scan the network and list the scanned devices in the Device List dialog box.  

 
 

4. Select the devices to add to the Network View, and then click Join to add the selected devices.   

AS332T
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9.4.3.2 Add devices (Manually)  

 Steps to add new devices manually 

1. Select the devices to add from the Product List. You can also enter the module name in the search bar. Drag the 

device onto the Network View.   

 

 
2. Create the network 

(a) Drag the Ethernet communication port of the device to the network to create a new connection.  

 



Chapter  9  Ethernet  Spec i f icat ion and Operat ion 

 

9-31  

9_ 

(b) Create network connections for the devices.  

 
 
 
 

(c) Once the connection is established, click the network line “Network_0” to see all the connected devices in this 
network in the Information window.  
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9.4.3.3 Set EIP parameters 

Click the tabs in the Information window to view and edit the EIP Parameter and the EDS Parameter.   

 
 

 Information Tab 

This tab contains the Module Name, Version, Rack, Slot, Slot, IP address, Mask, Network and Data Exchange 

Setting.  

 
 
 EIP Parameter Tab 

This tab contains parameter information from the EDS file. When offline, you can check only the connection 

parameters for setting up the EDS filtering rules.  

 Disable Keying: Disable key checking the product information versions.  

 Compatible Keying: Check if the product information and its master version match and check the 

minor version for compatibility. 

 Exact Match: Check if the product information, and both the master version and minor version match. 
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When the device is connected, you can click the Upload button to upload the related parameters from the device.  

 
 

 Name Definition  

① Module Status 

 Identification: displays information regarding Vendor, Product 

Type, Product Name, Revision, etc. 

 Status: displays connection status, including Major Fault, 

Minor Fault, Internal State, Configuration Status, and Module 

Identity.  

② IP Setting 

 Port1: indicates port 1 of the device, for editing IP Address, 

Subnet Mask, Gateway Address, and Host Name.   

Note: when there is a Port2, that means there are 2 Ethernet 

communication ports. 

③ Connection 
 EDS parameters filtering rules include Disable Keying, 

Compatible Keying, and Exact Match. 

④ Port Status 
 Displays Link Status, Speed, Duplex, Negotiation Status and 

Hardware Fault.  
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 EDS Parameter Tab: this is not supported for the AS Series modules; the software closes itself when this Tab 

is selected.  

 

9.4.4 Data Mapping 

When the connection between devices is established, you can use data mapping to exchange data between devices. 

This section provides an overview of how to create a data mapping table.  

Download Data ExchangeData Exchange
Set up

Data Exchange
Table

Network View

 
 
Descriptions for the Data Mapping: 

1

2 3 4 76 8 95 10  
 

 Name Definition  

 Connection Count 

Data mapping connection count; each row represents one 

independent EtherNet/IP connection. The number of connections 

cannot exceed the maximum number of connections for the 

Scanner. For the AS Series, the maximum number of connections 

32. 
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 Name Definition  

 Enable Enable and disable data mapping for the connection. 

 TAG 

Use TAG to perform data mapping with adapters. 

After selecting this check box,  

 The directional arrow points left of () (READ only) 

 Registers cannot be used in this row. 

 The length format is defined by the data format in the Global 

Symbols; you cannot change the length format here. 

 You must create a Consumed TAG in the Global Symbols in 

ISPSoft before using this function.  

 IP address 

The IP address of the Adapter to connect to. After the data mapping 

connection is established, the system loads the connected device’s 

IP address. You can also select the device’s IP address from the list 

to add and edit the connection.  

 Adapter name 

Once you select the IP address, its name is displayed but cannot be 

modified here. Refer to Section 9.4.3  for more information on  

how to change the device name.     

 
CPU register address 

Starting address of the data mapping’s register. 

FW V1.08 or previous versions support device D. 

FW V1.10 or later version support device D and M. 

Using device D or device M takes 2 bytes as a unit in data length. 

Select the TAG check box.  Select the Consumed TAG name from the list. 

 

Adapter address/parameter Target adapter’s register address / parameters 

Select the TAG check box.  
Input the name of the Produced TAG for other connected EIP 

devices. The default name is the same as the name shown in . 

 I/O mapping table 

Set up the IN/OUT parameters. When there is no I/O representative 

table presented for the Adapter, the parameters cannot be opened, 

for example in some PLCs. 

 Length  
Set the data mapping length; unit: byte, the maximum is 500 bytes. 

You cannot change the length format here when using TAG. 

 Property Set the advanced data mapping parameters. 
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 I/O Mapping Table 

Delta EIP devices provide an I/O mapping table. You can use the table to edit the parameters if needed.   

 Name Definition  

 Connection 
Select the connection from the list. Different connections may have 

different mapping parameters.  

 In 

Input mapping parameters. The No. column shows the maximum 

number of mapping parameters to input. Double-click the Name 

column to open the mapping table to edit the parameters.  

 Out 

Output mapping parameters. The No. column states the maximum 

number of mapping parameters to output. Double-click the Name 

column to open the mapping table to edit. 

 Name 
The parameter name; double-click the Name column to open the 

mapping table to edit the parameters. 

 Value 

Values; after editing and downloading, the scanner stores the 

values. When the connection is established, the values are written 

to the Adapter. 
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 Property 
 

 

 
 

 Name Definition  

 Requested Packet Interval (RPI) Time interval to request packets through the I/O connection, unit: ms 

 Multicast Communication mode setup: Multicast or Point-to-Point 

 Timeout 

Sets the timeout according to the RPI or a multiple of RPI (RPI*X). 

The minimum value is 100 ms to reduce timeout occurrence When a 

value that is less than 100 ms is treated as 100 ms.  

 Trigger Mode 

Cyclic: renews data cyclically  

Change of State: renews data once there is any change 

Application: renews data according to the product setup   

 Input Instance You can edit input instance, output instance and configure instance 

in some of the EDS files. The instance number is the same as the 

data mapping connection number. You can tell the mapped data is 

from which corresponding device by the instance number.  

 Output Instance 

 Configure Instance 
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 Steps to set up and download parameters 

1. Create a data mapping table (*):  

 Right-click the COM port on the Ethernet Scanner, and click Data Mapping to open the Data Mapping Table.  

 
The system creates a Data Mapping Tab, shown for Network_0.  

Network_0 Data Mapping Tab

Network_0 Data Mapping Table

 
2. Set the Data Mapping Parameters  

 Type the parameters in the data mapping table. See below for examples 

a) Reading D500–D599 from the Adapter with the IP address 192.168.1.2 to the D10000–D10099 in the 

Scanner. 

b) Writing D20200–D20299 from the Scanner to D100–D199 in the Adapter with the IP address 

192.168.1.1
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 Use TAG function in data mapping 

a) Create a General Device in the Network View as shown below and then set the IP address to be used   

         as a Produced TAG. For adding a device, please refer to Section 9.4.3. 

 

b) Start or switch to the data mapping page. 

 

c) Once you select the TAG check box, the directional arrow is to the left with () (READ only) 
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*You can also enter the IP address to be connected to other TAGs so that creating a General Device is not 

necessary.  

d) Selecting the Consumed TAG  

Select the created Consumed TAG from the CPU register address /TAG column. 

 

e) Enter the name for the to-be-connected Produced TAG.  

After you select the TAG, the software shows the same TAG name in the register address / parameters / 

address for the Adapter. You can modify the TAG name to have the same name as the Produced TAG 

name.  

 Set the properties  

a) Click the … button to set the properties. 

 

b) In the Property Setting dialog box, enter the data mapping parameters. 

Set the Requested Packet Interval (RPI) to refresh the data between the Scanner and Adapter 

periodically; for example, every 20ms.   
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3. Download 

 Click the Downloader button on the tool bar to open the Project Downloader window. 

 

 Select the Scanner communication port in EIP Builder; every communication port can download a data 

mapping table.  
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9.4.5 Diagnosis 

EIP Builder can provide diagnostic information on the connection and data mapping status. For the connection status, 

refer to the Adapter connection status and indicator in the Network View tab; and for data mapping status and error 

codes, refer to Network_0 in the data mapping tab.    

  
 

 Steps to view network status 

 Network View (Connection Status) 

a) Click the Network View tab to check the device status from the indicators: for example RUN / STOP and 

Error indicators for the PLC.   

 
The dotted line and the warning sign indicate a connection error, as shown below. 

  

Status 

Network View 
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 Network_0 (Data Mapping):  

a) Click the On-line Mode button on the toolbar. 

 

b) Click the Network _0 tab to check the data mapping status and the error codes for Network_0. For error 

code definitions, refer to Section 9.6.2.    

Connec tion Stat us

 

 
 

  

Connection Status 

Error Codes 
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9.5 Programming  

9.5.1 Explicit Message 

All connections in EtherNet/IP can be divided into explicit messaging connections and implicit (or I/O) messaging 
connections. Explicit messaging uses TCP/IP and request/response communications or client/server connections, 
requiring that the instruction include the memory location of the data to be sent to the client. Implicit messaging uses 
UDP/IP, in which a server sends information from predefined memory locations to a client at a given interval, using a 
requested packet interval (RPI) parameter to specify the interval. For details on using implicit messages, please refer to 
Section 9.4.4. This section provides an overview of how the AS Series uses explicit messaging instructions.   

When the AS Series acts a Scanner, you can use the EIPRW instruction (API 2208) to read and write Objects. When EIP 
Builder uses Objects as parameters, each Object includes various parameters. For details on the EIPRW instruction, 
please refer to the AS Programming Manual. For details on Objects that are supported by the AS Series, please refer to 
Section 9.8.  

 

9.5.2 TAG  

EtherNet/IP can use TAGs to exchange data. A Delta PLC can use Global Symbols to define a TAG, and then Delta HMI 
and third party devices can use the TAG. There are 2 types of EIP TAGs, Produced TAGs and Consumed TAGs.  
1. Produced TAG: a PLC makes Produced tags that send data to Consumed tags in other EIP Scanners for data 

mapping with other EIP devices.  
2. Consumed TAG: EIP Scanners make Consumed tags to receive data from Produced tags for data mapping with 

other EIP devices.  
You can use tags to connect to other EIP devices. Before connecting a Consumed TAG, please check the IP 
address of the device to be connected and the Produced TAG name. One device can have more than one Produced 
TAG and Consumed TAG. See the following example.  

Other EIP devices

Produced TAG

Consumed TAG

Produced TAG 1

Consumed TAG 1

Produced TAG

Consumed TAG

Produced TAG 2

Consumed TAG 2

 
 
The following Delta products support TAG functions:  
AS Series PLC CPU: V1.08.20 or later 
ISPSoft software: V3.09 or later 
DOPSoft software (Delta HMI editing software for DOP-100 series): V4.00.07 or later 
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9.5.2.1 Produced TAG 

Creating a Produced TAG 

1. In ISPSoft, in the Project tree, expand Global Symbols to see EtherNet/IP Table (Produced Tag). 

 

2. Double-click EtherNet/IP Table (Produced TAG) to create a Produced TAG. 
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3. Right click in the EtherNet/IP Table (Produced Tag) window and then click Add a Symbol to open the Add Symbol 

dialog box.   

 

4. Enter the required information in the table to create the Produced TAG.  

 

 

After the settings are complete, download the TAG to the PLC. Other EIP devices can access the Produced TAG with 

their Consumed TAG. For information on creating a Consumed TAG, refer to the EIP device manual.  
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9.5.2.2 Consumed TAG 

Creating a Consumed TAG 

1. In ISPSoft, in the Project tree, expand Global Symbols to see EtherNet/IP Table (Consumed Tag). 

 
2. Double-click EtherNet/IP Table (Consumed TAG) to create a Consumed TAG. 
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3. Right click in the EtherNet/IP Table (Consumed Tag) window and then click Add a Symbol.   

 

4. In the Add Symbol dialog box, enter the required information in the table to create a consumed tag.  

 

5. You can use tags in the data mapping. Refer to Section 9.4.4 for more information. 

 Descriptions for the Add Symbol dialog box 

1 2 3 4 5

 
Number Name Description 

 Identifier Create Tags for a PLC; up to 40 characters. 

 Address 
Correspond to registers or bytes in a PLC; you can use a data register or M bit 

device.  

 Type 
Supports data types such as BOOL, WORD, DWORD, INT, DINT, REAL, and 

ARRAY (one-dimensional array linear array, up to 512 bytes).  

 Initial Value Not supported  

 Comment Description for the TAG; up to 128 characters.  
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9.6 Troubleshooting  

This section provides an overview of error codes and troubleshooting for the AS Series.  

9.6.1 Error Code Classification 

There are two types of error code categories for the AS Series: Configuration Errors, and Application Errors. These error 

codes are defined by the ODVA for EtherNet/IP errors. Refer to the following table for AS Series error codes. 

Error Code Classification 

Description 1st Phase 2nd Phase 

Category Item 

Configuration error 
EDS files mismatched 

Mismatched EDS files lead to I/O connection 
failure. *   

Data exchange setup error 
Data exchange setup error lead to I/O 
connection failure. * 

Application error Ethernet/IP error EtherNet/IP communication failure * 

* Only the last 2 bytes of the error code are shown; for example, only 011C appears for the error code H’1101011C.  

9.6.2 Error Codes & How to fix them 

9.6.2.1 Configuration Errors  

(EIP Builder only shows Low word error codes) 

Category Error Code Description How to fix them 

EDS Files 

Mismatched 

H’1101011C  

The Transport Class field 

values of the Transport Class 

and Trigger in the EDS file 

are mismatched.  

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010114 

The Vender ID or the Product 

Code in the EDS file is 

mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010115 

The device type parameters 

in the EDS file are 

mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010116 
The revision parameters in 

the EDS file are mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 
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Category Error Code Description How to fix them 

3. Ask the vendor of the device for the EDS file. 

H’1101011E 

 

The direction parameters in 

the EDS file are mismatched. 

 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’1101011F 

The fixed / variable output 

flag in the EDS file is 

mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010120 

The fixed / variable input flag 

in the EDS file is 

mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010121 
The output priority in the 

EDS file is mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010122 
The input priority in the EDS 

file is mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010123 

The output connection type 

parameters in the EDS file 

are mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010124 

The input connection type 

parameters in the EDS file 

are mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010125 

The redundant ownership 

output parameters in the 

EDS file are mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 
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Category Error Code Description How to fix them 

3. Ask the vendor of the device for the EDS file. 

H’11010126 

The configuration size 

parameters in the EDS file 

are mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010129 

The configuration path 

parameters in the EDS file 

are mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010132 
The EDS file does not 

support Null forward open. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

Data 

Exchange 

Setup Error 

H’12010100 I/O connections duplicated 

1. Check if the system has created the I/O 

connections. 

2. Change the connection type to Listen Only. 

H’12010106 
Scanner ownership of I/O 

connections conflicts  

1. Check the scanner owner. 

2. Reconfigure the invalid scanner. 

3. Change the connection to multicast. 

H’12010110 
Incorrect adapter 

configuration  

1. Check the I/O connection status. 

2. Activate the I/O connections again. 

H’12010111 Adapter RPI not supported  Check the RPI for the adapter.  

H’12010113 Insufficient I/O connections 

1. Check if the number of connections exceeds 

the limit. 

2. Reduce the number of the product connections.  

H12010119  
The connection of non-Listen 

only is not established. 

1. Check if the system has created the I/O 

connections. 

2. Check the scanner I/O connection status. 

H’12010127 Incorrect adapter input size  
Check the module number and the product setup 

file to see if they match.  

H’12010128 Incorrect adapter output size 
Check the output size in the connection 

parameters. 
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Category Error Code Description How to fix them 

H’1201012D 
Consumed TAG does not 

exist. 

Check if the parameters in the Consumed tag are 

set correctly.  

H’1201012E 
Produced TAG does not 

exist. 

Check if the parameters in the Produced tag are 

set correctly. 

H’12010204 
I/O connection connecting 

timeout  

No response from the adapter; check if the power 

and the network connection for the adapter are 

working properly.  

H’12010302 
Network bandwidth NOT 

available for data 

1. Check the I/O connection limit between the 

scanner and the adapter. 

2.  Increase the RPI value or reduce the number of 

connections.  

H’12010315 
Incorrect adapter input/output 

instance  

Check the module number and the product setup 

file to see if they match.  

 

9.6.2.2 Application Error 

Category Error Code Description How to fix them 

EtherNet/ 

IP Error 
H’00010203 I/O connection timeout  

1. Check the network connection status. 

2. Check if the module is working properly. 

3. Increase the RPI value. 
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9.6.3 AS-FPFN02 Error Codes & How to fix them 

9.6.3.1 LED Indicators 

Description Procedure 

System Fail (SF) indicator RED light ON 
Check if the parameters downloaded to the Controller are the 

same as the actual placement  

Bus Fail (BF) indicator RED light BLINKING 

1. Check if the upper device is well-connected 

2. Check if the device name set in the software is the same as 

the device name shown in the function card 

3. Check if the MAC address and the device name are assigned 

correctly 

Bus Fail (BF) indicator RED light ON 

1. Check if the network cable is securely connected 

2. Check if the controller and the function card are both 

supplied with power 

 

9.6.3.2 Status Registers of Siemens S7-1500 

Status Register  

(Siemens S7-1500) 
Description 

Input Data Available 

%I0.0 

If the value is TRUE, the input data is valid.  

If the value is 0, the input data is invalid.  

Check if the AS300 firmware version is V1.08 or higher.  

Connection Status 

%I4.0 - %I4.7 

Indicates PN connection status of Slot 1 ~ Slot 8. 

If the value is TRUE, the Slot is with a working PN connection (with IO module) 

If the value is FALSE, the Slot is without a working PN connection. 

Connection Status 

%I5.0 - %I5.7 

Indicates PN connection status of Slot 9 ~ Slot 16. 

If the value is TRUE, the Slot is with a working PN connection (with IO module) 

If the value is FALSE, the Slot is without a working PN connection. 
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9.7 Studio 5000 Software Operation 

This section provides an overview using Ethernet/IP to connect to a Delta Ethernet/IP Adapter with third party software. 

For this example we use the Rockwell Automation software Studio 5000.  

 

9.7.1 Architecture 

The Rockwell Automation (RA) EIP Scanner uses Ethernet to connect to a Delta Adapter. The PC connects to the RA 

Scanner through Ethernet or USB. 

 
※ Rockwell Software Studio 5000, ControlLogix, RSLogix are registered trademarks of Rockwell Automation, Inc.  

 Operation Steps:  

Download Data ExchangeData Exchange
Set up

Data Exchange
Table

Network View

 

 

9.7.2 Create a New Project 

 Open Studio 5000 and under Create, click New Project. 

 

 
 

  

New 
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 Select a PLC and select the chassis. This example uses a 1756-L71. 

 
 
 

 Click Finish to create the new project. 

 
 

 

 

 

Select PLC 

Select a backplane 
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 After creating the project, Studio 5000 displays the Controller Organizer and workspace.  

 
 

9.7.3 Create a Scanner 

Next, add the 1756-EN2TR Ethernet/IP module, and then connect to the Ethernet/IP devices through the Ethernet/IP 

module.  

 

9.7.3.1 Create a New Ethernet/IP Module 

 Right-click 1756 Backplane 1756-A7 and then click New Module.  
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 Type 1756-EN2TR in the filter field, click the 1756-EN2TR module, and then click Create. 

 
 
 

 Type the Name, IP address and other required information, and then click OK to add the EtherNet/IP module.  
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 The new 1756-EN2TR module appears in the Controller Organizer tree.  

 
 

9.7.4 Connect to a Delta Adapter 

This section provides an overview of connecting to a Delta Ethernet/IP Adapter with the Rockwell Automation software 

Studio 5000. 

9.7.4.1 Import an EDS file 

 In Studio 5000, on the Tools menu, click EDS Hardware Installation Tool.  
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 Select Register an EDS file(s) and click Next. 

 

 
 Select Register a single file and click Browse to find the EDS file to import.  
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 Follow the instructions in the wizard and then click Finish to complete importing the EDS file.  

 

9.7.4.2 Create an Adapter 

 In Studio 5000, in the Controller Organizer under 1756-EN2TR, right-click Ethernet and then click New Module.  
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 Type the module number of the imported Delta EDS file in the filter field, click the Delta module, and then click 

Create. 

 
 

 Verify that the product name and IP address are the same as the information shown in the Module Definition 

section.  
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 Click Change if you need to make a change to the module definition.  

 
 Modify the module definition 

1) Name: Click the arrow button to select a valid connection. 

2) Size: Rockwell PLC supports maximum 500 bytes data size. (Data for input contains 2 bytes of Serial Number 

and for output contains 4 bytes 32-bit Run-idle header and 2 bytes of Serial Number.) If using AS300, you can set 

the maximum data length 498 SINT for input and 494 SINT for output.  

 
※ In general, there is no need to change the parameters from the imported EDS files which can usually be used 

without modification.   
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 In the New Module dialog box, click the Connection tab to modify the Requested Packet Interval and Input Type 

settings. The RPI uses the I/O connection to a Scanner to exchange data at regular intervals, and the units are 

micro-seconds. For Input Type select either Unicast or Multicast. The Input Type selections may vary for different 

products.  

 
 

 Click OK to create the adapter. The new Delta Adapter appears in the Controller Organizer tree.  

 

 
 
 

9.7.5 Editing Corresponding Addresses for AS300  

Refer to section 9.8.5 Assembly Object for defaults of mapping address. Refer to section 9.7.7 on how to open Program 

TAG and modify the contents of TAG:C to edit the mapping addresses. Refer to section 9.8.5 Assembly Object for details 

on TAG:C.  
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9.7.6 Download 

The next step is to download the project to the PLC and go online.  

 In Studio 5000, on the Communications menu, click Who Active. To establish a connection, select the Scanner 

connected to the PC, and then on the Communications menu click Download.  

 
 After the connection is successfully established, the I/O status shows green by I/O OK.  
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9.7.7 Data Mapping 

In the Controller Organizer, you can map data, including Configuration, Input and Output parameters. When you create a 

device I/O Configuration, the tags are added automatically.  

 Click Program TAGs to display the Tags window. 

 
 

 Tags are listed in the Name column. Tag names begin with a product name and end with C or I1 or O1, separated 

from the name by a colon (:), for example CMCEIP01:C, CMCEIP01:I1, and CMCEIP01:O1. 

 
 

 Tag name：C indicates the tag contains information from the Adapter EDS file, including Input and Output 

parameters. You can edit these parameters in Studio 5000.  

 Tag name：I1 indicates that the mapping starts from TAG：I1[0], and is mapped to the first parameters of the 

Adapter output. The length is the output length provided by the Adapter.  

 Tag name: O1, indicates that the mapping starts from TAG：O1[0], and is mapped to the first parameters of the 

Adapter Input. The length is the input length provided by the Adapter. 
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Tag:I1[0]

Tag:I1

Tag:I1[1]

Tag:I1[31]

Parameter_0

Parameter_1

Parameter_31

Adapter
Output

Tag:O1[0]

Tag:O1

Tag:O1[1]

Tag:O1[31]

Parameter_0

Parameter_1

Parameter_31

Adapter
Input

Delta Adapter
VFD-C2000

RA EIP Scanner
1756-L71+1756-EN2TR EtherNet/IP

..
.

..
.

..
. ..
.
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9.8 CIP Object 

9.8.1 Object List 

CIP requires objects (groups of related data and behaviors associated with this data) to describe a device, how it 

functions, communicates, and to define its unique identity. Objects can be further defined by Class (a set of objects 

representing the same type of system), Instance (a copy of an object), and Attribute (data values). An object’s instance 

and class have attributes, providing services and implementing behaviors. Instance 0 contains the basic information for 

every object, that is: version and length. Instance 1–N contains parameters for creating connections. You can get product 

parameters from the supported service code through objects.  

 
You can use API 2208 EIPRW instruction or explicit messages to read / write objects. The supported EtherNet/IP objects 

are listed in the following table. Refer to Section 9.8.2 for the data type definitions. Refer to Section 9.8.3 ~ 9.8.19 for 

object contents.  

Object Name Function Class ID 

Identity Object Provides identification of general information about the device.  1 (H’01) 

Message Router Object 

Provides a messaging connection point through which a client 

can address a service to any object class or instance residing in 

the physical device. 

2 (H’02) 

Assembly Object 

Binds attributes of multiple objects, which allows data to or from 

each object to be sent or received over a single connection and 

can be used to bind input data or output data.  

4 (H’04) 

Connection Manager 

Object 

Provides connection and connectionless communications, 

including establishing connections across multiple subnets. 
6 (H’06) 

Port Object 
Describes the communication interfaces that are present on the 

device and visible to CIP, including USB, Ethernet/IP and more. 
244 (H’F4) 
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Object Name Function Class ID 

TCP/IP Interface Object 

Provides the mechanism to configure a device’s TCP/IP 

network interface; examples of configurable items include the 

device’s IP Address, Network Mask, and Gateway Address. 

245 (H’F5) 

Ethernet Link Object 
Maintains link-specific counters and status information for an 

IEEE 802.3 communications interface.  
246 (H’F6) 

X Register Bit/Word Register 848 (H’350) 

Y Register Bit/Word Register 849 (H’351) 

D Register Bit/Word Register 850 (H’352) 

M Register Bit Register 851 (H’353) 

S Register Bit Register 852 (H’354) 

T Register Bit/Word Register 853 (H’355) 

C Register Bit/Word Register 854 (H’356) 

HC Register Bit/Word Register 855 (H’357) 

SM Register Bit Register 856 (H’358) 

SR Register Word Register 857 (H’359) 

 

9.8.2 Data Type 

This section provides an overview of the data types supported by objects.  

Data Type Description 

BOOL False (H’00) or True (H’01) 

SIGNED 

INTEGER 

SINT (1 byte), INT (2 bytes), DINT (4 bytes), LINT (8 bytes) 

Number 1st 2nd 3rd 4th 5th 6th 7th 8th 

SINT 0LSB        

INT 0LSB 1LSB       

DINT 0LSB 1LSB 2LSB 3LSB     

LINT 0LSB 1LSB 2LSB 3LSB 4LSB 5LSB 6LSB 7LSB 

 

Example: DINT value = H’12345678 

Number 1st 2nd 3rd 4th 

DINT 78 56 34 12 
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Data Type Description 

UNSIGNED 

INTEGER 

USINT (1 byte), UINT (2 bytes), UDINT (4 bytes), ULINT (8 bytes) 

Ex: UDINT value = H’AABBCCDD 

Number 1st 2nd 3rd 4th 

UDINT DD CC BB AA 
 

STRING 

ASCII CODES, 1 or 2 bytes/words 

STRING: 2 bytes character count + 1 byte character  

 Contents (Char count) Contents (String contents) 

STRING 04 00 4D 69 6C 6C 

 

STRING2: 2 bytes character count + 2 byte character 

 Contents (Char count) Contents (String contents) 

STRING2 04 00 4D 00 69 00 6C 00 6C 00 

 

SHORT_STRING: 1 bytes character count + 1 byte character 

 Contents (Char count) Contents (String contents) 

STRING 04 4D 69 6C 6C 
 

Fixed LENGTH 

BIT STRING 

BYTE (1 byte), WORD (2 bytes), DWORD (4 bytes), LWORD (8 bytes) 

  1st 2nd 3rd 4th 5th 6th 7th 8th 

Byte 7…0        

WORD 7…0 15…8       

DWORD 7…0 15…8 23…16 31…24     

LWORD 7…0 15…8 23…16 31…24 39…32 47…40 55…48 63…56 
 

STRINGI 

A single string consists of multiple language representation 

Name Data Type Meaning 

Number USINT 
The number of internationalized character 

strings 

Strings 
Array of: 

Struct of: 

Array of individual internationalized character 

strings 

LanguageChar1 USINT 
The first ASCII character of the ISO 639-2/T 

language 
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Data Type Description 

LanguageChar2 USINT 
The second ASCII character of the ISO 639-2/T 

language 

LanguageChar3 USINT 
The third ASCII character of the ISO 639-2/T 

language 

CharStringStruct USINT 

The structure of the character string, limited to 

the Elementary Data type value 0xD0 

(STRING), 0xD5 (STRING2), 0xD9 (STRINGN) 

and 0xDA (SHORT_STRING) 

CharSet UINT 

The character set which the character string is 

based on which comes from IANA MIB Printer 

Code (RFC 1759). 

International String 
Defined in 

CharStringStruct 

An array of 8-bit octet elements which is the 

actual international character string 

ISO 639-2/T language: 

Language First Character Second Character Third Character 

English e n G 

French f r e 

Spanish s p a 

Italian i t a 
 

STRUCT 

STRUCT of: Composed of any data types. 

Ex.: STRUCT of { BOOL, UINT, DINT } = { TRUE, H’1234, H’56789ABC } 

 1st 2nd 3rd 4th 5th 6th 7th 

Byte 01 34 12 BC 9A 78 56 
 

ARRAY 

Array of: Composed of one data type. 

Ex.: ARRAY of UINTs = { 1，2，3 } 

Number 1st 2nd 3rd 4th 5th 6th 

Array 01 00 02 00 03 00 
 

EPATH 

A path that consists of multiple segments and references the class, instance and attribute of 

another object. 

Example：Identity Object, Instance attribute 5 = “ 20 01 24 01 30 05 “ 
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9.8.3 Identity Object (Class ID: 01 Hex) 

This object stores identity information that consists of the Vendor ID, Device Type, Product Code and Major Revision for 

your device. 

 Service Code 

Service 

code 
Service Name 

Attribute 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’05 Reset X V Resets the drive to the start-up state. 

H’0E Get_Attribute_Single V V Read one attribute 

 Class 

 Class ID: H’01 

 

 Instance 

 H’00: Class Attribute 

 H’01: Instance Attribute 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’1 Revision of this object  

H’02 Max Instance Get UINT H’1 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’1 

Number of object instances 

currently created at this class level 

of the device 

 

 When Instance = 0, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Vendor ID Get UINT H’31F Delta Electronics, Inc. 

H’02 Device Type Get UINT H’0C Communication Adapter 
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Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’03 Product Code Get UINT H’4000 Product Code 

H’04 

Revision 

Get 

STRUCT -- 
Revision of this device: Major / 

Minor 

Major Revision USINT H’01 Major Revision Range: H’01–H’7F 

Minor Revision USINT H’01 Minor Revision Range: H’01–H’FF 

H’05 Status Get WORD H’00 
Status, refer to the following *1 

table 

H’06 Serial Number Get UDINT H’abcd 
The last 4 characters of the MAC 

address, ab:cd 

H’07 Product Name Get STRING “AS300T” 
The maximum length of a product 

name is 32 characters. 

   
 

*1 Status Description (H’05) 

Bit (s) Name Description 

0 Owned 

Does the device has an owner connection?. 

0: No 

1: Yes 

1 Reserved 0，Always OFF 

2 Configured 

Is the device configured? 

0: No 

1: Yes 

3 Reserved 0，Always OFF 

4-7 Extended Device Status 

0: Self-testing 

1: Firmware update 

2: At least one faulted I/O connection 

3: No I/O connections established 

4: Non-volatile configuration error 

5: Major fault 

6: At least one I/O connection in run mode 

7: At least one I/O connection established, all in idle 
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Bit (s) Name Description 

mode. 

8-15: Reserved 

8 Minor Recoverable Fault 
0: No minor recoverable fault detected 

1: Minor recoverable fault detected 

9 Minor Unrecoverable Fault 
0: No minor unrecoverable fault detected 

1: Minor unrecoverable fault detected 

10 Major Recoverable Fault 
0: No major recoverable fault detected 

1: Major recoverable fault detected 

11 Major Unrecoverable Fault 
0: No major unrecoverable fault detected 

1: Major unrecoverable fault detected 

 

9.8.4 Message Router Object (Class ID: 02 Hex) 

This object provides a messaging connection point through which a client may address a service to any object class or 

instance residing in the physical device. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V V Read a single attribute 

 Class 

 Class ID: H’02 

 Instance 

 H’00: Class Attribute 

 H’01: Instance Attribute 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’01 Revision of this object 

 

 When Instance = 0, the Instance Attributes are listed below. 



AS Ser ies  Hardware  and  Operat ion Manual  

 

9-74 

_9 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’02 Number Available Get UINT H’0 
The maximum number of 

connections 

H’03 Number Active Get UINT H’0 
The number of connected 

connections 

 

9.8.5 Assembly Object (Class ID: 04 Hex) 

This object binds attributes of multiple objects, which allows data to or from each object to be sent or received over a 

single connection and can be used to bind input data or output data.  

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V V Read a single attribute 

H’10 Set_Attribute_Single X V Edit a single attribute 

 Class 

 Class ID：H’04 

 Instance 

 H’00：Class Attribute 

 H’64：I/O Connection Output 1 

 H’65：I/O Connection Input 1 

 H’66：I/O Connection Output 2 

 H’67：I/O Connection Input 2 

 H’72：I/O Connection Output 8 

 H’73：I/O Connection Input 8 

 H’74-H’7A Reserved 

 H’80：Configuration 1 

 H’81：Configuration 2 
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 H’87：Configuration 8 

 H’C：Listen-Only Connection Number 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’2 Revision of this object 

H’02 Max Instance Get UINT H’C7 
The maximum number of 

instances 

 
 When Instance = 64–87, the Instance Attributes are listed below. (Length of input and output is editable. The 

maximum length is 250 words; supports only even bytes) 

I/O Message Connection 

Connection No. Function Instance Attribute Length 

Connection 1 

Input (TO) 0x65 D1000~D1099 

Output (OT) 0x64 D0~D99 

Configuration 0x80 Refer to the table below 

Connection 2 

Input (TO) 0x67 D1100~D1199 

Output (OT) 0x66 D100~D199 

Configuration 0x81 Refer to the table below 

Connection 3 

Input (TO) 0x69 D1200~D1299 

Output (OT) 0x68 D200~D299 

Configuration 0x82 Refer to the table below 

Connection 4 

Input (TO) 0x6B D1300~D1399 

Output (OT) 0x6A D300~D399 

Configuration 0x83 Refer to the table below 

Connection 5 

Input (TO) 0x6D D1400~D1499 

Output (OT) 0x6C D400~D499 

Configuration 0x84 Refer to the table below 

Connection 6 
Input (TO) 0x6F D1500~D1599 

Output (OT) 0x6E D500~D599 
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Configuration 0x85 Refer to the table below 

Connection 7 

Input (TO) 0x71 D1600~D1699 

Output (OT) 0x70 D600~D699 

Configuration 0x86 Refer to the table below 

Connection 8 

Input (TO) 0x73 D1700~D1799 

Output (OT) 0x72 D700~D799 

Configuration 0x87 Refer to the table below 

 
 Instance Attribute 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’03 Data Set UINT H’0 
The maximum number of 

connections 

H’04 Size Get UINT H’0 
The number of connected 

connections 

* For connection input data, WRITE function is not supported. 

* When IO connection is established, and the status of CPU module is RUN, WRITE function cannot be executed.  

 

Configure the contents of input and output to edit the mapping address.  

Configuration 

Address 
Data Type Contents 

Defaults 

(Connection 1) 

Word[0] UINT 
Input corresponding element 

0: D, 1:X, 2: Y 
0 

Word[1] UINT Reserved 200 

Word[2-3] DWORD Input corresponding element number 1000 

Word[4] UINT 
Output corresponding element 

0: D, 2: Y 
0 

Word[5] UINT Reserved 200 

Word[6-7] DWORD Output corresponding element number 0 
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 Examples of objects to be read and written 

(1) Read data from connection 1 input:  

Service code: H’0E 

Class ID: H’04 

Instance ID: H’65 

Attribute ID: H’03 

 

(2) Read data length of connection 2 output: 

Service code: H’0E 

Class ID: H’04 

Instance ID: H’66 

Attribute ID: H’04 

 

(3) Read data from connection 2 output:  

Service code: H’10 

Class ID: H’04 

Instance ID: H’66 

Attribute ID: H’03 

Data byte [0 ~ 200]: 00112233  

(The range of data length is determined by configurations; default: 100 words)  
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9.8.6 Connection Manager Object (Class ID: 06 Hex) 

Use this object for connection and connectionless communications, including establishing connections across multiple 

subnets. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V X Read a single attribute 

H’4E Forward_Close X V Close a connection 

H’54 Forward_Open X V 
Open a connection; the maximum 

data size is 511 bytes.   

 Class 

 Class ID：H’06 

 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 

 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT 1 Revision of this object 

H’02 Max Instance  Get UINT 1 
Maximum instance number of this 

object 

 
 When Instance = 1, the Instance Attributes are listed below. 

Attribute Name 
Access 

Rule 
Data Type Values Description 

H’01 Open Requests Get UINT H’0 
Number of Forward Open service 

requests received.  



Chapter  9  Ethernet  Spec i f icat ion and Operat ion 

 

9-79  

9_ 

Attribute Name 
Access 

Rule 
Data Type Values Description 

H’02 Open Format Rejects Get UINT H’0 

Number of Forward Open service 

requests that were rejected due to 

bad format. 

H’03 
Open Resources 

Rejects 
Get UINT H’0 

Number of Forward Open service 

requests that were rejected due to 

lack of resources. 

H’04 Open Other Rejects Get STRUCT H’0 

Number of Forward Open service 

requests that were rejected for 

reasons other than bad format or 

lack of resources. 

H’05 Close Requests Get WORD H’0 
Number of Forward Close service 

requests received. 

H’06 Close Format Rejects Get UDINT H’0 

Number of Forward Close service 

requests that were rejected due to 

bad format. 

H’07 Close Other Rejects Get STRING H’0 

Number of Forward Close service 

requests that were rejected for 

reasons other than bad format. 

H’08 Connection Timeouts Get UINT H’0 

Total number of connection 

timeouts that have occurred in 

connections controlled by this 

Connection Manager. 
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9.8.7 Port Object (Class ID: F4 Hex) 

This section describes the communication interfaces that are present on the device and visible to CIP, including USB, 

EtherNet/IP and more. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V 
Returns a predefined listing of this 

objects’ attributes 

H’0E Set_Attribute_Single V V 
Returns the contents of the 

specified attribute. 

 

 Class 

 Class ID：H’F4 

 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 

 H’N: Instance #N Attribute, the number of the Ethernet port 

 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT 1 Revision of this object 

H’02 Max Instance Get UINT 1 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT 1 

Number of object instances 

currently created at this class level 

of the device 

H’08 Entry Port Get UINT 1 Communication port for EtherNet/IP 

H’09 Port Instance Info Get 
ARRAY of 

STRUCT of 
-- 

Port Instance information: Port Type 

+ Port Number 
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Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

Port Type UINT H’04 EtherNet/IP, refer to the following *1 

Port Number UINT H’01 Identifies each communication port 

 

 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Port Type Get UINT H’04 EtherNet/IP, refer to the following *1 

H’02 Port Number Get UINT H’01 Identifies each communication port 

H’03 

Link Object 

Get 

STRUCT of -- 
Identifies Object attached to this 

port. Path length + Link Path 

Path Length UINT -- Path length 

Link Path EPATH -- Path segment 

H’04 Port Name Get 
SHORT_ 

STRING 
EIP1 Name of the communication port 

H’07 
Port Number and 

Node Address 
Get EPATH 01 01 

Communication port number and 

node number of this device on port. 

 

*1 Communication Port Type 

Communication Port Type Description 

1 Self-defined 

2 ControlNet 

3 ControlNet Redundant 

4 EtherNet/IP 

5 DeviceNet 

201 Modbus/TCP 

203 SERCOS III 
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9.8.8 TCP/IP Interface Object (Class ID: F5 Hex) 

This object provides the mechanism to configure a device’s TCP/IP network interface. Examples of configurable items 

include the device’s IP Address, Network Mask, and Gateway Address. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’0E Get_Attribute_Single V V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

 

 Class 

 Class ID = H’F5 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 

 H’N: Instance #N Attribute, number of IP addresses that the device supported 

 When Instance = 0, the Class Attributes are listed below.  

 

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’2 Revision of this object 

H’02 Max Instance Get UINT H’2 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’2 

Number of object instances 

currently created at this class level 

of the device 
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 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Status Get DWORD H’2 IP status, refer to the following *1 

H’02 
Configuration 

Capability 
Get DWORD H’15 

Configuration capability, refer to 

the following *2 

H’03 
Configuration 

Control 
Get/Set DWORD H’0 

Configuration Control, refer to 

the following *3 

H’04 

Physical Link 

Object： 

Get 

STRUCT of -- Path to physical link object 

Path Size UINT H’0 Size of Path 

Path EPATH -- 
Logical segments identifying the 

physical link object 

H’05 

Interface 

Configuration： 

Get/Set 

STRUCT of -- 
TCP/IP network interface 

configuration. 

IP Address UDINT H’C0A80005 
The device’s IP address; 

192.168.1.5 

Network Mask UDINT H’FFFFFF00 
The device’s network mask:  

255.255.255.0 

Gateway Address UDINT H’C0A80001 
Default gateway address: 

192.168.0.1 

Name Server UDINT 0 Primary name server 

Name Server 2 UDINT 0 Secondary name server 

Domain Name STRING 00 00 Default domain name 

H’06 Host Name Get/Set STRING AS300T Device name 

H’13 
Encapsulation 

Inactivity Timeout 
Get/Set UINT 120 

EIP device active connection 

time;  

unit:0-3600 seconds 

※ When the device is communicating with the CPU module, the Instance Attribute H’03 and H’05 cannot be 

written.  
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 Examples of objects to be read and written 

(1) Read data from Instance Attribute H’03:  

Service code: H’0E 

Class ID: H’F5 

Instance ID: H’01  

Attribute ID: H’03 

 

(2) Write data into Instance Attribute H’05:  

Service code: H’10 

Class ID: H’F5 

Instance ID: H’01  

Attribute ID: H’05 

Data Byte[0~3]: IP Address 

     Byte[4~7]: Network Mask 

 Byte[8~11]: Gateway Mask 

     Byte[12~15]: Name Server 

     Byte[16~19]: Name Server2 

     Byte[20~25]: Domain Name  

(Ex: AS300, 05 41 53 33 30 30; the first byte indicates the string length, its following bytes is for ASCII data.)  

 

*1 Interface Status 

Status Description 

0 The Interface Configuration attribute has not been configured. 

1 
The Interface Configuration attribute contains valid configuration obtained from BOOTP, DHCP or non-

volatile memory. 

2 The Interface Configuration attribute contains valid configuration obtained from hardware. 
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*2 Interface Capability Flags 

Bit Description 

0 BOOTP Client 

1 DNS Client 

2 DHCP Client 

3 DHCP-DNS Update 

4 Configuration Settable 

5 Hardware Configurable 

6 Interface Configuration Change Requires Reset 

 

*3 Interface Configuration Control 

Status Description 

0 
The device uses the interface configuration values previously stored (for example, in non-volatile 

memory or through hardware switches). 

1 The device obtains its interface configuration values through BOOTP. 

2 The device obtains its interface configuration values through DHCP on start-up. 

 

9.8.9 Ethernet Link Object (Class ID: F6 Hex) 

This object maintains link-specific counters and status information for an IEEE 802.3 communications interface. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’0E Get_Attributes_Single V V Read one attribute 

 

 Class 

 Class ID: H’F6 
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 Instance 

 H’00: Class Attribute 

 H’01: Instance Attribute 

 H’N: Instance #N Attribute, the number of the Ethernet port 

 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’03 Revision of this object 

H’02 Max Instance Get UINT H’021 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’01 

Number of object instances currently 

created at this class level of the 

device 

 

 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Interface Speed Get DWORD H’64 

Interface speed currently in use  

10(H’0A), 100(H’64), 1000(H’3E8) 

Mbps 

H’02 Interface Flags Get DWORD H’F 
Ethernet port status, refer to the 

following *1 

H’03 Physical Address Get 
ARRAY of 

6 USINTs 

By 

Product 
MAC address 

H’0A 

Interface Label 

Get 

SHORT_S

TRING 
NA 

Define the name of the Ethernet port  

For example: for port 1, the definition 

of the name in string is 01 31. 

Length USINT NA 
The maximum length of the name is 

16 words. 

Interface name 
SHORT_S

TRING 
NA 

Use ASCII characters to name the 

Ethernet port name. 
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Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’0B 

Interface Capability 

Get 

STRUCT 

of: 
-- 

Ethernet interface capability bits 

table *2 

Capability Bits DWORD 
H’0000000

7 

Ethernet interface capability bits 

definition 

Speed/Duplex Options 
STRUCT 

of: 
-- 

Ethernet interface capability speed & 

duplex option definition 

Speed/Duplex Array 

Count 
USINT H’04 

Ethernet interface capability speed & 

duplex array count 

Speed/Duplex Array 

ARRAY of 

STRUCT 

of: 

-- 
Ethernet interface capability speed & 

duplex array contents  

Interface Speed UINT NA 
Ethernet interface speed; ex:  

H’0A: 10 bps and H’64: 100 bps 

Interface Duplex Mode USINT NA 

Ethernet interface duplex mode; 

H’00: duplex mode and H’01: full 

duplex mode 

 

*1 Interface Flag Table 

Bit (s) Name Description 

0 Link Status 
0 indicates an inactive link 

1 indicates an active link 

1 Half/Full Duplex 
0 indicates half duplex 

1 indicates full duplex 

2-4 Negotiation Status 

0：Auto-negotiation in progress 

1：Auto-negotiation and speed detection failed 

2：Auto negotiation failed but detected speed 

3：Successfully negotiated speed and duplex 

4：Auto-negotiation not attempted. Forced speed and duplex. 

5 Manual Setting Requires Reset Set to zero 

6 Local Hardware Fault 
0: the interface detects no local hardware fault 

1: a local hardware fault is detected 

7-31 Reserved 0 
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※2 Interface Capability Bits 

 

9.8.10 X Register (Class ID: 350 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’32 Read_Parameter X V Read Parameter 

 

 Class 

 Class ID：H’350 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Bits  Item Description 

0 
Manual Setting Requires 

Reset 

Indicates if the device requires a reset when instance attribute #6 

(Interface Control attribute) changes. 

0 indicates the device does not require a reset 

1 indicates the device requires a rest 

1 Auto-negotiate 
0 indicates the interface does not support auto-negotiation 

1 indicates the interface supports auto-negotiation 

2 Auto-MDIX 
0 indicates the interface does not support auto MDIX operation 

1 indicates the interface supports auto MDIX operation 

3 Manual Speed/Duplex 

0 indicates the interface does not support speed/duplex setting. 

(Instance attribute #6, Interface Control attribute) 

1 indicates the interface supports speed/duplex setting 

4-31 Reserved Should be 0 
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Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 X0.0 Get BOOL H’00 X0.0 bit register 

H’01 X0.1 Get BOOL H’00 X0.1 bit register 

H’02-H’03FE X0.2-X63.14 Get BOOL H’00 X0.2 -X63.14 bit register 

H’3FF X63.15 Get BOOL H’00 X63.15 bit register 

 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 X0 Get INT H’00 X0 word register 

H’01 X1 Get INT H’00 X1 word register 

H’02-H’3E X2-X62 Get INT H’00 X2-X62 word register 

H’3F X63 Get INT H’00 X63 word register 

 

9.8.11 Y Register (Class ID: 351 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’351 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 
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 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 Y0.0 Set BOOL H’00 Y0.0 bit register 

H’01 Y0.1 Set BOOL H’00 Y0.1 bit register 

H’02-H’03FE Y0.2-Y63.14 Set BOOL H’00 Y0.2-Y63.14 bit register 

H’3FF Y63.15 Set BOOL H’00 Y63.15 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 Y0 Set INT H’00 Y0 word register 

H’01 Y1 Set INT H’00 Y1 word register 

H’02-H’3E Y2-Y62 Set INT H’00 Y2-Y62 word register 

H’3F Y63 Set INT H’00 Y63 word register 

 

9.8.12 D Register (Class ID: 352 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’352 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  
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Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 D0.0 Set BOOL H’00 D0.0 bit register 

H’01 D0.1 Set BOOL H’00 D0.1 bit register 

H’02-H’752FE D0.2-D29999.14 Set BOOL H’00 D0.2-D29999.14 bit register 

H’752FF D29999.15 Set BOOL H’00 D29999.15 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 D0 Set INT H’00 D0 word register 

H’01 D1 Set INT H’00 D1 word register 

H’02-H’752E D2-D29998 Set INT H’00 D2-D29998 word register 

H’752F D29999 Set INT H’00 D29999 word register 

 

9.8.13 M Register (Class ID: 353 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’353 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 

 When Instance = 1, the Instance Attributes are listed below.  
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Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 M0 Set BOOL H’00 M0 bit register 

H’01 M1 Set BOOL H’00 M1 bit register 

H’02-H’1FFE M2-M8190 Set BOOL H’00 M2-M8190 bit register 

H’1FFF M8191 Set BOOL H’00 M8191 bit register 

 

9.8.14 S Register (Class ID: 354 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’354 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 S0 Set BOOL H’00 S0 bit register 

H’01 S1 Set BOOL H’00 S1 bit register 

H’02-H’7FE S2-S2046 Set BOOL H’00 S2-S2046 bit register 

H’7FF S2047 Set BOOL H’00 S2047 bit register 
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9.8.15 T Register (Class ID: 355 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’355 

 
 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 T0 Set BOOL H’00 T0 bit register 

H’01 T1 Set BOOL H’00 T1 bit register 

H’02-H’1FE T2-T510 Set BOOL H’00 T2-T510 bit register 

H’1FF T511 Set BOOL H’00 T511 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 T0 Set INT H’00 T0 word register 

H’01 T1 Set INT H’00 T1 word register 

H’02-H’1FE T2-T510 Set INT H’00 T2-T510 word register 

H’1FF T511 Set INT H’00 T511 word register 
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9.8.16 C Register (Class ID: 356 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’356 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 C0 Set BOOL H’00 C0 bit register 

H’01 C1 Set BOOL H’00 C1 bit register 

H’02-H’1FE C2-C510 Set BOOL H’00 C2-C510 bit register 

H’1FF C511 Set BOOL H’00 C511 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 C0 Set INT H’00 C0 word register 

H’01 C1 Set INT H’00 C1 word register 

H’02-H’1FE C2-C510 Set INT H’00 C2-C510 word register 

H’1FF C511 Set INT H’00 C511 word register 
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9.8.17 HC Register (Class ID: 357 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’357 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 HC0 Set BOOL H’00 HC0 bit register 

H’01 HC1 Set BOOL H’00 HC1 bit register 

H’02-H’FE HC2-HC254 Set BOOL H’00 HC2-HC254 bit register 

H’FF HC255 Set BOOL H’00 HC255 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 HC0 Set DINT H’00 HC0 word register 

H’01 HC1 Set DINT H’00 HC1 word register 

H’02-H’FE HC2-HC254 Set DINT H’00 HC2-HC254 word register 

H’FF HC255 Set DINT H’00 HC255 word register 
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9.8.18 SM Register (Class ID: 358 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’358 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 SM0 Set BOOL H’00 SM0 bit register 

H’01 SM1 Set BOOL H’00 SM1 bit register 

H’02-H’FFE SM2-SM4094 Set BOOL H’00 SM2-SM4094 bit register 

H’FFF SM4095 Set BOOL H’00 SM4095 bit register 
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9.8.19 SR Register (Class ID: 359 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’359 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 SR0 Set INT H’00 SR0 word register 

H’01 SR1 Set INT H’00 SR1 word register 

H’02-H’7FE SR2-SR2046 Set INT H’00 SR2-SR2046 word register 

H’7FF SR2047 Set INT H’00 SR2047 word register 
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9.9 Delta EIP Product List 

9.9.1 Delta EIP Products 

Positioning Product Firmware Version 

Mid-range 

PLC 

AHCPU501-EN, AHCPU511-EN, AHCPU521-EN, AHCPU531-EN V2.00 

AHCPU560-EN2 V1.00 

AH10EN-5A V2.00 

AHRTU-ETHN-5A V1.00 

AH10EMC-5A V1.00 

AS300 Series V1.00 

AS200 Series V1.00 

AS-FEN02 communication card (V1.06) for AS300 Series (V1.00) V1.06 

AS-FEN02 communication card (V2.02) for AS00SCM-A Series 

(V1.00) 
V2.02 

Small PLC 

DVP-ES2-E Series V3.60 

DVP26SE Series V1.00 

DVP-ES3 Series V1.00 

Inverter 

CMM-EIP01/02 Communication Card for VFD-MS300 Series V1.00 

CMM-EIP03 Communication Card for VFD-MS300 Series V1.00 

CMC-EIP01 Communication Card for VFD-C2000 Series V1.06 

CMC-EIP02 Communication Card for VFD-C2000 Series V1.00 

 

9.9.2 Delta EIP Products, DLR (Device Level Ring) supported  

Positioning Product Firmware Version 

Mid-range 

PLC 

AHCPU560-EN2 V1.00 

AH10EN-5A V2.00 

AHRTU-ETHN-5A V1.00 

Inverter 
CMM-EIP03 Communication Card for VFD-MS300 Series V1.00 

CMC-EIP02 Communication Card for VFD-C2000 Series V1.00 

Ethernet 

Switch 
DVS-103I02C-DLR V1.00 
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9.9.3 Delta EIP Products, Scanner supported 

Positioning Product Firmware Version 

Mid-range 

PLC 

AHCPU501-EN, AHCPU511-EN, AHCPU521-EN, AHCPU531-EN V2.00 

AHCPU560-EN2 V1.00 

AH10EN-5A V2.00 

AS300 Series, AS200 Series V1.00 

Small PLC DVP-ES3 Series V1.00 
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9.10 Operation and Monitor on the Web 

9.10.1 Getting Started 
You can enter AS Series PLC IP address in the search bar of your browser to connect to your device. After that you can 
set up and monitor AS Series PLC.   
 

9.10.1.1 Exploring the webpage 

After connected to the module, you can see the AS300 webpage with 5 sections as the image shown below.  

 
 
Descriptions:  

Section Contents 

Banner Delta logo and the name of the connected device 

Login Username and password 

Menu 
Sitemap is shown in tree diagram. 
(The menu shows data based on the permission of the current 
user.)  

Context Main contents; click an item on the menu section, its content 
appears here.  

Bottom Copyright information and Delta webpage information  
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9.10.1.2 Using the Webpage 

List of browsers that support AS300 webpage:  

Provider Browser Supported versions 

Microsoft Internet Explorer V10.0 and later 

Microsoft Edge V20 and later 

Google Chrome V14 and later 

Mozilla Firefox V17 and later 

Apple Safari V5.1 and later 

 Operation Steps:  

a. Open your browser, enter AS300 PLC IP address in the search bar to connect to AS300 PLC.  

 
b. After the webpage appears, enter “Admin” in the User section and click Login without entering any password. 

You can set up the password after login. 
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9.10.1.3 Login  

You need to login to your account to set up.  

 Operation Steps:  

a. Provide the login information to login.  

 
 

b. After login successfully, the user field shows your account name (read only). After setting up, you can click 
Logout here to leave this webpage.   

 
 

Item Description 

User Your account name  

Password Your password 

“Login” / “Logout” Login: to enter the webpage 
Logout: to leave the webpage 

 

9.10.1.4 Menu  

The menu shows data based on the permission of the current user. 

Nodes 
Permission 

Administrator Write/Read Read 

Device information V V V 

Account management V   

Data monitor setup V   

Data monitor table 1 - 4 V V Read-only 

Hardware status V Read-only Read-only 

Save configuration V   
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 Log in as an Administrator, the following nodes appear.  

 
 

 Log in with Write/Read permission, the following nodes appear.  

 
 

 Log in with Read only permission, the following nodes appear.  

 
 



AS Ser ies  Hardware  and  Operat ion Manual  

 

9-104 

_9 

9.10.2 Device Information 

Here provides AS Series PLC product information. 

You do not need to log in to see the device information. This page is read only, not for editing.  

 
 

Item Description 

Device name Product name 

Device description Device description that user defined in ISPsoft 

Firmware version Firmware version  

IP address Product IP address 

MAC address Product MAC address 

Serial number Product serial number 

 

9.10.3 Network configuration 

You can set network related configurations here.  

9.10.3.1 Account management  

You can set 3 kinds of access types for up to 8 user accounts.     
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Item Description 

User ID 

 To name your user ID, you can use up to 16 characters from the 

following characters, A through Z (case-insensitive ), 0 through 9, 

_ (underscore) , (comma) and . (dot) . 

 The first default user ID is “Admin” (read only). 

Password 

 To name your password, you can use up to 16 characters from the 

following characters, A through Z (case-insensitive ), 0 through 9, 

_ (underscore) , (comma) and . (dot) . 

 No password for the default user ID “Admin” (read only), 

you can set up the password later.  

Access type 

 Administrator: You can set up all parameters and have permission 

to edit the password and permission.  

 Write/Read: You can open the data monitor pages and the 

diagnostic page. You can also edit the parameters.   

 Read: You can open the data monitor pages and the diagnostic 

page. But you cannot edit parameters.  

 Default user is “Administrator”. 

“Delete”  Use “Delete” to clear the user ID and password.  

“Apply” Use “Apply” to save the settings.  

 
 Operation Steps:  

a. After log in, double-click Account management to open the setting page.  
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b. Set up the User ID, the password and the access type. After editing, click “Apply” to save the setting or click 
“Delete” to clear the account.  

 
 

c. Double-click Save configuration to open the setting page.  

 
 

d. Click “Save” to save and download the settings to the device.  
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e. After download is complete, it will be prompted with a Download successful message. 

 
 

9.10.4 Data Monitoring 

You can set monitoring related configurations here.  

 

9.10.4.1 Data Monitoring Setup Page  

You can set up 4 pages of monitoring data and up to 30 items can be monitored on each page.  
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Item Description 

Table name 

 To name your table, you can use up to 16 characters from the 

following characters, A through Z (case-insensitive ), 0 through 9, 

_ (underscore) , (comma) and . (dot) . 

Device quantity  Device quantity to be monitored; default: read only 

Default update cycle  Set up the updated cycle time; default: 5 seconds; unit: second 

“Edit” 
 Click “Edit” to edit the table and the table name column turns 

green. The table contents appear below.  

“Delete”  Click “Delete” to delete the table and its contents.  

Device 
 Devices to be monitored; you can enter the following devices to 

monitor xX, yY, mM, sSmM, sSrR, dD, sS, tT, cC, hHcC and eE. 

Radix 

 Positional numeral system to be shown on the monitoring page; 

available formats are Signed decimal, Unsigned decimal, 

Hexadecimal, Octal, Binary, 32bit Signed decimal, 32bit Unsigned 

decimal, 32bit Hexadecimal, 32bit Octal, 32bit Binary, 32bit Float 

and 64bit Double 

Read only  Set up the monitored devices to read only or not.  

Description  Add a description here for the table.  

“Apply”  Click “Apply” to save the settings.  

 Operation Steps:  

a. After log in, double-click Data monitor setup to open the setting page.  
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b. Use “Edit” to edit the table name, device quantity, and update cycle time.  

 
 

c. The corresponding table contents appear below. 

 
 

d. Edit the devices to be monitored, radix to be shown, read only or not and the description. After editing, click 
“Apply” to save the setting.  
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e. Double-click Save configuration to open the setting page.  

 
 

f. Click “Save” to save and download the settings to the device.  

 
 

g. Once the download is complete, you can see the newly added table to be monitored under the Data Monitor 
node.  

 
 

h. Note: The data monitor table must be downloaded to the device otherwise even if the data monitor table is 
created, it cannot be monitored.  
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9.10.4.2 Data Monitor Table Pages 

The setting results are shown as below. 

 

 

Item Description 

Table name Name of the table; read only 

Monitor status 
Status of the monitoring; read only  
Yellow light: reading, Green light: reading complete, Red light: 
reading error  

Update cycle Update cycle time; default is what you set up in data monitor 
setup page; unit: second  

“-“ Minus; click once to decrease 1; the minimum value is 1 

“+“ Plus; click once to increase 1; the maximum value is 60 

Floating format setting Floating point setting; round down; default: round the number 
down to three decimal places  

Device Devices to be monitored; read only 

Radix 

Positional numeral system to be shown on the monitoring page; 
available formats are Signed decimal, Unsigned decimal, 
Hexadecimal, Octal, Binary, 32bit Signed decimal, 32bit 
Unsigned decimal, 32bit Hexadecimal, 32bit Octal, 32bit Binary, 
32bit Float and 64bit Double 

Description Add a description here for the table; read only 

Status 
Status of bit; read only 
Green LED: ON; No LED: OFF 

Value 

Values in devices to be monitored; read only 
Signed decimal: K+ Number 
Unsigned decimal: K+ Number 
Hexadecimal: H + hex Number 
Octal: O + octal Number 
Binary: B + binary Number 
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Item Description 

32bit Signed decimal: K+ Number 
32bit Unsigned decimal: K+ Number 
32bit Hexadecimal: H + hex Number 
32bit Octal: O + octal Number 
32bit Binary: B + binary Number 
32bit Float: float Number 
64bit Double: float Number 

“On” / ”Off”  

“ON”: the status of Bit is ON.  
“OFF”: the status of Bit is OFF.  
 If the authority level for the logged in user is READ, this 
column is read only.  

Set Value 

Change the value for the device to be monitored 
 Type the value in and click “SET” and the changed value 
appears in the VALUE column as the image shown above.  
 If the authority level for the logged in user is READ, this 
column is read only. 

“Set” 
Click “Set” to confirm the changed value. 
 If the authority level for the logged in user is READ, this 
column is read only. 

 

9.10.5 Diagnostic 

You can set diagnostic related configurations here.  

9.10.5.1 Hardware Status Page 

This page displays information on hardware status, CPU module, power module, and function cards. You can set CPU to 

run or stop. Here also shows the CPU running status and error codes.    

 
 For AS300, the hardware status page looks like below. 
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 For AS200, the hardware status page looks like below. 

 
 

Item Description 

Refresh cycle Refresh cycle time; default: 10; unit: second 

“-“ Minus; click once to decrease 1; the minimum value is 1 

“+“ Plus; click once to increase 1; the maximum value is 60 

Power module name Name of the power module; read only 

CPU module name Name of the CPU module; read only 

CPU Run LED 

LED of CPU running status; read only 

Green light: RUN  

LED Not Lit: STOP 

CPU Error LED LED of CPU Error; read only 

CPU Error code Error codes of CPU module; read only 

“Run” / “Stop” 

Click “RUN” to set the running status to RUN 

Click “Stop” to set the running status to STOP 

 If the authority level for the logged in user is WRITE/READ 

or READ, this column is read only. 

Function card name 

Name of the function card; read only 

 For communication module, two extra rows for the names 

of the communication function cards are shown here 

Module name 

Name of the module; read only 

When the actual placement is not the same as the arrangement 

in HWCONFIG, the background of this column will be in red.   

Module Error LED LED of module error; read only 

Module Error code Error codes of module; read only 
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9.10.6 Configurations 

9.10.6.1 Save Configuration Page 

You can save the configurations and download the parameters to your device here.  

 
 

Item Description 

“Save” Download the saved parameters to the device. 

PLC Status 
LED of PLC running status; read only 

Green light: RUN  

LED Not Lit: STOP 

“Run” / “Stop” 
Click “RUN” to set the running status to RUN 

Click “Stop” to set the running status to STOP 

Note: The data monitor table must be downloaded to the device. If not, once you log out, close the page or restart the 

PLC, all the temporary saved parameters will be cleared.  

 

9.11 Delta EIP Product Application (with OMRON Products) 

9.11.1 Architecture 

Delta EtherNet/IP Scanner connects to OMRON EtherNet/IP Adapter through Ethernet communication. PC connects to 

Delta EtherNet/IP Scanner through Ethernet communication or USB connection.  

Software versions for AS300 and OMRON NJ501-1300: 

 AS300 CPU  

ISPSoft: V3.02.25 

COMMGR: V1.06.05 

HWCONFIG: V3.02.20 

EIP Builder: V1.03.01 

 

 OMRON NJ501-1300: 
Sysmac Studio : V1.15 
Network Configurator : V3.59c 
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 Operation Steps:  

Download Connect ion 
Status

Data Mapping
Set up

EtherNet /IP
Set upNetwork Set up

 
 

9.11.2 TAG Connection 

EtherNet/IP can use TAGs to exchange data. Here AS300 CPU acts as Master and OMRON NJ501-1300 as a Producer 

TAG to establish an EtherNet/IP communication.  

 

 Create Produced TAG 

1. Start the OMRON software Sysmac Studio. Select Connect to Device. Configure the parameters and then click 

Connect.  
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2. After the connection is successfully established, click Tools on the menu bar. And then select EtherNet/IP 

Connection Settings to access the EtherNet/IP connection settings. 

3. Right-click the cell of the Node Address you’d like to edit its EtherNet/IP settings and then select Edit to open 

the EtherNet/IP communication setting window.   

4. Double-click Global Variables under Programming - Data in the Multiview Explorer. Right-click in the global 

variable table and select Create New from the menu. 

 

5. Right-click in the global variable table and select Create New from the menu. 

*Click Controller on the menu bar and change the Project to Disconnected before creating a new global  

 

6. Set the Network Publish to Output. 

And then with this attribute, you can access a variable from external devices through CIP communications or a 

tag data link. For tag data links, this can be a variable for data output (from the local Controller to another 

Controller). 

 
7. Select the tab of Built-in EtherNet/IP Connection Settings and select the Tag Set from the left. Right-click in 

the editing area and select Create New Tag Set from the menu and then name the tag set as ToAS .   
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8. Right-click on the created Tag Set and select Create New Tag from the menu.  

 
 

9. The tag is added in the created tag set.  

 
 

10. Click Controller and then Synchronize…from the menu bar to synchronize the setting with OMRON Scanner. 
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11. Create Tag sets in Network Configurator. Open Network Configurator and select Option-> Select Interface-> 

Ethernet I/F. 

 
 

12. Select Network -> Connect 

 
 

13. Select Interface and click OK to confirm the setting.  
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14. The blue light indicates the connection is working normally. 

 
 

15. Drag OMRON NJ501-1300 from the EtherNet/IP Hardware section to the network view. 

 
 

16. Right-click OMRON NJ501-130 (the scanner) and select Parameter -> Edit from the menu.  
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17. Click Edit Tags on the Tag Sets tab and click New on the Out-Produce tab to create a new tag with the same 

name and length as the one from the “output” tag set in Sysmac .  

 
 
18. The new tag is created as shown below.  
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19. After setting, click Network -> Download.  

 
 

 
20. After downloading, the Network Configurator dialog box is displayed.  
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 Create a Consumed TAG 

1. Start ISPSoft and click Tools -> Communication Settings and select a driver with Ethernet communication.  

※ Before setting the communication, make sure COMMGR is working normally and save the driver settings.  

 
 

 
 

2. Click Global Symbols to expand the tree node and see the options. Double-click EtherNet/IP Table (Consumed 

Tag) from the Project section on the left. Right-click the blank area and select Add a Symbol.  
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3. Set the data type to ARRAY[200] OF WORD and then click OK to confirm the setting.  

※ Data size should be the same as the Produced Tag data size

 

 

A symbol is added, as the image shown below. 
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4. Go to PLC-> Transfer -> Download to download the parameters to the Scanner. 

 
 

5. Double-click HWCONFIG from the Project section on the left to start HWCONFIG.  

 
 
  



Chapter  9  Ethernet  Spec i f icat ion and Operat ion 

 

9-125  

9_ 

6. Right-click the PLC and select Communication Software - > EIP Builder to start EIP Builder. 

 
 

7. Click Tool-> DDF(EDS) Manager to import the EDS File.  
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8. Drag and drop the device from the Product List on the right to add have it added in the Network View.  

※ You can select the device and click the Information tab to edit its IP address. 

 

 

9. Drag and drop the red spare to have the Ethernet communication port connected to the network. 
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10. Right-click the CPU’s communication port and select Data Mapping to create a data mapping table.  

 
11. Make sure the data below CPU Address/TAG and Adapter/TAG is correct.  

※ CPU Address/TAG: Consumed TAG 

   Adapter /TAG: Produced TAG, created by Producer 
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12. Click Operate-> Downloader to download the parameters to the Scanner. 

 

 

 Connection Check 

1. Click  to have the project in On-line Mode and see if the network lines are solid ones.  
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2. The solid network lines indicate the data mapping is being monitored successfully.  

 

 Data Mapping 

1. Start Sysmac Studio and make sure the project is in Online Mode. Go to View -> Watch Tab Page on the menu 

bar. Click Watch Tab Page to monitor.  

 

2. Select Watch (Table) 1 and input a name for the tag.  
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Modify the values according to the display format. Make sure the value in the Online Value column is the same as the 

value in the Modify column.  

 

 

3. Start ISPSoft, and select Device Monitor Table -> New to create a new device monitor table.  

 

 

4. Double click the blank area in the Monitor Table and then select the Identifier tab. Set up the Object (variable 

name) and the Name (source) and then click OK to confirm the setting.  
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5. After setting up, switch to Online Mode.  

 

6. Make sure the values in Consumed Tag are the same as the ones in Produced Tag.  

 

9.11.3 IO Connection 

 Set up an IO Connection from a slave station 

1. Create two variables and set the rule of one variable as input and set the rule of the other variable as output. Set 

the data type and length as Array[0..99] of word. 

 

 

2. Go to Tools -> Export Global Variables -> Network Configurator on the menu bar.  
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3. Start Network Configurator and then add and edit NJ501-1300 from the Ethernet Hardware List on the left. 

Select Parameter -> Edit and click To/From File -> Export to File on lower right corner of the Tag Sets page. 

 

 

 

4. After the file is imported, make sure the input and output variables are imported in In-Consume and Out-Produce 

sections.   
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5. Click the variable in In-Consume section and select Edit. 

 

6. Click Advanced button in the Edit Tag Set window and set the Instance ID to Manual and then input the Instance 

ID you’d like to use for IDs in In-Consume section.  
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7. Use the same method to set the Instance ID manually for IDs in In-Consume section as you have set for IDs in 

Out-Produce section. 

 

8. When the settings for Instance ID are done, click OK to confirm the settings on Edit Device Parameter.  

9. Click Network -> Download to download the parameters to the slaves.   
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 Set up an IO Connection from a Master station 

1. Start EIP Builder and drag and drop a General Device into the Network View area and set up network connection.  

 
 

2. Click slave icon and set up its IP address and then configure the parameters in the EIP Parameter tab.  

 

 

 

3. Set up the slave IO connection:  

a. Master Output Instance ID = Slave Input (In-Consume) Instance ID 

b. Master Input Instance ID = Slave Output (Out-Produce)Instance ID 

※ Refer to slave’s operation manual for more information on Instance IDs.  
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4. Set up the connection and start data mapping. 

 

5. Download the EIP parameters to the master.  
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 Connection status 

1. After the parameters are downloaded, change the project to Online Mode. And make sure the monitoring on 

the network and the data mapping table is normal.  

Network View 

 

 

Data mapping status 
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 Data Mapping 

1. Start ISPSoft and create a new Monitor Table. Add devices that correspond to the master in the table.  

 

 

2. Change the project to Online Mode and start to monitor the data mapping.  

Monitoring from the master 

5555
7CB6

00005555
00007CB6

0.000
0.000

 

 

Monitor from the slave 

 

Master_Address Slave_Address 

D0  
ToAS_IO 

（Instance ID=110) 

D500  
FromAS_IO 

（Instance ID=100) 

 



 

 10-1 

 
 

Chapter 10 CANopen Function and Operation 
 
Table of Contents 
 

10.1 Introduction to CANopen ................................................................. 10-2 
10.1.1 CANopen Function Descriptions...................................................... 10-2 
10.1.2 The Input/Output Mapping Areas ................................................... 10-4 
10.1.3 Refreshing Mechanism in the Input/Output Mapping Areas ................ 10-5 

10.2 Installation and Network Topology .................................................. 10-9 
10.2.1 The Dimensions of AS-FCOPM ........................................................ 10-9 
10.2.2 AS-FCOPM on AS300 PLC .............................................................. 10-9 
10.2.3 Configure the AS-FCOPM with HWCONFIG ...................................... 10-10 
10.2.4 The CAN Interface and Network Topology ....................................... 10-11 

10.3 The CANopen Protocol ................................................................... 10-16 
10.3.1 Introduction to the CANopen Protocol ............................................ 10-16 
10.3.2 The CANopen Communication Object ............................................. 10-17 
10.3.3 The Predefined Connection Set ..................................................... 10-22 

10.4 Sending SDO, NMT and Reading Emergency Message through the Ladder  
       Diagram ......................................................................................... 10-24 

10.4.1 Data Structure of SDO Request Message ........................................ 10-24 
10.4.2 Data Structure of NMT Message .................................................... 10-27 
10.4.3 Data Structure of EMERGENCY Request Message ............................ 10-28 
10.4.4 Example of Sending SDO through the Ladder Diagram .................... 10-30 

10.5 Troubleshooting ............................................................................ 10-32 
10.5.1 CANopen Network Node State Display ........................................... 10-32 

10.6 Application Example ...................................................................... 10-35 

10.7 Object Dictionary ........................................................................... 10-43 

8 10 



AS Ser ies  Hardware  and  Operat ion Manual   

 10-2 

_10 

10.1 Introduction to CANopen 
1. Because of its simple wiring, immediate and stable communication, strong debugging ability, and low 

cost, the CANopen network is widely used in fields such as industrial automation, the automotive 
industry, the medical equipment industry, and the building trades. 

2. The AS300 Series PLC is compatible with CANopen when using the AS-FCOPM function card for the 
CAN port, and can work in master mode or slave mode. The CAN port conforms to the basic 
communication protocol CANopen DS301. It supports master and slave modes.  

3. AS200 Series PLC is built with CAN communication port. The CAN port conforms to the basic 
communication protocol CANopen DS301. It supports master and slave modes. 

4. This chapter explains the functions of CANopen. In master mode, CANopen can support up to 64 slaves, 
station addresses 1~64. 

5. CANopen Builder is the CANopen network configuration software for the AS Series. You set the 
CANopen station address and the communication rate with this software. ISPSoft is the programming 
software for the AS Series. 

6. This chapter mainly focuses on the CANopen functions. Refer to Section 10.3 for more information. 

 

10.1.1 CANopen Function Descriptions 

The CAN port has the following functions when acting as a master. 

1. It supports the standard CANopen protocol DS301 V4.02. 

2. It supports the NMT (network management object) service. 

 It supports NMT state control. 

Use NMT state control to control the state of a slave in the CANopen network. 

 It supports NMT error control. 

Use NMT error control detect the disconnection of a slave. The NMT error control is classified into 
two types; Heartbeat and Node Guarding. The AS Series PLC does not support Node Guarding. 

3. It supports the PDO (Process Data Object) service. 

 Use PDO messaging to transmit immediate input and output data. 

 It supports up to 256 RxPDO and 1894 bytes.  

 It supports up to 256 TxPDO and 1894 bytes. 

 It supports synchronous and asynchronous modes for the PDO transmission type. 

4. It supports the SDO (Service Data Object) service. 

 Use SDO to read, write, or configure the slave parameters.  

 It supports standard SDO transmission mode.  

 It supports automatic SDO functions. You can write up to 20 pieces of data to a slave.  

 It supports using the SDO service in a PLC ladder diagram to read the data from a slave or write 
the data to a slave. 
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5. It supports the reading emergencies from a slave service. 

 Use this service to read an error or an alarm from a slave. 

 You can store up to 5 emergencies in a slave. 

 You can read emergencies from a slave through a PLC ladder diagram. 

6. It supports the SYNC object (synchronous object) service. 

7. Several devices can operate synchronously through the synchronous object service. 

8. The supported CANopen communication rates are: 20K, 50K, 125K, 250K, 500K, and 1Mbps. 

The supported mapping data types are: 

Storage Data type 
8-bit SINT USINT BYTE 

16-bit INT UINT WORD 

32-bit DINT UDINT REAL DWORD 

64-bit LINT ULINT LREAL LWORD 

 

The CAN port has the following functions when acting as a slave. 

 It supports the standard CANopen protocol DS301 V4.02. 

 It supports the NMT (network management object) service. 

 It supports the NMT state control. 

The state of the AS series in the CANopen network is controlled by a master. 

 It supports the NMT error control. 

The AS Series supports Heartbeat but not Node Guarding. 

 It supports the PDO (process data object) service. 

 The PDO message transmits the immediate input data and output data. 

 It supports up to 8 TxPDO and 8 RxPDO. 

 The PDO transmission type: synchronous mode and asynchronous mode 

 It supports the emergency service. 

If an error or an alarm occurs in the AS series, the master is notified through the emergency service. 
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10.1.2 The Input/Output Mapping Areas 

The following table lists the CANopen DS301 specifications for the AS series PLC.  

Type Item Description 

Master 
Maximum slave nodes Up to 64 nodes 
Maximum transfer size of 
a PDO (Read + Write) 

Up to 2000 Bytes (including some system configurations) 

Slave 
Maximum transfer size of 
a PDO (Read + Write) 

Up to 8 PDOs; each PDO with up to 8 bytes can be transferred 
at a time 

 

When the AS Series PLC acts as a Master, the output mapping areas are D25000-D25999, and the input 
mapping areas are D24000-D24999, as the following table shows. 

Device in the PLC Mapping area Mapping length 

D25000–D25031 
SDO request information, NMT service information, and 
Emergency request information 

64 bytes 

D24000–D24031 SDO reply information, and Emergency reply information 64 bytes 
D25032–D25978 RxPDO mapping area (Master  Slave) 1894 bytes 
D24032–D24978 TxPDO mapping area (Master  Slave) 1894 bytes 

 

When the AS Series PLC acts as a Slave, the output mapping areas are D25032–25063, and the input 
mapping areas are D24032–24063 as the following table shows. 

Device in the PLC Mapping area Mapping length 
D24032~24063 RxPDO mapping area (Slave  Master) 64 bytes 
D25032~25063 TxPDO mapping area (Slave  Master) 64 bytes 
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10.1.3 Refreshing Mechanism in the Input/Output Mapping Areas  

When AS PLC CPU acts as a Master, the factors including PLC scan time and the synchronization options 
affect the refreshing mechanism for data mapping in the input/output mapping area. Here we list three 
scenarios in synchronous mode and one scenario in non-synchronous mode for your reference.    
 
 Synchronous mode 
Scenario A: ½ synchronization cycle time (for the slave to send data) > PLC scan time  
A half of the synchronization cycle time is longer than a PLC scan time: at lease one PDO will be sent within 
one synchronization cycle time.  
 

 
 

Sync cyc le Sync cyc le Sync cycle Sync cyc le

        

½ Sync

    


½ Sync ½ Sync ½ Sync ½ Sync

 
 

Explanation:  

: Once the synchronization cycle starts, the timer starts to count. The counted time should be longer than a 
half of the set synchronization time (a rounded-down number) for Master to send PDO to Slave.    

 

: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  

PLC CPU sends PDO and then clears the counted time.  
 

: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
The counted time of the synchronization cycle is less than half of the synchronization cycle time (for the slave 
to send data), or the PDO had already been sent before, the PDO here cannot be sent and the time of the 
synchronization cycle continues to be counted.  

 

: From the cases in the green section, we know that the time for the PDO to be sent does NOT equal to the 
time to perform synchronization, but what we can be sure is that a Master can send at lease one PDO within 
every synchronization cycle.  
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Scenario B:  
Synchronous mode; ½ synchronization cycle time (for the slave to send data) < = PLC scan time < 
synchronication cycle time  
A half of the synchronization cycle time is less than a PLC scan time and the PLC scan time is less than or 
equals to a whole synchronization cycle time: it is possible that zero PDO will be sent during a 
synchronization cycle. 
 

 

Sync cycle Sync cycle Sync cycle Sync cyc le

 #1  

½ Sync ½ Sync ½ Sync ½ Sync ½ Sync

 



      
 

Explanation:  

: Once the synchronization cycle starts, the timer starts to count. The counted time should be longer than a 
half of the set synchronization time (a rounded-down number) for Master to send PDO to Slave.    

 

: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
PLC CPU sends PDO and then clears the counted time. 
 
#1: There was no PDO sent from the previous synchronization cycle. Before PLC scan time ends, the next 
synchronization cycle comes and the counted time is longer than a half of the set synchronization time (a 
rounded-down number), PLC CPU sends PDO and then clears the counted time.  
 
: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
The counted time of the synchronization cycle is less than half of the synchronization cycle time (for the slave 
to send data), the PDO here cannot be sent and the time of the synchronization cycle continues to be 
counted. 
 

: From the cases in the green section, we know that the time for the PDO to be sent does NOT equal to the 
time to perform synchronization, and it is possible that Master can send zero PDO during a synchronization 
cycle.   
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Scenario C:  
Synchronous mode; synchronization cycle time < = PLC scan time  
The synchronization cycle time is less than a PLC scan time: it is possible that zero PDO will be sent during a 
synchronization cycle. 
 

 

Sync cycle Sync cycle Sync cyc le Sync cycle

  #1 



Sync cycle



      
 
Explanation:  

: Once the synchronization cycle starts, the timer starts to count. The counted time should be longer than a 
half of the set synchronization time (a rounded-down number) for Master to send PDO to Slave.    
 
: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
PLC CPU sends PDO and then clears the counted time. 
 
#1: There was no PDO sent from the previous synchronization cycle. Before PLC scan time ends, the next 
synchronization cycle comes and the counted time is longer than a half of the set synchronization time (a 
rounded-down number), PLC CPU sends PDO and then clears the counted time.  
 
: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
The counted time of the synchronization cycle is less than half of the synchronization cycle time (for the slave 
to send data), the PDO here cannot be sent and the time of the synchronization cycle continues to be 
counted. 
 

: From the cases in the green section, we know that the time for the PDO to be sent does NOT equal to the 
time to perform synchronization, and it is possible that Master can send zero PDO during a synchronization 
cycle. The chance of Master not sending any PDO during a synchronization cycle is higher than what 
happened in scenario B.  
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 Non-synchronous mode  
 

  

X X

    PLCScancyc le PLCScancycle PLCScancycle PLCScancyc le PLCScancycle
 

 
Explanation:  

: After PLC scan time ends, PLC CPU refreshes to update the task of sending PDO.  
 
: If the data in PDO changes, PLC CPU sends PDO. 
 
: The data in PDO remains the same, the PDO here is NOT sent.  
 

Note: You can use the function of setting up the PLC scan time to ensure PLC CPU checks the task of 
sending PDO in every set scan time.   
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10.2 Installation and Network Topology 
This section introduces the physical dimensions of AS-FCOPM function card, the HWCONFIG settings of the 
AS Series, the CAN interface, the CANopen network framework, and the maximum communication distance. 

 

10.2.1 The Dimensions of AS-FCOPM 

61
.3

37
59

.3

23.9
 

Unit: mm 

10.2.2 AS-FCOPM on AS300 PLC 

 
Note: the AS-FCOPM card can only be installed in the Card 2 slot in the AS series 
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10.2.3 Configure the AS-FCOPM with HWCONFIG  

Before using the AS-FCOPM card in an AS300 Series PLC, use HWCONFIG in ISPSoft to configure the AS-
FCOPM card. If you are using an AS200 Series PLC, the first two steps can be ignored. 

1. You can only install the AS-FCOPM in the card 2 slot as marked in red below. Double click the function 
card 2 slot to go to the Device Setting dialog box.  

 
 

2. Select Manual for Card 2 Detect mode and select AS-FCOPM Card for Manual Select Card.  

 
 
3. Select the working mode, node ID and the bit rate for AS-FCOPM. 

* Working mode: CANopen DS301 

* Node ID: 1 

* Bit rate: 125k bps (the default, or you can select your own bit rate) 
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4. When finished, click the Download button on the toolbar to download the settings to the PLC.  

 
 

10.2.4 The CAN Interface and Network Topology 
10.2.4.1 Definitions of the CAN Signal and Data Types 
The CAN signal is a differential signal. The voltage of the signal is the voltage difference between CAN+ and 
CAN-. The CAN+ and CAN- voltages take SG as a reference point. The CAN network can be in one of two 
states. One state is a dominant level, and is indicated by the logical “0”. The other state is a recessive level, 
and is indicated by the logical “1”. The CAN signal level shows below. 

 
The following picture shows the data frame format. The CAN nodes transmit the CAN messages to the 
network from left to right. 

 
 

  

Dominant Recessive 
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10.2.4.2 The CAN Network Endpoint and the Topology Structure 
In order to make the CAN communication more stable, the two endpoints of the CAN network are connected 
to 120 ohm terminal resistors. The topology structure of the CAN network appears below. 

 
 

10.2.4.3 The Topology Structure of the CANopen Network 

 
1) Use standard Delta cables when wiring the CANopen network. These cables are the thick cable UC-

DN01Z-01A, the thin cable UC-DN01Z-02A, and the thin cable UC-DN01Z-02A. Separate the 
communication cables from any power cables to avoid interference. 

2) Connect the CAN+ (white) and CAN- (blue), which are at the endpoints of the network, to 120 ohm 
resistors. The AS-FCOPM card is equipped with a 120 ohm resistor switch; you can enable the resistor 
with the switch. Purchase the standard Delta terminal resistor for use with the other devices and the RJ45 
connecter.  

3) Note the limitation on the length of the CANopen network. The transmission distance of the CANopen 
network depends on the transmission rate of the CANopen network. The following table shows the 
relation between the transmission rate and the maximum communication distance. 

Transmission rate 
(bit/seconds) 20K 50K 125K 250K 500K 1M 

Maximum 
communication distance 
(meters) 

2500 1000 500 250 100 25 
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4) The list below shows the Delta network products for the CANopen network. 

Product Model Function 

 

 

AS332T-A 
AS332P-A 
AS324MT-A 
AS320T-B 
AS320P-B 
AS300N-A 

The AS300 series PLC can function as the 
CANopen master or slave when you install an 
AS-FCOPM function card. The AS-FCOPM is 
equipped with a 120 ohm resistor controlled 
by a switch. 

 

AS228T-A 
AS228P-A 
AS228R-A 
AS218TX-A 
AS218PX-A 
AS218RX-A 

AS200 Series PLC is built with CAN 
communication port. The CAN port conforms 
to the basic communication protocol 
CANopen DS301. It supports master and 
slave modes. The CAN communication 
terminal is equipped with a 120 Ω resistor. 
You can use a short circuit to use this 
resistor.  

 

DVP32ES200RC 
DVP32ES200TC 

The DVP-ES2-C series PLC has a built-in 
CAN interface. It can function as the 
CANopen master or slave. 

 

DVPCOPM-SL 

DVPCOPM-SL is a module connected to the 
left side of an S series PLC. It can function 
as the CANopen master or slave. The PLCs 
that you can connect to the DVPCOPM-SL 
are the DVP-28SV, DVP-28SV2, DVP-SX2, 
DVP-SA2, and DVP-EH2-L. 

 

IFD9503 

The IFD9503 gateway converts CANopen to 
Modbus, and connects a device (with an RS-
232 or RS-485 interface) that conforms to 
the standard Modbus protocol to a CANopen 
network.  You can connect up to 15 
devices. 

 

DVPCP02-H2 

The CANopen slave module is connected to 
the right side of an EH2 series PLC. It can 
connect the EH2 series PLC to a CANopen 
network. 

 
IFD6503 

This analyzes CANopen network data, and 
has ports both ends for a CAN interface and 
a USB interface. Use it to monitor CAN 
network data, or allow CAN nodes to 
transmit the data. The product is used with 



AS Ser ies  Hardware  and  Operat ion Manual   

 10-14  

_10 

Product Model Function 
the Netview Builder software. 

 

ASD-A2-xxxx-M 
servo driver 

This servo driver has a built-in CANopen 
interface. It controls positioning, speed, and 
torque. 

 

VFD-
C2000/CP2000/C200 
series AC motor drives 

This AC motor drive has a built-in CANopen 
function, and controls  positioning, speed, 
and torque. For the C2000/CP2000 series 
AC motor drives, you must purchase a 
CMC-COP01 to provide the CAN interface. 
Only the C200 series AC motor drive has the 
built-in CANopen interface. 

 

VFD-EC series AC motor 
drive 

The EC series AC motor drive has a built-in 
CANopen interface. It controls speed and 
torque. 

 

TAP-CN01 
This CANopen network topology distribution 
box has a 120 ohm resistor enabled with a 
switch. 

 

TAP-CN02 
This CANopen network topology distribution 
box has a 120 ohm resistor enabled with a 
switch. 

 

TAP-CN03 
This CANopen network topology distribution 
box has a 120 ohm resistor enabled with 
switch. 
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Product Model Function 

 

UC-CMC003-01A 
UC-CMC005-01A UC-
CMC010-01A 
UC-CMC015-01A 
UC-CMC020-01A 
UC-CMC030-01A 
UC-CMC050-01A 
UC-CMC100-01A 
UC-CMC200-01A 

These CANopen sub cables have RJ45 
connectors at both ends.  
UC-CMC003-01A: 0.3 meters 
UC-CMC005-01A: 0.5 meters 
UC-CMC010-01A: 1 meter 
UC-CMC015-01A: 1.5 meters 
UC-CMC020-01A: 2 meters 
UC-CMC030-01A: 3 meters 
UC-CMC050-01A: 5 meters 
UC-CMC100-01A: 10 meters 
UC-CMC200-01A: 20 meters 

 

UC-DN01Z-01A 
UC-DN01Z-02A 

CANopen network cable 
UC-DN01Z-01A: CANopen main cable 
UC-DN01Z-02A: CANopen sub cable 

 

TAP-TR01 
This 120 ohm resistor has an RJ45 
connector. 
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10.3 The CANopen Protocol 

10.3.1 Introduction to the CANopen Protocol 

The CAN (controller area network) fieldbus only defines the physical layer and the data link layer of a network. 
See the ISO11898 standard for information. The CAN fieldbus does not define the application layer. In practice, 
the hardware contains the physical layer and the data link layer. The CAN fieldbus itself is not complete, and 
needs a superior protocol to define the use of 11/29-bit identifier and 8-byte data. 

The CANopen protocol is the superior protocol based on the CAN fieldbus. It is one of the protocols defined 
and maintained by CiA (CAN-in-Automation) and was developed on the basis of the CAL (CAN application layer) 
protocol, using a subset of the CAL communication and service protocols. 

The CANopen protocol contains the application layer and the communication profile (CiA DS301). It also 
contains a framework for programmable devices (CiA 302), recommendations for cables and connectors (CiA 
303-1), and SI units and prefix representations (CiA 303-2). 

In the OSI model, the relation between the CAN standard and the CANopen protocol is described in the following 
diagram. 

 
 

1. The object dictionary 

CANopen uses an object-based method to define a standard device. Every device is represented by a set 
of objects and can be visited by the network. The diagram below illustrates the CANopen device model. 
The object dictionary is the interface between the communication program and the superior application 
program. 

The core concept of CANopen is the device object dictionary (OD). It is an orderly set of objects. Every 
object has a 16-bit index for addressing and also defines an 8-bit subindex. Every node in the CANopen 
network has an object dictionary that includes the parameters that describe the device and the network 
behavior. The object dictionary of a node is also described in the electronic data sheet (EDS) for the device. 

Device profile CiA  Device profile CiA  Device profile CiA  

OSI seventh layer  

Application layer 
Communication profile CiA DS-301 

CAN controller CAN 2.0A 

ISO 11898 + - 
+ - 

CAN network 

OSI second layer  

Data link layer 

OSI first layer  
Physical layer 
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10.3.2 The CANopen Communication Object 

The CANopen communication protocol contains the following communication objects. 

1. PDO (process data object) 

 The PDO provides the direct channel for the device application object, and transmits the real-time 
data. It has high priority. Every byte in the PDO CAN message data list transmits data, and the 
message usage rate is high. 

 There are two kinds of uses for PDOs; data transmission and data reception. They are distinguished 
by Transmit-PDOs (TxPDOs) and Receive-PDOs (RxPDOs). Devices supporting TxPDOs are called 
PDO producers, and devices that receive PDOs are called PDO consumers. 

 The PDO is described by the “producer/consumer mode”. The data transmits from one producer to one 
or many consumers. The data that can be transmitted is limited to between 1-byte and 8-byte data. 
After the producer transmits the data, the consumer does not need to reply to the data. Every node in 
the network detects the transmitted data and decides whether to process the received data . 

 Every PDO is described by two objects in the object dictionary: the PDO communication parameters 
and the PDO mapping parameters 

PDO communication parameters: the COB-ID used by PDO, the transmission type, the prohibition 
time, and the counter cycle 

PDO mapping parameters: the object list in an object dictionary. These objects are mapped into the 
PDO, including the data length (in bits). To explain the contents of the 
PDO, the producer and the consumer both have to understand the 
mapping.  

The PDO transmission modes: synchronous and asynchronous  

Synchronous mode: synchronous periodic and synchronous non-periodic  

Asynchronous: The producer transmits the PDO when the data changes, or after a trigger.  

The following table lists supported transmission modes. 

Type PDO transmission  
 Periodic Non-periodic Synchronous Asynchronous RTR 

0  X X   
1 – 240 X  X   

254    X  
255    X  
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Mode 0: The PDO information is transmitted only when the PDO data changes and the synchronous 
signal is received. 

Modes 1–240: One piece of PDO information is transmitted every 1–240 synchronous signals. 

Mode 254: The trigger is defined the manufacturer. The definition in the PLC is the same as mode 
255. 

Mode 255: The PDO is transmitted when the data changes, or it is transmitted after a trigger. 

All the data in the PDO has to be mapped from the object dictionary. The following diagram shows an 
example of PDO mapping. 

 

 

The following table shows the data format for RxPDO and TxPDO. 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 

Object 
identifier 

Data 

2. SDO (service data object) 

 The SDO builds the client/server relation between two CANopen devices. The client device can read 
the data from the object dictionary on the server device and write the data into the object dictionary on 
the server device. The SDO visit mode is “client/server” mode. The mode which is visited is the SDO 
server. Every CANopen device has at least one service data object that provides the visit channel for 
the object dictionary of the device. SDO can read all the objects in the object dictionary, and write all 
objects into the object dictionary.  

 The SDO message contains the index and subindex information used to position the objects in the 
object dictionary, and the composite data structure can easily be passed by the SDO visit. After the 
SDO client sends the reading/writing request, the SDO server replies. The client and the server can 
stop SDO transmission. The requested message and the reply message are separated by different 
COB-IDs. 

 The SDO can transmit the data in any length. If the data length is more than 4 bytes, the data must be 
transmitted by segment. The last segment of the data contains an end flag. 

PDO_1  

Application object C zzh zzzzh 

   

Application object B yyh yyyyh 
   

Application object A xxh xxxxh 

Object dictionary 

xxxxh 

zzzzh 

yyyyh 

8 xxh 3 

16 zzh 2 

8 yyh 1 

3 0 

PDO_1 mapping 

Application object A Application object C  Application object B 
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 The following table shows the structures of the SDO requested message and reply message. 

The format of the requested message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
600（hex） 

+Node-ID 
Requested 

code 
Object index Object 

subindex 
Requested data 

LSB MSB bit7-0 bit15-8 bit23-16 bit31-24 

 

The definition of the requested code in the requested message: 

Request code (hex) Description 
23 Writing 4-byte data 
2B Writing 2-byte data 
2F Writing 1-byte data 
40 Reading data 
80 Stopping the current SDO function 

 

The format of the reply message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
580（hex） 

+Node-ID 
Reply 
code 

Object index Object 
subindex 

Reply data 
LSB MSB bit7-0 bit15-8 bit23-16 bit31-24 

 

The definition of the reply code in the reply message: 

Reply code (hex) Description 
43 Reading 4-byte data 
4B Reading 2-byte data 
4F Reading 1-byte data 
60 Writing 1/2/4-byte data 
80 Stopping the current SDO function 

 

3. NMT (network management object) 

The CANopen network management conforms to the master/slave mode. Only one NMT master exists in 
the CANopen network, and all other nodes are considered to be slaves. NMT includes three services: 
module control, error control, and boot-up services. 

 Module control services 

The master node in the CANopen network controls the slave by sending commands. The slave 
receives and executes the command, and does not need to reply. All CANopen nodes have internal 
NMT states. The slave node has four states: initialization, pre-operational, operational, and stop 
states. The following diagram illustrates the device states. 
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(1) After power is supplied, the device automatically enters the initialization state. 

(2) After the initialization is complete, the device automatically enters the pre-operational state. 

(3)(6) The remote node starts. 

(4)(7) The device enters the pre-operational state. 

(5)(8) The remote node stops. 

(9)(10)(11) The application layer resets. 

(12)(13)(14) The communication resets. 

(15) After the initializing is complete, the device automatically enters the reset application state. 

(16) After the reset application state is complete, the device automatically enters the reset 
communication state. 

The following table shows the relation between the communication object and the state. You can only 
execute the communication object service in the correct state. For example, you can only execute 
SDO in the operational state and pre-operational states. 

 Initialization Pre-operational Operational Stopped 
PDO   X  

SDO  X X  
SYNC  X X  
Time Stamp  X X  
EMCY  X X  
Boot-up X    
NMT  X X X 

 

 

Initializing 

Reset application  

Reset communication  

Pre-operational 

Operational  

Stopped 

(1) 

(15) 

(16) 

(2)  

(3) (4) 
(7) 

(5) 

(6) 
(8) (9) 

(10) 

(11) 

(12) 

(13) 

(14) 

Initialization 
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The control message format for the node state: 

COB-ID Byte 0 Byte 1 

0 Command specifier (CS) 
Slave address  
(0: Broadcast) 

 

The command specifiers: 

Command specifier 
(hex) Function 

01 Start the remote node 
02 Stop the remote node 
80 Enter the pre-operational state 
81 Reset the application layer 
82 Reset the communication 

 Error control services 

The error control service detects the disconnection of a network node. The error control services are 
classified into two types: Heartbeat and Node Guarding. The AS Series PLC only supports Heartbeat. 
For example, the master can detect the disconnection of the slave only after the slave enables the 
Heartbeat service. 

The following illustrates the Heartbeat principle. The Heartbeat producer transmits the Heartbeat 
message according to the set Heartbeat producing time. One or many Heartbeat consumers detect the 
message transmitted by the Heartbeat producer. If the consumer does not receive the message 
transmitted by the producer within the timeout period, there is a problem in the CANopen 
communication or the producer is disconnected.  

 

Request 

Receiving 

Receiving 

 
Request 

Heartbeat consumer Heartbeat producer 

Heartbeat 
producing 
time Heartbeat 

timeout 
period 

Heartbeat event 

Heartbeat 
timeout 
period 

Receiving 
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 Boot-up services 

After the slave completes the initialization and enters the pre-operational state, it transmits the Boot-
up message. 

1. Other predefined CANopen communication objects (SYNC and EMCY) 

 SYNC Object (Synchronous object) 

The synchronous object is the message that the master node periodically broadcasts on the CANopen 
network. This object recognizes the network clock signal. Every device decides whether to use the 
event use synchronous communication with other network devices depending on its configuration. For 
example, when controlling a driving device, the devices do not act immediately after they receive the 
command sent by the master. They do act when they receive the synchronous message. This makes 
multiple devices act synchronously. 

The format of the SYNC message: 

COB-ID 
80 (hex) 

 Emergency object 

The emergency object is used by a CANopen device to indicate an internal error. When an emergency 
error occurs in the device, the device sends the emergency message (including the emergency error 
code), and the device enters an error state. After the error is eliminated, the device sends another 
emergency message with emergency error code 0, and the device enters the normal state. 

The format of the emergency message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 

80 (hex) 
+Node-ID 

Emergency error 
code Error 

register 
Factory-defined error code 

LSB MSB 

Note: The value in the error register is mapped to index 1001 (hex) in the object dictionary. If the value is 
0, no error occurred. If the value is 1, a normal error occurred. If the value is H’80, an internal error 
occurred in the device.  

10.3.3 The Predefined Connection Set 

In order to decrease the configuration workload of the network, CANopen defines a default identifier. In the 
predefined connection set, the structure of the 11-bit identifier is as follows. 

 

Function code Node ID 
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The following tables list the objects that are supported and the COB-IDs that are assigned to the objects. 

 

1. The broadcast object in the predefined connection setting 

Object Function code COB-ID Index of the 
communication parameter 

NMT 0000 0 - 
SYNC 0001 128 (80h) 1005h, 1006h, 1007h 

Time stamp 0010 256 (100h) 1012h, 1013h 
 

2. The corresponding object in the predefined connection set 

Object Function code COB-ID Index of the 
communication parameter 

Emergency 0001 129 (81h)–255 (FFh) 1014h, 1015h 
PDO1 (TX) 0011 385 (181h)–511 (1FFh) 1800h 
PDO1 (RX) 0100 513 (201h)–639 (27Fh) 1400h 
PDO2 (TX) 0101 641 (281h)–767 (2FFh) 1801h 
PDO2 (RX) 0110 769 (301h)–895 (37Fh) 1401h 
PDO3 (TX) 0111 879 (381h)–1023 (3FFh) 1802h 

PDO3 (RX) 1000 1025 (401h)–1151 (47Fh) 1402h 
PDO4 (TX) 1001 1153 (481h)–1279 (4FFh) 1803h 
PDO4 (RX) 1010 1281 (501h)–1407 (57Fh) 1403h 
SDO (TX) 1011 1409 (581h)–1535 (5FFh) 1200h 
SDO (RX) 1100 1537 (601h)–1663 (67Fh) 1200h 

NMT Error Control 1110 1793 (701h)–1919 (77Fh) 1016h, 1017h 
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10.4 Sending SDO, NMT and Reading Emergency Message 
through the Ladder Diagram 
You can edit the request message mapping area to affect the transmission of SDO, NMT and Emergency 
messages. The following table shows the corresponding relations between the request message mapping 
area, response message mapping area, and PLC device. 

PLC device Mapping area Mapping length 

D25000-D25031 SDO request message, NMT service message and 
Emergency request message 

64 bytes 

D24000-D24031 SDO response message and Emergency response message 64 bytes 
 

The CANopen master can only send one SDO, NMT, or Emergency request message to the same device at a 
time. Clear the request message mapping area to zero when sending SDO, NMT, or Emergency request 
message through the WPL program. 

10.4.1 Data Structure of SDO Request Message  
Sending SDO through the ladder diagram reads or writes the slave parameter. 

1. The data format of the SDO request message: 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message Header 

ReqID Command (Fixed to 01) 

D25001 Reserved Size 

D25002 Type Node ID 

D25003 

Message Data 

High byte of main index Low byte of main index 

D25004 Reserved Sub-index 

D25005 Datum 1 Datum 0 

D25006 Datum 3 Datum 2 

D25007 - D25031 Reserved 

 ReqID: the request ID. Whenever an SDO request message is sent out, the message is given a ReqID 
for CANopen master to identify. When reading/writing another SDO message, the original ID number 
must be changed. In other words, reading/writing SDO is triggered by changing of the value of 
“ReqID”. The ReqID range is between 00–FF (Hex). 

 Size: the length of the message data. The counting starts from D6253 with a byte as the unit. When 
reading, it is fixed to four and when writing, it is four plus the byte number of data types of index and 
subindex and the maximum value is eight. But when writing, if the data type of the index and subindex 
is word, the data length is six. The data length is file if the data type is byte. 

 Node ID: the node address for the target equipment on a CANopen network. 

 Type: 01 indicates the read access; 02 indicates the write access. 
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The following table shows the data format of the SDO response message. 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message Header 

ResID Status code 
D24001 Reserved Size 

D24002 Type Node ID 

D24003 

Message Data 

High byte of main index Low byte of main index 

D24004 Reserved Sub-index 

D24005 Datum 1 Datum 0 

D24006 Datum 3 Datum 2 

D24007~D24031 Reserved 

 

 Status code: 

The following table lists the status code values in the response message. 

Status code Explanation 
0 No data transmission request 
1 SDO message transmission succeeds. 
2 SDO message is being transmitted. 

3 Error: SDO transmission time-out 
4 Error: Illegal command code 
5 Error: the length of the transmitted data is illegal. 
6 Error: the length of the response data is illegal. 
7 Error: Equipment to be sent messages is busy. 
8 Error: Illegal type 

9 Error: Incorrect node address 
0A Error message (See the error code for SDO response message) 

0B-FF Reserved 

 ResID: the same as the request ID in the request message. 

 Size: the length of the message data, maximum of 20 bytes. The unit is bytes. When writing, the 
maximum is four; the data length is decided by the data type of index and subindex when reading. 

 Node ID:  the node address of the target equipment on CANopen network. 

 Type: in the SDO response message, 43 (Hex) refers to reading four bytes of data; 4B (Hex) refers to 
reading two bytes of data; 4F (Hex) refers to reading one byte of data; 60 (Hex) refers to writing 1/2/4 
byte(s) of data; 80 (Hex) refers to stopping SDO command. 
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Example 1: write 010203E8 (hex) to (Index_subindex) 212D_0 in slave of No. 3 through SDO; the data type of 
(Index_subindex) 212D_0 is double words (32 bits). 

 Request data:  

PLC device 
Request message 

 High byte(Hex) Low byte(Hex) 

D25000 
Message 
Header 

ReqID=01 Command =01 
D25001 Reserved =0 Size =8 
D25002 Type =02 Node ID =03 
D25003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D25004 Reserved =0 Subindex =0 
D25005 Datum 1=03 Datum 0=E8 
D25006 Datum 3=01 Datum 2=02 

 

 Response data: 

PLC device 
Response message 

 High byte(Hex) Low byte(Hex) 
D24000 

Message 
Header 

ResID =01 Command =01 
D24001 Reserved =0 Size =4 
D24002 Type =60 Node ID =03 
D24003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D24004 Reserved =0 Subindex =0 
D24005 Datum 1=00 Datum 0=00 
D24006 Datum 3=00 Datum 2=00 

 

Example 2: read the value of (Index_subindex) 212D_0 in slave of No. 3 through SDO; the data type of 
(Index_subindex) 212D_0 is double words (32 bits). 

 Request data:  

PLC device 
Request message 

 High byte(Hex) Low byte(Hex) 
D25000 

Message 
Header 

ReqID =01 Command =01 
D25001 Reserved =0 Size =4 
D25002 Type =01 Node ID =03 
D25003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D25004 Reserved =0 Subindex =0 
D25005 Datum 1=0 Datum 0=0 
D25006 Datum 3=0 Datum 2=0 
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10.4.2 Data Structure of NMT Message 

Use the NMT service to manage the CANopen network such as start, operation, reset of nodes, etc. 

The following table shows the data format of the NMT request message. 

PLC device 
Request message 

 High byte Low byte 

D25000 
Message 
Header 

ReqID Command (Fixed to 01) 

D25001 Reserved Size (Fixed to 04) 

D25002 Type (Fixed to 03) Node ID 

D25003 Message 
data 

Reserved NMT service code 

D25004 Reserved Node ID 

 Command: Fixed to 01. 

 ReqID: the request ID. Whenever an NMT request message is sent, the message is given a ReqID for 
the CANopen master to identify. Before another NMT request message is sent out, the original ID 
number must be changed. In other words, change the value of ReqID. The ReqID range is between 
00–FF (Hex) to trigger sending the NMA request message. 

 Node ID: the node address for the target equipment on the CANopen network (0: Broadcast). 

 NMT service code: 

NMT service code (Hex) Function 
01 Start remote node 

02 Stop remote node 
80 Enter the pre-operational state 
81 Reset application 
82 Reset communication 

 

The following table shows the data format of the NMT Response message. 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message 
header 

ResID Status code 
D24001 Reserved Reserved 
D24002 Reserved Node ID 

 When status code is 1, the NMT operation has succeeded. When status code is not equal to1, the 
NMT operation has failed and you should verify that the data in NMT request message is correct. 

 Node ID: the node address for the target equipment on the CANopen network. 
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Example 1: Stop slave of No. 3 through NMT 

 Request data: 

PLC device 
Request message 

 High byte(Hex) Low byte(Hex) 
D25000 

Message 
header 

ReqID =01 Command =01 
D25001 Reserved =0 Size =04 
D25002 Type =03 Node ID =03 
D25003 Message 

data 
Reserved NMT service code =02 

D25004 Reserved Node ID =03 

 Response data: 

 
10.4.3 Data Structure of EMERGENCY Request Message 

The Emergency request message communicates the slave error and alarm information. 

The following table shows the data format of the Emergency request message. 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message 
header 

ReqID Command (Fixed to 1) 
D25001 Reserved Size (Fixed to 0) 
D25002 Type (Fixed to 04) Node ID 

D25003~D25031 
Message 

data 
Reserved 

 Command: Fixed to 01. 

 ReqID: the request ID. Whenever an Emergency message is sent, the message is given a ReqID for 
the CANopen master to identify. Before another Emergency request message is sent out, the original 
ID number must be changed. In other words,  change the value of ReqID. The ReqID range is 
between 00–FF (Hex) to trigger the sending the Emergency request message. 

 Node ID: the node address of the target equipment on CANopen network. 

The following table shows data format of the Emergency response message. 

PLC device 
Response message 

 High byte(Hex) Low byte(Hex) 
D24000 

Message 
header 

ResID Status code 
D24001 Reserved Size Fixed to 2A 
D24002 Type (Fixed to 04) Node ID 
D24003 

Message 
data 

Total number of data Number of data stored 
D24004 Datum 1 Datum 0 
D24005 Datum 3 Datum 2 

PLC device 
Response message 

 High byte(Hex) Low byte(Hex) 
D24000 

Message 
header 

ResID=01 Status code =01 
D24001 Reserved =0 Reserved =0 
D24002 Reserved =0 Node ID =03 
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PLC device 
Response message 

 High byte(Hex) Low byte(Hex) 
D24006 Datum 5 Datum 4 
D24007 Datum 7 Datum 6 

D24008-D24011 Emergency2 
D24012-D24015 Emergency3 
D24016-D24019 Emergency4 
D24020-D24023 Emergency5 
D24024-D24031 Reserved 

 Command: Fixed to 01(Hex). 

 When status code is 1, reading the Emergency message has succeeded. When status code is not 
equal to1, reading the Emergency message has failed and you should verify that the data in the 
Emergency message is correct. 

 Node ID: the node address for the target equipment on the CANopen network. 

 Total number of data: the total number of Emergency messages CANopen master receives from the 
slave. 

 Number of data stored: the latest number of Emergency messages CANopen master receives from the 
slave (5 messages at most). 

 An Emergency 1 consists of the data in D6004-D6007  and every Emergency message consists of 8 
bytes of data. 

The following table shows the data format of Emergency messages on the CAN bus. Datum 0–datum 
7 in Emergency response message correspond to byte 0–byte 7 respectively. 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
80（hex） 

+Node-ID 
Emergency error 

code 
Error storage 

register 
Vendor custom error code 

 

Example 1: read the Emergency message from the slave No.2, and the Emergency messages the slave 
sends out successively.  

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
82（hex） 43 54 20 14 0 0 0 0 

 
COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 

82（hex） 42 54 20 15 0 0 0 0 

 Request data: 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message 
header 

ReqID=01 Command =01 
D25001 Reserved Size =0 
D25002 Type =04 Node ID =03 
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 Emergency response data 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message 
header 

ResID=01 Status code =01 
D24001 Reserved =0 Size =2A (Hex) 
D24002 Type =04 Node ID =03 
D24003 

Message 
data 

Total number of data =1 Number of data stored =1 
D24004 Datum 1=54 Datum 0=42 
D24005 Datum 3=20 Datum 2=14 
D24006 Datum 5=0 Datum 4=0 
D24007 Datum 7=0 Datum 6=0 

 
10.4.4 Example of Sending SDO through the Ladder Diagram 

1. Control Requirement: 

Read the value of P0-09 from the servo through SDO. 

2. Hardware Connection: 

 

3. The Corresponding Relation between Slave Parameter and Index/Subindex 

The index_subindex corresponding to P0-09 in servo is 2009_0. In the CANopen Builder network 
configuration software, right click the servo icon, and then click Parameter Edit. In the Parameter Edit 
dialog box, you can see the index_subindex corresponding to the servo parameter.  

For more details on how to operate the network configuration interface, refer to Section 11.1.1 in the 
CANopen Builder software help file 
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4. The Structure of the Request Message Devices: 

PLC device 
Content 

(Hex) 
Explanation 

High byte(Hex) Low byte(Hex) 

SDO 
request 

message 
mapping 

area 

D25000 0101 ReqID = 01 Command = 01  
D25001 0004 Reserved Size = 04  
D25002 0102 Type = 01 Node ID = 03 
D25003 2009 Index high byte = 20  Index low byte = 09  

D25004 0000 Reserved Subindex = 00  

 

5. Editing the Ladder Diagram in ISPSoft 

 

 
 

When M2=ON, after reading succeeds, the program stores the data from the target device in D24000–
D24005. The value of D24005: 100（hex）is the value read from P0-09. 

6. The Structure of the Response Message Devices: 

 

PLC device 
Content 

(Hex) 
Explanation 

High byte(Hex) Low byte(Hex) 

SDO 
response 
message 
mapping 

area 

D24000 0101 ResID = 01 Status code = 01  
D24001 0006 Reserved Size = 08 
D24002 4303 Type = 43  Node ID = 03  

D24003 2009 Main index high byte = 20 Index low byte = 09  
D24004 0004 Reserved Subindex = 00 
D24005 0100  Datum 1= 01 Datum 0= 00  
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10.5 Troubleshooting 

10.5.1 CANopen Network Node State Display 

1. In the AS Series PLC, while you enable the CANopen function, it uses SR825–893 as the special registers 
as shown in the following table. 

Special register Function 
SR825 Displays the state of AS300 series PLC. 

SR830–SR893 Displays the state of 64 nodes in the network 
SR826  Flag for the state of the slave 1–16 
SR827 Flag for the state of the slave 17–32 
SR828 Flag for the state of the slave 33–48 
SR829 Flag for the state of the slave 49–64 
SR821 Version of CANopen DS301 
SR822 Displays the CANopen baud rate (unit: 1kpps) 

 

2. As a master, the AS series PLC supports a maximum of 64 slaves ranging from node 1 to node 64. You 
can use SR826–829 to monitor the state of the nodes in the network. The 16 bits in SR826 correspond to 
16 slaves and their corresponding relations are shown in the following table.  

Bit b7 b6 b5 b4 b3 b2 b1 b0 
Node Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 
Bit b15 b14 b13 b12 b11 b10 b9 b8 

Node Node16 Node15 Node14 Node13 Node12 Node11 Node10 Node 9 

When the node in the master node list is normal, the corresponding bit is OFF; when the node in the master 
node list is abnormal (for example, initializing fails or the slave is offline for some reason), the 
corresponding bit is ON. 

 

3. The error code of every node is displayed through the corresponding special register (SR830–893) and 
the relations between special register and corresponding node (1–16) is shown in the following table. (You 
can also judge for other correspondings that are not listed here.) 

 

Special 
register 

SR830 SR831 SR832 SR833 SR834 SR835 SR836 SR837 

Node Node 1 Node 2 Node 3 Node 4 Node 5 Node 6 Node 7 Node 8 

Special 
register 

SR838 SR839 SR840 SR841 SR842 SR843 SR844 SR845 

Node Node 9 Node10 Node11 Node12 Node13 Node14 Node15 Node16 
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4. Node codes displayed in SR830–893 when the ASSeries PLC is the master:  

Code Indication How to correct 

0 
The node is error free or the node is 
not configured. 

N/A 

E0 
ASSeries PLC master module 
receives the emergency message 
sent from slave. 

Read the relevant message with the PLC program 

E1 
PDO data length returned from the 
slave is not consistent with the 
length set in the node list. 

Set the PDO data length of the slave and re-
download. 

E2 PDO of slave is not received. Check and ensure the setting is correct. 
E3 Downloading auto SDO fails. Check and ensure auto SDO is correct. 

E4 
Configuration of PDO parameter 
fails. 

Ensure that the PDO parameter setting is legal. 

E5 Error in key parameter setting. 
Ensure that the connected slave device is 
consistent with the configured slave in the 
software. 

E6 
The slave does not exist in the 
network Ensure that the power supply of slave is normal 

and slave is correctly connected to the network. 
E7 Slave error control is timed-out. 

E8 
The node IDs of master and slave 
repeat. 

Set the node ID of the master and slave again and 
ensure their node IDs are unique. 

 

5. Codes displayed in SR825 when the AS300 Series PLC is the master: 

Code Indication How to correct 

0 

In CANopen DS301 mode: the PLC 
works as master and is working 
normally. 
Not in CANopen DS301 mode: the 
master mode function is not 
activated. 

N/A 

F1 No slave in the list  
Add slave into the node list and then re-download 
the configuration data. 

F2 
The data are being downloaded to 
AS Series PLC 

Wait to finish downloading the configuration data. 

F3 
The configuration receiving error in 
AS Series PLC 

Download parameter configuration again. 

F4 Bus-OFF is detected. 
Check that the CANopen bus cables are properly 
connected and ensure that all the node devices run 
at the same baud rate before you reboot. 

F5 
AS Series PLC setting error such as 
incorrect node address 

The node address in the AS300 Series PLC should 
be between: 1–127. 

F8 
Internal error; the error is detected in 
the internal memory 

If the same error occurs after cycling the power, 
replace it with a new AS300 PLC. 

FB 
The sending buffer in the AS Series 
PLC is full. 

Check that the CANopen bus cable is properly 
connected and then reboot. 

FC 
The receiving buffer in the AS Series 
PLC is full. 

Check that the CANopen bus cable is properly 
connected and then reboot. 
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6. Codes displayed in SR825 when the AS Series PLC is the slave:  
 

Code Indication How to correct 

0 Working normally 

N/A 
Note: When the heartbeat alam function is not 
activated, if the connection is normal before a 
disconnection occurs, the code for the slave will 
still be working normally after the connection is 
back on.  

A0 AS Series PLC is being initialized. -- 

A1 AS Series PLC is pre-operational. 
Check if the CANopen bus cable is properly 
connected. If the master communication is not 
activated, no handling is needed. 

A3 
The data are being downloaded to 
AS Series PLC Wait to finish downloading the configured data. 

B0 Heartbeat message time-out 
Check if the CANopen bus cable is properly 
connected. 

B1 
PDO data length returned from the 
slave is not consistent with the 
length set in the node list. 

Reset the PDO data length in the slave and 
download the new setting to the AS Series PLC. 

F4 BUS-OFF state is detected. 
Check if the CANopen bus cables are properly 
connected and ensure that all the node devices run 
at the same baud rate before you reboot. 

FB 
The sending buffer in the AS Series 
PLC is full. 

Check if the CANopen bus cable is properly 
connected and then reboot. 

FC 
The receiving buffer in the AS Series 
PLC is full. 

Check if the CANopen bus cable is properly 
connected and then reboot. 
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10.6 Application Example 
The AS300 Series PLC can control Delta A2 servo rotation, and monitor the actual rotation speed of the motor 
in real time. It does this by mapping the relevant servo drive parameters to the corresponding PDO, and reads 
or writes the relevant servo drive parameters through the CAN bus. 

1. Connectting the Hardware 
 

 

Note: 

 Use a standard communication cable such as UC-DN01Z-01A / UC-DN01Z-02A / UC-CMC010-01A. 
and connect the terminal resistors (Delta standard terminal resistor TAP-TR01) to both ends of the 
network when you construct the network. 

 M of ASD-A2-xxxx-M refers to the model code and currently only the M-model servo supports 
CANopen communication. 

2. Setting Servo Parameters: 

 Set servo parameters as shown in the following table. 

Parameter Setting Explanation 
3-00 03 Node ID of the A2 servo is 2 
3-01 400 CAN communication rate is 1Mbps. 
1-01 04 Speed mode 
0-17 07 Drive displays the motor rotation speed (r/min) 
2-10 101 Set DI1 as the signal for Servo On 

2-12 114 Set DI3 as the signal _SPD0 for speed selection  
2-13 115 Set DI4 as the signal _SPD1 for speed selection 

 
3. Setting the CANopen Baud Rate and Node ID of AS300 Series PLC  

The AS300 Series PLC uses the default setting values: Node ID: 1 and baud rate: 1Mbps. 

You set the CANopen Node ID and baud rate for the AS300 series PLC in the CANopen Builder 
software, as shown in the following steps. 
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A. Right click the AS300 Series PLC icon in HWCONFIG, then click Communication Software, and 
then click CANopen Builder.  

 
 

B. IF AS300 is in master mode, you can skip this step. If not, you can go to Properites and set it in 
Master mode. After that download the parameter to AS300. Set AS300 Power off for 2 seconds 
and supply power again and then proceed to the next step. 
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C. Click the Online  button on the Toolbar to enter on-line mode.  

 

 

D. Click the Scan Network  button on the Toolbar to scan the network. 

 

 

E. On the Network menu, click Master parameter to display the Master Configuration dialog box.  
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Item Explanation Default 

Node ID 
Node ID of AS300 series PLC on the CANopen 
network 

1 

Baud rate CANopen communication rate 1M bit/second 
Work mode CANopen master/slave mode Master 
Cycle period Cycle time for sending one SYNC message 50ms 

Master heartbeat time 
Interval time for sending the master heartbeat 
message 

200ms 

 

Configure the CANopen communication stations and rates in HWCONFIG.  

F. After you complete the previous steps, click the Download  button on the Toolbar to download 
the parameters to the PLC.   

 

Note: you must reboot the AS300 Series PLC to enable the downloaded parameters.  
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4. Scanning the Network: 

On the Network menu, click Online or click the  button to scan for the master and slaves on the 
CANopen network. The master and slave found by the scan appear in CANopen Builder. For more 
information, refer to Section 11.1.1 in the CANopen Builder software help file. 

 
 

5. Configurating Nodes: 

Double click the slave icon in CANopen Builder to display the Node configuration dialog box.  

 Error Control Protocol 

Sets the error control protocol for the master to monitor if the slave is offline. 

 Auto SDO Configuration 

Perform one write action to the slave parameter with SDO.  The write action is finished when the slave 
enters the operational state from the pre-operational state. You can configure up to 20 SDOs by clicking 
Auto SDO configuration. 

 PDO Mapping and Properties 

Sets the mapping parameter and transmission type for the PDO. 

For more details on the function of these buttons, refer to Section 11.1.1 in the CANopen Builder 
software help file.  
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 PDO Mapping:  

RxPDO1: mapping parameter P1-09; transmission type 255. 

RxPDO2: mapping parameter P3-06, P4-07; transmission type 255. 

TxPDO1: mapping parameter P0-09; transmission type 1. 

 
 

 PDO transmission type : 

PDOs can be classified into RxPDO or TxPDO. RxPDO data are sent from master to slave and TxPDO 
data are sent from slave to master. 

The PDO transmission types can be synchronous or asynchronous. In synchronous transmission, the 
master sends out the SYNC message in a fixed cycle. You set the length of the cycle in the Master 
Properties dialog box (default is 50ms). In asynchronous transmission, the message is sent out when 
the PDO mapping parameter changes. 
The following table describes the PDO Transmission types. 

 

Transmission Type Description Remark 

0 

RxPDO 

When any change in the mapped data happens, 
RxPDO data is sent out immediately. The data 
the slave receives is valid only when receiving 
the next SYNCH message. RxPDO data is not 
sent out if there is no change in the data. SYNCH 

non-cycle 
 

TxPDO 

When any change in the mapped data happens 
and the slave receives the SYNC message, the 
data are sent out immediately. The TxPDO data 
are valid immediately after master receives them. 
TxPDO data is not sent out if there is no change 
in the data. 

N 
(N:1–240) 

RxPDO 

After N messages are sent out, and regardless of 
whether the mapped data changes, the data that 
the slave receives is valid only when receiving 
the next SYNCH message. 

SYNCH 
cycle 

 
TxPDO 

After N messages are sent out and regardless of 
whether the mapped data is changed, the data 
that the master receives is valid at once. 

254 RxPDO 

The mapped data is sent out immediately when it 
changes and is valid when the slaves receives it. 
RxPDO data is not sent out if there is no change 
in the data. 

ASYNCH 
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Transmission Type Description Remark 

TxPDO 

The slave sends out the data once every one 
Event timer time.  After that, the TxPDO data is 
not allowed to be sent out within an inhibit timer 
time. 
When the Event timer and Inhibit timer are both 
equal to 0, the slave sends TxPDO data to the 
master immediately when the data changes, and 
the data that master receives is immediately 
valid. 

255 Same as Type254 

Note: 

 Synchronous transmission type can fulfill multi-axis motion at the same time. 

 If you monitor a real-time changing parameter such as the actual rotation speed of the motor, set 
the TxPDO to the synchronous transmission type; otherwise the frequent change in the slave data 
can block the CANopen network. 

  

After you finish setting the above parameters, double click the master device to display the Node List Setting 
dialog box. Select ASDA-A2 Drive, and click > to move the A2 drive to the right-side list, and then download the 
configured data. 

 

The mapping relation between master and slave: 

AS300 Series PLC master register Data transmission on CANopen 
bus A2 device 

D25032 
 

Low word of P1-09 of 
servo 

D25033 
High word of P1-09 of 
servo 

D25034 P3-06 of servo 

D25035 P4-07 of servo 
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AS300 Series PLC master register Data transmission on CANopen 
bus A2 device 

D24032  
Low word of P0-09 of 
servo 

D24033 
High word of P0-09 of 
servo 

 

6. Program control: D25032 is given the value 256 in ISPSoft; that is, the speed command is set as 
256r/min in the following diagram. 

 

7. Program explanation 

When the AS300 Series PLC runs for the first time, set the parameter P3-06 for servo drive to F. 

 When M0 switches from OFF to ON, the instruction writes 256 to D25032 and then writes the value to  
the servo parameter P1-09 through RxPDO1. 

 When M1 switches from OFF to ON, change P4-07 to 5. DI1 and DI3 are ON. DI1 means the SERVO is 
ON and DI3 calls the speed specified by parameter P1-09 for servo rotation. 

 When M1 switches from ON to OFF, the speed command becomes 0 and the motor stops running. 
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10.7 Object Dictionary 
The following table lists the communication objects in the object dictionary. 

Index Subindex Object name Data type Attribute 
Default 
value 

H’1000 H’00 Device type Unsigned 32 bits R 0x00000000 
H’1001 H’00 Error register Unsigned 8 bits R 0 
H’1005 H’00 COB-ID SYNC Unsigned 32 bits RW 0x00000080 

H’1008 H’00 Manufacturer device name Vis-String R 
AS300 Series 

PLC 
H’1014 H’00 COB-ID EMCY Unsigned 32 bits R 0x80 + Node-ID 

H’1016 

-- Consumer heartbeat time    

H’00 Number of valid subindex Unsigned 8 bits R 1 

H’01 Consumer heartbeat time Unsigned 32 bits RW 0 

H’1017 H’00 Producer heartbeat time Unsigned 16 bits RW 0 

H’1018 

-- Identity Object    

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 Vendor-ID Unsigned 32 bits R 0x000001DD 
H’02 Product code Unsigned 32 bits R 0x00000055 
H’03 Revision number Unsigned 32 bits R 0x00010002 

H’1400 

-- 
RxPDO1 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO1 Unsigned 32 bits RW 
0x00000200+No

de-ID 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1401 

-- 
RxPDO2 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO2 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1402 

-- 
RxPDO3 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO3 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 

H’1402 H’03 Inhibit time Unsigned 16 bits RW 0 

H’1403 -- 
RxPDO4 communication 
parameter 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO4 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1404 

-- 
RxPDO5 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO5 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1405 

-- 
RxPDO6 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO6 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1406 

-- 
RxPDO7 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO7 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 

H’03 Inhibit time Unsigned 16 bits RW 0 

H’1407 

-- 
RxPDO8 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO8 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1600 -- RxPDO1 mapping parameter    

H’1600 

H’00 Number of valid subindex Unsigned 8 bits RW 4 

H’01 The first mapped object Unsigned 32 bits RW 0x20000110 

H’01 The second mapped object Unsigned 32 bits RW 0x20000210 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’02 The third mapped object Unsigned 32 bits RW 0x20000310 

H’03 The fourth mapped object Unsigned 32 bits RW 0x20000410 

H’1601 

-- RxPDO2 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’01 The second mapped object Unsigned 32 bits RW 0 

H’02 The third mapped object Unsigned 32 bits RW 0 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1602 

-- RxPDO3 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1603 

-- RxPDO4 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1604 

-- RxPDO5 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’1604 

H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1605 

-- RxPDO6 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1606 

-- RxPDO7 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1607 

-- RxPDO8 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1800 

-- 
TxPDO1 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO1 Unsigned 32 bits RW 
0x00000180+No

de-ID 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 

H’1800 H’05 Timer Unsigned 16 bits RW 100 

H’1801 

-- 
TxPDO2 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO2 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1802 

-- 
TxPDO3 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO3 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1803 

-- 
TxPDO4 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO4 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1804 

-- 
TxPDO5 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO5 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1805 

-- 
TxPDO6 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO6 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 

H’1805 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1806 

-- 
TxPDO7 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO7 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1807 

-- 
TxPDO8 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO8 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1A00 

-- TxPDO1 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 4 
H’01 The first mapped object Unsigned 32 bits RW 0x20010110 
H’02 The second mapped object Unsigned 32 bits RW 0x20010210 
H’03 The third mapped object Unsigned 32 bits RW 0x20010310 
H’04 The fourth mapped object Unsigned 32 bits RW 0x20010410 

H’1A01 

-- TxPDO2 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A02 

-- TxPDO3 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 

H’1A02 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A03 

-- TxPDO4 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 

H’1A04 

-- TxPDO5 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A05 

-- TxPDO6 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A06 

-- TxPDO7 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 

H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A07 -- TxPDO8 mapping parameter    

H’1A07 

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 



AS Ser ies  Hardware  and  Operat ion Manual   

 10-50  

_10 

MEMO 



 

11-1  

 
 

Chapter 11 CPU Module Operating Principles 
 

Table of Contents 
 

11.1 CPU Module Operations ............................................................. 11-2 
11.1.1 Procedure ................................................................................... 11-2 
11.1.2 I/O Refreshing and Communication Service ..................................... 11-3 
11.1.3 Interrupts ................................................................................... 11-3 

11.2 CPU Module Operating Modes ................................................... 11-4 
11.2.1 Operating Modes .......................................................................... 11-4 
11.2.2 Status and Operation under Different Operating Modes ..................... 11-4 
 

 

11 



AS Ser ies  Hardware  and  Operat ion Manual  

11-2  

_11 

11.1 CPU Module Operations  

11.1.1 Procedure 

The following diagram describes the operation of the CPU module. 

 

The CPU module is supplied with power. 

The system enables the initialization.  
 The non-latched memory is initialized. 
 The downloaded program is checked. 
 The parameters in the CPU module are checked. 
 The parameters in the module table are checked. 
 The module table in the CPU module is compared 

with the actual I/O configuration. 
 The I/O setting is downloaded to the I/O module. 
 If the memory card is installed, whether to execute 

the system copy procedure or not is checked. 

Diagnosis processing: 
 The memory card and other setting are checked. 
 The I/O bus is checked. 
 The system parameter is checked. 

The data sent to the I/O module is refreshed. 
 The data sent to the digital I/O module is refreshed. 
 The data sent to the analog I/O module is refreshed. 
 The data sent to other modules are refreshed. 

Program execution:  
 The user program is executed. 
 The interrupt subroutine is executed. 

The data sent from the I/O module is refreshed. 
 The data sent from the digital I/O module is 

refreshed. 
 The data sent from the analog I/O module is 

refreshed. 
 The data sent from other modules are refreshed. 

Communication service: 
 The communication through the CPU module 
 The communication through other I/O modules 
 The internal communication between the CPU 

module and the I/O module 
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11.1.2 I/O Refreshing and Communication Service 

 Refreshing I/O  

The CPU module reads external I/O data periodically or outputs data to an external I/O. Refreshing the 

I/O includes the following.  

 Refreshing data in a digital I/O module 

 Refreshing data in an analog I/O module, temperature measurement module, loadcell module, 

positioning and counter module 

 Refreshing data in a network module 

All I/O refreshing executes in the same loop. The data in an input device refreshes before a program 

executes, and the data in an output device refreshes after the program executes. 

Unit Maximum data exchange Data exchange area 

Digital I/O module 
Depends on the number of input/output 

channels in the unit. 
Input relay/Output relay 

Analog I/O module, 

temperature measurement 

module, loadcell module, 

positioning and counter 

module 

Depends on the number of input/output 

channels in the unit. 
Data register 

Network module Depends on the unit. Data register 

 

 Communication service 

Communication service is the unscheduled communication service for a network module. It includes the 
communication requests sent from external equipment to a CPU module, and the communication requests 
sent from the CPU module to the external equipment. The communication requests may be received from 
time to time but the data or state refreshing on the devices or components will only start afer the END 
instruction is scanned and executed if the coummunicaiton is concerning the internal devices or 
components of the PLC CPU.   

 

11.1.3 Execution Timing of Interrupts  

Interrupts can be categorized into three types, periodic interrupts, timer interrupts, and condition interrupts. The 
timing to execute any interrupt is after the current executing instruction is complete and the position and state of 
the next to be executed instruction is retained. After the interrupt is executed, the execution of the next 
instruction will resume.     
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11.2 CPU Module Operating Modes  

11.2.1 Operating Modes 

There are two operating modes. They can be used to control a user program and all tasks. 

STOP mode: A program is not executed in this mode. Users can download a module table, initialize CPU 

configuration and other setting, download a program, check a program, and force a bit ON/OFF. 

RUN mode: A program is executed in this mode. Users can NOT download a module table, and initialize CPU 

configuration and other setting. 

11.2.2 Status and Operation under Different Operating Modes 

The following table lists the status and operation states for RUN and STOP modes. 

 Basic operation 

CPU 

mode 
Program 

I/O 

refreshing 
External output 

Program memory 

Non-latched 

area 

Latched 

area 

STOP 

The execution 

of the program 

stops.  

I/O refreshing 

executes. 

OFF. If you set the I/O 

module so that the final 

state of the external output 

on the I/O module is 

retained, the final state of 

the external output on the 

I/O module is retained. 

The data in the program 

memories is retained. 

RUN 
The program  

executes. 

I/O refreshing  

executes. 

The program controls the 

external output. 

The program controls the 

program memories. 
 

 Relationship between the operating modes and tasks 

Mode Loop task Interrupt task 

STOP Execution of a loop tasks stops. 
Execution of an interrupt task 

stops. 

RUN 

 The tasks that have not been executed are in the 

HALT state. 

 If a task is active, or the instruction TKON is 

executed, the task executes. 

 If a task is not active, or the instruction TKOFF  

If the condition of the interrupt is 

met, the interrupt task executes. 
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executes, the task does not execute. 

 

 Relationship between changing modes and the program memory 

Change of the mode Non-latched area Latched area 

STOP→RUN 
Data is cleared or retained depending 

on your setting. 
The data is retained. 

RUN→STOP The data is retained. The data is retained. 
 



 

12-1 

 
 

Chapter 12 Troubleshooting 
 
Table of Contents  

12.1 Troubleshooting .............................................................................. 12-3 
12.1.1 Basic troubleshooting steps ............................................................ 12-3 
12.1.2 Clear the Error States .................................................................... 12-3 
12.1.3 Troubleshooting SOP ..................................................................... 12-4 
12.1.4 Viewing System Log and Error Step ................................................ 12-5 

12.2 Troubleshooting for CPU Modules .................................................... 12-7 
12.2.1 ERROR LED Indicators Are ON ........................................................ 12-7 
12.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds ............................ 12-7 
12.2.3 ERROR LED Indicators Blinking Rapidly Every 0.2 Seconds ................. 12-9 
12.2.4 ERROR LED Indicators Slow Blinking Every 3 Seconds and Lighting up for  

1 Second ..................................................................................... 12-9 
12.2.5 BAT. LOW LED Indicators Are ON .................................................... 12-9 
12.2.6 BAT. LOW LED Indicators Blinking Every 0.5 Seconds ........................ 12-9 
12.2.7 The LED RUN and ERROR Indicators are Blinking Simultaneously Every  

0.5 Seconds ............................................................................... 12-10 
12.2.8 The RUN and LED Indicators are Blinking One After Another Every  

0.5 Seconds. .............................................................................. 12-10 
12.2.9 Other Errors (Without LED Indicators) ........................................... 12-10 

12.3 Troubleshooting for I/O Modules .................................................. 12-18 
12.3.1 Troubleshooting for Analog Modules (AD/DA/XA) and Temperature Modules  

(RTD/TC) ................................................................................... 12-18 
12.3.2 Troubleshooting for the Positioning Module AS02/04PU .................... 12-19 
12.3.3 Troubleshooting for the High-Speed Counter Module AS02HC ........... 12-19 
12.3.4 Troubleshooting for the Load Cell Module AS02LC ........................... 12-20 
12.3.5 Troubleshooting for the Module AS04SIL IO-Link as a Communication  

Module ...................................................................................... 12-21 
12.3.6 Troubleshooting for the Module AS00SCM as a Communication Module12-24 
12.3.7 Troubleshooting for the Module AS00SCM as a Remote Module ......... 12-25 
12.3.8 Troubleshooting for AS01DNET Modules ......................................... 12-26 

12.4 Error Codes and LED Indicators for CPU Modules .......................... 12-27 
12.4.1 Error Codes and LED Indicators for CPU Modules ............................ 12-27 
12.4.2 Error Codes and LED Indicators for Analog/Temperature Modules ..... 12-33 
12.4.3 Error Codes and LED Indicators for Positioning Module AS02 / 04PU .. 12-34 
12.4.4 Error Codes and LED Indicators for High Speed Counter Module  

AS02HC ..................................................................................... 12-34 
12.4.5 Error Codes and LED Indicators for Load Cell Module AS02LC ........... 12-34 
12.4.6 Error Codes and LED Indicators for Module AS04SIL IO-Link as  

a Communication Module ............................................................. 12-35 
12.4.7 Error Codes and LED Indicators for Module AS00SCM as a  
 Communication Module................................................................ 12-36 
12.4.8 Error Codes and LED Indicators for Module AS00SCM as a Remote  

12 12 



AS Ser ies  Hardware  and  Operat ion Manual  

12-2 

_12 

Module ...................................................................................... 12-36 
12.4.9 Error Codes and LED Indicators for Module AS01DNET  

(Master/Slave Mode) ................................................................... 12-36 
12.4.10 Error Codes and LED Indicators for Module AS01DNET  

(RTU Mode) ............................................................................... 12-38 
 

  



 Chapter  12 Troubleshoot ing  

12-3 

12_ 

12.1  Troubleshooting 
12.1.1 Basic troubleshooting steps 
This chapter includes the possible errors the can occur during operation, their causes, and corrective actions.  

(1) Check the following: 

 The PLC should be operated in a safe environment (consider environmental, electronic, and vibration safeties). 

 Connect power supply correctly to the PLC. 

 Secure the module, terminal, and cable installations.  

 All LED indicators show correctly. 

 Set all switches correctly. 

(2) Check the following operational functions: 

 Switch the RUN/STOP state 

 Check the settings for the AS Series to RUN/STOP 

 Check and eliminate errors from external devices  

 Use the System Log function in ISPSoft to check system operation and logs 

(3) Identify possible causes: 

 AS Series or external device 

 CPU or extension modules 

 Parameters or program settings 

 

12.1.2 Clear the Error States  

Use the following methods to clear the error states. If the error source is not corrected, the system continues to show errors.   

(1) Switch the CPU model state to STOP and then to RUN. 

(2) Turn off the CPU and turn it on again.  

(3) Use ISPSoft to clear the error logs.  

(4) Reset the CPU to the default settings and download the program again.  
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12.1.3 Troubleshooting SOP 
An error
occurred

Basic
troub leshoot in g

steps 
done

CPU module er ror 
or modules er ror

ERROR LED ON

ERROR L ED b linking 
normal ly 

(every 0 .5 sec.)

ERR OR LED bl ink ing
slowly (every 1 sec. , 

stop for 3 sec.)

Other LED blinking

Refer to sect ion 12 1 1 for. .
Basic troubleshooti ng steps

Yes

No

1. Refer to sec ti on 1 2.1.4 for the sys tem log
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.3 for troubleshoot ing for 
    I /O modules

Yes

No

No

Yes

No

Yes

Yes

No

Yes

Yes

No

CPU module
error

Mo dule
error

ERROR LED b l inking 
fast

(every 0 .2 sec.)

After going t hrough 
troubleshooting s teps,
the issues a re s til l not 

reso lved. 

No

The system runs normally.

1. Refer to sect ion 1 4 for the sys tem log 1 2. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

1. Refer to sect ion 1 4 for the sys tem log 1 2. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

1. Refer to sect ion 12 1 4 for the sys tem log. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

1. Refer to sect ion 1 4 for the sys tem log 1 2. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

1. Refer to sect ion 1 4 for the sys tem log 1 2. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

If the p roblem per sis ts , please contact 
support .
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12.1.4 Viewing System Log and Error Step  
If ISPSoft is connected to an AS Series, you can view actions and errors in the AS Series by clicking System Log on the 
PLC menu. The CPU can store up to 20 error log sets. After the 20 sets are stored, the 1st log is replaced with the 21st if 
there are new logs coming in, and the old logs are replaced with the new ones sequentially. When the memory card is 
installed in the CPU module, 20 sets of the old logs are backed up in the memory card and up to 1000 logs can be recorded. 
If the stored logs exceed 1000, the oldest 20 logs are replaced with the newest 20 logs in the memory card.  

(1) On the PLC menu, click System Log. 

 
(2) The System Log window appears. Click Clear Log to clear the error log in the window and the error log in the CPU 

module, and reset the CPU module. 

 
 

 Group No.: The number 1 indicates that the error occurred in the CPU module or the right-side module 1. The 
numbers 2–16 indicate the error occurred in the remote modules 1–15.   

 Module No.: The number 0 indicates that the error occurred in the CPU module or the remote module. The 
numbers 1–32 indicate the error occurred in the right-side module of the CPU module / remote 
module. The number 1 represents the closest module to the CPU module or the remote module. This 
number increases from the closest to the furthest from the CPU module or the remote module. Note: 
up to eight extension modules can be connected to the right-side of the remote module.   

 PLC/Module name: Model names of the CPU, remote, and extension modules.  
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 Error Code: Error codes in the error log. 

 Date & Time: The date and time the error occurred. The most recently occurring error is listed on the top.  

 The last column shows the descriptions for the error.  

(3) If the error occured is an exceeding device ragne error (SM0 = ON) or a program syntax error (SM5 = ON), you can 
use the following steps to see the problematic step in the program.   

 SM0 = ON: Check the value (32-bit) in SR1 to see the latest exceeding device range error in the program.   

 SM5 = ON: Check the value (32-bit) in SR5 to see the latest syntax error step in the program.  

 After knowing which the problematic step is, go to ISPSoft -> Edit -> Step positioning and then enter the number 
of the problematic step, the system will take you to the specified step in the program. 
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12.2  Troubleshooting for CPU Modules 
Check the LED indicators and the error codes from the CPU module and refer to the following table for troubleshooting. 
V in the Log column indicates the error is recorded in the log. X in the Log column indicates the error is not recorded in 
the log. H in the Log column indicates whether or not you can set recording the error in the log in HWCONFIG.  

 

12.2.1 ERROR LED Indicators Are ON 
Error 
Code 
(16#) 

Description Solution  Flag Log 

000A Scan timeout 
1. Check the setting of the watchdog timer in HWCONFIG. 
2. Check whether the program causes a long scan time 

SM8 V 

 

12.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds 

Error 
Code 
(16#) 

Description Solution Flag Log 

000C 
The program in the PLC is 
damaged. 

Download the program again. SM9 V 

0010 CPU memory access is denied. 
If the problem persists, contact the local authorized 
distributors. 

SM9 V 

002E 
CPU external memory access is 
denied. 

If the problem persists, contact the local authorized 
distributors. 

SM9 V 

002F 
PLC programs are not consistent 
with the system logs. 

Download the program again. SM34 V 

0070 
The arrangement of the function 
cards is not consistent with the 
settings. 

Check whether the settings in HWCONFIG are 
consistent with the arrangement of the function cards. 

SM10 V 

0102 
The interrupt number exceeds the 
range. 

Check the syntax error step in the program. Modify and 
compile the program and then download the program 
again. 

SM5 X 

0202 
The MC instruction exceeds the 
range.  

SM5 X 

0302 
The MCR instruction exceeds the 
range.  

SM5 X 

0D03 
The operands used in DHSCS are 
not used properly. 

SM5 X 

0E05 
The operands HCXXX used in 
DCNT are not used properly. 

SM5 X 

1300 
- 

130F 

Errors occurred in the remote 
modules 

Refer to Section 12.3.7 for more information on the error 
codes for the remote modules. 

SM30 V 

1402 
The arrangement of the I/O 
modules is not consistent with the 
settings. 

Check whether the settings in HWCONFIG are 
consistent with the arrangement of the I/O modules. 

SM10 V 

140B 
The number of connected 
communication modules exceed the 
maximum number 4. 

Check the total number of communication modules. SM10 V 
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Error 
Code 
(16#) 

Description Solution Flag Log 

140D 
The number of connected extension 
modules exceed the maximum 
number 32. 

Check the total number of extension modules. SM10 V 

140E 
More than eight remote modules on 
the right side of the CPU module.  

Check the total number of remote modules on the right 
side of the CPU module (maximum is 8). 

SM30 V 

1600 
The extension module ID exceeds 
the range.  

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the problem persists, contact the local authorized 
distributors.  

SM10 V 

1601 
The extension module ID cannot be 
set.  

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the problem persists, contact the local authorized 
distributors.  

SM10 V 

1602 
The extension module ID is 
duplicated.  

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the problem persists, contact the local authorized 
distributors.  

SM10 V 

1603 
The extension module cannot be 
operated.  

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the problem persists, contact the local authorized 
distributors.  

SM10 V 

1604 
Extension module communication 
timeout 

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the problem persists, contact the local authorized 
distributors.  

SM10 V 

1605 Hardware failure 
If the problem persists, contact the local authorized 
distributors. 

SM10 V 

1606 
Errors on the communication 
module function card 

Make sure the function card is properly connected to the 
CPU module and turn the modules on again. 

SM10 V 

1607 The external voltage is abnormal. 
Check whether the external 24 V power supply to the 
module is normal. 

SM10 V 

1608 
The Internal factory calibration or 
the CJC is abnormal. 

If the problem persists, contact the local authorized 
distributors. 

SM10 V 

1609 
- 

160F 
Reserved (Error codes for the extension modules) 

200A Invalid instruction 
Check the syntax error step in the program. Modify and 
compile the program and then download the program 
again. 

SM5 V 

6010 
The number of MODBUS TCP 
connections exceeds the range.  

Check the number of superior devices (maximum is 32). 
SM 

1092 
V 

6011 
The number of EtherNet/IP 
connections exceeds the range. 

Check the number of connections (maximum is 16).  
SM 

1093 
V 

C000 
- 

CFFF 
The program syntax is incorrect. 

Save the PLC program and hand the file to the company 
or the technicians. 
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12.2.3 ERROR LED Indicators Blinking Rapidly Every 0.2 Seconds 
The blinking happens when the power supply 24 VDC of the CPU module is disconnected, or the power supply is not 
sufficient, not stable or abnormal.  

Error 
Code 
(16#) 

Description Solution Flag Log 

002A The external voltage is abnormal. 
Check whether the external 24 V power supply to the 
module is normal. 

SM7 V 

 

12.2.4 ERROR LED Indicators Slow Blinking Every 3 Seconds and 
Lighting up for 1 Second 

Error 
Code 
(16#) 

Description Solution Flag Log 

1500 
 

Connection lost in the remote 
modules 

Check the network connection cable.  SM30 V 

1502 
- 

150F 

Errors occurred in the remote 
modules 

Refer to Section 12.3.7 for more information on the 
remote module error codes. 

SM30 V 

1800 
- 

180F 

Errors occurred in the extension 
modules 

Refer to Section 12.3 for more information on the 
extension module error codes. 

SM10 V 

1900 
- 

191C 

Heartbeat errors occurred in the 
slave for the Delta ASD-A2 
control. 

1. Check the CANopen connection cable.  
2. Check if the specific slave is working properly.  
Note: The last 2 digits of the error code represent the ID 
number of the slave (convert hexadecimal to decimal). 

- V 

 

12.2.5 BAT. LOW LED Indicators Are ON 
The blinking happens when there is no battery (CR1620) or the power is low. Turn this option off in the HWCONFIG > 
CPU > Device Setting > Show Battery Low Voltage Error CPU when you don’t need the RTC function to keep track of the 
current time (default is enabled).    

Error 
Code 
(16#) 

Description Solution Flag Log 

0027 Battery Low Change battery or turn this option off  SM219 X 

 

12.2.6 BAT. LOW LED Indicators Blinking Every 0.5 Seconds 

The blinking happens when RTC cannot keep track of the current time.  

Error 
Code 
(16#) 

Description Solution Flag Log 

0026 
RTC cannot keep track of the 
current time 

If the problem persists, contact the local authorized 
distributors. 

SM218 V 
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12.2.7 The LED RUN and ERROR Indicators are Blinking 
Simultaneously Every 0.5 Seconds 

The blinking happens when the firmware of the CPU module is being upgraded. If this happens once the power is 
supplied to the CPU module, it means errors occurred during the previous firmware upgrade. Users need to upgrade the 
firmware again or contact your point of purchase.     

 

12.2.8 The RUN and ERROR LED Indicators are Blinking One After 
Another Every 0.5 Seconds.  

The blinking happens when the CPU module memory card is backing up, restoring, or saving.  

If you are using AS218 Series CPU and without engaging any SD card, the RUN and LED indicators blinking indicates 
the AIO firmware is being updated. If the blinking happens at the instant when the CPU is supplied with power, the 
blinking means AIO firmware update failed and you need to update the firmware again. If you are not updating the AIO 
firmware, the blinking indicates CPU error and you need to contact the local authorized distributors. 
 

12.2.9 Other Errors (Without LED Indicators) 
Error 
Code 
(16#) 

Description Solution Flag Log 

0011 The PLC ID is incorrect. Check the PLC ID. SM34 V 

0012 The PLC password is incorrect.  Check the PLC password. SM34 V 

002D 
The PLC maximum password attempts 
exceeded.  

Reset the CPU module or restore the CPU module 
to its default settings. 

SM34 V 

0050 
The memories in the latched special 
auxiliary relays are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its default settings, and then download 
the program and the parameters again. 

2. If the problem persists, contact the local 
authorized distributors.  

SM6 V 

0051 
The latched special data registers are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its default settings, and then download 
the program and the parameters again. 

2. If the problem persists, contact the local 
authorized distributors.  

SM6 V 

0052 
The memories in the latched auxiliary 
relays are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its default settings, and then download 
the program and the parameters again. 

2. If the problem persists, contact the local 
authorized distributors.  

SM6 V 

0054 The latched counters are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its default settings, and then download 
the program and the parameters again. 

2. If the problem persists, contact the local 
authorized distributors. 

SM6 V 

0055 
The latched 32-bit counters are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its default settings, and then download 
the program and the parameters again. 

2. If the problem persists, contact the local 
authorized distributors.  

SM6 V 
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0056 
The latched special auxiliary relay is 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its default settings, and then download 
the program and the parameters again. 

2. If the problem persists, contact the local 
authorized distributors.  

SM6  V 

0059 
The latched data registers are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its default settings, and then download 
the program and the parameters again. 

2. If the problem persists, contact the local 
authorized distributors.  

SM6 V 

005D 
The CPU module does not detect a 
memory card. 

Check that the memory card is inserted correctly 
into the CPU module. 

SM453 V 

005E 
The memory card is initialized 
incorrectly. 

Check whether the memory card is broken.  SM453 V 

0063 
An error occurs when data is written to 
the memory card. 

Check whether the file path is correct or whether 
the memory card is malfunctioning. 

SM453 V 

0064 
A file in the memory card cannot be 
read.  

Check whether the file path is correct, or whether 
the file is damaged. 

SM453 V 

1950 

The initialization of the Delta ASD-A2 
control has not yet been completed, the 
CANopen instructions cannot be 
executed. 

1. Check the CANopen connection cable.  
2. Check if the specific slave is working properly.  
3. If nothing is wrong, initialize the Delta ASD-A2 

again. 

- V 

19B0 Heartbeat timeout occurred in the slave 
mode 

Check the CANopen connection cable.  - V 

19B1 
The data length of PDO (process data 
object) in the slave mode is not 
matched with the setting.  

Revise the PDO data length setting in the slave 
mode and download the setting again.  

- V 

19E1 

The data length of PDO (process data 
object) in the slave mode is not 
matched with the setting of the scan list.  
Refer to CANopen communication 
related descriptions in AS Series 
Operation Manual for more details on 
the error codes 19E1 to 19E8.  

Revise the PDO data length setting in the slave 
mode and download the setting again.  

- V 

19E2 PDO in the slave mode is not received.  Check if the configurations are correctly set.  - V 

19E3 
The function of auto downloading SDO 
fails at the first startup.  

Check if the SDO contents for auto downloading  
are correct.  

- V 

19E4 PDO configurations are set incorrectly.  Make sure to set the PDO configurations correctly. - V 

19E5 
The main settings are not consistent 
with the connected slave.  

Check ifthe main settings are consistent with the 
connected slave.  

- V 

19E6 
This slave does NOT exist in this 
network.  

Make sure power of the slave is working properly 
and the network cable is well-connected.  

- V 

19E7 
Control timeout occurred in the slave 
mode 

Make sure power of the slave is working properly 
and the network cable is well-connected. 

- V 

19E8 The master ID is duplicated. 
Revise IDs for mater and slave. Make sure no 
duplications.  

- V 

19F3 Incorrect configuration table 
1. Download the configuration table again. 
2. If the problem persists, contact the local 
authorized distributors.  

- V 
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19F4 
CANopen communication is in the BUS-
OFF state. 

1. Check if the network cable is normal and the 
shielded cable is grounded.  

2. Check if the start and end of the network cable 
are both connected with a 121Ω terminal 
resistor. 

3. Check ifall the nodes share the same baud rate 
on the network.  

- V 

19FB 
The sending registers exceed the 
range.  

Revise the time to synchronize (suggested to use a 
longer time). 

- V 

19FC 
The receiving registers exceed the 
range.  

Revise the time to synchronize (suggested to use a 
longer time). 

- V 

2001 

Not using the FCOMP card or not in the 
right mode for the ASDA-A2 while using 
the CANopen communication 
instruction. 

1. Use the FCOMP card in the function card slot to 
check if the operation mode is correct.  

2. Check the syntax error step in the program. 
Modify and compile the program and then 
download the program again. 

SM0 V 

2003 
The device used in the program 
exceeds the device range. 

Check the syntax error step in the program. Modify 
and compile the program and then download the 
program again. 

SM0 V 

200B 
The operand n or the other constant 
operands K/H exceed the range. 

SM0 V 

200C The operands overlap. SM0 V 

200D 
The binary to binary-coded decimal 
conversion is incorrect. 

SM0 V 

200E The string does not end with 00.  SM0 V 
2012 Incorrect division operation SM0 V 

2013 
The value exceeds the range of values 
that can be represented by the floating-
point numbers. 

SM0 V 

2014 
The task designated by the TKON or 
YKOFF instruction is incorrect or 
exceeds the range. 

SM0 V 

2017 
The instruction BREAK is written 
outside of the FOR-NEXT loop. 

SM0 V 

2027 
No such position planning table number 
or the format is incorrect.  

1. Check the syntax error step in the program. 
Modify and compile the program and then 
download the program again. 

2. Check the settings of the position planning table. 

SM0 V 

2028 
High speed output instruction is being 
executed. Only one instruction can be 
executed at a time.  

Refer to SR28 for the record of the axis number 
and rearrange the output control procedures. 

- V 

2030 
During the execution of CSFO 
instruction, the output frequency 
exceeds the upper limit. 

Modify the ratio of input / output frequency or lower 
the inut frequency value. 

- V 

2031 

During the execution of CSFO 
instruciotn, when the output frequency 
is set to 0, but even after 2 seconds, the 
output is still not complete.  

- V 

6004 The IP address filter is set incorrectly. 
Set the Ethernet parameter for the CPU module in 
HWCONFIG again. 

SM1108 X 

600D RJ45 port is not connected.  Check the connection. SM1100 X 
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6012 
There are devices using the same IP 
address.  

1. Check if there are devices using the same IP 
address.  

2. Check if there is more than 1 DHCP or BOOTP 
server on the network.  

SM1101 V 

6100 The email connection is busy. 

Retry the email connection later. This error does 
not cause the PLC to stop running. Solve the 
problem by means of the related flag in the 
program. 

SM1113 X 

6103 
The trigger attachment mode in the 
email is set incorrectly.  

Set up the trigger attachment mode in HWCONFIG 
> CPU Module > Device Setting > Options > 
Ethernet Port Advanced > Email > Trigger Setting 
> Trigger Attachment Mode.  

SM1113 X 

6104 
The attachment in the email does not 
exist. 

Check whether the attachment exists in the 
memory card. 

SM1113 X 

6105 
The attachment in the email is 
oversized. 

Check the size of the attachment. If the size is over 
2 MB, the file cannot be sent as an attachment. 

SM1113 X 

6106 
There is an SMTP server response 
timeout. 

Check for the correct address and set up the 
SMTP server in HWCONFIG > CPU Module > 
Device Setting > Options > Ethernet Port 
Advanced > Email again. 

SM1113 X 

6107 
There is an SMTP server response 
timeout. 

1. Check whether the status of the SMTP server is 
normal. 

2. Retry sending of the email later. This error does 
not cause the PLC to stop running. Solve the 
problem by means of the related flag in the 
program. 

SM1113 X 

6108 SMTP verification failed  
Check for the correct ID/Password and set up in 
HWCONFIG > CPU Module > Device Setting > 
Options > Ethernet Port Advanced > Email again. 

SM1113 X 

6200 
The remote communication IP address 
set in the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6201 
The local communication port set in the 
TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6202 
The remote communication port set in 
the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6203 
The device from which the data is sent 
in the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 
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6206 
The device which receives the data in 
the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6208 
The data received through the TCP 
socket exceeds the device range. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6209 
The remote communication IP address 
set in the UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

620A 
The local communication port set in the 
UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

620C 
The device from which the data is sent 
in the UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

620F 
The device which receives the data in 
the UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6210 
The data received through the UDP 
socket exceeds the device range. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6212 
There is no response from the remote 
device after the timeout period. 

Make sure that the remote device is connected. - X 

6213 The data received exceeds the limit. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6214 
The remote device refuses the 
connection. 

Make sure the remote device operates normally. - X 

6215 The socket is not opened. Check whether operational sequence in the - X 
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program is correct. 

6217 The socket is opened. 
Check whether operational sequence in the 
program is correct. 

- X 

6218 
The data has been sent through the 
socket. 

Check whether operational sequence in the 
program is correct. 

- X 

6219 
The data has been received through the 
socket. 

Check whether operational sequence in the 
program is correct. 

- X 

621A The socket is closed. 
Check whether operational sequence in the 
program is correct. 

- X 

7011 
The device communication function 
code in COM1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7012 
The device communication address 
used in COM1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7013 
The device used in COM1 exceeds the 
device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7014 
The device length of the communication 
data in COM1 exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7017 
The device checksum for the 
communication serial port of COM1 is 
incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7021 
The device communication function 
code in COM2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7022 
The device communication address 
used in COM2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7023 
The device used in COM2 exceeds the 
device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7024 
The device length of the communication 
data in COM2 exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7027 
The device checksum for the 
communication serial port of COM2 is 
incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7031 
The device communication function 
code in the Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7032 
The device communication address 
used in the Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7033 
The device used in the Ethernet 
exceeds the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7034 
The device length of the communication 
data in the Ethernet exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 
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7037 
The device checksum for the 
communication serial port of the 
Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7041 
The device communication function 
code in the USB is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7042 
The device communication address 
used in the USB is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7043 
The device used in the USB exceeds 
the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7044 
The device length of the communication 
data in the USB exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7047 
The device checksum for the 
communication serial port of the USB is 
incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B1 
The device communication function 
code in function card 1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B2 
The device communication address 
used in function card 1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B3 
The device used in the function card 1 
exceeds the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B4 
The device length of the communication 
data in function card 1 exceeds the 
limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B7 
The device checksum for the 
communication serial port of function 
card 1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C1 
The device communication function 
code in function card 2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C2 
The device communication address 
used in function card 2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C3 
The device used in function card 2 
exceeds the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C4 
The device length of the communication 
data in function card 2 exceeds the 
limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C7 
The device checksum for the 
communication serial port of function 
card 2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7203 Invalid communication function code 
1. Refer to the function codes defined by the   

communication protocols. 
2. Check if the product firmware and the software 

- H 
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used are the most updated versions.  
3. Make a note of the operation procedures and 

screenshots of the error windows and hand this 
note to the company or the technicians from the 
agents. 

8105 
The contents of the program 
downloaded are incorrect. 
The program syntax is incorrect. 

1. Download the program and parameters again. 
2. Check the communication cable. 
3. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8106 

The contents of the program 
downloaded are incorrect. 
The length of the execution code 
exceeds the limit. 

1. Download the program and parameters again. 
2. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8107 

The contents of the program 
downloaded are incorrect. 
The length of the source code exceeds 
the limit. 

1. Download the program and parameters again. 
2. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8000 
- 

8FFF 

Errors occur between software and 
PLC. 

1. Check if the product firmware and the software 
used are the most updated versions.  

2. Make a note of the operation procedures and  
  screenshots of the error windows and hand this  
  note to the company or the technicians from the  
  agents. 
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12.3  Troubleshooting for Other I/O Modules 
 Introduction to troubleshotting modules 

Digital I/O, analog I/O, temperature measurement, positioning, counter, load cell, and network modules can be 
installed in an AS Series system. There are 2 types of error codes; error and warning. The CPU module and its 
modules stop operating when errors occur. The CPU modules and its modules do not stop operating when warnings 
are triggered.  

 

12.3.1 Troubleshooting for Analog Modules (AD/DA/XA) and 
Temperature Modules (RTD/TC) 

 
12.3.1.1 ERROR LED Indicators Are ON 
You can set up HWCONFIG to have the following errors appear as warnings when they occur. Otherwise, when an error 
occurs, only an error message appears.  

Error 
Code Description Solution 

16#1605 Hardware failure 
If the problem persists, contact the local authorized 
distributors. 

16#1607 The external voltage is abnormal. Check the power supply. 

16#1608 
The factory calibration or the CJC is 
abnormal. 

If the problem persists, contact the local authorized 
distributors. 

 
12.3.1.2 ERROR LED Indicators Blinking Every 0.2 Seconds 
The following errors are specified as warnings to ensure that the CPU can still run even when the warnings are triggered 
by its modules. If you need the CPU STOP running immediately when the first 4 errors occur, you need to set the them 
as errors.  

Error 
Code Description Solution 

16#1801 The external voltage is abnormal. Check the power supply. 

16#1802 Hardware failure 
If the problem persists, contact the local authorized 
distributors.  

16#1804 The factory calibration is abnormal. 
If the problem persists, contact the local authorized 
distributors.  

16#1807 The CJC is abnormal. 
If the problem persists, contact the local authorized 
distributors.  

16#1808 
The signal received by channel 1 
exceeds the range of analog inputs 
(temperature). 

Check the signal received by channel 1 

16#1809 
The signal received by channel 2 
exceeds the range of analog inputs 
(temperature). 

Check the signal received by channel 2 

16#180A 
The signal received by channel 3 
exceeds the range of analog inputs 
(temperature). 

Check the signal received by channel 3 

16#180B 
The signal received by channel 4 
exceeds the range of analog inputs 
(temperature). 

Check the signal received by channel 4 
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Error 
Code Description Solution 

16#180C 
The signal received by channel 5 
exceeds the range of analog inputs 
(temperature). 

Check the signal received by channel 5 

16#180D 
The signal received by channel 6 
exceeds the range of analog inputs 
(temperature). 

Check the signal received by channel 6 

16#180E 
The signal received by channel 7 
exceeds the range of analog inputs 
(temperature). 

Check the signal received by channel 7 

16#180F 
The signal received by channel 8 
exceeds the range of analog inputs 
(temperature). 

Check the signal received by channel 8 

- 
When power-on, the module is not 
detected by CPU module. 

Check if the connection between module and CPU 
module is working. If not, connect again. 

 

12.3.2 Troubleshooting for the Positioning Module AS02/04PU 
12.3.2.1 ERROR LED Indicators Blinking Every 0.2 Seconds 

Error 
Code Description Solution 

16#1802 Hardware failure 
If the problem persists, contact the local authorized 
distributors. 

 

12.3.3 Troubleshooting for the High-Speed Counter Module AS02HC 
12.3.3.1 ERROR LED Indicators Are ON 

Error 
Code Description Solution 

16#1605 
Counted result in the latched area is not 
retainable (major error)  

Counted data is lost. Switch the module power OFF 
and ON again. The error code is cleared by the 
system. If the problem persists, contact the local 
authorized distributors. 

16#1606 
Module settings in the latced area is not 
retainable. (major error) 

Module setting data is lost. Switch the module power 
OFF and ON again. Download the HWCONFIG 
settings again to clear the error code. If the problem 
persists, contact the local authorized distributors. 

16#1607 
Module setting error  
(major error) 

Check if the setting in HWCONFIG is consistent with 
the actual placement. If the problem persists, contact 
the local authorized distributors. 
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12.3.3.2 ERROR LED Indicators Blinking Every 0.5 Seconds 
The following errors are specified as warnings to ensure that the CPU module can still run even when the warnings are 
triggered by its AIO modules.  

Error 
Code Description Solution 

16#1800 Counter overflow / underflow on CH1 Check the counter result. If the alarm is not required, 
disable the alarm output function in HWCONFIG. Use 
any of the followings to clear the error code: clear, 
reset, preset the counter, restart the module, or 
execute DHCCNT instruction again.   

16#1801 Counter overflow / underflow on CH2 

16#1802 Linear count exceeding the set 
upper/lower limit on CH1 

Check the signal received by channel 1 and 2. 
Hardware counter is still counting; when the number is 
accumulated to the maximum and go back to the 
minimum, the error code will be cleared.   

16#1803 Linear count exceeding the set 
upper/lower limit on CH2 

16#1804 The variation in relation to a SSI encoder 
position exceeding the limit on CH1 

Check if there is any interruption and check the device 
specification to see if the offset setting is matching with 
the actual placement. When the next reading is normal, 
the error code will be cleared.  16#1805 The variation in relation to a SSI encoder 

position exceeding the limit on CH2 

16#1806 Abnormal SSI communication on CH1 Check the execution of DHCCNT instruction. If it is 
parity check, check is there is any interruption and 
check if the data format is correct. Check if the device 
wiring is secure, and if the encoder power supply is 
normal. 

16#1807 Abnormal SSI communication on CH2 

16#1808 SSI absolute position cross zero point on 
CH1 

Check the SSI absolute encoder specification and 
modify the setting accordingly. If the alarm is not 
required, disable the alarm output function in 
HWCONFIG. Use any of the followings to clear the 
error code: clear, reset, preset the counter, restart the 
module, or execute DHCCNT instruction again. 

16#1809 SSI absolute position cross zero point on 
CH2 

 

12.3.4 Troubleshooting for the Load Cell Module AS02LC 
12.3.4.1 ERROR LED Indicators Are ON 
You can set up HWCONFIG to have the following errors appear as warnings when they occur. Otherwise, when an error 
occurs, only an error message appears.  

Error 
Code Description Solution 

16#1605 Hardware failure (that is, the driver board) 
If the problem persists, contact the local authorized 
distributors. 

16#1607 The external voltage is abnormal. Check the power supply. 
 
 
 
 
 
 
 
 



 Chapter  12 Troubleshoot ing  

12-21  

12_ 

12.3.4.2 ERROR LED Indicators Blinking Every 0.2 Seconds 
The following errors are specified as warnings to ensure that the CPU module can still run even when the warnings are 
triggered by its modules. The following first 3 error codes are set as warnings by default in HWCONFIG; CPU must 
STOP running immediately when the first 3 errors occur.  

Error 
Code Description Solution 

16#1801 The external voltage is abnormal. Check the power supply. 

16#1802 Hardware failure 
If the problem persists, contact the local authorized 
distributors. 

16#1807 Diver board failure  
If the problem persists, contact the local authorized 
distributors. 

16#1808 
The signal received by channel 1 
exceeds the range of analog inputs or the 
SEN voltage is abnormal.  

Check the signal received by channel 1 and the cable 
connections. 

16#1809 
The signal received by channel 1 
exceeds the weight limit. 

Check the value input to channel 1 and the maximum 
weight setting. 

16#180A 
The factory calibration in channel 1 is 
incorrect. 

Check the weight calibration in channel 1.  

16#180B 
The signal received by channel 2 
exceeds the range of analog inputs or the 
SEN voltage is abnormal. 

Check the signal received by channel 2 and the cable 
connections. 

16#180C 
The signal received by channel 2 
exceeds the weight limit. 

Check the value input to channel 2 and the maximum 
weight setting. 

16#180D 
The factory calibration in channel 2 is 
incorrect. 

Check the weight calibration in channel 1. 

- When power-on, the module is not 
detected by CPU module. 

Check if the connection between module and CPU 
module is working. If not, connect again. 

 

12.3.5 Troubleshooting for the Module AS04SIL IO-Link as a 
Communication Module 

12.3.5.1 ERROR LED Indicators (Module Status) Blinking Every 0.2 Seconds 
The following error codes identify possible errors when the AS04SIL module is installed on the right side of the CPU 
module or RTU and acts as a communication module.  

Error 
Code Description Solution 

16#1605 Hardware failure 
1. Check that the module is securely installed.  
2. Install a new AS04SIL or if the problem persists, 

contact the local authorized distributors. 

16#1606 
24VDC power supply is not sufficient and 
then recovered from low-voltage for less 
than 10 ms. 

Check whether the 24 V power supply to the module is 
normal. 
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12.3.5.2 ERROR LED Indicators (Network Status) Are ON 
The following error codes identify possible errors when the AS-SIL module is installed on the right side of the CPU 
module or RTU and acts as a communication module.  

Error 
Code Description Solution 

16#1802 No external power supply Check the external power supply  
 
12.3.5.3 ERROR LED Indicators (Network Status) Blinking Every 0.1 Seconds 
The following error codes identify possible errors when the AS-SIL module is installed on the right side of the CPU 
module or RTU and acts as a communication module.  

Error 
Code Description Solution 

16#1800 Error occurs in IO-Link Master  
See the following IO-Link Event Code table for more 
information. 

16#1801 Error occurs in IO-Link device 
See the following IO-Link Event Code table for more 
information. 

16#1803 
Error in the download of IO-Link device 
mapping tables 

Redownload the configuration by the software. 

16#1804 
Failure to switch the process data 
parameter set 

Check if the configurations of the actual connected 
device are the same as the ones in the software. 

16#1805 
A connection error occurs in IO-Link via 
communication port 1  

1. Cut the external power off for 3 seconds and then    
  put the power back on. 
2. Redownload the configuration by the software. 16#1806 

A connection error occurs in IO-Link via 
communication port 2  

16#1807 
A connection error occurs in IO-Link via 
communication port 3  

16#1808 
A connection error occurs in IO-Link via 
communication port 4  

16#1809 
Device scanning error and the scanning is 
forced to stop 

1. Cut the external power off for 3 seconds and then    
  put the power back on. 
2. Scan all device again 

 
IO-Link Event Code Table 

 You can find the IO-Link event codes in the module data exchange area where the device sates of communication port  
 1~4 are stored. Check the IO-Link device operation manual if the event occurred is from IO-Link devices.  

IO-Link 
Event 
Codes 

Type 
Event Solution 

Source 

Warning Error Notifica-
tion 

IO-Link 
Master 

IO-Link 
Device 

16#4000  V  
Device temperature over-
load 

Lower load  V 

16#4210 V   
Device temperature over-
run  

Clear source of heat  V 

16#5101  V  Device fuse blown Change fuse  V 

16#5110 V   
Power supply voltage 
over-run 

Check tolerance  V 

16#5111 V   
Power supply voltage 
under-run 

Check tolerance  V 

16#6320  V  Parameter error 
Check device 
specificaitons 

 V 

16#6321  V  Parameter missing 
Check device 
specifications 

 V 

16#7710  V  Device short circuit Check installation  V 
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IO-Link 
Event 
Codes 

Type 
Event Solution 

Source 

Warning Error Notifica-
tion 

IO-Link 
Master 

IO-Link 
Device 

16#8C10 V   
Process variable range 
over-run  

Check process data  V 

16#8C20  V  
Measurement range over-
run 

Check application  V 

16#8C30 V   
Process variable range 
under-run 

Check process data  V 

16#8CA0 V   
No connected IO-Link 
device 

Check installation V  

16#8CA1 V   
The version of the IO-Link 
protocol is different from 
the one configured.  

Use matching IODD file 
and configured again.  

V  

16#8CA2 V   
Connected device is 
different from the one 
configured in the software 

Check configurations and 
installation 

V  

16#8CA3    Reserved  V  

16#8CA4  V  
IO-Link device process 
cable short circuit 

Check installation V  

16#8CA5 V   
Master temperature 
exceeds 135°C 

Clear source of heat V  

16#8CA6  V  
Master temperature 
exceeds 160°C 

Clear source of heat and 
lower load 

V  

16#8CA7 V   
Device power supply 
voltage under-run L+ 
(<18V) 

Check the external power 
supply  V  

16#8CA8  V  
Device power supply 
voltage under-run L+ (<9V) 

Check the external power 
supply  

V  

16#8CA9 V   Illegal device ID 
Check device 
specifications 

V  

16#8CAA V   
IO-Link process data 
range over-run  

Check device 
specifications 

V  

16#8CAB V   
Process data range over-
run  

Scan the device and 
download the configuration 
again 

V  

16#8CAC  V  Data storage error 
If the problem persists, 
contact the local 
authorized distributors. 

V  

0xFF21   V New connected device  V  
0xFF22   V Device disconnected Check installation V  

0xFF23   V 
Data storage identification 
mismatch  

Set the Data Storage 
access locked and set it to 
backup / restore and then 
backing up data according 
to actual placement.  

V  

0xFF24   V Data storage not sufficient 
Check device 
specifications 

V  

0xFF25   V 
Data storage parameter 
access denied 

Check device 
specifications V  
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12.3.6 Troubleshooting for the Module AS00SCM as a Communication 
Module 

12.3.6.1 ERROR LED Indicators Are ON 
The following error codes identify possible errors when the AS00SCM module is installed on the right side of the CPU 
module and acts as a communication module.  

Error 
Code Description Solution 

16#1605 Hardware failure 
1. Check that the module is securely installed.  
2. Install a new AS00SCM or if the problem persists, 

contact the local authorized distributors. 

16#1606 The function card setting is incorrect.  

1. Check if the function card is securely installed.  
2. Install a new function card or if the problem persists, 

contact the local authorized distributors. 
3. Check if the setting in HWCONFIG is consistent with 

the function card setting. 
4. Install a new AS00SCM or if the problem persists, 

contact the local authorized distributors. 
 
12.3.6.2 ERROR LED Indicators Blinking Every 0.5 Seconds 
The following error codes identify possible errors when the AS00SCM module is installed on the right side of the CPU 
module and acts as a communication module.  

Error 
Code Description Solution 

16#1802 Incorrect parameters  Check the parameter in HWCONFIG. Download the 
parameter again. 

16#1803 Communication timeout 

1. Check whether the communication cable is 
properly connected. 

2. Check if the station number and the 
communication format are correctly set.  

3. Check if the connection with the function card is 
working correctly. 

16#1804 The UD Link setting is incorrect. 
1. Check the settings of the UD Link. 
2. Check the warning settings in the PLC. 

 
The following error codes can only be viewed with SCMSoft; when the following errors occur, they are not shown on the 
LED indicators and the system does not send the error messages to the CPU module.   

Error 
Code Description Solution 

16#0107 
The settings in HWCONFIG and manual 
settings are not consistent with function 
card 1.   

Check the settings in HWCONFIG and manual 
settings for function card 1.   

16#0108 
The settings in HWCONFIG and manual 
settings are not consistent for function card 
2. 

Check the settings in HWCONFIG and manual 
settings for function card 2. 

16#0201 Incorrect parameters  Check the parameter in HWCONFIG. Download the 
parameter again. 
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Error 
Code Description Solution 

16#0301 Function card 1 communication timeout 

1. Check if the station number and the 
communication format are correctly set.  

2. Check if the connection with the function card is 
working correctly. 

16#0302 Function card 2 communication timeout 

1. Check if the station number and the 
communication format are correctly set.  

2. Check if the connection with the function card is 
working correctly. 

16#0400 Invalid UD Link Group ID for function card 1 
1. Check the UD Link settings. 
2. Check the warning settings in the PLC. 

16#0401 Invalid UD Link Group ID for function card 2 
1. Check the UD Link settings. 
2. Check the warning settings in the PLC. 

16#0402 Invalid UD Link Command for function card 1 
1. Check the UD Link settings. 
2. Check the warning settings in the PLC. 

16#0403 Invalid UD Link Command for function card 1 
1. Check the UD Link settings. 
2. Check the warning settings in the PLC. 

 

12.3.7 Troubleshooting for the Module AS00SCM as a Remote Module 
Errors from the remote modules are regarded as warnings for AS Series CPU modules. The LED indicator of the CPU 
module blinks and the CPU module can still operate. Use flag SM30 to manage error presentation in the remote 
modules.   

 

12.3.7.1 ERROR LED Indicators Are ON 
Error codes:   

Error 
Code Description Solution 

16#1301 Hardware failure 

1. Check if the module is securely installed.  
2. Change and install a new AS00SCM or if the 

problem persists, contact the local authorized 
distributors. 

16#1302 The function card setting is incorrect.  

1. Check if the function card is securely installed with 
the AS-FCOPM card.  

2. Change and install a new function card or if the 
problem persists, contact the local authorized 
distributors. 

3. Check if the setting in HWCONFIG is consistent 
with the function card setting.  

4. Install a new AS00SCM or if the problem persists, 
contact the local authorized distributors. 

16#1304 
More than eight remote modules on the 
right side of the CPU module. 

Check the total number of remote modules on the right 
side of the CPU module (maximum is 8). 
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12.3.7.2 ERROR LED Indicators Blinking Every 0.5 Seconds 
Warning type of error codes:   

Error 
Code Description Solution 

16#1506 Remote module had been stopped.  

This error code should work with AS Series Remote 
Module Setting in ISPSoft. When this error code shows 
up, it indicates the remote module had been stopped: 
Master Disconnected, Master Reconnected, IO Module 
Alarm, or IO Module Timeout. Check and clear the 
problem and then power-off and then power-on the 
remote module to refresh its state. Refer to section 9.4.3 
in AS Series Module Manual for more details.  

 
12.3.7.3 ERROR LED Indicators Blinking Every 0.5 Seconds 
Warning type of error codes:   

Error 
Code Description Solution 

16#1500 Remote module communication timeout  Make sure the communication cable is well connected 

16#1502 Incorrect parameters  Check the parameter in HWCONFIG. Download the 
parameter again. 

16#1503 
Remote extension module communication 
timeout 

Make sure the communication cable is well connected 
and the module is properly connected to the CPU 
module and turn the modules on again. 

16#1505 
The actual placement of the extension 
modules is NOT the same as it is set.  

Check if the parameter in HWCONFIG is the same as 
the actual placement.  

16#1604 
Extension module communication 
timeout 

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again. 
2. If the problem persists, contact the local authorized 
distributors. 

 
12.3.7.4 ERROR LED Indicators Blinking Every 0.2 Seconds 
This happens when the 24 VDC power supply for the remote module is not sufficient. Check the power supply. If the 
power supply is normal, remove the extension module from the CPU module and then check if the SCM remote module 
is out of order. Error codes: 

Error 
Code Description Solution 

16#1303 
24VDC power supply is not sufficient and 
then recovered from low-voltage for less 
than 10 ms. 

Check whether the 24 V power supply to the module is 
normal. 

 

 
12.3.8 Troubleshooting for AS01DNET Modules 

Refer to sections 12.4.9 and 12.4.10 for more details.  
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12.4 Error Codes and LED Indicators for Modules 
12.4.1 Error Codes and LED Indicators for CPU Modules 
A. Columns 

a. Error code: If an error occurs in the system, an error code is generated. 

b. Description: The description of the error 

c. CPU status: If the error occurs, the CPU stops running, keeps running, or shows the status you defined for the 
error. 

 Stop: The CPU stops running when the error occurs. 

 Continue: The CPU keeps running when the error occurs. 

d. LED indicator status: If the error occurs, the LED indicator is ON, OFF, or blinks. 

 ERROR: System error 

 
 Descriptions 

Module Type LED indicator Descriptions 

CPU Error LED 

There are five types of error indicator states for of the CPU module errors, 
including LED indicator ON, OFF, blinking fast, blinking normally, and blinking 
slowly. When the LED indicator is ON, blinking fast/normally, clear the problems 
first in order to run the CPU module. When the LED indicator is blinking slowly, 
indicating a warning type of error codes, it does not require immediate action. 
Clear the problems when the module is powered off.  
 

Error type: 
ON: A serious error occurs in the module. 
Blinking fast (every 0.2 seconds): unstable power supply or hardware  
Failure.  
Blinking normally (every 0.5 second): system program errors or system  
cannot run.  
 

Warning type:  
Blinking slowly (every 1 second and off for 3 seconds): a warning is    
triggered, but the system can still run.  

 OFF: 
  A warning is triggered, but the system can still run. You can modify the rules    
  and use ISPSoft or SM/SR to show the warnings, instead of using indicators to  
  show the errors. 
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Note: refer to Section 12.2 for the status descriptions of the Error LED indicators.  

Error 
code Description CPU 

status 

ERROR LED indicator 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

000A Scan timeout Stop V     

000C The program in the PLC is damaged. Stop   V   
0010 CPU memory access is denied. Stop   V   

0011 The PLC ID is incorrect.  Continue     V 
0012 The PLC password is incorrect. Continue     V 

0026 
RTC cannot keep track of the current time  

 (the battery LED is blinking.) 
Continue      

0027 Battery low (the battery LED is ON.) Continue      

002A 
24VDC power supply is not sufficient and then is 
recovered from low-voltage for less than 10 ms. 

Continue  V    

002D The PLC maximum password attempts exceeded. Continue     V 

002E 
The access to the external memory of the CPU is 
denied. 

Stop   V   

002F 
PLC programs are not consistent with the system 
logs. 

Stop   V   

0050 
The memories in the latched special auxiliary relays 
are abnormal. 

Continue     V 

0051 The latched special data registers are abnormal. Continue     V 

0052 
The memories in the latched auxiliary relays are 
abnormal. 

Continue     V 

0054 The latched counters are abnormal. Continue     V 

0055 The latched 32-bit counters are abnormal. Continue     V 
0056 The latched special auxiliary relay is abnormal. Continue     V 
0059 The latched data registers are abnormal. Continue     V 
005D The CPU module does not detect a memory card. Continue     V 
005E The memory card is initialized incorrectly. Continue     V 

0063 
An error occurs when data is written to the memory 
card. 

Continue     V 

0064 A file in the memory card cannot be read.  Continue     V 

0070 
The actual placement of the function cards is not 
consistent with the settings. 

Stop   V   

0102 The interrupt number exceeds the range. Stop   V   
0202 The MC instruction exceeds the range.  Stop   V   
0302 The MCR instruction exceeds the range.  Stop   V   

0D03 
The operands used in DHSCS are not used 
properly. 

Stop   V   

0E05 
The operands HCXXX used in DCNT are not used 
properly. 

Stop   V   

1300 
- 

130F 
Errors occurred in the remote modules Continue    V  
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Error 
code Description CPU 

status 

ERROR LED indicator 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

1402 
The arrangement of the I/O modules is not 
consistent with the settings. 

Stop   V   

140B 
Number of communication modules exceeds the 
limit of four.  

Stop   V   

140D 
Number of extension modules exceeds the limit of 
32.  

Stop   V   

140E 
Number of remote modules exceeds the limit of 
eight on the right side of the CPU module.  

Stop   V   

1500 Connection lost in the remote modules Continue    V  

1502 
- 

150F 
Errors occurred in the remote modules Continue    V  

1600 The ID of the extension module exceeds the range. Stop   V   
1601 The ID of the extension module cannot be set.  Stop   V   
1602 The ID of the extension module is duplicated.  Stop   V   
1603 The extension module cannot be operated.  Stop   V   
1604 Extension module communication timeout Stop   V   
1605 Hardware failure Stop   V   

1606 Errors on the communication module function card Stop   V   
1607 The external voltage is abnormal. Stop   V   

1608 
The Internal factory calibration or the CJC is 
abnormal. 

Stop   V   

1609 
- 

160F 
Reserved (Error codes for the extension modules) Stop    V   

1800 
- 

180F 
Errors occurred in the extension modules Continue    V  

1900 
- 

191C 

Heartbeat errors occurred in the slave of the Delta 
ASD-A2 control. 

Continue    V  

1950 
The initialization of the Delta ASD-A2 control has 
not yet been completed, the CANopen instructions 
cannot be executed. 

Continue     V 

2001 
Not using the FCOMP card or not in the right mode 
for the ASDA-A2 while using the CANopen 
communication instruction. 

Continue     V 

2003 
The device used in the program exceeds the device 
range or is illegal. 

Continue     V 

200A Invalid instruction Stop   V   

200B 
The operand n or the other constant operands K/H 
exceed the range. 

Continue     V 

200C The operands overlap. Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

200D 
The binary to binary-coded decimal conversion is 
incorrect. 

Continue     V 

200E The string does not end with 00.  Continue     V 
2012 Incorrect division operation Continue     V 

2013 
The value exceeds the range of values which can 
be represented by the floating-point numbers. 

Continue     V 

2014 
The task designated by the TKON or YKOFF 
instruction is incorrect, or exceeds the range. 

Continue     V 

2017 
The instruction BREAK is written outside of the 
FOR-NEXT loop. 

Continue     V 

2027 
No such position planning table number or the 
format is incorrect.  

Continue     V 

2028 
The high speed output instruction is being 
executed. Only one instruction can be executed at 
a time. 

Continue     V 

2030 
During the execution of CSFO instruction, the 
output frequency exceeds the upper limit. 

Continue     V 

2031 
During the execution of CSFO instruciotn, when 
the output frequency is set to 0, but even after 2 
seconds, the output is still not complete.  

Continue     V 

6004 The IP address filter is set incorrectly. Continue     V 
600D RJ45 port is not connected.  Continue     V 

6010 
The number of MODBUS TCP connections 
exceeds the range. 

Continue   V   

6011 
The number of the EtherNet/IP connections 
exceeds the range. 

Continue   V   

6012 There are devices using the same IP address.  Continue     V 
6100 The email connection is busy. Continue     V 

6103 
The trigger attachment mode in the email is set 
incorrectly.  

Continue     V 

6104 The attachment in the email does not exist. Continue     V 
6105 The attachment in the email is too big. Continue     V 
6106 There is an SMTP server response timeout. Continue     V 
6107 There is an SMTP server response timeout. Continue     V 
6108 SMTP verification failed  Continue     V 

6200 
The remote communication IP address set in the 
TCP socket function is illegal. 

Continue     V 

6201 
The local communication port set in the TCP socket 
function is illegal. 

Continue     V 

6202 
The remote communication port set in the TCP 
socket function is illegal. 

Continue     V 

6203 
The device from which the data is sent in the TCP 
socket function is illegal. 

Continue     V 

6206 
The device that receives the data in the TCP socket 
function is illegal. 

Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

6208 
The data that is received through the TCP socket 
exceeds the device range. 

Continue     V 

6209 
The remote communication IP address set in the 
UDP socket function is illegal. 

Continue     V 

620A 
The local communication port set in the UDP socket 
function is illegal. 

Continue     V 

620C 
The device from which the data is sent in the UDP 
socket function is illegal. 

Continue     V 

620F 
The device that receives the data in the UDP socket 
function is illegal. 

Continue     V 

6210 
The data that is received through the UDP socket 
exceeds the device range. 

Continue     V 

6212 
There is no response from the remote device after 
the timeout period. 

Continue     V 

6213 The data received exceeds the limit. Continue     V 
6214 The remote device refuses the connection. Continue     V 
6215 The socket is not opened. Continue     V 

6217 The socket is opened. Continue     V 
6218 The data has been sent through the socket. Continue     V 
6219 The data has been received through the socket. Continue     V 
621A The socket is closed. Continue     V 

7011 
The device communication function code in COM1 
is incorrect. 

Continue     V 

7012 
The device communication address used in COM1 
is incorrect. 

Continue     V 

7013 
The device used in COM1 exceeds the device 
range. 

Continue     V 

7014 
The device length of the communication data in 
COM1 exceeds the limit. 

Continue     V 

7017 
The device checksum for the communication serial 
port of COM1 is incorrect. 

Continue     V 

7021 
The device communication function code in COM2 
is incorrect. 

Continue     V 

7022 
The device communication address used in COM2 
is incorrect. 

Continue     V 

7023 
The device used in COM2 exceeds the device 
range. 

Continue     V 

7024 
The device length of the communication data in 
COM2 exceeds the limit. 

Continue     V 

7027 
The device checksum for the communication serial 
port of COM2 is incorrect. 

Continue     V 

7031 
The device communication function code in 
Ethernet is incorrect. 

Continue     V 

7032 
The device communication address used in 
Ethernet is incorrect. 

Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

7033 
The device used in Ethernet exceeds the device 
range. 

Continue     V 

7034 
The device length of the communication data in 
Ethernet exceeds the limit. 

Continue     V 

7037 
The device checksum for the communication serial 
port of Ethernet is incorrect. 

Continue     V 

7041 
The device communication function code in USB is 
incorrect. 

Continue     V 

7042 
The device communication address used in USB is 
incorrect. 

Continue     V 

7043 The device used in USB exceeds the device range. Continue     V 

7044 
The device length of the communication data in 
USB exceeds the limit. 

Continue     V 

7047 
The device checksum for the communication serial 
port of USB is incorrect. 

Continue     V 

70B1 
The device communication function code in function 
card 1 is incorrect. 

Continue     V 

70B2 
The device communication address used in function 
card 1 is incorrect. 

Continue     V 

70B3 
The device used in function card 1 exceeds the 
device range. 

Continue     V 

70B4 
The device length of the communication data in 
function card 1 exceeds the limit. 

Continue     V 

70B7 
The device checksum for the communication serial 
port of function card 1 is incorrect. 

Continue     V 

70C1 
The device communication function code in function 
card 2 is incorrect. 

Continue     V 

70C2 
The device communication address used in function 
card 2 is incorrect. 

Continue     V 

70C3 
The device used in function card 2 exceeds the 
device range. 

Continue     V 

70C4 
The device length of the communication data in 
function card 2 exceeds the limit. 

Continue     V 

70C7 
The device checksum for the communication serial 
port of function card 2 is incorrect. 

Continue     V 

7203 Invalid communication function code Continue     V 

8105 
The contents of the downloaded program are 
incorrect. 
The program syntax is incorrect. 

Continue     V 

8106 
The contents of the downloaded program are 
incorrect. 
The length of the execution code exceeds the limit. 

Continue     V 

8107 
The contents of the downloaded program are 
incorrect. 
The length of the source code exceeds the limit. 

Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

8000 
- 

8FFF 
Errors occur between software and PLC. Continue     V 

 

12.4.2 Error Codes and LED Indicators for Analog/Temperature 
Modules 

Error code Description 

ERROR LED indicator status 

A  D /  
D  A /  
A ↔D 

ERROR 

16#1605 Hardware failure OFF ON 
16#1607 The external voltage is abnormal. OFF ON 
16#1608 The factory calibration or the CJC is abnormal. OFF ON 

16#1801*1 The external voltage is abnormal. OFF Blinking 
16#1802*1 Hardware failure OFF Blinking 

16#1804*1 The factory calibration is abnormal. 
RUN: Blinking 
STOP: OFF 

Blinking 

16#1807*1 The CJC is abnormal. OFF Blinking 

16#1808 
The signal received by channel 1 exceeds the range of 
analog inputs (temperature). 

RUN: Blinking 
STOP: OFF 

Blinking 

16#1809 
The signal received by channel 2 exceeds the range of 
analog inputs (temperature). 

16#180A 
The signal received by channel 3 exceeds the range of 
analog inputs (temperature).  

16#180B 
The signal received by channel 4 exceeds the range of 
analog inputs (temperature).  

16#180C 
The signal received by channel 5 exceeds the range of 
analog inputs (temperature). 

16#180D 
The signal received by channel 6 exceeds the range of 
analog inputs (temperature). 

16#180E 
The signal received by channel 7 exceeds the range of 
analog inputs (temperature). 

16#180F 
The signal received by channel 8 exceeds the range of 
analog inputs (temperature). 

- When power-on, the module is not detected by CPU 
module. 

OFF 

Blinking once 
or twice and 

after 2 seconds, it 
blinks repeatedly 

*1: The errors are specified as warnings to ensure the CPU module can still run even when the warnings are triggered by 
its AIO modules. Set up HWCONFIG to have the following first 4 error codes appear as errors when they occur. 
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12.4.3 Error Codes and LED Indicators for Positioning Module AS02 / 
04PU 

Error code Description 
ERROR LED indicator status 

A  D  ERROR 

16#1802 Hardware failure  OFF Blinking 
 

12.4.4 Error Codes and LED Indicators for High Speed Counter Module 
AS02HC 

Error code Description 
ERROR LED indicator status 

ON Blinking 

16#1605 
Counted result in the latched area is not retainable (major 
error)  

V  

16#1606 
Module settings in the latced area is not retainable. (major 
error) 

V  

16#1607 
Module setting error  
(major error) 

V  

16#1800 Counter overflow / underflow on CH1  V 
16#1801 Counter overflow / underflow on CH2  V 
16#1802 Linear count exceeding the set upper/lower limit on CH1  V 
16#1803 Linear count exceeding the set upper/lower limit on CH2  V 

16#1804 The variation in relation to a SSI encoder position 
exceeding the limit on CH1 

 V 

16#1805 The variation in relation to a SSI encoder position 
exceeding the limit on CH2 

 V 

16#1806 Abnormal SSI communication on CH1  V 
16#1807 Abnormal SSI communication on CH2  V 
16#1808 SSI absolute position cross zero point on CH1  V 
16#1809 SSI absolute position cross zero point on CH2  V 

 

12.4.5 Error Codes and LED Indicators for Load Cell Module AS02LC 

Error code Description 
ERROR LED indicator 

A  D  ERROR 

16#1605 Hardware failure (the diver board included) OFF ON 
16#1607 The external voltage is abnormal. OFF ON 

16#1801*1 The external voltage is abnormal. OFF Blinking 
16#1802*1 Hardware failure OFF Blinking 
16#1807*1 Diver board failure  OFF Blinking 

16#1808 
The signal received by channel 1 exceeds the range of 
analog inputs or the SEN voltage is abnormal.  

RUN: Blinking Blinking 
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Error code Description 
ERROR LED indicator 

A  D  ERROR 

16#1809 The signal received by channel 1 exceeds the weight limit. STOP: OFF 

16#180A The factory calibration in channel 1 is incorrect. 

16#180B 
The signal received by channel 2 exceeds the range of 
analog inputs or the SEN voltage is abnormal. 

16#180C The signal received by channel 2 exceeds the weight limit. 
16#180D The factory calibration in channel 2 is incorrect. 

*1: The following errors are specified as warnings to ensure the CPU module can still run even when the warnings are 
triggered by its AIO modules. You can set up HWCONFIG to have the following first 3 error codes appear as errors when 
they occur. 

 

12.4.6 Error Codes and LED Indicators for Module AS04SIL IO-Link as 
a Communication Module 

Error Code Description 
MS Status LED indicator 

ON Blinking 

16#1605 Hardware failure  V 

16#1606 
24VDC power supply is not sufficient and then recovered from 
low-voltage for less than 10 ms. 

 V 

 

Error Code Description 
NS LED indicator 

ON Blinking 

16#1800 Error occurs in IO-Link Master   V 
16#1801 Error occurs in IO-Link device  V 
16#1802 No external power supply V  
16#1803 Error in the download of IO-Link device mapping tables  V 

16#1804 
Failure to switch the process data 
parameter set  

V 

16#1805 A connection error occurs in IO-Link via communication port 1   V 
16#1806 A connection error occurs in IO-Link via communication port 2   V 
16#1807 A connection error occurs in IO-Link via communication port 3   V 
16#1808 A connection error occurs in IO-Link via communication port 4   V 
16#1809 Device scanning error and the scanning is forced to stop  V 
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12.4.7 Error Codes and LED Indicators for Module AS00SCM as a 
Communication Module 

Error Code Description 
ERROR LED indicator status 

ON Blinking 

16#1605 Hardware failure V  
16#1606 The setting of the function card is incorrect.  V  
16#1802 Incorrect parameters   V 
16#1803 Communication timeout  V 
16#1804 The setting of the UD Link is incorrect.  V 

 

12.4.8 Error Codes and LED Indicators for Module AS00SCM as a 
Remote Module 

Error Code Description 
ERROR LED indicator status 

ON Blinking Blinking 
slow 

Blinking 
fast 

16#1301 Hardware failure V    
16#1302 The setting of the function card is incorrect.  V    

16#1303 
24 VDC power supply is not sufficient and then is recovered 
from a low-voltage less than 10ms situation. 

   V 

16#1304 More than eight remote modules on 
the right side of the CPU module. V    

16#1500 Remote module communication timeout   V   

16#1502 Incorrect parameters   V   
16#1503 Extension module communication timeout  V   

16#1505 The actual placement of the extension modules is NOT the 
same as it is set.  

 V   

16#1506 Remote module had been stopped.    V  
16#1604 Extension module communication timeout  V   

 

12.4.9 Error Codes and LED Indicators for Module AS01DNET 
(Master/Slave Mode) 

Code Explanation Correction 

0~63 
Node address of AS01DNET-A 
(in normal operation)  

-- 

80 AS01DNET-A is in STOP status. Turn the PLC to RUN and start I/O data exchange 

F0 
The node ID of AS01DNET is the 
same as that of other node or 
exceeds the allowed range. 

1. Ensure that the node address of AS01DNET is unique.  
2. Re-power AS01DNET.  

F1 No configured slave in Scan List. 
Configure the scan list and then download the configuration to 
AS01DNET. 

F2 
Too low voltage of the work 
power 

Check if the power supply for AS01DNET and the PLC is normal. 
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Code Explanation Correction 

F3 AS01DNET enters the test mode 
Switch the function switch IN1 from On to Off and re-power 
AS01DNET-A. 

F4 BUS-OFF 

1. Check if the network cable is normal and the shielded cable is 
grounded. 

2. Check if the baud rates of all nodes in the network are same. 
3. Check if the start and end of the network cable are both connected 

with a 121Ω terminal resistor. 
4. Re-power AS01DNET-A.  

F5 No network power  
1. Check if the network cable is normal.  
2. Ensure that the network power is normal.  

 F6 
Internal error; Flash or RAM 
check error  

If the error still exists after re-power, send AS01DNET-A back for 
repair. 

F8 
Error produced in factory 
manufacturing 

If the error still exists after re-power, send AS01DNET-A back for 
repair.  

F9 
Internal error; EEPROM access 
failure 

If the error still exists after re-power, send AS01DNET-A back for 
repair. 

FA Invalid configuration data 

1. Configure the network correctly and re-download it to AS01DNET-
A. 

2. Check if the node address of one slave in the scan list is the same 
as that of AS01DNET-A. 

E0 
Identification parameters returned 
from the slave do not match the 
configuration data. 

1. Check if there is any change in node ID of the slave in the 
network. 

2. Check if some node device in the network is replaced. 
3. Re-configure the network. 

E1 
I/O Data size returned does not 
match that in the scan list.  

Re-configure I/O data size of the slave, download the configuration to 
AS01DNET-A and run the PLC.  

E2 

The slave device in the scan list 
does not exist or is offline when 
AS01DNET-A is in master mode.  

1. Check if there is a change in the node address of the slave. 
2. Check if the communication cable is disconnected or connected 

loosely. 
3. Check if the bus cable length exceeds the maximum transmission 

distance. If so, the system may not be stable. 

The I/O connection between the 
slave AS01DNET-A and the 
master is broken when 
AS01DNET-A is in slave mode.  

E3 
AS01DNET-A fails to transmit 
data. 

1. Make sure that the connection between AS01DNET-A and the 
network is normal. 

2. Check if the baud rate of AS01DNET-A is the same as that of 
other node in the network. 

E4 
Error detected in sequence of 
fragmented I/O data from the 
slave device. 

Check if the slave is operating normally. 

E5 
The slave device returns error 
when AS01DNET-A attempts to 
communicate with it. 

Check if the slave is operating normally.  

E6 
IO data size returned from the 
slave is bigger than that 
configured in Scan List.  

Check that the IO data size of the slave should be the same as that 
configured in Scan List.  

E7 
AS01DNET-A is checking MAC 
ID. 

If the code is displayed long, do the troubleshooting according to the 
following steps.  
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Code Explanation Correction 
1. Make sure that at least two nodes work normally in the network.  
2. Check if either end of the network is connected with the terminal 

resistor of 121Ω. 
3. Check if the baud rates of the node devices in the network are 

same. 
4. Check if the communication cable is normal so as to avoid that 

the cable is disconnected or connected loosely. 
5. Check if the bus cable length exceeds the maximum transmission 

distance. If so, the system may not be stable. 
6. Check if the shielded wire of the network cable is grounded. 
7. Re-power AS01DNET-A scanner module. 

 

12.4.10 Error Codes and LED Indicators for Module AS01DNET  
    (RTU Mode) 

Code Indication How to deal with 

0~63 Node ID of the scanner module 
(When in RUN state)  No correction needed 

F0 The node ID is repeated or 
exceeds allowed range. 

1. Ensure that the node ID of AS01DNET (RTU) is unique in 
the DeviceNet network within the range of 0~63.  

2. Repower it on after changing the node ID. 

F1 
No I/O module is configured to 
AS01DNET (RTU) in the 
DeviceNet Builder software. 

Add I/O modules in AS01DNET (RTU) in the DeviceNet 
Builder software and download the configuration data to 
AS01DNET (RTU) after the configuration is finished. 

F2 The work voltage of AS01DNET 
(RTU) is too low.  

Check if the power supply for AS01DNET (RTU) works 
normally. 

F3 AS01DNET (RTU) enters the 
test mode.  Repower AS01DNET (RTU). 

F4 AS01DNET (RTU) is the Bus-
Off state. 

1. Check if the network communication cable is normal and 
the shielded cable is grounded.  

2. Ensure the baud rates of all network nodes are same.  
3. Check if the two ends of the network are both connected 

with a 120Ω terminal resistor. 
4. Repower the scanner module. 

F5 No network power supply for 
AS01DNET(RTU) 

1. Check if the network cable is normal. 
2. Check if the network power supply is normal. (The external 

24V DC network power supply is connected between red 
V+ and black V- of AS01DNET (RTU) .) 

F6 
Internal error; 
An error in the internal storage 
units of AS01DNET (RTU)  

Return the product for repair if the error still exists after re-
power on. 

F7 
Internal error; 
An error in the data exchange 
units of AS01DNET (RTU)  

Return the product for repair if the error still exists after re-
power on. 

F8 Manufacture error  Return the product for repair if the error still exists after re-
power on. 
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Code Indication How to deal with 

F9 
Internal error; 
An error in the access of the 
Flash of AS01DNET (RTU) 

Return the product for repair if the error still exists after re-
power on.  

E4 Module error 

Check if an error occurs in the modules connected to the 
right side of AS01DNET (RTU);  
Check if the module exists;  
Check if current module matches that configured in the 
software; 
Check if the unconfigured module is added. 

E7 Repeated node ID detection 
 

If the code has emerged for a long time, please shoot troubles 
in the methods below. 
1. Ensure that there are at least two nodes working normally 

in the network. 
2. Check if the two ends of the network are both connected 

with a 121Ω terminal resistor. 
3. Ensure that the baud rates of all network nodes are same. 
4. Check if the network cable has a problem such as being 

disconnected and loosened. 
5. Check if the bus communication cable length exceeds 

maximum transmission distance. If the maximum 
transmission distance is exceeded, the stability of the 
system can not be ensured. 

6. Check if the shielded wire of the network communication 
cable is grounded. 

7. Turn on the power of AS01DNET (RTU) again. 

E9 
The number of I/O modules 
connected to AS01DNET (RTU) 
exceeds the maximum 8. 

Check if the number of I/O modules connected to AS01DNET 
(RTU) is more than 8.  

80 AS01DNET (RTU) is in STOP 
state.  

1. Check if the RUN/STOP switch of the PLC connected to 
the DeviceNet master is turned to RUN. 

2. Check if the value of control word of AS01DNET (RTU) is 
1. For details, refer to section 11.5.4.3.4. 

83 
The AS01DNET (RTU) 
configuration in the software is 
being downloading. 

Wait until the download of AS01DNET (RTU) configuration 
data is completed.  
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13.1  Data Tracer 
13.1.1 About Data Tracer 
Data Tracer is used for the real-time collection of variable symbols, values, states in devices, after some trigger condition 
is met so as to draw curve charts for analysis of value trends. Refer to Section 22.2 in ISPSoft User Manual for more 
details.  

Operation 1 

 Compile the current project before using the function. Click Wizard> Data Tracer to open the Data Tracer window as 
shown below. 

  

 

 Click the button  of Symbol Name to open the Add Sample Source window. 

 

 

 Click the button  of Symbol Name in the Add Sample Source window and select the variable symbol name to 
be added in the Choose Symbol window or directly type a device name in the Device Name box. 
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 Set up the sample period and trigger setting. 

 

 

 After setting up the parameters, click  on the icon toolbar to have the system in the online mode. Then click  
to download the settings to the PLC.  

 

 

 After the sample parameter settings in the data tracer are completed and downloaded, any of the following three 
modes on the icon toolbar can be used for watching curves in the online mode. 

 

 

 Click  on the icon toolbar to export the data to your computer for future use.  
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13.1.2 Example 
If X0.0 is a signal to open/close externally. Use Data Trace to measure the width of time when X0.0 is ON.  

 Steps:  

 Open Data Tracer and enter X0.0 for monitoring.  

 Set the Customized Time to 100 ms to take samping, set the trigger device to X0.0, set the trigger position to 10, 
and then set the compare condition to ON as the image shown below.  

 
 Set the mode to One-shot trigger and wait for the trigger (ON). Once it is triggered, it displays the recorded curve 
data.  

 The value in I∆X1 is 2500 ms, the time measured between two vertical lines, X1 and X2. for X0.0. 
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13.2 Data Logger 
13.2.1 About Data Logger 

Data logger is used for the long-term recording of variable symbols, values, states in devices, and drawing curve charts. 
The data is stored in the PLC and the memory card of the PLC for analysis of value trends. Refer to Section 22.3 in 
ISPSoft User Manual for more details.  

Operation A 
 Compile the current project before using the function. Click Wizard> Data Logger to open the Data Logger window 

as shown below.  

 
 

 Click the button  of Symbol Name to open the Add Sample Source window. 

 
 

 Click the button  of Symbol Name in the Add Sample Source window and select the variable symbol name to 
be added in the Choose Symbol window or directly type a device name in the Device Name box. 
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 After setting up the parameters, click  on the icon toolbar to have the system in the online mode. Then click  

to download the settings to the PLC. And then click  to record data. 
 
Note: From here you can also follow Operation B to complete the recording and saving.   

 
 

 When the recording is done, click the uploade button to update the data for later viewing.   

 
 

 Click  on the icon toolbar to export the data to your computer for future use.  

 
 

 Click  on the icon toolbar or use SM and SR to save the data to the SD Card installed on the PLC.   
 
 

Operation B 
You can also use SM flags or SR registors to complete the data recording, data saving or set to store data on a SD card 
permanently. See the example below for reference.  
Example:  

 
 Check if the flag SM457 is ON. If the flag SM457 is ON, it indicates the valid recorded parameters are downloaded in 

data logger. And that means the operation A is done correctly.  

 Use inputs to enable/disable or set the flag SM454 to ON for the PLC to start recording. If you need to store data on 
a SD card, set SR902=16#5AA5. 

 When SM455 is ON or when the quantity of data has met the value set in SR900 (32-bit value), the system start 
saving data on a SD card.  
NOTE: While sending data to the SD card for storage, the PLC needs a period of undisturbing time, approximately 
tens of milliseconds. During this period, the PLC is not allowed to execute interrupts. Make sure the PLC is NOT 
executing any interrupts, especially the external input ones before starting to send data to the SD card for storage.  
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 When SM455 is switching from OFF to ON, set SM456 ON. And the PLC starts to store the recorded data on the SD 
card. The default path and the file name are as shown below:  

 Default saving path 

AS200: \SDCard\PLC CARD\AS200\Log 

AS300: \SDCard\PLC CARD\AS300\Log 

 Default file name 
DATA_LOGGER_yyyymmdd_hhmmss.log 
EX: DATA_LOGGER_20181108_161901.log 

 

13.2.2 Related SM Flags and SR Registors 

SM / SR Attr. Description  

SM450 R 
Check here to see if a SD Card is installed in the PLC.  
ON: SD card inside  
OFF: No SD card 

SM452 R 
Check here to see if data is being stored on the SD card. 
ON: In the operation of storing 
OFF: Not in the operation of storing 

SM453 R 
Check here to see if there is any SD card operational error.  
ON: Abnormal 
OFF: Normal  

SR453 R 
Check here to see the last operational error code of the SD card. 
Note: Only available when SM453=ON 

SM454 R/W 
Set this flag to ON/OFF to start or stop recording. The system will not set this flag to OFF 
automatically even if the space for recording is full. You need to set the flag to OFF manually. 

SM455 R 
Check here to see if the recorded number has reached the set limit.  
ON: The quantity of recordings has reached the set number or the SD card is in cycle recording.   

SM456 R/W 
Used with SR902 to activate the settings in SR902 for the SD card. 
Note: Set the flag from OFF to ON and the PLC starts to store the recorded data on the SD card 
when SR902=16#5AA5. 

SM457 R 
Check here to see if there is any valid, downloaded, recorded parameters in the data logger.  
ON: The valid recorded parameters are downloaded in data logger. 

SR900 R 
Check here to see the quantity of the recorded data (32-bit value). 
Note: It increments the number of the recorded data by 1 for each record.  

SR902 R/W 

Control codes for recorded data. 
 16#5AA5: Store data to a default root and specified file name on the SD card. 
 0: The storing is done.  
 Others: Invalid numbers 
Note: Used with SM456 to activate this setting.  

Note: “R” in the column of attribute (Attr.) indicates the item is read only and the status can be read here. 

“W” in the column of attribute (Attr.) indicates you can set, delete or write a value for this item.   
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13.3 Delta Drive Parameters Backup and Restore 
Delta device parameters can be backed up and restored. This function allows you to backup and restore the device 
parameters, including parameters of inverters and servo drives that are connected to the PLC CPU. You can backup the 
device parameters for later use. If a device is not funcitoing, you can change to a new one and use the backup the 
parameters to set up the new device quickly. Here we use AS Series PLC CPU as an example to backup and restore 
Delta device paratmeters. Refer to EIP Builder User Manual for detailed information on operation of other series.  
 

13.3.1 System Requirement 

Software: ISPSoft V3.10 or later, EIP Builder V1.07 or later  

PLC CPU: AS Series PLC firmware V1.08 or later 

Drive: C2000 Series inverter firmware V2.06 or later 

EIP Communicaiton Card: CMC-EIP01 firmware V1.08 or later 
 

13.3.2 The Architecture Overview for Backup and Restore 

Through EIP Builder, you can backup device parameters and store them in the SD card that is installed in AS Series PLC 
CPU. For restoration, you can use HMI to manage the SR from AS PLC CPU to restore the drive parameters to the Delta 
drive that is connected to the AS Series PLC CPU.  

 

For AS300 Series PLC CPU, you can deloy back up and restoration for up to 16 Delta drives at the same time.  

For AS100 and AS200 Series PLC CPU, you can utilize back up and restoration for up to 8 Delta drives at the same time. 

Find the architecture overview for back up and restoration below. Refer to Chapter 9 for details on the EtherNet/IP 
operation.  
 

 

 
 

AS300
192.168.1.11

C2000_No.1
192.168.1.9

C2000_No.2
192.168.1.10

Delta Driver

Ethernet Switch

Software
192.168.1.99

HMI
192.168.1.98
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13.3.3 Steps to Backup Delta Device Parameters  
Step 1: Open EIP Builder and make sure AS Series PLC CPU is well-connected and ready to communicate. And then 
make sure AS Series PLC CPU is also connected to the Delta drives and they are also ready to communicate.    

 
Step 2: Make sure a SD Card is installed in the AS Series PLC CPU and the AS Series PLC CPU is at the state of STOP. 

Step 3: Click the Uploader icon on the tool bar for backup.  

 
 
Step 4: Select the paremeters that you need to store for backup and click Start.  

 
 



AS Ser ies  Hardware  and  Operat ion Manual  

13-10  

_13 

Step 5: Once all the selected parameters are uploaded to the computer, you can see the information “All done”.  

 
 

Step 6: Click the Downloader icon on the tool bar to download the backup file from the computer to the SD card of 
AS Series PLC CPU.  

 
 

Step 7: Select the paremeters that you need to download and click Start.  

 

MELODY.CHEN 陳雅亭
“確定”按鈕, 需改為英文版

MELODY.CHEN 陳雅亭
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Step 8: Once all the selected parameters are downloaded to the SD card of the AS Series PLC CPU, you can see the 
information “All done”.  

OK

 
Step 9: Use your computer to check if the backup file is saved in the SD card. 
 
Remarks:  
 Default backup file path 
AS300: \SDCard\PLC CARD\AS300\DevPara 
AS200: \SDCard\PLC CARD\AS200\DevPara 
 
 File naming: mmmm_nn_tt_pppppppppppppppp.par 
mmmm: device or module code (e.g. PLC CPU is 0000.) 
nn: communication port number (e.g. PLC Ethernet communication port is 03.) 
tt: communication protocol type (e.g. Ethernet communication is fixed to 01.) 
pppppppppppppppp: device information (IP + ID + 000000 in the hexadecimal format) 
For example: If the device IP is 192.168.1.9 and its ID is 9, the device information is C0A80109 
(IP: 192 = 16#C0, 168=16#A8, 1=16#01, 9=16#09) + 09 (ID) + 000000 = C0A8010909000000.par  
 

 
 
 

Step 10: You can use ISPSoft to set the Delta drive’s number in SR1601 and SR1602 for easier operation when it is 
required to use the restoration function on site.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MELODY.CHEN 陳雅亭
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13.3.4 Steps to Restore Delta Device Parameters  
Two ways you can use to restore the Delta device parameters. One is to use ISPSoft to perform the restoration and the 
other way is to send commands (SM/SR) to the SD card of the AS Series PLC CPU through HMI. Refer to section 
3.1.4.16 Delta Device Parameters Backup and Restore from ISPSoft User Manual for more information. Here we focus on 
the operation of sending commands (SM/SR) to the SD card of the AS Series PLC CPU through HMI. 
 
Use SM/SR devices to appoint which Delta drive should be restored. Refer to the table below. After you have set the 
configurations, the PLC executes the restorations when the PLC is Power-On or from Stop to Run. 
 

SM / SR Function Description Retainable 

SR1600 Parameter restoration code 

0: No action (default) 
1: The AS Series PLC CPU executes the 
restoration when the PLC is Power-On or from Stop 
to Run. When the restoration is complete, reset the 
value to 0. 

Yes 

SR1601.0 
~ 

SR1601.15 
and 

SR1602.0 
~ 

SR1602.15 

Target device number to perform 
parameter restoration  

SR1601.0: corresponding to target device #1 
SR1601.1: corresponding to target device #2 
    ︙ 

SR1601.15: corresponding to target device #16 
OFF: No action (default) 
ON: Execute restoration on the appointed target 
device. 

Yes 

SR1603 
The total number of Delta drives that 
error has occurred during restoration 

0: No error occurred 
1~16: The total number of Delta drives that error 
has occurred during restoration 

No 

SR1604 
The last digit of the device’s IP 
address that a most recent error 
occurred during restoration 

0 ~ 255: The last digit of the device’s IP address 
that a most recent error occurred during restoration.  
(Only valid when SM1161 is switched to ON. Find 
SM1161 description below.) 

No 

SR1605 
The error code of the last device that 
error occurred 

Refer to the error code table below. No 

SM1160 Parameter restoration complete 

OFF: When the value in SR1600 changes from 1 to 
0, reset SM1160 to OFF.  
ON: When the restoration is complete and 
successful, SM1160 switches to ON.  

No 

SM1161 
Error occurred during parameter 
restoration  

OFF: When the value in SR1600 changes from 1 to 
0, reset SM1160 to OFF. 
ON: If any error occurred during restoration, 
SM1161 switches to ON.  

No 
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In HWCONFIG, you can set up the handling method: what to do if an error occurs while restoring.  

 Execution delay time when power on:  
You can set up how logh should the PLC CPU wait before the restoration begins. The default is 3 seconds. It means 
after power on, and after the PLC CPU detects its modules, it will wait for 3 seconds before executing restoration. 
But if the value in SR1600 is 0, the action here will be ignored.  

 
 
 

 When error occurs, CPU module:  
You can set up if an error occurs during restoration, the PLC CPU stops or keeps running (default). If an error occurs 
during restoration, the PLC CPU will show warning error LED and stores the error message “H’0021”. Refer to the 
error code table below.    

 
 

 Delta Device Parameter Restore Setting:  
For the connected Delta devices, you can set up more configuraitons for security, including IP address, ID Number, 
Password Protecton, and Compatibile Check.  
Note: Delta devices will also check for the compatibility, even if you have selected the option “Ignore Checks if 
Possible” here.   
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Example: Back up parameter from Delta drives, number 1, 3, 6 and 16 and execute restorations.  
 
Backup 
Step 1: Select the devices that you need to backup in EIP Builder. Here we select device 1, 3, 6 and 16. 

 
 
Step 2: Download the backup file from the computer to the SD card of AS Series PLC CPU. 
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Step 3: Make sure you have the backup file ready and the IP addresses and Slave IDs in the backup file of the SD card 
are identical to the ones that need to be restored.   

 
SD Card: 
File naming: mmmm_nn_tt_pppppppppppppppp.par 
mmmm: device or module code (e.g. PLC CPU is 0000.) 
nn: communication port number (e.g. PLC Ethernet communication port is 03.) 
tt: communication protocol type (e.g. Ethernet communication is fixed to 01.) 
pppppppppppppppp: device information (IP + ID + 000000 in the hexadecimal format) 
For example: If the device IP is 192.168.1.101 and its ID is 01, the device information is C0A80165 
(IP: 192 = 16#C0, 168=16#A8, 1=16#01, 101=16#65) + 01 (ID) + 000000 = C0A8016501000000.par  

 

 
 
Step 4: You can use ISPSoft to set the Delta drive’s number in SR1601 and SR1602 for easier operation when it is 
required to use the restoration function on site.  
 
Restoration 
Step 1: Check and make sure you have set the IP addresses, Slave IDs, and passwords of the Delta drives to be restored. 
Step 2: Use the HMI, e.g., Delta DOP series HMI to set up SR1601=16#8025 (SR1601.0, SR1601.2, SR1601.5, 

SR1601.15; these 4 bits set to ON and others set to OFF.) 
Note: You can use ISPSoft to set the Delta drive’s number in SR1601 and SR1602 beforehand, it would be easier 
for personeels to execute restoration on site.   

Step 3: Make sure a SD Card is installed in the AS Series PLC CPU and the AS Series PLC CPU is at the state of STOP.  
Step 4: Use HMI to set SR1601 to 1. Switch PLC CPU from STOP to RUN.  
Step 5: Check if the value in SM1160 of the PLC CPU. If it is ON, it indicates the restoration is complete. If it is not ON, go  
       check if the value in SM1161 is ON. If it is ON, it indicates an error has occurred during restoration.  
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Troubleshooting 

 When SM1161 is ON and the value in SR1603 is not 0.  

 Read the value in SR1604 to find the last digit of the device’s IP address that a most recent error occurred during 
restoration to find out which device is not functioning.  

 Read the value in SR1605 or use the PRST_ErrRead to read the error code. See the table below for 
troubleshooting.  

Type Error Code 
in SR1605 Error Message Solution 

PLC setting 
and operation 

error 

H'0001 CPU module can NOT detect SD card 
Make sure SD card is installed 
securely. Unplug it and plug it in again.  

H'0002 No backup file in SD card.  
Make sure there is a backup file in SD 
card.  

H'0003 
Error occurred while reading data from 
SD card. For instance, failed to read or 
the file is corrupted. 

Check if SD card is damaged. 

H’0004 Failed to write data into SD card. 
Check if SD card is written proof or if it 
is damaged.  

H’0008 

Restoration setting error  
(For example, the IP address to be 
restored is set as a broadcasting one. 
For restoration, the IP address should be 
one on one, not broadcasting.  

Check if the naming of IP address and 
ID is the same as what is set in 
HWCONFIG. 

H’000A Connection lost 
Check if the network cable is 
well-connected and the wiring is 
correct.  

Backup and 
restoration 

error 

H’1000 Not supported parameter settings 
Check if the Delta drive’s firmware 
version in the backup file is matched 
with the one to be restored.  

H’1001 Device series not matched 
Check if the Delta drive’s series in the 
backup file is matched with the one to 
be restored. 

H’1002 Device version not matched 
Check if the Delta drive’s firmware 
version in the backup file is matched 
with the one to be restored. 

H’1003 Incompatible device voltage level 
Check if the Delta drive’s voltage level 
in the backup file is matched with the 
one to be restored. 

H’1004 Incompatible device power 
Check if the Delta drive’s power in the 
backup file is matched with the one to 
be restored. 

H’1010 Device model not matched 
Check if the Delta drive’s model in the 
backup file is matched with the one to 
be restored. 

H’1011 Incorrect device password 
Check if the Delta drive’s password is 
the same as what is set in HWCONFIG. 

H’1100 Device communication timeout 
Check if the network cable is 
well-connected and free from noise 
interference. 

H’1101 
Currently the device can NOT execute 
backup or restoration.  

If the problem persists, contact the 
local authorized distributors of the 
Delta drive. 

H’1103 
Currently the device can NOT compete 
the execution of backup or restoration.  

If the problem persists, contact the 
local authorized distributors of the 
Delta drive. 

H’1106 Device responds with incomplete data If the problem persists, contact the 
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Type Error Code 
in SR1605 Error Message Solution 

for backup/restoration  local authorized distributors of the 
Delta drive. 

H’1108 
Device responds with an unexpected 
error.   

Check if the network cable is 
well-connected and free from noise 
interference. 

Restoration 
error 

H’2000 Parameters exceed the upper limit.  
If the problem persists, contact the 
local authorized distributors of the 
Delta drive. 

H’2001 Parameters are less than the lower limit. 
If the problem persists, contact the 
local authorized distributors of the 
Delta drive. 

H’2002 Parameters can NOT be written. 
If the problem persists, contact the 
local authorized distributors of the 
Delta drive. 

H’2003 
Currently the device is at the state of 
RUN.  

Switch the device to the state of STOP. 

H’2004 
Currently the device is at the state of 
error. 

Refer to the drive user manual for more 
information.  

H’2005 Incorrect device file 
If the problem persists, contact the 
local authorized distributors of the 
Delta drive. 

H’2006 
Number of device parameters not 
matched. 

If the problem persists, contact the 
local authorized distributors of the 
Delta drive. 

H’2007 
Execution of backup or restoration 
timeout 

If the problem persists, contact the 
local authorized distributors of the 
Delta drive. 

 

13.3.5 FAQ 
Question 1: Is Ethernet/IP the only communication protocol for backup and restoration? 

Answer: Yes, currently Ethernet/IP is the only communication protocol supported. RS485 communicaiton will also be 
available in the near future.  

 

Question 2: Are the file name and the folder path editable?  

Answer: The file name of the backup file contains to 4 sections, PLC Ethernet communication port, Ethernet 
communication protocol, and device information. Only the device information can be edited according to the device to be 
restored. See below for more details on the file naming.  
File naming: mmmm_nn_tt_pppppppppppppppp.par 
nn: communication port number (e.g. PLC Ethernet communication port is 03.) 
tt: communication protocol type (e.g. Ethernet communication is fixed to 01.) 
pppppppppppppppp: device information (IP + ID + 000000 in the hexadecimal format) 
For example: If the device IP is 192.168.1.101 and its ID is 01, the device information is C0A80165 
(IP: 192 = 16#C0, 168=16#A8, 1=16#01, 101=16#65) + 01 (ID) + 000000 = C0A8016501000000.par 

 

Question 3: Can backup and restoration be executed when PLC CPU is at the state of RUN?  

Answer: No. Backup and restoration can only be executed when PLC CPU is at the state of STOP. Since AS Series PLC 
CPU reads data from or writes data into the SD card, it affects the PLC scan time and may further affect the PLC 
operation.  
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A.1 Installing the USB Driver for an AS Series CPU module in 
Windows XP with SP3 

The instructions below show how to install the USB driver for an AS Series CPU module on Windows XP. To 

install the USB driver on another operating system, refer to the instructions in the operating system for 

information on installing new hardware. 

Before you install the USB driver, you must install ISPSoft version 3.00 or above on your computer. 

(1) Supply power to the AS Series CPU module. Connect the AS Series CPU module to a USB port on your 

computer with a USB cable. In the Found New Hardware Wizard, select No, not this time and then click 

Next. 

 

(2) The wizard displays the name of the detected USB device. Select Install from a list or specific location 

(Advanced) and then click Next. 
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(3) After you install ISPSoft version 3.00 or above, the driver for the AS CPU module is under the folder where 

you installed ISPSoft: ...\ISPSoft\drivers\Delta_PLC_USB_Driver\. 

Select Include this location in the search and enter the correct path, or click Browse to browse for the 

correct folder. Click Next to continue the installation. 
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(4) The system installs the driver. If the Hardware Installation message appears during the installation, click 

Continue Anyway. 

 

 

(5) Click Finish.  
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(6) Open the Windows Device Manager window. If the Delta PLC port for the USB device is under Ports 

(COM & LPT), the installation of the driver is successful, and Windows assigns a communication port 

number to the USB device. 

 

 

Additional remarks 

 If you connect the PLC to a different USB port on the computer, the system may ask you to install the driver 

again. Follow the steps above, and install the driver again. After you install the driver, the communication 

port number that the operating system assigns to the USB device may have changed. 

 If Windows XP has not been updated to the version SP3 on the computer, an error message stating the 

missing files will appear during the installation. Resolve this issue with one of the following steps. 

(a) Cancel the installation, install Windows XP SP3 on the computer, and reinstall the driver according to 

the steps above. 

(b) Get the file needed, and specify the path where the file is stored for the missing file in the error 

message window. 
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A.2 Installing the USB Driver for an AS Series CPU module in 
Windows 7  

This section describes the steps to install the USB driver for an AS Series CPU module on Windows 7. To 

install the USB driver for an AS Series CPU module on another operating system, refer to the instructions in the 

operating system for information about installing new hardware.  

Before you install the USB driver, you must install ISPSoft version 3.00 or above on your computer. 

Supply power to the AS Series CPU module. Connect the AS Series CPU module to a USB port on the 

computer with a USB cable.  

(1) Windows detects the module. From the Windows Control Panel, open the Device Manager. The name of 

the USB device appears in the Device Manager window. Double-click the AS300.  
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(2) In the AS300 Properties dialog box, click Update Driver…..  

 

(3) Click Browse my computer for driver software.  
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(4) After you install ISPSoft version 3.00 or later, the driver for the AS Series CPU module is under the folder 

where you installed ISPSoft ...\ISPSoft\drivers\Delta_PLC_USB_Driver\. Enter the path to the driver, or 

click Browse to browse to the correct folder. 

Specify the correct path. If you installed the driver for the AS series CPU module to another location, 

specify the corresponding path. Click Next to continue the installation. 
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(5) Click OK. The system installs the driver. If the Windows Security window appears during the installation, 

click Install this driver software anyway. 

 

 

(6) When the installation completes, click Close. 
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(7) Open the Device Manager window again. If the name of the Delta USB device appears under Ports (COM 

& LPT), the installation of the driver is successful. The operating system assigns a communication port 

number to the USB device. 

 

 

Additional remarks 

 If you connect the PLC to a different USB port on the computer, the system may ask you to install the driver 

again. Install the driver again. After you install the driver, the communication port number that the operating 

system assigns to the USB device may have changed. 
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A.3 Installing the USB Driver for an AS Series CPU module in 
Windows 8 

Windows 8 driver signature enforcement provides a way to improve the security of the operating system by 

validating the integrity of a driver or system file each time it is loaded into memory. Because the Delta PLC USB 

driver does not include the driver signature, this section shows you how to disable driver signature enforcement 

in Windows 8 to successfully install the Delta PLC USB driver. Once you disable the driver signature 

enforcement setting, it returns to its original state after you restart Windows. 

Follow these steps to disable driver signature enforcement in Windows 8. 

1. Press the Windows button  【WIN】+【I】 on your keyboard to display the Settings window. Click 

Change PC settings. 

2. The PC settings window appears. Click General and then click Restart now under Advanced startup.  
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3. After the computer restarts, under Choose an option, click Troubleshoot.  Under Troubleshoot,  click 

Advanced options. 

 
 

4. On the Advanced options page, click Startup Settings, and then on the Startup Settings page, click 

Restart to restart the computer.  

 
 

5. Press the 7 or F7 key on your keyboard to choose Disable driver signature enforcement. Press Enter 

and the system directs you back to the Windows 8 operating system. Install the Delta PLC USB driver now 

by connecting the AS Series CPU module to your computer’s USB port. Refer to Section A2 for the steps 

to install the USB driver. 
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A.4 Installing the USB Driver for an AS Series CPU module in 
Windows 10 

Windows 10 driver signature enforcement provides a way to improve the security of the operating system by 

validating the integrity of a driver or system file each time it is loaded into memory. Because the Delta PLC USB 

driver does not include the driver signature, this section shows you how to disable driver signature enforcement 

in Windows 10 to successfully install the Delta PLC USB.  Once you disable the driver signature enforcement 

setting, it returns to its original state after restarting Windows. 

This section describes the steps to disable driver signature enforcement in Windows 10. 

1. Click the Windows Start button and then click Settings. 

2. In the Settings window, click Update & Security. 

A (Setting) B (Update & Security) 
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3. In the Settings window, click Recovery, and then click Restart now. 

C (Recovery) D (Restart now) 

  

 

4. After the computer restarts, under Choose an Option, click Troubleshoot, and then click Advanced 

options. 

 
 

5. On the Advanced options page, click Startup Settings. On the Startup Settings page click Restart to 

restart the computer.  
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6. On your keyboard, press 7 or F7 to choose Disable driver signature enforcement, and the system 

directs you to the Windows 10 operating system page. Install the Delta PLC USB driver.    

 

7. Install the USB driver for the AS Series CPU module by connecting the AS Series CPU module to your 

computer’s USB port. Refer to Section A2 for the steps to install the USB driver.  
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A.5 Notes on Utilizing USB Communication  

 Suggested to use USB communication in the following occasions: PLC program upload / download, 

PLC parameters monitoring, and firmware upgrade. 

 Suggested NOT to use USB communication for applications that require long time communication and 

without any connection drop.  

 When experiencing connection lost, you can unplug the USB cable and then plug it back in and try the 

communication again.  

 For the first time USB communication user, you need to install the USB driver for the AS Series PLC 

CPU.  

 If the communication is still not working after unplugging and plugging, you need to open the Devices 

(Windows settings -> Devices) to see if the USB driver is still valid. The USB driver may be lost due to 

Windows updates. If your USB driver is invalid, install the USB driver again.  
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B.1 Standard Modbus Device Addresses 

Applicable to AS300 and AS200 series PLC 

Device Type Format Device range 
Modbus address 

(Decimal number) 

AS Address  

(Hexadecimal number) 

X 
Bit DD.DD X0.0-X63.15 124577-125600 6000-63FF 

Word DD X0-X63 332769-332832 8000-803F 

Y 
Bit DD.DD Y0.0-Y63.15 040961-041984 A000-A3FF 

Word DD Y0-Y63 440961-441024 A000-A03F 

M Bit DDDD M0-M8191 000001-008192 0000-1FFF 

SM Bit DDDD SM0-SM4095 016385-020480 4000-4FFF 

SR Word DDDD SR0-SR2047 449153-451200 C000-C7FF 

D Word DDDDD D0-D29999 400001-430000 0000-752F 

S Bit DDDD S0-S2047 020481-022528 5000-57FF 

T 
Bit DDD T0-T511 057345-057856 E000-E1FF 

Word DDD T0-T511 457345-457856 E000-E1FF 

C 
Bit DDD C0-C511 061441-061952 F000-F1FF 

Word DDD C0-C511 461441-461952 F000-F1FF 

HC 
Bit DDD HC0-HC255 064513-064768 FC00-FCFF 

DWord DDD HC0-HC255 464513-464768 FC00-FCFF 

E Word DD E0-E9 465025-465039 FE00-FE09 
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B.2 Function Codes and Number of Devices Supported 
for Modbus Protocols 

Applicable to AS300 and AS200 series PLC 

Function 

code 
Name Description 

Number of devices 
supported 

(FW V1.06.00 or 
later) 

Number of devices 
supported 

(FW V1.06.10 or 
later) 

01 Read Coil Status X, Y, M, SM, S, T, C, HC 1~256 bits 1~1600 bits 

02 
Read Discrete Input 

Status 
X, Y, M, SM, S, T, C, HC 1~256 bits 1~1600 bits 

03 Read Holding Registers X, Y, SR, D, T, C, HC, E 
1~100 words,  

(1~50 for HC) 

1~100 words,  

(1~50 for HC) 

04 Read Input Registers X 1~100 words 1~100 words 

05 Force Single Coil Y, M, SM, S, T, C, HC 1 bit 1 bit 

06 Preset Single Register Y, SR, D, T, C, HC, E 1 word 1 word 

0F Force Multiple Coils Y, M, SM, S, T, C, HC 1~256 bits 1~1600 bits 

10 Preset Multiple Register Y, SR, D, T, C, HC, E 
1~100 words,  

(1~50 for HC) 

1~100 words,  

(1~50 for HC) 

17 
Read/Write Multiple 

Register 
Y, SR, D, T, C, HC, E 

1~100 words,  

(1~50 for HC) 

1~100 words,  

(1~50 for HC) 
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C.1 EMC Standards for an AS Series System 

C.1.1 AS Series System EMC Standards 

The EMC standards that are applicable to an AS series system are listed in the following tables. 

 EMI 

Port Frequency range Level (Normative) Reference standard 

Enclosure port 

(radiated) 

(measured at a 

distance of 10 meters) 

30-230 MHz 40 dB (μV/m) quasi-peak 

IEC 61000-6-4 
230-1000 MHz 47 dB (μV/m) quasi-peak 

AC power port 

(conducted) 

0.15-0.5 MHz 
79 dB (μV) quasi-peak 

IEC 61000-6-4 
66 dB (μV) average 

0.5-30 MHz 
73 dB (μV) quasi-peak 

60 dB (μV) average 

 

 EMS 

Environmental 

phenomenon 

Reference 

standard 
Test Test level 

Electrostatic 

discharge 
IEC 61000-4-2 

Contact ± 4 kV 

Air ± 8 kV 

Radio frequency 

electromagnetic field  

Amplitude modulated 

IEC 61000-4-3 
80% AM, 

1 kHz sinusoidal 

2.0-2.7 GHz 1 V/m 

1.4-2.0 GHz 3 V/m 

80-1000 MHz 10 V/m 

Power frequency 

magnetic field  
IEC 61000-4-8 

60 Hz 30 A/m 

50 Hz 30 A/m 
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 Conducted immunity test 

Environmental phenomenon 
Fast transient 

burst 
High energy surge 

Radio frequency 

interference 

Reference standard IEC 61000-4-4 IEC 61000-4-5 IEC 61000-4-6 

Interface/Port 
Specific 

interface/port 
Test level Test level Test level 

Data 

communication 

Shielded cable 1 kV 1 kV CM 10 V 

Unshielded cable 1 kV 1 kV CM 10 V 

Digital and analog 

I/O 

AC I/O 

(unshielded) 
2 kV 

2 kV CM 

1 kV DM 
10 V 

Analog or DC 

I/O(unshielded) 
1 kV 1 kV CM 10 V 

All shielded lines 

(to the earth) 
1 kV 1 kV CM 10 V 

Equipment power 

AC power 2 kV 
2 kV CM 

1 kV DM 
10 V 

DC power 2 kV 
0.5 kV CM 

0.5 kV DM 
10 V 

I/O power and 

auxiliary power 

output 

AC I/O and AC 

auxiliary power 
2 kV 

2 kV CM 

1 kV DM 
10 V 

DC I/O and DC 

auxiliary power 
2 kV 

0.5 kV CM 

0.5 kV DM 
10 V 
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C.1.2 Installation Instructions to meet EMC Standards 

You must install an AS Series PLC in a control box. The control box protects the PLC and isolates 

electromagnetic interference generated by the PLC. 

(1) Control box 

 Use a conductive control box. Remove the paint on the plate bolts to ensure good contact between the 

inner plate and the control box. 

 Connect the control box with a thick wire to ensure that the control box is well-grounded, even if there 

is high-frequency noise.  

 The diameter of holes in the control box must be less than 10 millimeters (3.94 inches). Radio 

frequency noise may be emitted if the hole diameter is larger than 10 millimeters. 

 Minimize the distance between the door of the control box and the PLC to prevent radio waves from 

leaking. You can also prevent radio waves from leaking by putting an EMI gasket on the painted 

surface. 

(2) Connecting a power cable and a ground 

Connect the PLC system power cable and the ground as described below. 

 Provide a ground point near the power supply module. Use thick, short wires to connect the terminals 

LG and FG with the ground. The length of the wire should be less than 30 centimeters (11.18 inches). 

Noise generated by the PLC system is passed to the ground through LG and FG; therefore, the 

impedance should be as low as possible. Although the wires are used to reduce noise, they 

themselves carry a lot of noise. Using short wires can prevent the wires from acting as antennas. 

 Twist the ground and the power cable together; the noise flowing through the power cable is then 

passed to the ground. The ground and the power cable do not need to be twisted if you install a filter 

on the power cable. 
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C.1.3 Cables 

Grounding a shielded cable 

Cables drawn from the control box carry high-frequency noise. When they are outside of the control box, they 

are like antennas emitting noise. The cables connected to digital input/output modules, analog input/output 

modules, temperature measurement modules, network modules, and motion control modules should all be 

shielded cables to prevent the emission of noise. Using shielded cables also increases the resistance to 

external noise. You improve the resistance to noise if the signal cables that are connected to the digital 

input/output modules, analog input/output modules, temperature measurement modules, network modules, 

and motion control modules are all shielded cables that are grounded properly. If you do not use shielded 

cables or ground the shielded cables correctly, noise resistance will not improve. Make sure the shield of any 

connected cable contacts the control box.  You must scrape any paint off of the control box at the contact point. 

All fastening must be metal, and the shield must contact the surface of the control box. Use washers to correct 

any unevenness or use an abrasive to level the surface. 

Ground the shield of a shielded cable as close to a module as possible. Ensure that there is no electromagnetic 

induction between grounded cables.   
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D.1  Cautions 

Observe the following precautions before performing maintenance and inspection.  Incorrect or careless operation 

will lead to injury or equipment damage. 

  To prevent a breakdown of an AS Series system or a fire, ensure that the ambient environment 

does not contain corrosive substances such as chloride gas, sulfide gas or flammable substances 

such as oil mist, cutting powder, or dirt. 

  To prevent the connectors from oxidizing and to prevent electric shock, do not touch the 

connectors. 

  To prevent electric shock, turn off the power before pulling the connectors or loosening the 

screws. 

  To prevent cable damage, and to prevent the connectors from being loosened, do not put weight 

on the cables or pull on them. 

  Ensure that the input voltage is within the rated range. 

  To prevent product breakdown, fire, or injury, do not disassemble or alter the modules. 

  To prevent a controlled element from malfunctioning, ensure that the program and parameters 

are written into a new CPU module before restarting the AS Series system.  

  To prevent incorrect output or equipment damage, refer to the related manuals for more 

information about operating the modules. 

  To prevent damage to the modules, touch grounded metal or wear an antistatic wrist strap to 

release static electricity from your body before working on a module. 

  To prevent noise from causing system breakdown, keep a proper distance from the system when 

using a cell phone or communication device. 

  Do not install an AS Series system in direct sun or in a humid environment. 

  To prevent the temperature of an element from being too high, maintain a proper distance 

between the AS Series system and heat sources such as coils, heating devices, and resistors. 

  To protect an AS Series system, install an emergency stop switch and an overcurrent protection 

device.   

  Inserting and pulling a module several times can loosen the contact between the module and the 

backplane. 
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  To prevent an unexpected shock from resulting in damage to the AS Series system and a 

controlled element, ensure that the modules are correctly and firmly installed. 

D.2 Daily Maintenance 

To keep an AS series system operating normally, ensure that the ambient environment and the AS series system 

conform to the cautions listed in section D.1. You can then perform the daily inspection described below. If you find any 

problems, follow the solution and perform any necessary maintenance. 

D.2.1 Required Inspection Tools 

 A screwdriver 

 Industrial alcohol 

 A clean cotton cloth 

D.2.2 Daily Inspection 

No. Item Inspection Criterion Remedy 

1 Appearance Check visually. 
Dirt must not be 

present. 
Remove the dirt. 

2 Installing of a backplane 

Check whether the set 

screws are loose. 
The backplane must 

be installed firmly. 

Tighten the 

screws. 

Check whether the 

backplane is installed on 

the DIN rail properly. 

Install the 

backplane on the 

DIN rail properly. 

3 Installing of a module 

Check whether the 

module is loose that the 

projection is inserted into 

the hole on the backplane, 

and that the screw is 

tightened. 

The projection under 

the module must be 

inserted into the hole 

in the backplane, and 

the screw must be 

tightened. 

Install the module 

firmly. 

4 Connection 

Check whether the 

removable terminal block 

is loose. 

The removable 

terminal block must 

not be loose. 

Install the terminal 

block firmly. 

Check whether the 

connector is loose. 

The connector must 

not be loose. 

Tighten the 

screws on the 

connector. 
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No. Item Inspection Criterion Remedy 

5 

Power 

supply 

module 

POWER 

LED 

indicator 

Check whether the 

POWER LED indicator is 

ON. 

The POWER LED 

indicator must be ON. 

Please refer to 

Chapter 12 for 

more information 

about 

troubleshooting. 

CPU 

module 

RUN LED 

indicator 

When the CPU module is 

running, check whether 

the RUN LED is ON. 

The RUN LED 

indicator must be ON. 

ERROR LED 

indicator 

Check whether the 

ERROR LED indicator is 

OFF. 

The ERROR LED 

indicator must be OFF. 

BUS FAULT 

LED 

indicator 

Check whether the BUS 

FAULT LED indicator is 

OFF. 

The BUS FAULT LED 

indicator must be OFF. 

SYSTEM 

LED 

indicator 

Check whether the 

SYSTEM LED indicator is 

OFF. 

The SYSTEM LED 

indicator must be OFF. 

LED indicators on an 

extension module* 

Check whether the LED 

indicators on the 

extension module are ON. 

If the LED indicators 

are ON, the module is 

operating normally. 

* Please refer to the Module Manual for more information related to the LED indicators on the extension modules. 

D.3 Periodic Maintenance 

In addition to daily inspection, you should perform periodic maintenance depending on the actual operating 

environment. After making sure that the ambient environment and the AS Series system conform to the cautions listed 

in Section D.1, perform the periodic inspection described below. If you find any problems, follow the solution and 

perform any necessary maintenance. 

D3.1 Required Inspection Tools 

 A screwdriver 

 Industrial alcohol 

 A clean cotton cloth 

 A multimeter 

 A thermometer 

 A hygrometer 
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D.3.2 Periodic Inspection 

No. Item Inspection Criterion Remedy 

1 

A
m

bi
en

t e
nv

iro
nm

en
t Ambient 

temperature/hu

midity 

The ambient temperature 

and the ambient humidity 

are measured by a 

thermometer and a 

hygrometer. 

The ambient 

temperature and the 

ambient humidity must 

conform to the 

specifications for the 

modules or the 

backplane. If the 

specifications are 

different, the strictest 

specifications have 

priority. 

To ensure that the 

system operates 

in a stable 

environment, 

determine why the 

environment 

varies, and 

resolve the issue. 

Atmosphere Measure corrosive gas. 
Corrosive gas must 

not be present. 

2 Supply voltage 
Measure the AC power 

supply. 

The power supply 

should meet the 

specifications for the 

power supply module. 

Check the power 

supply. 

3 

In
st

al
la

tio
n Looseness 

Check whether the module 

is loose. 

The module must be 

installed firmly. 

Please refer to 

Chapter 4 for 

more information 

on installing the 

module. 

Adhesion of 

dirt 
Check the appearance. 

Dirt must not be 

present. 
Remove the dirt. 

4 

C
on

ne
ct

io
n 

Looseness of 

terminal 

screws  

Tighten the screws with a 

screwdriver. 

The screws must not 

be loose. 

Tighten the 

screws. 

Looseness of 

connectors 
Pull the connectors. 

The connectors must 

not be loose. 

Tighten the 

screws on the 

connectors. 

5 
PLC system 

diagnosis 
Check the error logs. No new error occurs. 

Please refer to 

section 12.1.3 for 

more information. 
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No. Item Inspection Criterion Remedy 

6 Maximum scan time 

Check the states of SR413 

and SR414 through the 

device monitoring table in 

ISPSoft. 

The maximum scan 

cycle must be within 

the range specified in 

the system 

specifications. 

Determine why 

the scan time 

exceeds 

specifications. 
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